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Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help
You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed Help
If you’re setting up an on-premise PeopleSoft environment, and your organization has firewall restrictions
that prevent you from using the hosted PeopleSoft Online Help, you can install the online help locally.
See Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files
You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation
Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

• Application Fundamentals

• Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.
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In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions
PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions
The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign 
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

. . . (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
 Options are separated by a pipe ( | ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
 an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

⇒ This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes
PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.
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ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY_CD_TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY_TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers
Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

• Asia Pacific

• Europe

• Latin America

• North America

Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

• USF (U.S. Federal)

• E&G (Education and Government)

Translations and Embedded Help
PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We
are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.
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Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

• Using the PeopleSoft Online Help.

• Managing hosted Online Help.

• Managing locally installed PeopleSoft Online Help.

Related Links for PeopleSoft HCM

Oracle Help Center

PeopleSoft Online Help Home

PeopleSoft Information Portal

My Oracle Support

PeopleSoft Training from Oracle University

PeopleSoft Video Feature Overviews on YouTube

PeopleSoft Business Process Maps (Microsoft Visio format)

HCM Abbreviations

PeopleSoft Spotlight Series

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.

Follow Us

Icon Link

YouTube
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Icon Link

Twitter@PeopleSoft_Info.

PeopleSoft Blogs

LinkedIn
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Chapter 1

Getting Started with PeopleSoft Manage
Base Benefits

PeopleSoft Manage Base Benefits Overview

The PeopleSoft Manage Base Benefits business process provides you with the tools that you need to
manage your employee benefit programs. It enables you to set up your basic benefits system architecture
and manually enroll employees and their dependents into the benefits system. This comprehensive
benefits management solution supports a full range of benefit programs and plans, and provides you with
everything you need to maintain your benefit records and to respond to inquiries from decision makers,
managers, and other employees.

With the PeopleSoft Manage Base Benefits business process, you can:

• Define the tables that you need to build your benefit programs.

• Manually enroll employees and dependents into benefit programs.

• Print HIPAA (Health Insurance Portability and Accountability Act) reports.

• Track and manage FMLA (Family Medical Leave Act) requests.

• Calculate accrued leave awards and maintain employee leave balances.

• Manage qualified savings plans and pension plans.

• Manage vacation buy and sell programs.

• Administer COBRA (Consolidated Omnibus Budget Reconciliation Act) coverage for qualified
participants and their dependents.

• Process retroactive benefits and deductions.

• Send enrollment data to third-party administrators.

• Send FEHB (federal employee health benefits) data to the OPM (Office of Personnel Management).

Related Links
"PeopleSoft Benefits Administration Overview" (PeopleSoft Benefits Administration)

PeopleSoft Manage Base Benefits Business Process

The PeopleSoft Manage Base Benefits business process includes four core phases of operation:
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1. Setting up supporting tables and benefit plans.

2. Building benefit programs.

3. Assigning employees to benefit programs and enroll them in plans for which their program enrollment
makes them eligible.

Note: For Federal users, employees are assigned to benefit programs through the HR PAR process.

4. Calculating rates and benefit deductions.

If you use PeopleSoft Payroll for North America, you calculate deductions through the payroll
process. If you use another payroll system, you use PeopleSoft Payroll Interface to link the PeopleSoft
benefits information to that system.

The following diagram illustrates the four core phases of operation that make up the structure upon which
benefit programs are built:

PeopleSoft Manage Base Benefits Integrations

The PeopleSoft Manage Base Benefits business process integrates with the following PeopleSoft
applications:

• HR Administer Workforce.

• HR Report Total Compensation.

24  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 1 Getting Started with PeopleSoft Manage Base Benefits

• HR Company Cars.

• Payroll for North America.

• Benefits Administration.

• FSA Administration.

• Stock Administration.

• Pension Administration.

• Payroll Interface.

This diagram illustrates the PeopleSoft Manage Base Benefits integration flow with other PeopleSoft
applications.

We cover integration considerations in the implementation topics in this PeopleBook.

Supplemental information about third-party application integrations is located on the Oracle's website.

Related Links
"Identifying Integrations for Your Implementation" (Application Fundamentals)

PeopleSoft Manage Base Benefits Implementation

PeopleSoft Setup Manager enables you to generate a list of setup tasks for your organization based on
the features that you are implementing. The setup tasks include the components that you must set up,
listed in the order in which you must enter data into the component tables, and links to the corresponding
PeopleBook documentation.

Other Sources of Information

In the planning phase of your implementation, take advantage of all PeopleSoft sources of information,
including the installation guides, data models, business process maps, and troubleshooting guidelines.
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Refer to the PeopleSoft HCM 9.2 - Reorganization of Component Interface Permissions (Doc ID
2342162.1) MOS posting for a list of system-delivered CIs and their usage, the mapping of CIs and
associated permission lists, and the mapping of CI permission lists and user roles.

Related Links

See product documentation for:

PeopleTools: Setup Manager

PeopleTools: Component Interfaces
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Chapter 2

Setting Up the Installation Table for Base
Benefits

Defining the Installation Settings for Base Benefits

To set up implementation defaults for Base Benefits, use the Benefits Installation (INSTALLATION_BN)
component.

This topic describes the Benefits installation component. Other system-wide implementation defaults
are set on the installation (INSTALLATION_TBL) component for Human Resources. See "Setting
Up Implementation Defaults" (Application Fundamentals) in your PeopleSoft HCM Application
Fundamentals product documentation. Also consult your PeopleSoft Human Resources installation
product documentation.

Pages Used to Define Benefits Installation Settings

Page Name Definition Name Usage

Benefits Installation Page INSTALLATION_BN Defines system-wide Benefits
installation settings.

Note: The settings given here are in
addition to the settings on pages in the
Installation (INSTALLATION_TBL)
component for HR.

Benefits Installation Page
Use the Benefits Installation page (INSTALLATION_BN) to define system-wide Benefits settings.

Note: The settings given here are in addition to the settings on the pages in the Installation
(INSTALLATION_TBL) component for HR.

Navigation:

Set Up HCM, >Install, >Product Specific, >Benefits Installation
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This example illustrates the fields and controls on the Benefits Installation page.

Related Links
"Setting Up Implementation Defaults" (Application Fundamentals)
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Setting Up Base Benefits Core Tables

Understanding the Core Tables for PeopleSoft Manage Base
Benefits

Before you can begin building your benefit programs and entering your benefit plan information, some
core tables must be set. These topics discuss setting up these tables.

Setting Up Benefit Providers

A benefit provider is a vendor. It is the entity that sponsors the benefit plan that your company offers your
employees. For example, if your company offers a Blue Cross/Blue Shield health insurance plan, Blue
Cross/Blue Shield is the provider. If your organization has a self-funded medical plan but uses a third-
party administrator (TPA) to handle administrative functions such as eligibility and claims, the TPA can
be considered a vendor.

You use the Provider/Vendor Table component (PROVIDER_TABLE) to set up an ID for each vendor.

To include a benefit provider in the HIPAA (Health Insurance Portability and Accountability Act) EDI
File Creation process, you must specify the vendor's Federal Employer Identification Number (FEIN).

Warning! If your organization uses PeopleSoft Payroll for North America or PeopleSoft Payroll Interface
to pay a benefit vendor, add the vendor using the Payables Vendor table, not the Base Benefits Provider/
Vendor table.

Related Links
"Understanding Vendor Tables" (Application Fundamentals)
"Using PeopleSoft eBenefits Pages" (PeopleSoft eBenefits)

Setting Up Dependent Relationships

Use the Dependent Relationships Table (DEPBEN_TYPE_TBL) component to define dependent
relationships.

This section provides an overview of dependent relationships and discusses how to define dependent
relationships.

See "Using PeopleSoft eBenefits Pages" (PeopleSoft eBenefits).
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Note: Beneficiary relationships are not tracked because they do not have the same legal ramifications as
dependents.

Page Used to Set Up Dependent Relationships

Page Name Definition Name Usage

Dependent Relationships Table Page DEPBEN_TYPE_TBL Define dependent relationships.

Coverage Code Tbl (Coverage Code
Table) Page

COVRG_CD_TBL Create new coverage codes for your
benefit programs. We recommend that
you give the coverage code a numeric
value of one through seven. Coverage
codes should be ordered according to
their complexity, with Employee being
first

Personal Profile Page DEPEND_BENEF2 Enter or update information about a
dependent.

Understanding Dependent Relationships
You define the relationships—for example, child, grandparent (grandmother or grandfather), nephew,
or niece (other relative)—that qualify as dependents according to your organization's rules. You
cannot enroll dependents in benefits if their relationships are not defined. For example, if you had not
defined child as an allowable dependent type, you couldn't enter an employee's son as a dependent.
The characteristics that you apply to the relationship will be used later by the system to validate the
relationship.

Dependent Relationships Table Page
Use the Dependent Relationships Table (dependent relationship) page (DEPBEN_TYPE_TBL) to define
dependent relationships.

Navigation:

Set Up HCM > Product Related > Base Benefits > Dependent Relationships Table > Dependent
Relationships Table

This example illustrates the fields and controls on the Dependent Relationships Table page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Relationship to Employee Displays the relationship that you selected to access the page.

Effective Date Enter the date on which the dependent relationship goes into
effect.

Status Select whether the dependent relationship is Active or Inactive.

If the status is Inactive, the relationship is no longer considered
a valid dependent relationship.

Covered Person Type Select the covered person type you are using to define the
relationship.

The delivered values are:

• Employee

• Spouse

• Child (child, grandchild, domestic partner child, other
child, step child, foster child)

• Adult Child (children who are eligible to be enrolled in
their parents’ health plan until they attain age 26.)

• Other Qualified Dependent

• Domestic Partner

• Non-qualified Dependent

• ExSpouse

Age Limit Flag When the COBRA process for overage dependents runs, the
system uses this check box to indicate which dependent roles
should have the overage rules applied.

Field or Control Description

Certificate ID Select to define a certification form for a relationship. The
certificate ID defined here appear in the Oracle's PeopleSoft
eBenefits Self-Service application.
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Field or Control Description

Mutually Exclusive Select to limit each participant to one dependent with a
relationship that has been flagged as mutually exclusive at
one time. The system allows the participant to save more than
one mutually exclusive dependent in eBenefits, but makes the
dependent a beneficiary. An informational message appears to
the employee.

Field or Control Description

Gender Validation Values include:

• No Gender Validation: Select for no gender validation to
occur.

• Opposite Sex Only: Select to ensure that when a
dependent is added or a relationship changes, that person
is the opposite sex from the participant.

• Same Sex Only: Select to ensure that when a dependent is
added or a relationship changes, that person is the same
gender as the participant.

Note: Certificate ID and gender validation can affect benefits certification.

Related Links
Setting Up Benefits Certifications

Setting Up Coverage Codes

To set up the coverage code that defines who can be covered by a benefit, use the Health Coverage Codes
(COVERAGE_CODES) component.

This section provides an overview of coverage codes and discusses how to define coverage codes.

Page Used to Set Up Coverage Codes

Page Name Definition Name Usage

Health Coverage Codes Page COVRG_CD_TBL Define coverage codes.

Understanding Coverage Codes
You define and manage coverage codes for your benefit programs using the Coverage Code table. You
will attach these coverage codes to your benefit plan options on the Benefit Program table.
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PeopleSoft Manage Base Benefits delivers nine basic coverage codes for which you define a minimum
and maximum allowable for each eligible covered person type. These delivered coverage codes are
described in this table:

You should create a new Coverage Code or modify your existing Coverage codes as appropriate to
include the Covered Person type of Adult Child.

Delivered
Coverage Code

Employee
Minimum /
Maximum

Spouse
Minimum /
Maximum

Domestic
Partner
Minimum /
Maximum

Other Qualified
Dependent or
Child Minimum /
Maximum

Other
Nonqualified
Dependent
Minimum /
Maximum

1

Employee Only

1 / 1 not allowed not allowed not allowed not allowed

2

Employee +
Spouse

1 / 1 1 / 1 not allowed not allowed not allowed

3

Employee +
Dependents

1 / 1 not allowed not allowed 1 / 99 not allowed

4

Family

1 / 1 1 / 1 not allowed 1 / 99 not allowed

5

Domestic Partner
Adult

not allowed not allowed 1 / 1 not allowed not allowed

6

Domestic Partner
Child(ren)

not allowed not allowed not allowed not allowed 1 / 99

7

Domestic Partner
Adult + Child(ren)

not allowed not allowed 1 / 1 not allowed 1 / 99

12

EE + Domestic
Partner

1 / 1 not allowed 1 / 1 not allowed not allowed
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Delivered
Coverage Code

Employee
Minimum /
Maximum

Spouse
Minimum /
Maximum

Domestic
Partner
Minimum /
Maximum

Other Qualified
Dependent or
Child Minimum /
Maximum

Other
Nonqualified
Dependent
Minimum /
Maximum

14

EE + Domestic
Partner + Child
(ren)

1 / 1 not allowed 1 / 1 1 / 99 not allowed

22

Employee + Same-
Sex Spouse

1 / 1 1 / 1

(US Same-Sex
Spouse)

not allowed not allowed not allowed

24

Family (with
Same-Sex Spouse)

1 / 1 1 / 1

(US Same-Sex
Spouse)

not allowed 1 / 99 not allowed

90

Covered Person

1/1 0/1 0/1 0/99 0/9

You can also define coverage codes to validate enrollments against a total number of eligible covered
person types, for example, a coverage code that allows enrollment of the employee plus one dependent.
The dependent can be either a spouse or a child. The system will sum the allowable covered person types
defined for the coverage code rather than look at the minimum and maximum defined for each individual
covered person type.

Coverage Code 90 is used to coordinate with the rate structure where you combine a qualified and a non
qualified person under one rate, for example, employee and domestic partner. It looks at "who" is covered
rather than how many persons are covered.

Health Coverage Codes Page
Use the Health Coverage Codes page (COVRG_CD_TBL) to define coverage codes.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Health Coverage Codes >
Health Coverage Codes
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This example illustrates the fields and controls on the Health Coverage Codes page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

COBRA Coverage Set A 2-character code that is used to group coverage codes
together for COBRA eligibility purposes. When an individual
experiences a COBRA event, the system must adjust the range
of coverage codes available to each qualified beneficiary. By
restricting itself to a specific set of coverage codes, COBRA
processing can more accurately determine which benefit
options to present to a participant who is eligible for COBRA
coverage. If COBRA coverage sets are not established, then
COBRA processing may encounter multiple equivalent
coverage codes, and eligibility determination may fail.

Total Covered Persons Select to activate the total covered person types functionality
for this coverage code.

Total Minimum Covered  and Total Maximum Covered These fields are visible only when the Total Covered Persons
check box is selected.

Enter the allowable minimum and maximum covered persons.
 Include the employee in this count.
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Allowable Covered Person Types

Field or Control Description

Covered Person Type Select from the following values to define the relationship you
have to the dependent.

Child, Adult Child, Domestic Partner, Employee, ExSpouse,
 Non-Qualified Dependent, Other Qualified Dependent,
 Spouse, and US Same-Sex Spouse.

Note: The coverage code controls for covered person type are
used in PeopleSoft Benefits Administration.

See "Event Rules Table- Event Rules Page" (PeopleSoft
Benefits Administration).

Minimum Covered Enter the minimum number of covered persons allowed.

If you selected the Total Covered Persons check box, this
field is not editable.

Maximum Covered Enter the maximum number of covered persons allowed.

If no limit applies to the number for this coverage code, enter
99.

If you selected the Total Covered Persons check box, this
field is not editable.

Setting Up Coverage Group Codes

To set up coverage group codes, use the Life and AD/D Coverage Groups (COVERAGE_GROUP_TBL)
component.

This section provides an overview of coverage group codes and discusses how to enter coverage group
code information.

Page Used to Set Up Coverage Group Codes

Page Name Definition Name Usage

Life and AD/D Coverage Groups Page COVERAGE_GROUP_TBL Enter the coverage group code
information that sets the maximum total
life and AD/D coverage for a group of
life and AD/D benefit plans.
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Understanding Coverage Group Codes
Life insurance and accidental death and dismemberment (AD/D) plans use coverage group codes to
establish the maximum lifetime coverage allowed.

For example, if you define a coverage group code with a 500,000 USD maximum, then enter that
coverage group code for a supplemental life plan and a group life plan, and associate both benefit plans
with a benefit program. If you were to enroll an employee in both of those plans, the system would ensure
that the employee's total coverage by both plans does not exceed 500,000 USD.

If the total coverage for a participant exceeds the coverage maximum, the system reduces the total
coverage to meet the coverage maximum. When the system processes the deduction, it accumulates the
coverage amounts and begins reducing coverage when the coverage group maximum is reached. The
system processes plans in order of deduction priority, and if more than one plan has the same priority, it
processes in increasing plan type order.

Note: Oracle's PeopleSoft Payroll uses the effective date to determine which coverage maximum to use
for a particular processing cycle, according to the pay period end date.

Life and AD/D Coverage Groups Page
Use the Life and AD/D Coverage Groups page (COVERAGE_GROUP_TBL) to enter the coverage
group code information that sets the maximum total life and AD/D coverage for a group of life and AD/D
benefit plans.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Life and AD/D Coverage
Groups > Life and AD/D Coverage Groups

This example illustrates the fields and controls on the Life and AD/D Coverage Groups page. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Effective Date Enter the effective date for the coverage maximum.

Payroll uses the effective date to determine which coverage
maximum to use for a particular processing cycle, according to
the pay period end date.
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Field or Control Description

Coverage Maximum Enter the maximum total life and AD/D coverage.

This amount applies to all the life and AD/D benefit plans
that you associate with the coverage group code and that you
associate with one benefit program.

You connect a life or AD/D plan with a coverage group code
using the Life and AD/D Plan table.

Setting Up FEGLI Codes

To set up Federal Employee Group Life Insurance (FEGLI) codes, use the FEGLI Code Table
(GVT_FEGLI_TBL) component.

This section discusses how to enter FEGLI code information.

Page Used to Set Up FEGLI Codes

Page Name Definition Name Usage

FEGLI Code Table Page GVT_FEGLI_TBL Enter FEGLI code information.

FEGLI Code Table Page
Use the FEGLI Code Table page (GVT_FEGLI_TBL) to enter FEGLI code information.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > FEGLI Codes > FEGLI
Codes
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This example illustrates the fields and controls on the FEGLI Code Table page. You can find definitions
for the fields and controls later on this page.

Setting Up the Service Step Table

To set up the service step table, use the Service Step Table (SERVICE_STEP_TABLE) component.

This section provides an overview of the service step table and discusses how to enter service step table
information.

Page Used to Set Up the Service Step Table

Page Name Definition Name Usage

 Service Step Table Page SERVICE_STEP_TABLE Enter service step table information
that links the rate of employer matching
contributions to an employee's length of
service.

Understanding the Service Step Table
When you set up savings plans, you can define your organization's employer match according to the
employee's years of service. The Service Step Table defines the different intervals, tax classification, and
amount of match.

You can also define deduction classifications based on either a percentage of the employee's gross salary
or a percentage of the employee's contribution amount.

 Service Step Table Page
Use the Service Step Table page (SERVICE_STEP_TABLE) to enter service step table information that
links the rate of employer matching contributions to an employee's length of service.

Navigation:
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Set Up HCM > Product Related > Base Benefits > Rates and Rules > Service Step Table > Service
Step Table

This example illustrates the fields and controls on the Service Step Table page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

After Months of Service Enter the number of months the employee must be employed
to receive the employer match.

Deduction Class Enter the tax classification for this match.

Up to % of Employee Earnings  (up to percent of employee
earnings)

Enter the maximum amount of the employer match
contribution percentage.

% of Employee Investment (percent of employee
investment)

Enter the percentage amount of the employee contribution that
the employer will match.

Example of Before-Tax and After-Tax Matching

Assume you have a 401(k) plan that's set up to match:

• 50% for the first 3% of the employee's salary for before-tax contributions.

• 100% up to 6% of the employee's salary for before-tax contributions.
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• 25% on the first 2%, 50% up to 4%, and 100% up to 6% on the employee's after-tax contributions.

Here's how you set this up:

Deduction Class Up to % of Employee Earnings % of Employee Investment

Before 3 50

Before 6 100

After 2 25

After 4 50

After 6 100

Setting Up the Service Step Table for Thrift Savings Plan (TSP) Employer Match
Calculation for Federal Benefits

For Thrift Savings Plan (TSP) Employer Match Calculation, set up the Service Step Table as follows:

1. The first 3% of contribution is 100% Employer Match.

2. The remaining contribution is 50% Employer Match.

3. Total contribution for matching cannot exceed 5%.

This image shows the Service Step Table for Thrift Savings Plan (TSP) employer match calculation for
federal benefits.
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Example of After Months of Service Rewards

This example shows how to use the After Months of Service field to create multiple service steps to
reward employees for staying with the company.

After Months of Service Deduction Class Up to % of Employee
Earnings

% of Employee
Investment

0 Before 3 50

0 Before 6 100

0 After 2 25

0 After 4 50

0 After 6 100

24 Before 10 100

24 After 2 50

24 After 4 75

24 After 6 100

Setting Up Benefit Rates

To set up benefit rates, use the Benefit Rate Types (BN_RATE_TYPE) and Benefit Rates
(BN_RATE_TABLE) components.

This section provides overviews of benefit rates and percent of gross limits.

Pages Used to Define Benefit Rates

Page Name Definition Name Usage

Benefit Rate Types Page BN_RATE_TYPE Define benefit rate types.

Benefit Rates Page BN_RATE_TABLE Enter benefit rate information.
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Page Name Definition Name Usage

Amount Subject to Limit Page BN_RATE_LMT_SEC Define the percent-of-gross limits.

Understanding Benefit Rates
Benefit rates are used by plan types AX (Simple Benefits), 1X (Health Benefits), 2X (Life and Accidental
Death), and 3X (Disability). The Benefit Rate table defines rates in terms of flat amounts, percentages of
compensation base, or rates per-unit-of-coverage. It also defines the criteria to use to select an individual
rate from the table, such as age, gender, coverage code, benefit plan, or compensation range. The structure
of a set of benefit rates (the rate terms and the selection criteria) is defined in the Benefit Rate Types page,
while the rate data is entered in the Benefit Rates page. Benefit rate types enable you to mix and match
criteria and rate terms to create benefit rates that best fit your business needs.

Understanding Percent of Gross Limits
Some states set a limit on the amount an employee pays for certain benefits, especially health insurance.
This limit is based on a percentage of the employee's gross pay, and the percentage is defined on the
Calculation Rules Table. However, this limit applies only to the portion of a benefit cost that represents
coverage for the employee—the cost to cover a spouse or other family members is not subject to the limit.
In general, the benefits rates do not break out costs per person. Therefore, the Benefit Rate table has a
special entry area for defining what portion of the overall employee rate is subject to this optional limit.

If the percent-of-gross limit is, in fact, defined, then the system applies this limit by calculating benefit
costs like this:

Lesser of [(EE Premium Amount Subject to Limit) or (Gross Pay × Limit %)] plus (Total EE Premium
Amount − EE Premium Amount Subject to Limit)

Suppose that a monthly-paid employee is enrolled in family medical coverage, which has a flat rate of
300 USD per month. The amount of the employee's portion is 125 USD. The following example shows
how to apply a 1.0% of gross pay limit to the employee-only coverage:

Total EE Premium Amount = 300 USD
EE Premium Amount Subject to Limit = 125 USD
Limit = 1.0% of Gross Pay
Gross Pay = 10,000 USD

The deduction is calculated as:

[Lesser of (125 or (10,000 × .01))] + (300 − 125)
= [Lesser of (125 or 100)] + (175)
= (100) + (175)
= 275 USD

The amount of the employee premium in excess of the limited deduction is 25 USD (300 − 275). This
excess amount is added to the employer-paid premium.

Here's another example. Instead of the employee's single-coverage portion of the premium being a flat
amount of 125 USD, assume that this is 30% of the premium amount:
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Total EE Premium Amount = 300 USD
EE Premium Amount Subject to Limit = 30%
Limit = 1.0% of Gross Pay
Gross Pay = 10,000 USD

The deduction is calculated as:

[Lesser of (300 × 30%) or (10,000 × .01))] + (300 − 125)
= [Lesser of (90 or 100)] + (175)
= (90) + (175)
= 265 USD

In this case, 35 USD (300 - 265) is added to the employer-paid premium.

You can define limits on the employee's portion of a benefit premium by specifying a percent of gross
limit on the Calculation Rules Table.

For example, current legislation in Hawaii requires that employers charge no more than 1.5% of an
employee's gross wages for medical coverage. Only the employee's personal coverage is subject to this
limit.

If the rate table indicates that the employer pays part of the premium, then any premium in excess of
this final employee deduction amount (in this case, 1.5% of gross wages) is redirected (added) to the
employer-paid portion of the premium. If the employer does not pay part of the premium, then no
redirection occurs.

Benefit Rate Types Page
Use the Benefit Rate Types page (BN_RATE_TYPE) to define benefit rate types.

Navigation:

Set Up HCM > Product-Related > Base Benefits > Rates and Rules > Benefit Rate Types >
Benefit Rate Types

This example illustrates the fields and controls on the Benefit Rate Types page. You can find definitions
for the fields and controls later on this page.
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Field or Control Description

Rate or Percent Select Rate if you are specifying either flat amounts or rates
per-unit-of-coverage, or Percent if the rate is calculated as a
percentage of compensation.

Uses Compensation This field is automatically selected if either the rate type is
Percent or any of the key fields that are used will use the
employee's compensation data to determine the rate.

Uses Demographics This field is automatically selected if any of the key fields that
are used will use demographic data to determine the rate.

Rate Keys

Field or Control Description

Key Nbr (key number) The key number controls the order in which the keys appear
when you create a rate table.
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Field or Control Description

Field Name The application field to use as a key in the Benefit Rate table.
 This list of available fields is fixed and limited to:

Note: The source of any biographical information is
determined by the Source of Demographics field on the
Calculation Rules Table page.

• Age (in years): The covered person's (employee, spouse,
 or other dependent) age, calculated using their birth date
and the Age-As-Of field on the Calculation Rules Table.

• Benefit Base: The employee's compensation base,
 calculated using the several benefit base-related attributes
in the Calculation Rules Table.

• Benefit Plan: The employee's enrolled benefit plan.

• Coverage Code: The employee's enrolled coverage code.

• Covered Person Type: The covered person type 
(Employee, Spouse, Domestic Partner, Child, and so
on) of the individual whose rate component is being
calculated.

• Gender: The covered person's gender.

• Months of Service: The employee's length of service,
 calculated using his or her service date and the Service-
As-Of attribute in the Calculation Rules Table.

Note: The service calculation is frozen as of a termination
date.

• Smoker Status: The covered person's smoker status.

Matching Operator Specify the type of comparison operation the system uses
when attempting to match a value with the keys of a benefits
rate table. Use this field to resolve each key ("=" for discrete
keys such as codes, and ">," ">=," "<," and "<=" for numeric
brackets.)

Note: You can define only one numeric bracket, and it must be
the last key.

Delivered Benefit Rate Types

Benefit rate types delivered with your system are:
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• Age–Graded. (By Gender, Smoker): Defines rates, flat amounts, or per unit of coverage for the insured
based on gender and smoker status within specific age brackets.

• Flat Rate: Defines rates that are based on a specific monetary amount.

• Percent of Base: Defines rates as simple fixed percentages of an employee's compensation base.

• Length of Service (Months): Defines rates (flat amounts or per unit of coverage) based on length-of-
service brackets.

• Compensation Bands: Defines rates (flat amounts or per unit of coverage) based on compensation
brackets.

• Covered Person Type: Defines rates (flat amounts or per unit of coverage) individually for each
covered person type. This rate type is applicable only to Health plans because they are the only plan
type that supports coverage codes.

This rate type allows qualified and nonqualified persons to be assigned to different rates and results in
a rate being calculated per covered person on the enrollment.

• Benefit Plan and Coverage Code: Defines rates, flat amounts, or per unit of coverage based on the
benefit plan and coverage code enrollment. This rate type is useful for consolidating all rates for a
given health provider into a single table.

Benefit Rates Page
Use the Benefit Rates page (BN_RATE_TABLE) to enter benefit rate information.

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Benefit Rates > Benefit
Rates

This example illustrates the fields and controls on the Benefit Rates page. You can find definitions for the
fields and controls later on this page.
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Warning! PeopleSoft Base Benefits delivers a set of rates with an ID of IRS. PeopleSoft Payroll for North
America uses these IRS rates to calculate imputed income. The IRS table ID set should not be changed.

Benefit Rate Table

Use the Benefit Rate Table group box to define the structure of the rate table.

Field or Control Description

Benefit Rate Type Select from one of the system-delivered or custom rate types.

This controls the overall structure of this rate table, especially
the keys in the Rate Data section

Premium Frequency Define how you quote the cost of benefit rates.

If the employee's pay frequency differs from the premium
frequency, the system annualizes the coverage rates and
divides by employee pay frequency to determine the pay
period rate.

Rate per Unit • For a flat rate, select None.

• For a rate that applies to each $100 of coverage, select
Per Hundred.

• For a rate that applies to each $1,000 of coverage, select
Per Thousand.

Currency Code (Optional) Select a currency code to indicate the currency
in which the rate data is specified. This is for informational
purposes only—the system does not perform any currency
conversion during deduction or cost calculations. However, the
system does use this information when you are in the Benefit
Program Table pages to match available benefit rates against
the currency code associated with the benefit program.

Specify Optional Limit Click to access the Amount Subject to Limit page.

See Amount Subject to Limit Page.

Rate Data

Use this group box to enter composite rates, detail rates, or tax adjustments. Composite rates are based on
a specific dollar amount. Composite rates define rates as either Employee or Employer without defining a
tax class. The actual tax class used is determined dynamically during processing based on the tax classes
defined within the applicable deduction code. Tax classes A and B (after-tax and before-tax) are employee
classes, and classes T and N (taxable and nontaxable) are employer classes. The deduction code cannot
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define more than one employee tax class or employer tax class unless a GTL (group term life) or DPL
(dependent life) effect is involved, in which case both N and T are allowed because the T class will be
managed by the imputed income processing.

You can enter rates using either the Composite method or theDetail method, but not both.

Composite Rates

Enter the rates that are based on a specific dollar amount. The appearance of the grid is based on the
benefit rate type.

Field or Control Description

Age (>) You can enter the keys based on your criteria from the benefit
rate type.

Total Rate Enter the total cost of the coverage. Include any administrative
fee that you may charge.

Employee Rate Enter the rate charged to the employee and deducted through
the paycheck. This is either after-tax or before-tax, depending
on the deduction code definition.

Employer Rate Enter the rate the employer pays to subsidize the cost of a
benefit. This is either taxable or nontaxable, depending on the
deduction code definition.

Employee Percent Enter the employee's portion of contribution. If you've
specified a percent, this represents the percentage of base that
the employee pays for the benefit.

Employer Percent Enter the percentage of base that the employer contributes
towards the benefits.

Note: The fields that appear in the Rate Data group box depend upon the rate type that you select.

Detail Rates

Access the Detail Rates tab on the Benefit Rates page.
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This example illustrates the fields and controls on the Benefit Rates page: Detail Rates tab. You can find
definitions for the fields and controls later on this page.

Use the Detail Rates grid to split employee premiums across Before and After Tax, or to split employer
premiums across taxable and nontaxable.

An example is premiums for domestic partner health coverage in the US, where the cost for qualified
individuals can be Before Tax, but non-qualified individuals are After Tax.

Field or Control Description

Before-Tax Rates,  After-Tax Rate, Non-Taxable Rate, and
Taxable Rate

Allocate the total rate across the tax classes as desired. The
classes here have the same meaning and impact as those
specified in the deduction code. Any given tax class rate will
be taken only if the deduction code being processed also has
that tax class defined. You should not specify a taxable rate
component for use in plans that are subject to imputed income.
The system expects to generate the taxable cost for these plans.

Before-Tax Percent,  After-Tax Percent, Non-Taxable
Percent, and Taxable Percent

Allocate the percentages across the tax classes as desired.

Warning! Oracle's PeopleSoft Base Benefits delivers a set of rates with an ID of IRS. PeopleSoft Payroll
for North America uses these IRS rates to calculate imputed income. The IRS table ID set should not be
changed.

Tax Adjustment

Access the Tax Adjustment tab on the Benefit Rates page.
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This example illustrates the fields and controls on the Benefit Rates page, Tax Adjustment tab. You can
find definitions for the fields and controls later on this page.

The tab displays a column for the Non-Taxable Before-Tax benefit deduction class (labeled Tax
Adjustment). Define the rates applicable to adult children here. For the Percent of Base rate type, the
column label is Adjustment Percent.

The Tax Adjustment tab has the same attributes as the rate columns on the existing tabs:

• Default zero amount, numeric 5 decimals, etc., for amount rates.

• Percent of Base Rate Type Adjustment Percent field attributes have the same attributes as the other
percentage rate fields on the page.

• The Total Rate column formulae on the two existing tabs does not include the rate on the tax
adjustment tab.

The functionality is targeted at the two rate types that are most suited to health care deductions:

• Benefit Plan and Coverage Code

• Covered Person Type

In addition, the Percentage of Base type is included.

Copyright © 1988, 2022, Oracle and/or its affiliates. 51



Setting Up Base Benefits Core Tables Chapter 3

Amount Subject to Limit Page
Use the Amount Subject to Limit page (BN_RATE_LMT_SEC) to define the percent-of-gross limits.

Navigation:

Click the Specify Optional Limit link on the Benefit Rates page.

This example illustrates the fields and controls on the Amount Subject to Limit page. You can find
definitions for the fields and controls later on this page.

Specify the portion of the benefit rate to be subject to the percent-of-gross limit defined in the Calculation
Rules Table page.

Field or Control Description

Amount Subject to Limit Select whether the limit amounts is:

• Entire Rate Amount

• Flat Amount Limit

• Not Applicable

• Percent of Rate

Flat Amount Limit This field is available if you selected Entire Rate Amount in
the Amount Subject to Limit field.

Enter the amount that is subject to the limit.

Percent of Rate Limit This field is available if you selected Percent of Rate in the
Amount Subject to Limit field.

Enter the percentage amount of the employee rate that is
subject to the limit.
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Setting Up Annual Benefits Base Rates

Some benefits, such as life and disability insurance, can be based upon the employee's compensation rate
or an annual benefits base rate (ABBR) that you define for the employee.

To set up annual benefits base rates, use the Annl Benef Base Rt Type Table (ABBR_TYPE_TBL)
component.

This section provides an overview of Annual Benefits Base Rates (ABBR) and discusses how to define
annual benefits base rates.

Page Used to Set Up ABBR Types

Page Name Definition Name Usage

Annl Benef Base Rt Type Tbl Page ABBR_TYPE Define annual benefits base rates.

Annl Benef Base Rt Type Tbl Page
Use the Annl Benef Base Rt Type Tbl (annual benefits base rates table) page (ABBR_TYPE) to define
annual benefits base rates.

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Annl Benef Base Rt Type
Tbl > Annl Benef Base Rt Type Tbl

This example illustrates the fields and controls on the Annl Benef Base Rt Type Tbl page. You can find
definitions for the fields and controls later on this page.

Setting Up Calculation Rules

To set up calculation rules, use the Calculation Rules Table (CALC_RULES_TABLE) component.

This section provides an overview of calculation rules and discusses how to define calculation rules.
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Page Used to Set Up Calculation Rules

Page Name Definition Name Usage

Calculation Rules Table Page CALC_RULES_TABLE Define calculation rules by specifying
salary, age, and service as of dates,
 as well as coverage, calculation, and
rounding options for the rule.

Understanding Calculation Rules
You use calculation rules to define how deductions are calculated for each benefit plan. Calculation rules
relate only to rate-based plans or plans that require a compensation base, not a coverage base. When
determining calculation rules, you need to understand:

• Compensation base versus annual benefits base rate.

• (USF) Compensation base.

• As-of dates.

Compensation Base Versus Annual Benefits Base Rate

Calculation rules use an employee's compensation as part of the definitions. If you are going to base
the employee's compensation on an amount other than the employee's regular compensation rate, you
can enter an amount in the Annual Benefits Base Rate field on the Compensation page of the Job Data
component.

The term Base Benefits is a generic reference to the compensation to be used, whether it is the annual
compensation rate on the employee's job record or an alternate annual benefit base rate, and whether it is a
single rate from a single job record or an aggregate across multiple jobs.

If a calculation rule specifies that the ABBR should be used, but the employee has not been assigned an
ABBR, the system uses the employee's regular compensation rate instead.

See "Understanding Job Data" (PeopleSoft Human Resources Administer Workforce).

(USF) Compensation Base

The compensation base is set through the Personnel Action Request (PAR) process. You can:

• Use the adjusted regular compensation amount provided in the Expected Pay page, accessed from
the Compensation Data page of the PAR component. The regular compensation amount is the base
pay for the employee's compensation frequency with locality or LEO (law enforcement officer)
adjustments.

• Override the FEGLI base rate.

The system uses the regular adjusted compensation amount for benefit processing. The exception to this
rule is FEGLI plans: you can have the system use a different base rate when processing FEGLI plans by
overriding the FEGLI base. The FEGLI base mirrors the quoted total pay until it is overridden.

See "Understanding U.S. Federal Hiring" (PeopleSoft Human Resources Administer Workforce).
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As-Of Dates

The Calculation Rules Table has several as-of-date rules that you can define to control the calculation of
age, service, and benefits base. These rules give flexibility in defining the reference date the system uses
for interval calculations, such as age and service, or flexibility in the determination of the effective date
when retrieving the base compensation data. The following rules are available:

• As of the current pay run's pay-end date (or as of the current processing date for those applications
that are not based on pay runs.)

• As of the current pay run's check issue date.

• As of a specific month and day for the current year. This is often used to freeze compensation at the
point of open enrollment, typically 01/01 of the year, or to prevent unexpected midyear changes due
to temporal events.

• As of a specific month and day for the previous year.

The Age As-Of rule has the following additional options:

• As of the next pay run's pay end date. This is mainly used by USF users to protect age from changing
mid pay-period.

• As of date of the original enrollment in a benefit plan, date of first uninterrupted enrollment. This is
mainly used by long-term care plans, for which costs are fixed at the point of enrollment.

If you use Multiple Jobs functionality, you must also tell the system which jobs to use when calculating
the employee's earnings.

Calculation Rules Table Page
Use the Calculation Rules Table page (CALC_RULES_TABLE) to define calculation rules by specifying
salary, age, and service as of dates, as well as coverage, calculation, and rounding options for the rule.

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Calculation Rules Table >
Calculation Rules Table
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This example illustrates the fields and controls on the Calculation Rules Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Effective Date Must be the same as or prior to the effective dates of the one or
more benefit program and benefit plan combinations that you
associate the calculation rules with.

Demographics

Field or Control Description

Use Age As Of Used to calculate rates for life plans that you associate with
age-graded rates.

Use Service As Of Used to calculate rates for plans that you base on months of
service.
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Field or Control Description

Source for Demographics Designate whose personal information to use. Values are:.

• Covered Dependent: This is useful for dependent life
plans defined as sum of dependent coverage because each
covered dependent has an independent coverage amount,
 and the premium is typically based on that individual's
age, gender, and smoker status.

• Employee

• Spouse/Partner: This is useful for spousal life plans.

If the system cannot locate a birth date for a dependent or
spouse, it generates a warning that a birth date was not located
and uses the employee's age instead, while still retaining the
dependent's sex and smoker status.

Benefit Base

Field or Control Description

Use Benefits Base As Of Enter the date to use when retrieving the employee's salary
if the system needs to use an employee's salary to determine
a rate (for example, a compensation-banded rate table or a
percent-of-salary rate table).

Source

Field or Control Description

Annual Rate Select to make calculations using the regular compensation
base entered on the Job Data - Compensation page.
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Field or Control Description

Annual Benefits Base Rate Select to make calculations using an annual benefit base rate 
(ABBR.)

The ABBR selected can be either the primary ABBR found
on the Job Data - Benefit Program Participation page or any
alternate ABBR from the ABBR Update page.

Note: Set a maximum benefits base rate by assigning each
employee an ABBR that is not higher than the desired
maximum.

Note: For federal users, ABBR corresponds to the Total Pay
field on the Expected Pay page of the PAR Compensation Data
component.

Multiple Jobs

Field or Control Description

Combine Base for Multiple Jobs Select if you want to aggregate salary from multiple jobs as a
basis for a rate determination. Selecting this rule activates the
Group Method options.

Group Method If you selected Combine Base for Multi Jobs, select the
group method to use for selecting jobs to contribute to the total
benefit base. Choose from:

• All Flagged Jobs: All flagged jobs, regardless of benefit
record number, are included in the calculation.

Note: This means that the job has the Include in
Deductions check box selected on the Maintain Primary
Jobs Flags page.

• Flagged Jobs in Benefit Record: All flagged jobs within
the current benefit record number are included in the
calculation.

• Primary Job in Benefit Record: Only the primary job
within the current benefit record number is included in the
calculation.

Consider Active Jobs Only If you selected Combine Salary for Multi Jobs, select this
option to have the system look only at jobs with a status of
Active in the Job Data components.
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Optional Rate Limit

Field or Control Description

Max Deduction % of Gross Pay (maximum deduction
percentage of gross pay)

If you have employees in Hawaii, state laws mandate that
employers charge no more than 1.5% of gross wages for
employee-only coverage.

Use this field to establish a calculation rule with the maximum
deduction percent of gross pay set to a value of 1.5 or lower.
 This rule will be attached to the cost row of the benefit plan
coverage code associated with employee-only coverage.

This deduction calculation is performed when:

• The Pay Calculation process is being run.

• The plan type is Health.

• The coverage code is Employee Only.

• The calculation rule ID is defined.

• The values for maximum percent of gross pay,
 deductions, and gross pay are all greater than zero.

The maximum deduction percent of gross pay calculation
looks like this:

Deduction = (Max Percent of Gross Pay) × (Federal Taxable
Gross Pay) ÷ 100.

The smaller deduction appears on the paycheck.

Setting Up Deduction Codes

To set up deduction codes, use the Deduction Table (DEDUCTION_TABLE) component.

This section provides an overview of deduction codes and discusses how to create deduction codes.

Page Used to Set Up Deduction Codes

Page Name Definition Name Usage

Deduction Table - Setup Page DEDUCTION_TABLE1 Create deduction codes.
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Understanding Deduction Codes
The Manage Base Benefits business process in PeopleSoft HR is designed to work with PeopleSoft
Payroll for North America and PeopleSoft Payroll Interface. Calculating deductions accurately is an
important payroll function.

To set up benefit deductions:

• Use the Deduction Table component (DEDUCTION_TABLE) to select the plan type (any plan type
except General Deduction), enter a deduction code, and set up the deduction processing rules.

See "Setting Up Deductions" (PeopleSoft Payroll for North America).

See "Setting Up and Maintaining General Deductions" (PeopleSoft Payroll Interface).

• Use the Benefit Plan Table component (BENEFIT_PLAN_TABLE) and other components in the
Manage Base Benefits business process to set up the benefit plans.

See Defining Benefit Plans.

• Use the Benefit Program Table component (BEN_PROG_DEFN) and other components in the
Manage Base Benefits business process to build the benefit program and to define the deduction
calculation rules.

See Building Benefit Programs.

The Deduction Table component enables you to select a plan type, enter a deduction code, and set up
the deduction processing rules that enable you to specify processing details such as deduction priorities,
deduction tax classifications, deduction pay period schedules, and other special payroll process indicators.
The Benefit Program Table component enables you to set up the deduction calculation rules, actual rates,
rules, and routines to use to determine the cost of the deduction. To calculate benefit deductions, payroll
uses both the deduction processing rules from the Deduction Table component and deduction calculation
rules from the Benefit Program Table.

Note: To set up the Benefit Program Table, you must enter deduction codes. Deduction codes are set up
on the Deduction Table component through either PeopleSoft Payroll for North America or PeopleSoft
Payroll Interface. However, if you are not using a PeopleSoft payroll application to calculate deductions,
you can set up dummy deduction codes using other pages in PeopleSoft HR.

Designing a Deduction Strategy

When setting up deductions, you need to make some basic decisions about your strategy before you set up
deduction rules, and these decisions depend in part upon how you want to report deductions to employees.

Here's a quick reference that shows the basic benefit deduction pay stub reporting options and how to
make them happen:

You Want to Report Do This Result on Pay Stubs

The amount for each benefit plan. Define a deduction code for each benefit
plan.

Itemized descriptions and deduction
amounts appear for each chosen plan
type.
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You Want to Report Do This Result on Pay Stubs

One total for a plan type. Define a deduction code for a specific
plan type.

The total deduction of a plan type
appears.

One total for all deductions. Modify your pay check print program to
print the total deduction for several plan
type series.

For example, you might print the total
deductions for all health and life plan
type series, while still showing a separate
deduction for a savings plan, such as 401
(k).

You must modify your system because
you can't automatically roll up to a
higher level than plan type.

The total deduction of all plan types you
modify appears.

Deduction Table - Setup Page
Use the Deduction Table - Setup page (DEDUCTION_TABLE1) to create deduction codes.

Navigation:

• Set Up HCM > Product Related > Payroll for North America > Deductions > Deduction Table

• Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table

This example illustrates the fields and controls on the Deduction Table - Setup page. You can find
definitions for the fields and controls later on this page.
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To create a deduction code, enter the effective date and the long description.

If you are using PeopleSoft Payroll for North America or Payroll Interface, refer to the documentation
for those products for information about how to set up the Deduction Table component
(DEDUCTION_TABLE).

See "Setting Up Deductions" (PeopleSoft Payroll for North America).

See "Setting Up and Maintaining General Deductions" (PeopleSoft Payroll Interface).

Setting Up Special Accumulators

To set up special accumulators, use the Special Accumulator Table (SPCL_EARNS_TABLE) component.

This section provides an overview of special accumulators and discusses how to enter special accumulator
information.

Page Used to Set Up Special Accumulators

Page Name Definition Name Usage

Special Accumulator Table Page SPCL_EARNS_TABLE Enter special accumulator information.

Understanding Special Accumulators
Sometimes you need to define an employee's earnings based on specific types of earnings rather than total
gross earnings. Special accumulators act like a bucket, accumulating only the earning types that you want
included when determining the employee's earnings.

Special accumulators are used during deduction calculations and limit testing. You might have a benefit
deduction that you base on an earnings amount other than total gross.

For example, you might use a special accumulator to identify all the separate earnings to include when
accumulating employee earnings for 401(k) deductions.

Typically, you want to define a special accumulator for qualified savings plans, such as 401(k), that are
subject to limit testing.

You first name the special accumulator using the Special Accumulator Table. The next step is to tie
specific earnings types to that special accumulator.

Special Accumulator Table Page
Use the Special Accumulator Table page (SPCL_EARNS_TABLE) to enter special accumulator
information.

Navigation:
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Set Up HCM > Product Related > Payroll for North America > Compensation and Earnings >
Special Accumulator Table > Special Accumulator Table

This example illustrates the fields and controls on the Special Accumulator Table page. You can find
definitions for the fields and controls later on this page.

Setting Up Limits for Qualified Savings Plans

To set up limits for qualified savings plans, use the Limit Table (LIMIT_TBL) component.

This section provides overviews of limits, lists common elements used in this section, and discusses how
to set up limits.

Page Used to Set Up Limits for Qualified Savings Plans

Page Name Definition Name Usage

Limit Table LIMIT_TBL1 Identify the rules that apply to the 401,
 402, 403, 415, and 457 limits, using the:

• Limit Table Page for 401(a) Limits

• Limit Table Page for 402(g) Limits

• Limit Table Page for 403(b) Limits

• Limit Table Page for 415 Limits

• Limit Table Page to Set Up 415(c)
Limits for 403(b) Plans

• Limit Table Page for 457 Limits

• Limit Table Page for User Defined
Limits

Understanding Limits
Certain qualified benefit savings plans may be subject to government regulations. Limits are tied to
deduction codes. When your payroll department runs the pay calculation process, the system checks
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whether a deduction has any limits associated with it. If it does, the system runs the testing calculations
and makes the limit adjustments to every affected employee's records. If a deduction cannot be taken, it is
reported with the appropriate reason-not-taken code.

Understanding 401 Limit
The 401 limit is designed to eliminate the tax advantage that highly compensated employees have by
participating in qualified plans. This limit sets up a maximum cap on the employee's annual earnings
during the calculation of the employee's contribution. When calculating the employee annual earnings, the
system applies the 401 limit against the Special Accumulator field defined on the Savings Plan tables,
not on the Special Accumulator field on the Limit Table.

Understanding 402 Limit
The 402 limit imposes a flat dollar annual limit on the amount an employee can contribute as an elective
deferral.

Understanding 403 Limit
The 403 limit defines the parameters that extend the maximum amount of the elective deferrals that an
employee (with 15 or more years of service) in a qualifying organization can contribute to the 403(b)
savings plans. In addition to the 403 limit, 403(b) savings plans are also subject to 401, 402, and 415
limits.

To calculate this amount:

1. Multiply the employee's eligible earnings by 20%.

2. Multiply the figure by the employee's total years of service.

3. Subtract the prior year's pretax contributions.

Understanding 415 Limit
The 415 limit restricts the total amount an employee as well as an employer can contribute to defined
savings plans. 401(k) plans are the most common type of defined savings plans to fall under Section 415,
but other types include profit-sharing, money purchase pensions, stock bonuses, thrift savings, and target
benefit plans.

Employee year-to-date contributions cannot exceed either of the following amounts:

• A specific percentage amount of the employee's eligible earnings.

• A specific flat annual amount.

If, for a given payroll, the employee's and employer's contribution exceeds the limits, the contribution
must be reduced to fall within the limits. Use an other common ID when you need to keep your
companies separate for tax purposes but need to maintain accurate current employee balances across
companies for calculating Section 415 limits.
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Understanding 415Z Limit
This is identical to the 415 limit with the exception that it applies to 403(b) plans only.

Understanding 457 Limit
Section 457 plans are deferred compensation plans offered by state and local governments and employers
that are exempt from federal income tax. The amount deferred annually by an employee cannot exceed a
specific flat amount or 100% of the employee's taxable income, whichever is less.

Note: Section 457 plans are not qualified plans and are not subject to the tax code's nondiscrimination and
related requirements. However, they are subject to deferral limits and mandatory distribution rules that
apply to qualified plans.

Understanding Limit Extensions
Employees who meet specific eligibility criteria and elect the applicable option can increase their elective
deferrals in savings plans subject to certain limits. The increase is handled with limit extensions for
which, in general, the sum of the limit table amount and the extension amount is used instead of the limit
table amount. Limit extensions are stored on the Savings Management (SAVINGS_MGT_EE) record.

The limit extensions are:

• 402 - Catch Up, for employees with 15 or more years of service in a 403(b) plan.

• 457 - Catch Up, for employees within three years of retirement in a 457 plan.

• 402 - Age 50, for employees age 50 or more in a 401(k) and, a 403(b) plan, or both.

• 457 - Age 50, for employees age 50 or more in a 457 eligible governmental plan.

• 401(a) - Adjust Eligible Earnings for 401(k), 403(b), and 457 plans.

Related Links
Understanding Savings Plan Management
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Common Elements Used to Define Limits

Field or Control Description

Deductions Subject To Limit Select the deduction codes for any and all benefit plans
that fall under the specified limit. This list should be as
comprehensive as possible. Both general deductions and
benefit plans can be specified.

To associate a limit with a deduction, enter the plan type,
 benefit plan, general deduction code, and deduction class.

A single plan type may require more than one deduction
classification. You may have to insert rows for after-tax,
 before-tax, nontaxable benefit, and nontaxable pretax benefit
classifications for a single 401(k) plan.

Note: 401(a) limit processing is supported on savings plan
deductions only. A general deduction will not enforce 401(a)
limits.

Deductions Which Add to Spcl Accum (deductions which
add to the special accumulator)

Enter deductions to add to the special accumulator. These are
the taxable benefits that the IRS stipulates can be included in
the calculation of the limits.

The system increases the employee's eligible earnings by
the total year-to-date plus the current amount of the taxable
benefits that you enter here before calculating the employee's
current limit.

To add a deduction to a special accumulator, enter the plan
type, benefit plan, general deduction code, and deduction
class.

Deductions Which Subtract From Spcl Accum  (deductions
which subtract from the special accumulator)

Enter the deductions that subtract from the special
accumulator. These are deductions that the IRS stipulates must
be excluded from the calculation of the limits. (Ordinarily,
 these are before-tax deductions, but you may encounter
exceptions.)

The system reduces the employee's eligible earnings by the
total year-to-date plus current amount of the deductions that
you enter here before calculating the employee's current limit.

For each taxable benefit, fill in the plan type, benefit plan,
 deduction code, and deduction class.

Maximum Benefit Base The amount that you enter in this field is determined by IRS
regulations. It determines the maximum cap on the employee's
annual earnings during the calculation of the employee's
contribution.

Max Percent of Accumulator  (maximum percentage of
accumulator)

Enter the percentage amount to use when the system calculates
the maximum amount that the employee can contribute.
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Field or Control Description

Maximum Yearly Deduction Enter the flat cap on yearly contributions.

Rollover Allowed Select if you want any contribution amount that exceeds the
limit to roll over to another plan type or tax class. The actual
destination of the excess funds is defined on the Savings Plan
Table.

Special Accumulator Used to determine which year-to-date and current employee
earnings are eligible for limit testing.

Limit Table Page for 401(a) Limits
Use the Limit Table page (LIMIT_TBL1) to identify the rules that apply to the 401(a) limits.

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Limit Table > Limit Table

Access the Limit Table page for 401(a) limits.

This example illustrates the fields and controls on the Limit Table page for 401(a) limits. You can find
definitions for the fields and controls later on this page.

Limit Table Page for 402(g) Limits
Use the Limit Table page (LIMIT_TBL1) to identify the rules that apply to the 402(g) limits.
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Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Limit Table > Limit Table

Access the Limit Table page for 402(g) limits

This example illustrates the fields and controls on the Limit Table page for 402(g) limits. You can find
definitions for the fields and controls later on this page.

Limit Table Page for 403(b) Limits
Use the Limit Table page (LIMIT_TBL1) to identify the rules that apply to the 403(b) limits.

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Limit Table > Limit Table

Access the Limit Table page for 403(b) limits

This example illustrates the fields and controls on the Limit Table page for 403(b) limits (1 of 4). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Limit Table page for 403(b) limits (2 of 4). You can
find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Limit Table page for 403(b) limits (3 of 4). You can
find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Limit Table page for 403(b) limits (4 of 4). You can
find definitions for the fields and controls later on this page.
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Field or Control Description

403(b) Service Prorated By Select the proration method to use for the 403(b) service year
calculation in the Projection process. This information is taken
from the employee's job record.

Elect 402(g) Cap Expansion Select either Automatic Election, No, or Yes.

402(g) Per Year Max Average,  402(g) Annual Cap
Expansion,  and 402(g) Lifetime Cap Expansions

All of these fields are determined by IRS regulations. Enter the
current approved standards.

Limit Table Page for 415 Limits
Use the Limit Table page (LIMIT_TBL1) to identify the rules that apply to the 415 limits.

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Limit Table > Limit Table

Access the Limit Table page for 415 limits.

This example illustrates the fields and controls on the Limit Table page for 415 limits (1 of 3). You can
find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Limit Table page for 415 limits (2 of 3). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Limit Table page for 415 limits (3 of 3). You can
find definitions for the fields and controls later on this page.

Limit Table Page to Set Up 415(c) Limits for 403(b) Plans
Use the Limit Table page (LIMIT_TBL1) to identify the rules that apply to the 415(c) Limits for 403(b)
plans.

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Limit Table > Limit Table

Access the Limit Table page for 415(c) Limits for 403(b).

This example illustrates the fields and controls on the Limit Table page for 415(c) Limits for 403(b) (1 of
3). You can find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Limit Table page for 415(c) Limits for 403(b) (2 of
3). You can find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Limit Table page for 415(c) Limits for 403(b) (3 of
3). You can find definitions for the fields and controls later on this page.

Setting Up Deduction Class Order for 415 Limit Tables
If you are setting up the 415 Limit Table, access the Installation Table to set the deduction class order.

Access the Installation Table (Set Up HCM > Install > Installation Table).

Navigate to the Product Specific tab.

This example illustrates the fields and controls on the Installation Table - Product Specific page. You can
find definitions for the fields and controls later on this page.

Benefits Deduction Class Order

Field or Control Description

EE After Tax Then PTax Benefit When applying the 415(c) limit, the system applies the
reduction first to the employer before tax contribution, then to
the employee after tax contribution.
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Field or Control Description

PTax Benefit Then EE After Tax When applying the 415(c) limit, the system applies the
reduction first to the employee after tax contribution, then to
the employer before tax contribution.

Limit Table Page for 457 Limits
Use the Limit Table page (LIMIT_TBL1) to identify the rules that apply to the 457 limits.

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Limit Table > Limit Table

Access the Limit Table page for 457 limits.

This example illustrates the fields and controls on the Limit Table page for 457 limits (1 of 3). You can
find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Limit Table page for 457 limits (2 of 3). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Limit Table page for 457 limits (3 of 3). You can
find definitions for the fields and controls later on this page.

Field or Control Description

Max Annual 457 Catch Up  (maximum annual 457 catch up) Section 457 plans have a catch-up rule. Within three years of
retirement, a participant can increase the amount contributed to
the savings plan. This field is determined by IRS regulations.

Limit Table Page for User Defined Limits
Use the Limit Table page (LIMIT_TBL1) to identify the rules that apply to User Defined limits.

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Limit Table > Limit Table

Access the Limit Table page for User Defined limits.

This example illustrates the fields and controls on the Limit Table page for User Defined limits page. You
can find definitions for the fields and controls later on this page.
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User Defined Per Check Limit can be used to limit a deduction across two plans. For example, the table
can be set up to limit the employer contribution across two plans.

Note: Unlike the other limits, User Defined Per Check Limit is set to limit in one pay check period. The
others are set to limit plan balances.

Setting Up Dependent Rules for Health Plans

To set up dependent rules for health plans, use the Dependent Rules Table (DEP_RULE_TBL)
component.

This section provides an overview of dependent rules and discusses how to enter dependent rules.

Understanding Dependent Rules
Dependent rules are used by health benefit plans (1X plan types) to establish age-related limits on
dependent eligibility for health plan coverage. You can establish general age limits and a separate age
limit for dependents who are students. Additionally, you can make disabled dependents eligible regardless
of age, and you can make married dependents ineligible regardless of age.

Dependent rules are associated with specific plan types within a benefit program. For example, a
particular benefit program must use one dependent rule for all of its medical plans (plan type 10), but you
can use a different dependent rule for the dental plans (plan type 11) in that program, and you can use
different limits for a different program.

Default Dependent Rules

Within a benefit program, plan types are not assigned a dependent rule use these default rules:

Setting Default Limit for Plan Types With No Dependent Rule
ID

Dependent Age Limit 99

Student Age Limit 99

Exclude Disabled from Age Limit Yes (check box selected): disabled dependents are eligible for
coverage regardless of age.

Dependent Ineligible if Married No (check box not selected): married dependents are not
disqualified from coverage.
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COBRA Processing

To generate COBRA event triggers during COBRA overage processing, the system uses the most
restrictive settings from the dependent rules used by all of the 1X plan types under the benefit program, as
described in the following table:

Setting Value Used for COBRA Overage Processing

Dependent Age Limit Lowest value in use in the benefit program.

Student Age Limit Lowest value in use in the benefit program.

Exclude Disabled from Age Limit No (check box not selected) as long as at least one plan type in
the benefit program has this value. Otherwise, Yes (check box
selected).

Dependent Ineligible if Married Yes (check box selected) as long as at least one plan type in
the benefit program has this value. Otherwise, No (check box
not selected).

The system uses these settings only when creating the initial COBRA event triggers. When the system
processes the triggers to generate COBRA enrollments, it correctly applies the rules for specific plan
types.

Dependent Rules Table Page
Use the Dependent Rules Table page (DEP_RULE_TBL) to define the rules that control dependent age
limits for health plans.

Navigation:

Set Up HCM, Product Related, Base Benefits, Rates and Rules, Dependent Rules Table, Dependent Rules
Table
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This example illustrates the fields and controls on the Dependent Rules Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Dependent Age Limit Enter the age at which a dependent is no longer eligible
for coverage. This limit applies to dependents who are not
students.

Student Age Limit Enter the age at which a student dependent is no longer
eligible for coverage. If there are no special rules for student
dependents, enter the same age that you entered in the
Dependent Age Limit field.

Exclude Disabled from Age Lmt (exclude disabled from age
limit)

Select to exclude disabled dependents from the age limits.

Dep Ineligible if Married (dependent ineligible if married) Select to make married dependents ineligible for health
benefits, regardless of their age.

Setting Up Earnings for Leave and Vacation Buy/Sell Plans

Earnings types are the various ways in which an employee might receive income. The benefit-related
earnings that most concern earnings types are leave plans and vacation buy/sell plans.

To have the system process these earnings during the payroll process, you'll use the Earnings Table to
create these codes. The Earnings Table stores the business rules that define how to calculate employee
earnings.

Setting Up Payroll Information for Leave Accruals
This section assumes that your payroll department uses PeopleSoft Payroll for North America. If your
organization uses another payroll accounting system, you'll need to ensure that the proper information
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is provided to the system for the correct processing of leave accruals. Follow these basic steps, making
appropriate choices from your options.

1. On the Earnings Table - Special Process page, enter the leave plan type for the leave plan you are
defining in the Leave Plan Accrual group box.

2. Select the appropriate Add To Accrual Balance check box.

The Add To Accrual Balance selection is important during the PeopleSoft Payroll Confirm
process. It enables you to indicate where the accrued hours will be posted as unprocessed data on the
employee's Leave Accruals pages.

You can choose to add hours to the Taken, Service Hours, Adjusted, Bought, or Sold accumulator.

The Leave Accrual process retrieves data from these sections to calculate the leave accrual award and
the resulting leave accrual balance.

3. Select Taken when you want these hours to reduce the accrual balance (as in taken vacation hours or
sick hours—but not regular hours).

Select Service Hours when the associated leave plans accrue a leave balance based upon the number
of hours worked, and the hours for this earnings code should be considered in the accrual calculation.

Select Adjusted to define a special earnings type that adjusts accrual balances by adding to or
subtracting from employee accrual balances.

Select Bought or Sold only when you are using this earning as the Vacation Buy or Vacation Sell
earning.

Related Links
Understanding the Leave Process

Setting Up Vacation Buy and Sell Earnings
Organizations typically allow employees to buy or sell vacation once, at the beginning of a plan year,
based on vacation buy and sell earnings, deductions, and benefit plan rules.

To set up vacation buy/sell earnings:

1. Access the Earnings Table - Special Process page.

2. For Vacation Buy plans, select Bought in the Add to Accrual Balance group box.

3. For Vacation Sell plans, select Sold in the Add to Accrual Balance group box.

Related Links
Understanding the Vacation Buy/Sell Process

Setting Up Benefits Certifications

To create a benefits certification, use the Certification Definition (BN_CERTIF_SETUP) component.
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This section provides an overview of benefits certification and discusses how to define benefit
certification forms.

Page Used to Create Benefit Certification Forms

Page Name Definition Name Usage

Certification Definition Page BN_CERTIF_SETUP Define benefits certifications.

Understanding Benefits Certification
The Benefits Certification contains a series of statements that you, as the administrator, need to define for
a participant to answer.

You can present three types of questions, or statements, to the participant in the Benefits Certification
display:

• Yes/No

• Rating

• Multiple choice

The Yes/No Question

Each Yes/No statement appears as a single statement with a radio button displayed next to it. The default
display value for each response is left blank. For each statement, the resulting answer is whatever value
the administrator enters as a response value multiplied by the weight value, if any.

The Rating Question

Each rating statement appears as a single statement with a set of radio buttons. This form appears
similar to a typical polling statement. The default display for each response in the set is Not Selected.
When evaluating each of the responses, you must select one radio button. Each radio button in each
statement can have a predefined numeric value. The following example results in answers of 5, 4, 2, and 3
(assuming that they are in a sequence of 5–1).

The Multiple Choice Question

Each multiple choice statement appears as a single statement with a check box that has a designated value
or rank. The default display for each response in the set of options is Not Selected. You can select one or
more of the options in each statement. In the subsequent example, the statement results in an answer of 6
(assuming that they are in a sequence of 1–5).

Reviewing the Certification

When you have created your benefits certification, you can preview it by clicking the Test Certificate
button on the Certification Definition page. This certificate, if assigned to a particular benefit plan or
dependent relationship, will appear in eBenefit self-service to the participant.
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Related Links
Setting Up Dependent Relationships
"Using PeopleSoft eBenefits Pages" (PeopleSoft eBenefits)

Certification Definition Page
Use the Certification Definition page () to define benefits certifications.

Navigation:

Set Up HCM > Product Related > Base Benefits > Certification Definition > Certification
Definition

This example illustrates the fields and controls on the Certification Definition page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Passing Value Enter a minimum value for the certification to pass.
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Field or Control Description

Apply Weighting Select to control the display of the Weight field in the
Questions group box below.

Values are:

• None (the default)

• Multiply: Because the answers to the questions are
weighted, or have values, the system multiplies these
values by a multiplier (defined here) to enable the
administrator to assign more weight or importance to
various questions. The Weight field is required when you
select Multiply.

Test Certificate Select to display the Certification Definition page, which
appears to the participant in the eBenefits self-service
application when enrolling in benefit plans. You can also test
the certificate to verify that the values of the answers and the
certificate are calculating properly.

Instructions

Enter instructional text to display to the participant. This is optional.

Agreement

Field or Control Description

Type Select from Accept, Agree, and N/A. The agreement text box
can be left blank, but the type needs to be defined.
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Questions

Field or Control Description

Type Select from the following values to determine the display of
the Available Responses group box.

• Yes / No: Single statements are displayed.

• Rating: Statements with several options appear. The
sequence number needs to be specified and must be
unique. This type allows one or more response rows
to be created; they will appear as radio buttons on the
certificate. Only one answer is allowed.

• Multiple (choice): Select from one or more statements.
 The sequence number needs to be specified and must
be unique. This type allows one or more response rows
to be created and they will appear with check boxes, so
multiple responses can be selected.

Sequence Number Enter the number next to the entry that specifies the order in
which it will appear to the participant.

Weight Enter a number that the system uses when applying weighting.
 The system multiplies the response by 1.

Question Text Enter a statement for the participant to respond to.

Available Responses The system automatically displays either:

• Sequence Number: The system enters the sequence
number.

• Label text: Yes, No, or anything within the field size limit.
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Defining Benefit Plans

To define benefit plans, use the Benefit Plan Table (BENEFIT_PLAN_TABLE) component.

This section provides an overview of benefit plans and discusses how to enter benefit plan information.

Page Used to Define Benefit Plans

Page Name Definition Name Usage

Benefit Plan Table Page BENEFIT_PLAN_TABLE Enter benefit plan information.

Understanding Benefit Plans
Benefit plans are the benefits you want to offer to your employees. Benefit plans can be broken down into
categories. A -character alphanumeric numbering scheme is used to identify the different categories. Nine
categories are already set up in the Manage Base Benefits business process.

Category Numbering Sequence

Simple Benefits A0 – A9, AA – AZ

Health 10 – 19, 1A – 1Z

Life and Accidental Death 20 – 29, 2A – 2Z

Disability 30 – 39, 3A – 3Z

Savings 40 – 49, 4A – 4Z

Leave 50 – 59, 5A – 5Z

Flexible Spending Accounts 60 – 69, 6A – 6Z

Retirement 70 – 79, 7A – 7Z
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Category Numbering Sequence

Pension 80 – 89, 8A– 8Z

Vacation Buy/Sell 90 – 99, 9A – 9Z

Within each category, a set of predefined benefit plan types help the system identify the type of benefit
plan. The following table lists the delivered benefit plan types.

Benefit Plan Type Description

A0 Long-Term Care

A1 Legal Services

A2 Wellness Credit

10 Medical

(USF) FEHB (federal employees health benefits)

11 Dental

12 Medical and Dental

13 Major Medical

14 Vision

15 Nonqualified Medical

16 Nonqualified Dental

17 Nonqualified Vision

20 Basic Life

(USF) FEGLI (federal employees' group life insurance)

21 Supplemental Life Additional

(USF) Option B – Additional

22 AD/D (life and accidental death and dismemberment)
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Benefit Plan Type Description

23 Life and AD/D

24 Dependent AD/D

25 Dependent Life

(USF) Option C – Family

26 Survivor Income

27 Supplemental AD/D

2Y (USF) FEGLI Living Benefits

2Z (USF) Option A – Standard

30 Short Term Disability

31 Long Term Disability

40 401(k)

41 Profit Sharing

42 Thrift (including Roth 401(k))

43 IRA (individual retirement account)

44 Capital Accumulation

45 US Savings Bonds

46 Elective 403(b)

47 Non-Elective 403(b)

48 Employer Only 403(b)

49 457(b)

4A Stock Purchase (Stock Purchase Administration only)
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Benefit Plan Type Description

50 Sick Leave

51 Vacation Leave

Annual Leave

52 Personal Leave

53 FMLA Leave (Obsolete)

5A Company Car (global users only)

60 Flexible Spending Health Care

61 Flexible Spending Dependent Care

65 Flexible Spending Canadian Health Care

66 Flexible Spending Canadian Retirement Counseling

67 Health Savings Account (health care for U.S. companies)

70 PERS (public employees' retirement system)

Retirement

7Z (USF) TSP 1% Agency Contribution (thrift saving plan 1
percent agency contribution)

80 (CAN) Standard Pension

81 (CAN) Supplementary Pension

82 (USA) Pension Plan 1

83 (USA) Pension Plan 2

84 (USA) Pension Plan 3

85 (USA) Pension Plan 4

86 (USA) Pension Plan 5
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Benefit Plan Type Description

87 (USA) Pension Plan 6

90 Vacation Buy

91 Vacation Sell

You can add additional benefit plan types. However, you need to understand the numbering scheme
behind benefit plan types. The system is designed to recognize specific sequences.

For example, anything with a 1 as the first character is recognized as a health plan. Anything with a 2 as
the first character is recognized as a life and accidental death plan.

Because Oracle's PeopleSoft application adds plan types starting from the beginning of the alphabet,
Oracle recommends that you start with Z and work backward to A. Oracle also recommends that you not
delete a plan type; simply make it inactive.

Note: You should work within the PeopleSoft plan type series. If you add plan types that do not conform
to the provided series, you'll have to add the new plan type to the Translate Table and update associated
processing logic.

To set up a benefit plan:

1. Identify the benefit provider for the benefit plan and enter the benefit provider in the Provider/Vendor
Table page.

2. Enter the detail information for the benefit plan on the Benefit Plan Table page.

3. Repeat this process for each benefit plan that you will offer to your employees.

Benefit Plan Table Page
Use the Benefit Plan Table page (BENEFIT_PLAN_TABLE) to enter benefit plan information.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plans and Providers > Benefit Plan Table >
Benefit Plan Table
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This example illustrates the fields and controls on the Benefit Plan Table page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Set ID Select a set ID for the vendor to be used.

Include in Health Pagelet This check box is visible only for health plans (plan types 1x)

Select this check box to include the plan in the Health Benefits
Pagelet, which shows overall enrollment statistics for health
plans.

Vendor ID Enter the provider ID.

Define vendor IDs on the Provider/Vendor Table page.

SPD URL ID  (summary plan description uniform resource
locator identifier)

Enter the URL ID for the provider.

This URL is used with the PeopleSoft Benefits Self Service
application to provide access to the summary plan description.

Group Number Enter the group number.

Group numbers are defined on the Provider Policy Table page.
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Field or Control Description

Default Deduction Code (Optional) Entering a default code saves you from typing the
deduction code each time that you associate this benefit plan
with a benefit program on the Benefit Program Table.

Deduction codes are created on the Deduction Table.

Minimum Spousal Allocation %  (minimum spousal
allocation percentage)

Certain qualified plans in the life, savings, or pension category
have mandated lower limits on the percentage amount that
must be assigned to a spouse. Enter that amount here for the
system to enforce or monitor compliance with this beneficiary
right.

Include in Nondiscrimination Check to include in nondiscrimination testing. Available only
to plan types in the 40-series (savings plans).

Pay Mode Complete if you are using PeopleSoft Payroll for North
America with PeopleSoft Payables.

Select when the vendor will be paid:

Pay as Deducted: Pay the vendor each time payroll calculates
this deduction.

Pay at Specified Date: Specify the date in the AP Payment
Date Type field.

Pay when Collection Complete: Pay the vendor only when the
goal amount or deduction end date has been reached. (This pay
mode is valid for general deductions and garnishments.)

AP Payment Date Type (accounts payable payment date
type)

Choose from Check Date or Pay Period End Date.

EDI Plan Coverage Description (electronic data interchange
coverage description)

(Optional) Enter a value that is included in the HIPAA (Health
Insurance Portability and Accountability Act of 1996) file.

EDI Insurance Line Code (electronic data interchange
insurance line code)

Select a value from the drop-down menu.

Self-Service Plan Description Enter text describing the benefit plan to appear on all fluid
Benefits Self Service plan enrollment pages.

In Classic Self Service, this field is used only for health (1x),
 disability (3x), leave (5x), and retirement (7x) plans.

Contact Type Select the type of contact: COBRA Administrator 
(Consolidated Omnibus Budget Reconciliation Act),
 HIPAA Administrator (Health Insurance Portability and
Accountability Act), or Plan Administrator.
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Field or Control Description

Contact ID Select the contact ID for the administrator.

Contact IDs are defined on the Benef Administrative Contact 
(benefits administrative contact) page.

Related Links
Setting Up Internal Administrative Contact Information

Setting Up Health Plans

To set up health plans, use the Health Plan Table (HEALTH_PLAN_TABLE) component.

This section discusses how to enter health plan details.

Page Used to Set Up Health Plans

Page Name Definition Name Usage

Health Plan Table Page HEALTH_PLAN_TABLE Enter health plan details.

Health Plan Table Page
Use the Health Plan Table page (HEALTH_PLAN_TABLE) to enter health plan details.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Health Plan Table > Health
Plan Table
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This example illustrates the fields and controls on the Health Plan Table page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Health Provider Required Select whether an employee must declare a health provider
when enrolling in this plan through self-service.

Wait Period Days Enter the number of days an employee must wait to be eligible
for the plan.

Self-Insured Plan Select this check box if the health plan is employer-sponsored
self-insured health coverage.

Benefit Plan Coverage Value Options include MEC and Minimum Value, MEC and Not
Minimum Value, and Not Minimum Essential Coverage.

Lowest-Cost Monthly premium This cost is the employee share of the lowest-cost monthly
premium for self-only minimum essential coverage providing
minimum value that is offered to the employee. (This field is
only used for employees using the Base Benefits product.)

Setting Up Simple Rate Plans

To set up benefit plans, use the Simple Plan Table (SIMPLE_PLAN_TABLE) component.

This section provides an overview of simple rate plans and discusses how to enter simple benefits plan
details.
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Page Used to Set Up Simple Rate Plans

Page Name Definition Name Usage

Simple Plan Table Page SIMPLE_PLAN_TABLE Define simple benefits that have no
participation attributes and are rate-
driven.

Understanding Simple Rate Plans
Simple rate plans, also called simple benefits plans, are a generic plan type for benefits that have no
additional participation attributes other than their election. The costs for these plans are calculated from
the benefit rate tables.

While these plans do not have any participation attributes, they can be extended by establishing a link to
other components, both delivered and custom. From these other components, additional information can
be maintained manually.

Simple Plan Table Page
Use the Simple Plan Table page (SIMPLE_PLAN_TABLE) to define simple benefits that have no
participation attributes and are rate-driven.

Navigation:

Setup HCM > Product-Related > Base Benefits > Plan Attributes > Simple Plan Table > Simple
Plan Table

This example illustrates the fields and controls on the Simple Plan Table page. You can find definitions
for the fields and controls later on this page.

Extended Attributes Management

Complete this group box if you want to collect optional extended information about enrollments in this
plan. Select a menu name and component name.

If you want to override the label that is supplied by default from the component definition, enter an
optional link label.
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If you define an extended attributes component, the component link appears on the Base Benefits
enrollment page. This enables you to navigate to the component and enter additional information for the
employee.

Setting Up Life Insurance and Accidental Death Plans

To set up life and accidental death plans, use the Coverage Formula Table (BN_FORMULA) and Life and
AD/D Plan Table (LIFE_ADD_TABLE) components.

This section provides an overview of coverage calculation formulas.

Understanding Coverage Calculation Formulas
You can create simple formulas to define how coverage should be calculated. These formulas are used
by both life and disability insurance plans. You can specify how the benefits compensation base is
determined, a formula to apply against that base to derive a coverage amount, and limits on the coverage
amount. You can also define whether the coverage is subject to reduction based on attained age. The
examples illustrate calculation possibilities with as of rates:

Example: Employer Pays Increased Premium

An employee belongs to a life insurance plan that uses the premium as of January 1, current year and
coverage as of the current date. The system uses the benefit base for the calculation.

Employee Effective Date Salary Benefit Base

Ann Jeffrey January 1, 2008 10,000 12,000

Ann Jeffrey April 1, 2008 15,000 15,000

Ann Jeffrey January 1, 2009 17,500 18,000

Table Effective Date Rate Per

Life (employee) January 1, 2008 1.00 Thousand

Life (employer) January 1, 2008 2.00 Thousand

The employee gets a raise, so coverage increases during the year; however, until the next January 1, the
system calculates the employee premium as if the coverage did not increase. The employer pays the
difference between the employee deduction and the actual cost. This affects imputed income.
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Pay End Date Coverage Employee Amount Employer amount

January 31, 2008 12,000 12.00 24.00

February 28, 2008 12,000 12.00 24.00

March 31, 2008 12,000 12.00 24.00

April 30, 2008 15,000 12.00 33.00

May 31, 2008 15,000 12.00 33.00

Example: Coverage and Premium Remain the Same

Another employee belongs to a life insurance plan that uses the premium as of January 1, current year and
coverage as of January 1, current year.

Employee Effective Date Salary Benefit Base

Jim Henry January 1, 2008 10,000 12,000

Jim Henry April 1, 2008 15,000 15,000

Jim Henry January 1, 2009 17,500 18,000

Table Effective Date Rate Per

Life (employee) January 1, 2008 1.00 Thousand

Life (employer) January 1, 2008 2.00 Thousand

No change is made in Jim Henry's coverage or premium until the new year.

Pay End Date Coverage Employee Amount Employer Amount

January 31, 2008 12,000 12.00 24,00

February 28, 2008 12,000 12.00 24,00
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Pay End Date Coverage Employee Amount Employer Amount

March 31, 2008 12,000 12.00 24,00

April 30, 2008 15,000 12.00 24,00

May 31, 2008 15,000 12.00 24,00

Coverage Formula Table Page
Use the Coverage Formula Table page (BN_FORMULA) to create coverage calculation formulas.

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Coverage Formula Table >
Coverage Formula Table

You can select from existing formulas to calculate life insurance coverage or create your own coverage
calculation formulas, both from the Coverage Formula Table page.
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This example illustrates the fields and controls on the Coverage Formula Table page. You can find
definitions for the fields and controls later on this page.
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Benefit Base

Field or Control Description

Coverage Base As Of Select the employee's salary that the system will use for
coverage calculation. Values are:

• Check Date

The date of the pay check is used to calculate the
coverage amounts.

• Last Year On

A specific date is used to calculate the coverage amounts.
 You must enter the month and day.

• Pay End Date

The pay end date is used to calculate the coverage
amounts.

• This Year On

A specific date is used to calculate the coverage amounts.
 You must enter the month and day.

Premium Base As Of Select the employee's salary that the system will use for
premium calculation. The options are:

• Check Date

The date of the pay check is used to calculate the
coverage amounts.

• Pay End Date

The pay end date is used to calculate the coverage
amounts.

• Last Year On

A specific date is used to calculate the coverage amounts.
 You must enter the month and day.

• Pay End Date

The pay end date is used to calculate the coverage
amounts.

• This Year On

A specific date is used to calculate the coverage amounts.
 You must enter the month and day.
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Source

Field or Control Description

Annual Rate Select this field for the system to use the regular compensation
base entered on the Job Data - Compensation page in
Workforce Administration.

Annual Benefits Base Rate Enter a rate from the drop-down menu. The system uses the
rates defined in the Annl Benef Base Rt Type Tbl page.

Multiple Job Rules

Field or Control Description

Combine Base for Multiple Jobs Select this option if you want to aggregate salary from
multiple jobs as a basis for a coverage determination.

Group Method This field is available if you selected the Combine Base for
Multiple Jobs option.

Select the grouping method for the system to use when
selecting jobs to contribute to the total benefit base. Values are:

• All Flagged Jobs

All flagged jobs are included in the calculation regardless
of the benefit record number.

• Flagged Jobs in Benefit Record

All flagged jobs within the current record number are
included in the calculation.

• Primary Job in Benefit Record

Only the primary job within the current benefit record
number is included in the calculation.

Consider Active Jobs Only Select to have the system consider only jobs with an active
status.

Maximum Benefit Base Enter the maximum amount of benefit base that can be used in
the coverage formula calculation.

Note: This is most often used in disability plans to limit the
amount of salary subject to replacement.
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Coverage Minimum and Maximum

Field or Control Description

Coverage Minimum Enter the minimum amount of coverage that an employee can
receive. If the calculated coverage falls below this amount, this
amount will be covered as a default.

Coverage Maximum Enter the maximum amount of coverage that an employee can
receive. If the calculated coverage exceeds this amount the
coverage is capped.

Coverage Formula

Field or Control Description

Coverage Formula Displays the formula in an algebraic format.

Show Formula Click to refresh the Coverage Formula field.

Formula

Field or Control Description

Operand Select from these mathematical options to build your formula.

Entry Type Select an entry type. Values are:

• Constant

Select if the value is a constant.

• Base

Select if the base salary may change.

Numeric Value This field is available if you select Constant in the Entry Type
field.

Enter a numeric value.

Round to Multiple of Enter a numeric value to designate the precision of the
rounded number. Typical multiples are 100 and 1000.
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Field or Control Description

Round Up Amount Enter a numeric value to designate when a number gets
rounded.

Age Coverage Reduction

Field or Control Description

Age Enter the age of employee. The system determines the age by
the pay period end date.

Percent Enter a percentage that the system will deduct from the
employee's coverage.

An Example for Creating a Formula

Here is an example for setting up the formula for ((2 X BASE) ROUND + 1000)) ROUND

1. For Seq No field 10, select the ( symbol in the Operand field.

2. Add a row.

3. For Seq No field 20, select the ( symbol in the Operand field.

4. Add a row.

5. For Seq No field 30, select Constant in the Entry Type field and enter 2 in the Numeric Value field.

6. Add a row.

7. For Seq No field 40, select the * symbol in the Operand field and select Base in the Entry Type
field.

8. Add a row.

9. For Seq No field 50, select the ) symbol in the Operand field.

10. Add a row.

11. For Seq No field 60, select Round in the Operand field, enter 1000 in the Round to Multiple of 
field, and enter 500.00 in the Round Up Amount field.

12. Add a row.

13. For Seq No field 70, select + in the Operand field, select Constant in the Entry Type field, and enter
1000.00 in the Numeric field.

14. Add a row.

15. For Seq No field 80, select the ) symbol in the Operand field.
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16. Add a row.

17. For Seq No field 90, select the ) symbol in the Operand field.

18. Add a row.

19. For Seq No field 100, select Round in the Operand field, enter 500.00 in the Round to Multiple of
field, and enter 1000 in the Round Up Amount field.

The formula creation area should look like this:

This example illustrates the fields and controls on the Formula creation area. You can find definitions for
the fields and controls later on this page.

When you are done and have clicked Save Formula or Save, the formula that you created appears in the
Coverage Formula Scroll area.

This example illustrates the fields and controls on the Completed customized formula. You can find
definitions for the fields and controls later on this page.

Other examples of formulas you may want to create are:

• Flat Amount

• 2 x Base

• (2 x Base) Round

• (2 x Base) Round + Flat Amount

• ((2 x Base) + Flat Amount) Round

• (Base + Flat Amount) Round
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• ((2 x Base) Round + Flat Amount) Round

Life and AD/D Plan Table Page
Use the Life and AD/D Plan Table page (LIFE_ADD_TABLE) to enter life or AD/D plan details.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Life and AD/D Plan Table >
Life and AD/D Plan Table

This example illustrates the fields and controls on the Life and AD/D Plan Table page. You can find
definitions for the fields and controls later on this page.
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Life/ADD Plans

Field or Control Description

Coverage Group Code (Optional) Enables you to define a maximum benefit amount
for a group of life and AD/D plan types. Coverage group codes
are defined on the Life and AD/D Coverage Groups page.

You might do this if employees can choose more than one
life plan type—perhaps life and AD/D—but the total benefit
for the combined plans cannot exceed a specific amount. The
coverage group code maximum applies to all the life and AD/
D benefit plans that you associate with a coverage group code
and one benefit program.

Discriminatory Life Select this field for the system not to deduct any coverage
amounts from the U.S. imputed income calculation.

Coverage Type

Field or Control Description

Plan Level Select to indicate that coverage for this plan is determined by a
specific formula ID.

Employee Level Select to indicate that coverage for this plan is specified by the
flat amount on the enrollment page.

Formula ID Select from the available coverage formula IDs.

Insured Person Type

Field or Control Description

Employee Select to indicate that the person insured by this plan is the
employee.

On the enrollment page, this directs the system to collect
beneficiary allocations.

Dependents Select to indicate that the persons insured by this plan are the
employee's dependents and not the employee.

On the enrollment page, this directs the system to collect a list
of covered individuals.
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Field or Control Description

Dependent Specific Coverages? Select the check box to indicate that each covered dependent
will have an individual coverage amount entered for him or
her on the enrollment page.

If this check box is not selected, then a single coverage amount
is specified and each covered person receives this same
amount of coverage.

Specify Coverage Relationship? Select the check box to specify if the coverage should be based
on the dependent's relationship with the employee.

If this check box is selected, then a Relationship grid displays
below.

If this check box is not selected, then all the dependents are
eligible for coverage.

Relationship to Employee Select the relationship of the covered dependents with the
employee.

Restricting Insurance Coverage

You can associate coverage formulas that include coverage minimum and maximum amounts with a life
benefit program and benefit plan combination. When you do this, the system verifies that coverage for
participants doesn't exceed those minimums and maximums, regardless of the coverage that you enter on
the Life and AD/D Plan table. This enables you to restrict the amount of coverage for an individual life
plan.

You can use the Coverage Group Code page to also restrict the amount of coverage across all life
insurance plans in which the employee enrolls. For example, you define a coverage group code with a
500,000 USD maximum, then enter that coverage group code for a supplemental life plan and a group life
plan, and associate both benefit plans with a benefit program. If you enrolled an employee in both of these
plans, the system would ensure that the employee's total coverage by both plans does not exceed 500,000
USD.

If the maximum is exceeded, the system reduces the total coverage to meet the coverage maximum. When
the system processes deductions, it accumulates the coverage amounts and begins reducing coverage
when the coverage group maximum is reached. The system processes plans in order of deduction priority.
If more than one plan has the same priority, it processes in increasing plan type order.

(USF) Understanding Option A - Standard FEGLI Plan Calculations
PeopleSoft Payroll for North America calculates coverage and premiums for the Option A - Standard
FEGLI optional life plan in accordance with federal regulations. The Option A - Standard plan provides at
least 10,000 USD in additional coverage, depending upon the employee's rate of pay.

When an employee's annual rate of pay is more than the sum of the annual rate of basic pay for Level II
Executive Schedule positions under 5 U.S.C. 5313, plus 10,000 USD, Option A coverage automatically
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increases. The amount then becomes the difference between the employee's annual rate of pay and the
maximum allowable Basic Insurance Amount (BIA). Calculations are included in the Calculation Rules
Table for calculation rule ID OPTA.

The maximum allowable BIA appears in the Maximum Benefits Base field on the Calculation Rules
Table page. PeopleSoft Payroll for North America uses this information to calculate coverage and
premium amounts.

Setting Up Disability Plans

To set up disability plans, use the Disability Plan Table (DISABILITY_PLN_TBL) component.

This section lists prerequisites and discusses how to enter disability plans details.

Page Used to Set Up Disability Plans

Page Name Definition Name Usage

Disability Plan Table Page DISABILITY_PLN_TBL Define details for disability benefit plans.

Prerequisites
Insurance companies typically quote disability benefits in monthly terms (as opposed to life insurance
benefits, which are quoted in annual terms). Define the amount of covered salary that forms the basis for a
disability plan on the Coverage Formula Table page.

See Coverage Formula Table page

Disability Plan Table Page
Use the Disability Plan Table page (DISABILITY_PLN_TBL) to define details for disability benefit
plans.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Disability Plan Table >
Disability Plan Table
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This example illustrates the fields and controls on the Disability Plan Table page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Salary Replacement %  (salary replacement percentage) Enter the percent of employee salary that this plan will replace,
 limited to the maximum monthly benefit.

Use as Base for Premium Calc  (use as base for premium
calculation)

Select for the system to use the employee covered salaries
to calculate disability plan premiums. When this option is
selected, disability plan premium calculations are based on
the salary replacement percentage of the employee's disability
benefit rather than the employee's covered salary. This amount
is still limited to the specified maximum monthly benefit.

Calculation of Disability Plan Coverage

Similar to life insurance, disability plans use a coverage formula to determine the covered salary against
which the premium rate is applied. Whereas life insurance plans typically calculate coverage in annual
terms, disability plans typically calculate salary replacement coverage in monthly terms. You typically
create a very simple formula for disability plans:

Base/12

You may want to round the base salary or final result. You could use the maximum benefit base to cap the
employee's covered annual salary before the calculation, or you could use the coverage maximums to cap
the resulting covered monthly salary.

The final monthly salary could be subject to either a percent-of-base type rate or a rate-per-unit type rate.
Unless Use Salary Replacement as Base is selected, the rate takes into account the salary replacement
percentage. This means that you would have a different rate for 50% replacement than you do for
66% replacement because the base represents only the covered salary and not the actual replace salary.
However, if Use Salary Replacement as Base is selected, then the coverage base already accounts for the
replacement percentage and a single set of rate would probably be used. The treatment and presentation of
this plan is determined by your own business practice.

106  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 4 Setting Up Benefit Plans

Setting Up Savings Plans

This section discusses how to set up savings plans using the Savings Plan Table (SAVINGS_PLAN_TBL)
component.

Pages Used to Set Up Savings Plans

Page Name Definition Name Usage

Employee Limit on Investments Page SAVINGS_PLAN_TBL1 Define employee investment limits.

Employer Contribution/Match Page SAVINGS_PLAN_TBL2 Define employer contributions.

Rollover of Funds Page SAVINGS_PLAN_TBL5 Set up employee rollover options.

Employee Limit on Investments Page
Use the Employee Limit on Investments page (SAVINGS_PLAN_TBL1) to define employee investment
limits.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Savings Plan Table
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This example illustrates the fields and controls on the Employee Limit on Investments page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Use Special Accumulator Enter a special accumulator to identify eligible earnings for
calculating employee deductions. Special accumulators are set
up using the Special Accumulator Table.

Plan Contribution Select who will be a contributor to this savings plan:

EE Contribution Optional (employee contribution optional):
You might use this for plans that feature an employer
nonmatching contribution, with voluntary additional employee
contributions. You might also use it for a zero-contribution
enrollment plan allowing for rollover funds.

EE Contribution Required (employee contribution required):
This option enables employer matching.

Employer Only (No EE) (employer only [no employee]): You
could use this to establish an employer-funded savings benefit.
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Limits on Employee Investments

Field or Control Description

Employee IT'D Earning Threshold (employee year-to-date
earning threshold)

This amount is used to determine when the over-threshold
limit applies. If this amount is left at zero, the up-to-threshold
limits apply to all levels of earnings.

Field or Control Description

Up-To-Threshold Limit (Percent of Earnings) Enter the before-tax, after-tax, and total percentage of earnings
that an employee can invest, as long as the employee year-to-
date (IT'D) earnings threshold has not been met.

Over-Threshold Limit (Percent of Earnings) Enter the before-tax, after-tax, and total percentage amounts
that an employee can invest after the IT'D earnings threshold
has been met.

Rules for Highly Compensated Employee Investments

In response to marginal or failed 401(k) and 401(m) nondiscrimination testing, you may need to reduce
investments by highly compensated employees (HCEs) to comply with regulations. Enter the before-tax,
after-tax, and total investment amounts that an employee can invest.

For example, you could set a lower 8% before-tax contribution cap on HCEs or set up a 2% reduction
on elected contribution of each HCE to bring deferrals into compliance. Depending on the results of the
nondiscrimination testing, you can adjust the limits throughout the year.

Investments

Enter a numerical identifier for each investment option and a description.

Note: U.S. federal government users enter an alphabetical identifier.

Employer Contribution/Match Page
Use the Employer Contribution/Match page (SAVINGS_PLAN_TBL2) to define employer contributions.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Savings Plan Table >
Employer Contribution/Match
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This example illustrates the fields and controls on the Employer Contribution/Match page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Employee IT'D Earning Threshold (employee year-to-date
earning threshold)

Displays the value enter on the Employee Limit on
Investments page for this field.

Service Step Table ID Use to link the rate of employer matching contributions to an
employee's length of service.

If you enter a service step table ID, the system automatically
selects Service Step Table option in the Before Tax
Employer Contribution and After Tax Employer
Contribution group boxes.

Before and After Tax Employer Contribution

Employer contribution refers to amount employer contributes towards employee's savings plan, either on
a matching or nonmatching basis.

In a matching contribution, the employer's contribution is dependent or limited by employee's
contribution in the savings plan.
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Field or Control Description

Pct of Employee Investment (percent of employee
investment)

Select to enter the percentage the organization will match of
an employee contribution in the Percent Match field. For
example, if an organization matches 25% of an employee's
contribution, the system will generate an employer match
of 25 U.S. dollars (USD) for an employee with a 401k
contribution of 100 USD.

Service Step Table Select to use a service step table that defines different levels of
percent match of employee's earnings per length of service and
deduction class. For example, the service step table specified
After 24 Months of Service, the employer will matches 40%
of up to 3% of Employee's Earnings and 60% of up to 8% of
Earnings for Before Tax. Hence if employee had 36 months
of service and had Before Tax contribution 10% of his Before
Tax Earnings of $1,000, then his first 3% of contribution is
at 40% giving $12 while the next 5% (8% less 3% already
matched) is at 60% giving $30. Hence, Employer Match Total
is $42.

In a nonmatching contribution, the employer's contribution is independent of employee's contribution and
sets the contribution using the following options:

Field or Control Description

Flat Amount Per Pay Period Select and enter the dollar amount that the employer will
contribute per pay period regardless of the amount an
employee contributes in the Flat Amount field.

Pct of Special Accumulator (percent of special accumulator) Select and enter a percentage of an employer contribution
in the Under Threshold field. A special accumulator is
predefined total of certain earnings, a percentage of which is
what employer will contribute.

You can also identify other options or enter additional information, such as contribution percentages and
amounts, for employer matching and contribution.

Field or Control Description

Special Calculation Routine Select to have the system use a custom routine that is not
supported by the standard PeopleSoft system. You must
modify your COBOL programs.
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Field or Control Description

Percent Matching Enter the percentage the organization will match of an
employee contribution. This field appears when the Pct of
Employee Investment option is selected.

Flat Amount Enter the dollar amount that the employer will contribute per
pay period regardless of the amount an employee contributes.
 This field appears when the Flat Amount Per Pay Period
option is selected.

Under Threshold Enter a percentage of an employer contribution. This field
appears when the Pct of Special Accumulator option is
selected.

Allow Negative Employer Match/Contribution Select to enable negative earnings to result in an employer
match when the employee's contribution is negative. The
system will not make a positive contribution when there are
negative earnings present, this includes rollovers, flat dollar
contribution amounts, and excess credits. The earnings are
used in the calculation, but only to generate running employer
totals—the earnings do not interfere with the match-tier
processing. The negative employer match/contribution resets
to zero if not allowed.

Employer Limits on Non-Matching Contribution or Employee's Contribution
Subject to Employer Match

Field or Control Description

Before Tax % of Earnings Limit, After Tax % of Earnings
Limit,  and Combined % of Earnings Limit

Enter a percentage of before, after, or combined earnings that
will be matched by the employer contribution.

For example, if the Before Tax % of Earnings Limit field
had 6%, then the employer would match contributions up to
6% of the employee's rate of contribution. If the employee
only contributed 5%, only 5% would be matched.

Amount Per Pay Period Limit Select a dollar amount upon which to apply the employer
contribution.
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Field or Control Description

Limit Employee Match Select a method for calculating an employer's savings plan
match. This can be done in two different ways: one limits
the employee's contributions subject to matching after the
employer match calculation and the other limits the employee
contributions prior to calculating the employer match. Options
are After Employer Match and Before Employer Match.

You can define the maximum amount that the employer contributes to a savings plan, on either a
matching or nonmatching basis.

• When you are defining a nonmatching contribution plan, this data defines the actual amount an
employer contributes.

For example, your organization might fund savings plans with after-tax dollars at 3% of the
employee's earnings, up to 500 USD per pay period. You would enter 3% in the After-Tax % of
Earnings Limit field and 500 in the Amount Per Pay Period Limit field.

• When you are defining a plan that has an employer match, this data defines the maximum amount of
employee funds eligible for matching, rather than defining the amount of the employer match.

For example, your organization might match 50% of an employee's contributions, but only on
a before-tax basis, up to 6% of earnings or 1,000 USD per pay period, whichever is less. In this
example, you would enter 6% in the Before-Tax % of Earnings Limit field and 1000 in the Amount
per Pay Period Limit field.

• Use the Combined % of Earnings Limit field to combine the limits for both before-tax and after-tax
employer match.

• Use the Limit Employee Match field to specify whether the limit or reduction is applied before or
after the employer match is calculated as described in the examples below.

This feature applies only for employer match calculations that use the Service Step Table.

Example: Limiting Employee Match Before or After Employer Match When Using
the Service Step Table

This example uses the following data:

• Savings plan limit for employer contribution: 4.5%

• Service Step table:

• Up to 3% of employee earnings: 100% match.

• Up to 6% of employee earnings: 50% match.

• Employee enrollment:

• Before-tax: 1%
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• After-tax: 6%

• Earnings: $5225

• Before-tax deduction: 52.25

• After-tax deduction: $315.50

After Employer Matching

The reduction (limit) of the employee contributions that are subject to matching after the match
calculation is calculated like this:

• Before-tax employer match: $52.25

(1% earnings x 100% match)

• Non-taxable Employer match: $182.88

[( 3% x 100% match = $156.75) + (3% x 50% match = $78.38)] = (4.5% x $5225) = $235.13 match

$235.13 – $52.25 = $182.88

Before Employer Matching

The reduction (limit) of the employee contributions subject to matching before the match calculation is
calculated like this:

• Before-tax employer match: $52.25

(1% earnings x 100% match)

• Non-taxable Employer match: $169.82

[(4.5% limit – 1% earnings used for before-tax = 3.5%) (3% x 100% match = $156.75) + (.5% x 50%
=13.06) = $169.82

Calculating Thrift Savings Plan (TSP) Employer Match for Federal Benefits
This section contains information about employer match per employee contribution before-tax and after-
tax calculation for Thrift Savings Plans including Roth 401(k).

Note: Use this TSP employer match calculation logic only if the deduction is for TSP EE Contrib-Agency
Match, i.e., Reporting Code = ‘TSP EE Contrib – Agency Match’.

To calculate the employer match using the Agency Matching Contribution formula, use the total of TSP
and Roth 401(k) employee contribution amounts to determine the percentage of pay contributed. To
calculate the employer match, the following rules apply:

1. The first 3% of contribution is 100% Employer Match.

2. The remaining contribution is 50% Employer Match.

3. Total contribution for matching cannot exceed 5%.
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Set up the service step table to define before-tax and after-tax values. For more information, see Setting
Up Service Step Table.

Thrift Savings Plan (TSP) Employer Match Calculation Example

In this example, the employee earnings is $4000.

• Before-tax Employee Contribution = $4000 x 2% = $80

• After-tax Employee Contribution = $4000 x 4% = $160

• Non-taxable Before-tax Employer Match = $4000 x 2% x 100% = $80

• Non-taxable Employer Match = $4000 x 1% x 100% + $4000 x 2% x 50% = $80

Rollover of Funds Page
Use the Rollover of Funds page (SAVINGS_PLAN_TBL5) to set up employee rollover options.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Savings Plan Table >
Rollover of Funds

This example illustrates the fields and controls on the Rollover of Funds page. You can find definitions
for the fields and controls later on this page.

Note: Employer-only plans cannot receive rollovers from another plan, because rollovers are a form of
employee contribution.
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Field or Control Description

Rollover Options Choose from the following:

None: Rollovers are not allowed.

Refund Excess Over Limit: Use with 403(b) plans, for which
the limiting of employee contributions is more dynamic. In
certain situations, an employee's contributions are not limited
as quickly as they should be. On subsequent pay runs, the
system may determine that the employee was allowed to
contribute too much. This option enables the system to reduce
prior contributions in excess of the current limit by creating a
refund or negative deduction of the excess deferral amount.

Specified at Employee Level: Rollover amounts are based
on information entered on the employee enrollment pages.
 The plan type, benefit plan, deduction code, and class for
before-tax, after-tax, or both are made on employee enrollment
records.

Specified at Plan Level: Rollover amounts are based on
information entered on the benefit plan pages. Enter the plan
type, benefit plan, deduction code, and class for before-tax,
 after-tax, or both.

Note: Specified at Plan Level and Specified at Employee
Level require that the employee be enrolled in the specified
rollover savings plan before the actual rollover event occurs
during a payroll run. If you want a savings plan to receive
rollover funds without active employee contributions, set up
the plan as Employee Contribution Optional on the Employee
Limit on Investments page and enroll employees with a zero
contribution amount.

Before Tax Rollover  and After Tax Rollover Enter the plan type, benefit plan, deduction code, and class for
the rollover options.

Calculate Pct of Annual Rate (calculate percentage of annual
rate)

Select to enable PeopleSoft Payroll Interface to calculate
deductions for a savings plan. Payroll Interface estimates
employee deductions using an employee's annual
compensation rate.

This is considered an estimate because the annual rates
and actual earnings, not available to PeopleSoft Payroll
Interface, are not necessarily the same. Also, no year-to-date
accumulators are available to apply regulatory limits.

With the exception of savings plan deductions, PeopleSoft
Payroll Interface does not calculate deductions that are based
on a percentage of an employee's earnings. To calculate such
deductions, you need either PeopleSoft Payroll for North
America or an appropriate interface with another payroll
system.
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Setting Up Thrift Savings Plans (TSP)
This topic contains set up specifications for Thrift Savings Plans (TSP) (Plan Type - 42) that includes the
Roth 401(k) plan for federal employees.

For more information about Thrift Savings Plan (TSP) including Roth 401(k), see product documentation
for PeopleSoft HCM: Payroll for North America.

Setting Up TSP Employer Match - FERS Plan

The following table contains the fields and values to set up the TSP Employer Match - FERS Plan:

Page Name Section Field Name Value

Employee Limit on
Investments

Limits on Employee
Investments >Up To
Threshold Limit (Percent of
Earnings)

After-Tax Enter the percentage of
earnings which is the limit for
contributing to Roth 401(k)
plan.

Employer Limits on Non-
Matching Contribution or
Employee's Contribution
Subject to Employer Match

Combined % Earnings
Limit

Enter the combined
percentage earnings limit.
 This will be the combined
earnings matching for TSP
and Roth.

Employer Contribution/Match

Savings Plan Information Service Step Table ID Use the service step table
defined for TSP - Roth 401(k)
employer match.

Setting Up TSP No Match - CSRS Plan

The following table contains the fields and values to set up the TSP No Match - CSRS Plan:

Page Name Section Field Name Value

Employee Limit on
Investments

Limits on Employee
Investments >Up To
Threshold Limit (Percent of
Earnings)

After-Tax Enter the percentage of
earnings.

Employer Contribution/Match Employer Limits on Non-
Matching Contribution or
Employee's Contribution
Subject to Employer Match

Combined % Earnings
Limit

Leave this field empty as
there is no employer match
associated with this plan.
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Page Name Section Field Name Value

Savings Plan Information Service Step Table ID Leave this field empty as
there is no employer match
associated with this plan.

Setting Up Leave Plans

To set up leave plans, use the Leave Plan Table (LEAVE_PLN_TBL) component.

This section discusses how to enter leave plan details.

Note: Before you begin, make sure that you have created earnings codes for the leave plans.
The payroll tables summarized in this section are from PeopleSoft Payroll for North America. If
your organization does not implement PeopleSoft Payroll for North America, work with your payroll
department to ensure that the system can access the proper data for leave accrual processing.

Page Used to Set Up Leave Plans

Page Name Definition Name Usage

Leave Plan Table Page LEAVE_PLAN_TABLE Enter leave plan details.

Related Links
Setting Up Calculation Rules

Leave Plan Table Page
Use the Leave Plan Table page (LEAVE_PLAN_TABLE) to enter leave plan details.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Leave Plan Table > Leave
Plan Table
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This example illustrates the fields and controls on the Leave Plan Table page (1 of 2). You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Leave Plan Table page (2 of 2). You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Balance Visible to EE for Self-Service  (balance visible to
employee for self-service)

Select to enable employees to view their leave balances on the
self-service transaction View Paycheck.

Accrual Process Date Displays the date on which the leave accrual calculation
process was last run.

Service Units Select a unit by which length of service is calculated.

If you select Months, the system uses the service date on the
employee employment record as the basis for accrued service.
 If you select Hours, the system uses the actual hours from the
appropriate earnings code maintained by PeopleSoft Payroll
for North America.

Accrual Rate Units The unit by which the accrual rate is quoted. Accrual awards
are always measured in hours.

Hours Per Hour: Leave hours accrued on an hourly basis.

Hours Per Month: Leave hours accrued on a monthly basis.

Hours Per Pay Period: Leave hours accrued on a pay period
basis. For US Federal users only. Defines the hours an
employee will accrue per pay period.

Hours Per Week: Leave hours accrued on a weekly basis.

Hours Per Year: Leave hours accrued on a per year basis.

Award Frequency Displays how often the leave accrual award is given to
employees. This is determined by the accrual rate unit.

If the accrual rate unit is Hours per Hour, then the award
frequency is Every Run.

If the accrual rate unit is Hours per Month, then the award
frequency is First Run of Month.

If the accrual rate unit is Hours per Year, then the award
frequency is First Run of Year.
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Field or Control Description

Automatic Accrual Processing Defines how leave hours are calculated.

Special Calculation Routine: means that your company has a
custom calculation method.

Service Calc at Year Begin (service calculation at year
begin): calculates leave hours according to length of service as
of January 1 of the current year.

Max Leave Balance (maximum leave balance): defines the
maximum leave hours that an employee can accrue. If no
maximum exists, enter 9999.

Max Leave Carryover (maximum leave carryover): defines
the maximum number of hours that an employee can carry
from one calendar year to the next. If no maximum exists,
 enter 9999.

Manual Accrual Processing The values that you enter here are for reference only; they do
not affect leave accrual processing in any way.

First Year Award Values For leave plans with annual accruals, use to define a leave
plan in which, during the first year of service, leave hours are
prorated based on the month that employment begins. This is
available only when the leave plan's accrual rate unit is Hours
Per Year.

Although the award frequency for annual accrual leave plans
is First Run of Year, you will actually run the Leave Accrual
process each month to process the first year award values
exclusively. After the first year, employees receive awards
only on the first run of the year, as planned.

Accrual Rate Values Defines how your employees accrue leave time. This is tied
directly to what you selected in the Service Units field.

Service Bonus Values Defines how employees accrue bonus hours (in addition to
regular leave accruals).

Setting Up FMLA Plans

To set up Family Medical Leave Act (FMLA) Plans, use the FMLA Plan Table (FMLA_PLAN_TBL)
component.

This section lists prerequisites and discusses how to enter FMLA plan details.
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Page Used to Set Up FMLA Plans

Page Name Definition Name Usage

FMLA Plan Table Page FMLA_PLAN_TBL Enter FMLA plan details.

Related Links
Understanding FMLA Plan Administration

Prerequisites
The FMLA contains provisions regarding employer coverage, employee eligibility and entitlement,
notice and certification, continuation of health benefits, and job restoration. Because an FMLA plan is an
entitlement type of leave plan, it is managed separately from your other enrolled leave plans. Before you
can set up FMLA plans, you must activate FMLA administration.

To activate FMLA administration:

1. Access the Product Specific page on the Installation Table.

2. Select FMLA Administration in the Benefits Functions group box.

This enables you to gain access to pages and fields for setting up and administering FMLA plan
balances.

Related Links
"Product Specific Page" (Application Fundamentals)

FMLA Plan Table Page
Use the FMLA Plan Table page (FMLA_PLAN_TBL) to enter FMLA plan details.

Navigation:

Set Up HCM > Product Related > Base Benefits > FMLA (Family Medical LV) > FMLA Plan
Table > FMLA Plan Table
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This example illustrates the fields and controls on the FMLA Plan Table page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Calendar Type Employees who are eligible for FMLA-protected leave are
entitled to at least 12 weeks of leave during each 12–month
FMLA year. Three different ways are available to define the
FMLA year:

Fixed Calendar: Defines a 12–month period with a specific
starting date (defined with the Begin Month and Begin Day
fields). It can be the calendar year, fiscal year, or a 12–month
period that is defined by state law. Employees with Fixed
Calendar FMLA leave plans are entitled to the defined annual
entitlement, less any FMLA-protected leave taken in the
current fixed calendar year. The eligibility weeks for an FMLA
request that is made using a fixed calendar year are reduced
according to the date that the request is made.

Roll-Forward: Begins the FMLA year when employees
take an FMLA-protected leave and ends 12 months later.
 Employees' next FMLA year begins with the first FMLA-
protected leave they take after the first 12-month FMLA year
has passed.

Roll-Backward: Counts the FMLA year backwards for 12
months from the time that employees take FMLA protected
leave. If employees have taken FMLA leave in the year
previous to their scheduled FMLA leave start date, that
amount of leave is subtracted from their annual entitlement for
the upcoming FMLA-protected leave request.

Annual Entitlement Defines the number of weeks of FMLA-protected leave that
employees are entitled to every FMLA year. You can define an
entitlement of more than the government-mandated 12 weeks,
 but not less.
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Field or Control Description

Minimum Service Weeks Required  and Minimum Earned
Hours Required

Use to define the length of service requirements that must
be met before an employee is eligible for FMLA coverage.
 According to the standards set by the FMLA, the values for
these fields cannot be greater than 52 weeks (12 months) and
1,250 hours, respectively.

Working any portion of a week counts as a full week of
employment, which enables part-time and seasonal employees
to meet this requirement. The weeks of employment are also
not required to be consecutive, which means that employees
who are rehired after a gap in employment may still meet this
requirement. The Earned Hours Required field enables the
definition of a specific number of hours (up to 1,250) that
an employee must have worked for the company during the
previous 52 weeks to qualify for FMLA coverage.

Use Standard or Payroll Hours If you use PeopleSoft Payroll for North America, define how
earned hours required and entitlement hours are calculated.

Std Hrs (standard hours): Calculates the earned hours using
standard hours per work week. The system determines
standard hours per work week from the employee Job record
effective as of the leave begin date.

Pay Hrs (payroll hours): Calculates the standard hours using
the actual hours worked per week during the 52 weeks prior to
the request begin date. Provides more accuracy for employees
who work an irregular schedule.

If payroll hours are used, you must establish an FMLA
hours special accumulator to track FMLA hours. Special
accumulators and their codes are defined through the Special
Accumulator Table.

Note: If you do not use PeopleSoft Payroll for North America,
 the Pay Hrs option is not allowed.

Related Links
Setting Up Special Accumulators

Setting Up FSA Plans

To set up FSA plans, use the FSA Benefits Table (FSA_BENEFITS_TABLE) and HSA Excluded
Coverages (HSA_EXCLUDED_CVRGS) components.

This section provides an overview of FSA plans.
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Pages Used to Set Up FSA Plans and HSA Excluded Coverages

Page Name Definition Name Usage

Spending Accounts Page FSA_BENEFITS_TABLE Define spending account plan details for
US and Canada

HSA Contribution Limits Page HSA_CONTRIB_LIMITS Define the contribution limits for HSA
plans.

Note: This page is available for Benefits
Administration only.

FSA Admin Config Page FSA_ADMIN_CONFIG Define the FSA Admin Configuration.

HSA Excluded Coverages Page HSA_EXCLUDED_CVRGS Define specific plans that will be
excluded from coverage when one
selects an HSA.

Understanding FSA Plans
The PeopleSoft system enables you to manage two types of spending accounts: Flexible spending
accounts (FSAs) and Health savings accounts (HSAs).

Flexible spending accounts (FSAs) are before-tax employee savings plans that can be used for certain
approved expenses, such as health care or dependent care. The following plan types are predefined for
FSAs:

• Plan type 60 - FSA health care for U.S. companies.

• Plan type 61 - FSA dependent care for U.S. companies.

• Plan type 65 - FSA health care for Canadian companies.

• Plan type 66 - Canadian retirement counseling accounts.

HSAs are tax-advantaged accounts that enable eligible people to save money and subsequently use that
money and any earnings from that money to pay for medical expenses tax-free. People are eligible to
contribute to an HSA if they are covered under a high deductible health plan (HDHP).

The PeopleSoft system delivers the plan type 67 to use for HSAs, however any 6x plan type can be used.
However, PeopleSoft does not recommend using 60, 61, 65 and 66, as these are delivered plan types for
FSA Health and Dependent care for US and Canada.

Spending Accounts Page
Use the Spending Accounts page (FSA_BENEFITS_TABLE) to define spending account plan details for
US and Canada.

Navigation:
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Set Up HCM > Product Related > Base Benefits > Plan Attributes > FSA Benefits Table >
Spending Accounts

This example illustrates the fields and controls on the Spending Accounts page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

(CAN) Employer Carryforward Choice Carry forward credit or claim amounts from one plan year to
the next.

(CAN) Future Borrowing Select to allow plan enrollees to spend FSA credits prior to
their inclusion within the plan year.

Plan Management

Field or Control Description

Type of Account Select whether the spending account is a Flexible Spending
Account or a Health Savings Account.

If you are using PeopleSoft Benefits Administration, the
system shows the HSA Contribution Limits page when you
select Health Savings Account.

126  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 4 Setting Up Benefit Plans

Field or Control Description

Plan Contribution Indicate whether employees are expected to contribute to the
plan by selecting one of the following options:

• EE Contribution Optional

• EE Contribution Required

• Employer Only (No EE)

Contribution Frequency Select a frequency to define how you quote amounts for this
spending account plan.

If, when you are entering an employee's election, an employee
contribution percentage is specified in addition to an annual
pledge, then it is specified in terms of this contribution
frequency.

Balance ID The system uses the pay period end date or check date and the
schedule of balance periods associated with this balance ID to
calculate deductions.

Employee Contribution

Field or Control Description

Minimum Annual Contribution Enter the minimum contribution employees can make
annually.

Maximum Annual Contribution Enter the maximum contribution employees can make
annually either here or on the HSA Contribution Limits page.

See Entering HSA Contribution Limits.

Catch-up Extension Amount Enter the annual HSA catch-up extension amount as defined
by the IRS.

Catch-up Contribution Age Enter the age as of which employees can contribute the
additional catch-up amount.
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Employer Contribution

Field or Control Description

Employer Contribution Indicate whether and how an employer matches contributions
to this plan:

• None: No employer match is contributed.

• Flat Amount: Matches the employee contribution with a
flat amount that you enter, up to a chosen percentage.

• Percent of Employee Contribution:  Matches a percent
of the employee contribution that you enter, up to a limit
that you define.

• Special Calculation Routine: Uses a custom routine not
supported by the standard PeopleSoft system.

Note: HSA plans only use the None and Flat Amount options.

Flat Contribution Amount If you are using Benefits Administration, enter the employer
contribution on the HSA Contribution Limits page only if
the plan is an HSA plan. If the plan is an FSA, then enter the
contribution amount on this page.

See Entering HSA Contribution Limits.

HSA Contribution Limits Page
Use the HSA Contribution Limits page (HSA_CONTRIB_LIMITS) to define the contribution limits for
HSA plans.

Note: This page is only available when using Benefits Administration.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > FSA Benefits Table > HSA
Contribution Limits
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This example illustrates the fields and controls on the HSA Contribution Limits page. You can find
definitions for the fields and controls later on this page.

Employees can contribute to an HSA only if they are covered by an HDHP. Their contributions to an HSA
are determined by the HDHP and the coverage code. For each controlling plan you enter, make sure that
you include a row for each coverage code.

Contribution Controls

Field or Control Description

Controlling Plan Type Select the benefit plan type whose membership controls
eligibility for this plan.

Controlling Benefit Plan Select the HDHP benefit plan whose membership controls
eligibility for this plan.

Coverage Code Select the plan's coverage code.

Maximum Annual Contribution Enter the maximum annual amount that can be contributed
to the HSA when an employee is covered by this plan and
coverage code. This maximum is the total limit for both
employee and employer contributions combined.

Employer Contribution Amount Enter the amount that employers will contribute based on the
Employer Contribution Frequency to the HSA for employees
covered by this plan and coverage code.

Limit to % (limit to percent) Leave blank because employer contributions must be
nondiscriminatory.
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FSA Admin Config Page
Use the FSA Admin Config page (FSA_ADMIN_CONFIG) to define the FSA Admin Configuration.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > FSA Benefits Table > FSA
Admin Config

This example illustrates the fields and controls on the FSA Admin Config page. You can find definitions
for the fields and controls later on this page.

Use the following fields to determine the service dates that are valid for submitted claims:

Field or Control Description

FSA Service From Date This field by default displays the effective date of the plan and
must be within the service date range to be paid under the plan.

This value can also be longer than 12 months and overlap the
service dates of other plans that the employer offers and in
which the employee is enrolled.

Through This field by default displays the date that is 12 months after 
the effective date of the plan.

FSA Plan Year Select the year pertaining to this plan.

FSA Minimum Check Amount (flexible spending account
check amount

Enter a cost below which the system does not pay out any
claims.
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Field or Control Description

Ignore Min Check Amt at Close (ignore minimum check
amount at close)

Select to close out the plan and process and pay out any
approved, pending claims below the minimum amount. All
claims are paid when the system runs the closure process for
the benefit plan.

Note: If this option is not selected, all claims below the
minimum amount remain unpaid. If the pending claim
has a service date that overlaps two FSA plans in which
an employee is enrolled, the system moves the claims to
the second FSA plan until enough claims exist to meet the
minimum check amount of the second FSA plan.

Carryover limit Define the maximum FSA carryover limit.

Note: The maximum carryover amount should not exceed
$500.

For more information on setting the FSA carryover, see
Understanding U.S. Health FSA Carryover

HSA Excluded Coverages Page
Use the HSA Excluded Coverages page (HSA_EXCLUDED_CVRGS) to define specific plans that will
be excluded from coverage when one selects an HSA.

Navigation:

Set Up HCM > Product Related > Base Benefits > Program Structure > HSA Excluded Coverages

If an employee enrolls in an HSA, he or she cannot enroll in some plans. These nonpermitted plans
are defined in an HSA Excluded Coverages table by plan type and plan. This table validates all HSA
enrollments through eBenefits and Benefits Administration.

This example illustrates the fields and controls on the HSA Excluded Coverages page. You can find
definitions for the fields and controls later on this page.
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Setting Up Retirement Plans

To set up a retirement plan for PERS (the California Public Employees Retirement System) or the U.S.
federal government, use the Retirement Plan Table (RTRMNT_PLAN_TABLE) component.

This section discusses how to enter retirement plan details.

Page Used to Set Up Retirement Plans

Page Name Definition Name Usage

Retirement Plan Page RTRMNT_PLAN_TABLE Set up California PERS or U.S. federal
government retirement plans.

Retirement Plan Page
Use the Retirement Plan Table page (RTRMNT_PLAN_TABLE) to set up California PERS or U.S.
federal government retirement plans.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Retirement Plan Table >
Retirement Plan Table

This example illustrates the fields and controls on the Retirement Plan Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Employer Contribution to Employee % (employer
contribution to employee percentage)

Define how much the employer contributes to the employee's
total contribution percentage.
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Field or Control Description

Use Special Accumulator Instead of Gross To have the system use a special accumulator instead of the
total gross, enter the desired accumulator code here.

To use a special accumulator, work with your payroll
department to define the code and its detail. You can set up
special accumulators—as many as you need—to process
savings, retirement, and pension plans.

(USF) Federal Retirement Plans

Federal employees who are enrolled in FERS retirement plans are automatically enrolled in a TSP (Thrift
Savings Plan) 1% Agency Contribution plan as well. In this plan, the employee's agency contributes 1%
of the employee's basic pay for each pay period to the employee's TSP account. The TSP 1% Agency
Contribution plan is predefined; its benefits do not take the place of those offered by other retirement
plans. Employees enrolled in the TSP 1% Agency Contribution plan receive these contributions
regardless of whether they contribute their own money to their TSP accounts.

Select OASDI Offset for retirement plans that have employee contributions offset by employee
contributions to OASDI. The system reduces employee retirement plan contributions by the OASDI
contribution amount and the following pre-tax deductions (Medical (plan type 10), Dental (plan type 11),
Vision (plan type 14), Flex Spending Health - U.S. (plan type 60), Flex Spending Dependent Care (plan
type 61) and Health Savings Account (plan type 67)) until the maximum OASDI/FICA contribution level
is reached.

You must define a special accumulator for the system to track the Basic Pay Wages that are used in the
retirement deduction calculation. 

Related Links
Setting Up Special Accumulators
TSP Agency Basic Page

Setting Up Pension Plans

To set up pension plans, use the Pension Plan Table (PENS_PLAN_TABLE_US) component.

This section discusses how to enter US and Canadian pension plan details.

Note: Pension plans are also managed by PeopleSoft Pension Administration. However, the pension plan
must be set up in the Manage Base Benefits business process.
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Pages Used to Set Up Pension Plans

Page Name Definition Name Usage

Pension Plan Table Page (USA) PENS_PLAN_TABLE_US Enter details for U.S.-defined pension
plans.

Pension Plan Table CAN Page PENSION_PLAN_TABLE Enter details for Canadian-defined
pension plans.

Pension Plan Table Page (USA)
Use the Pension Plan Table page (PENS_PLAN_TABLE_US) to enter details for U.S.-defined pension
plans.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Pension Plan Table >
Pension Plan Table

This example illustrates the fields and controls on the Pension Plan Table page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Pension Type Select the type of pension plan. Valid values for U.S. pension
plans are Qualified and Non Qualified.

Do not select Defined Benefit or Money Purchase, as these are
valid only for Canadian pension plans.

Allow Contingent Beneficiaries Select if the plan allows nonspouse beneficiaries. (If selected,
 the MDIB group box appears.)
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Field or Control Description

Plan Yr Begins (Month/Day)  (plan year begins [month/day])
and  Plan Yr Ends (Month/Day) (plan year ends [month/
day])

Specify the month and day when your plan year begins. A
plan year normally ends the day before the next one begins.
 However, if you change your plan year, the row for the
resulting short plan year will have nonconsecutive begin and
end dates.

Be sure to include a row for a short plan year. Failure to do
this can cause calculation errors. A short plan refers to the
period of transition when a change occurs in the plan year. For
example, assume a plan has a fiscal year starting from July 1 to
June 31. Due to a business decision, the plan year changes to
January 1 to December 31, beginning on January 1, 2004. The
short plan year would be from July 1, 2003 to December 31,
 2004.

MDIB Rule Should Apply (minimum distribution incidental
benefit rule should apply)

Select if the MDIB rule applies.

MDIB Age Difference (minimum distribution incidental
benefit age difference)

Enter an age difference.

Contributory Plans You can incorporate U.S. pension plans (plan types 82 to
87) into a manual or automated benefit program only if the
plan is defined as a contributory plan in which the employee
contributes some portion of earnings to the plan.

Note: The system does not determine whether the rules
that you set up meet Internal Revenue Code qualification
standards. Such compliance is your responsibility.

Voluntary Contributions Allowed No parameters exist for defining voluntary contribution rates;
these are established on an employee-by-employee basis when
you enroll employees in the plan.

Special Accumulator Code Enter the code that tracks pensionable earnings.

Rates of Deduction Enter contribution rates. You can have different rates above
and below a threshold. For example, employees can contribute
2% of earnings up to 50,000 USD and 3% of earnings above
that. Enter the rate up to the threshold in the first Rates of
Deduction field, the threshold in the next field, and the rate
beyond the threshold in the final field.

If the threshold changes—for example, if you use the Taxable
Wage Base (TWB) as the threshold—insert additional
effective-dated rows to record the changes.

Pension Plan Table CAN Page
Use the Pension Plan Table CAN page (PENSION_PLAN_TABLE) to enter details for Canadian-defined
pension plans.
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Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Pension Plan Table CAN >
Pension Plan Table CAN

This example illustrates the fields and controls on the Pension Plan Table CAN. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Use Special Accumulator Instead of Gross Enter the special accumulator code that you want the system to
use in pension calculations.

The system normally performs pension plan calculations based
on employee total gross. If you use a special accumulator,
 work with your payroll department to define the code and
details. You can define several special accumulators—as many
as you need—to process savings, retirement, and pension
plans.
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Field or Control Description

Based on IT'D (based on year-to-date) Select if you identified a special accumulator in the Use
Special Accumulator Instead of Gross field.

The system will add the current period special accumulator
earnings to the special accumulator year-to-date balance. If
you do not select the check box, the system takes the special
accumulator earnings for the current pay period and annualizes
them based on the number of pay periods in the year.

Pension Plan Type Select the type of pension plan. Valid values for Canadian
pension plans are Defined Benefit and Money Purchase. Do
not select either Qualified or Non Qualified,  as these are valid
only for U.S. pension plans.

Defined benefit calculates the pension credit and does not
maintain a pension adjustment balance for the employee.
 Defined benefit pension credits must be calculated based on
the retirement benefits accrued by each employee, according
to the provisions of the plan and the plan year. The system
doesn't have the information to perform this calculation.

Money purchase calculates the pension credit for the current
period as the total of all employee and employer contributions
to the plan. The system posts the total of all pension credits
for the period (an employee can be enrolled in more than one
pension plan at the same time) to the Pension Adjustment
Year-To-Date balance for the employee. If your pension plan
has been defined as a money-purchase type, the Pension
Adjustment (PA) amount is automatically calculated and
maintained by the pay confirmation process and represents a
combination of the employee and employer contributions.

Voluntary Contributns Allowed (voluntary contributions
allowed)

Select to allow employees whom you enroll in the plan to
make voluntary contributions above the amount that you
define for the plan.

Coordinate with CCP (coordinate with Canadian Pension
Plan)

Select to have the system reduce the calculated contribution
amount for both the employee and the employer by the amount
contributed to the Canada Pension Plan (CPP) for the current
pay period.

Warning! When you define the pension contribution as a
before-tax deduction, the system calculates the amount to
deduct before it performs the normal tax calculation. When
you select Coordinate with CPP, the system performs
a special CPP/QPP calculation prior to calculation of the
pension contribution. To ensure that CPP/QPP is correctly
calculated, you or your payroll department must define the
pension benefit deduction priority as lower (a higher number)
than all taxable benefits.

Plan Registration Nbr (plan registration number) Enter the registration number for the pension plan. The system
uses the plan registration number for reporting on the T4 tax
form at the end of the year.
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Field or Control Description

Contribution Percent Use this group box to define the employer and employee
contribution percentages. The rate type that you select
determines the information that you will need to provide.

Rate Type Select a rate type. Valid values are Fixed Rate, None, and Slide
Rate.

If you select Fixed Rate, the Pension Rate Table becomes
available and you must enter the rates to use to process the
employee and employer contributions. This is based on
IT'D earnings and should not be selected even if a special
accumulator is used. If more than one set of rates apply, Oracle
recommends that you use Slide Rate.

If you choose None, use the fields to the right to define the
rates.

If you select Slide Rate, the Pension Rate Table becomes
available and you must enter the rates to use to process
the employee and employer contributions. To avoid setup
problems, define your rates in both Contribution Up to YMPE
and Contribution Over YMPE for each earnings limit and
ensure that a ceiling earnings limit is entered that cannot be
exceeded by annualizing an employee's pay. Otherwise, an
error message is reported during the pay calculation run.

Contribution Up To YMPE (contribution and up to yearly
maximum pensionable earnings),  Contribution Over YMPE 
(contribution and over yearly maximum pensionable earnings),
  Employer % (employer percent), and  Employee % 
(employee percent)

To define rates that are not based on a table, select None in
the Rate Type field and use Contribution & Up to YMPE,
 Employee %, and Employer %, and Contribution & Over
YMPE, Employee %, and Employer %. YMPE is an amount
set by the government upon which CPP/QPP contributions are
made. It is a ceiling, and excess earnings on this ceiling are not
subject to CPP/QPP contributions.
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Field or Control Description

Annual Rate To define fixed or sliding rates, select either Fixed Rate or
Sliding Rate in the Rate Type field.

For example, you enter three sets of rates and you enter
limits of $20,000, $60,000, and $80,000 for the rates. When
the system processes an employee pension contribution for
pensions defined using fixed rates, it looks for the set of
rates with the lowest associated earnings limit that is greater
than employee annual earnings. If employee annual earnings
exceed the highest earnings limit amount, the system uses the
rates associated with the highest amount. When the system
processes an employee pension contribution for pensions with
sliding rates, it splits the earnings between different rate levels
up to employee annual earnings.

Here is an example for fixed rates: An employee with annual
earnings of $50,000 uses rates associated with the $20,000
earnings limit for the first $20,000, and uses rates associated
with the $60,000 earnings limit for the remaining $30,000.

Here is an example for sliding rates: an employee with annual
earnings of $50,000 uses the rates associated with the $60,000
earnings limit. If the annual earnings for another employee are
$90,000, the system uses the rates associated with the $80,000
earnings limit.

Defined Benefit PA Factors If you want to use the SQR (Structured Query Report)
program TAX104CN as a template Pension Adjustment
Calculation routine, complete the Defined Benefit PA Factors
group box. TAX104CN calculates and loads the appropriate
balance records. To complete the group box, contact your
pension administrator or an appropriate governing office.
 The only optional field in this group box is PA Annual Base
Hours. If this field is blank, the system applies the employee's
standard work hours from the Job Data - Job Information page
to perform the calculation.

If your pension plan has been defined as a money purchase
type, the pension adjustment (PA) amount is automatically
calculated and maintained by the pay confirmation process
and represents a combination of the employee and employer
contributions.

If you have pension plans set up as defined benefit plans,
 leave the pension adjustment amounts in the Defined Benefit
PA Factors group box blank. Typically, you will generate
the pension adjustment amounts using an external service
provider, or perhaps an internal process, outside of the
PeopleSoft application. When the information is calculated,
 you must import it into the PeopleSoft system.

Setting Up Vacation Buy/Sell Plans

To set up vacation buy/sell plans, use the Vacation Buy/Sell Table (VACATION_TABLE) component.
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This section discusses how to enter vacation buy/sell plan details.

Page Used to Set Up Vacation Buy/Sell Plans

Page Name Definition Name Usage

Vacation Buy/Sell Table Page VACATION_TABLE Enter details for vacation buy/sell plans.

Vacation Buy/Sell Table Page
Use the Vacation Buy/Sell Table page (VACATION_TABLE) to enter details for vacation buy/sell plans.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > Vacation Buy/Sell Table >
Vacation Buy/Sell Table

This example illustrates the fields and controls on the Vacation Buy/Sell Table page. You can find
definitions for the fields and controls later on this page.

With a vacation buy plan, employees can use earnings to gain more vacation days. With vacation sell,
they contribute vacation hours for cash.

Field or Control Description

Vacation Buy or Sell Select either Vacn Buy (vacation buy) or Vacn Sell (vacation
sell), depending on the plan type.

Vacation Buy is predefined plan type 90; Vacation Sell is plan
type 91.
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Field or Control Description

Accruals Earnings Type Select the earning type to use for this plan.

Accruals earning types are defined on the Earnings Table for
PeopleSoft Payroll for North America.

When employees buy vacation, accrual balances increase.
 When employees sell vacation, accruals decrease.

Amount Frequency Select the rate at which the system will store and calculate the
value of vacation hours that an employee buys or sells. This
field is independent of pay period.

When an employee buys or sells vacation, two kinds of data
are affected: leave accruals and pay. The first time you process
leave accruals after an employee buys or sells vacation hours,
 you see current leave accrual balances, based on the total
vacation hours bought or sold. However, for employee pay,
 PeopleSoft Payroll for North America spreads the vacation
buy or sell amount over the remainder of the calendar year.
 This is done with the help of the amount frequency and
accruals earnings type that you define.

Vacation Hours  and Vacation Amount When an employee buys or sells vacation, the system verifies
that the amount is at least the minimum, not more than the
maximum, and in the increment that you define. The system
also verifies that the value of the hours bought or sold does not
exceed the percent of salary or the maximum amount.

Related Links
Understanding the Leave Process
Understanding the Vacation Buy/Sell Process
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Building Base Benefit Programs

Understanding Benefit Programs

This section provides an overview of:

• Benefit programs.

• Plan types.

• Plans.

• Effective dates.

Related Links
Defining Benefit Plans
"Building Benefit Programs with the Benefit Program Table" (PeopleSoft Benefits Administration)

Understanding Benefit Programs
A benefit program is a collection of benefits that are offered to a group of employees. You may have
multiple benefit programs if you offer different benefits to different groups of employees, charge different
premiums, or administer enrollment rules differently for various employee groups.

Use the Benefit Program Table to establish a program for employees, link the appropriate plan types
and benefit plans to it, and associate a variety of rules, such as rates, calculation rules, and dependent
rules. The Benefit Program Table brings together all of the information that relates to a benefit program,
including whether to process enrollments manually or use PeopleSoft Benefits Administration automated
enrollment.
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This diagram shows the building blocks for benefit programs:

Understanding Plan Types
Plan types are essential in a benefit program. They group individual plans or options that can be elected
by an employee for a particular type of benefit, such as basic life insurance or medical.

Understanding Plans
Plans are the individual benefits into which an employee can be enrolled. A plan is always subordinate to
a plan type. For example, you may offer employees a choice of four different medical plans, each from
a different HMO (health maintenance organization) or plan provider. In this case, you would be offering
four different plans in the medical plan type. Each plan has an associated deduction code, set of rates, and
calculation rules.

Understanding Effective Dates
To keep your benefit program accurate and consistent, the benefit plans, calculation rules, and options
must be individually effective-dated in a coherent, logical manner. If they aren't, your benefit program
will be left open to a variety of errors.

Using effective dates is an efficient way for you to maintain accurate records of your benefits information.
You can create historical records and enter future-dated information at your convenience, all because
when you enter information, you also enter an effective date that is synchronized with the effective dates
for the other elements of the benefit program.
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Provider and Benefit Plan Effective Dates

Consider provider and benefit plan information. To set up a provider, enter its effective date on the
Provider table. To set up a benefit plan, enter the plan's effective date and identify its provider on the
Benefit Plan Table. The system checks that the provider is effective prior to or on the same date as the
benefit plan; otherwise, the provider information cannot exist for the benefit plan.

Benefit Programs and Effective Dates

Things get more complicated when you associate a set of rates and calculation rules, which also have
effective dates, with a benefit program and its associated benefit plans. The system reviews the effective
dates of the program, the plan, the rates, and the calculation rules. The system can't check that you've set
up the correct dates, because any date could possibly be correct. Instead, it goes by the benefit program.

The system looks for effective dates for the benefit program that you're working with and the set
of benefit plans that you associate with that benefit program. A benefit program and benefit plan
combination is effective based on both sets of dates.

Plans associated with a benefit program can't be in effect unless their effective dates are set on or before
the effective date of the benefit program. Similarly, the rates and calculation rules that you associate with
the plans can't be in effect unless their effective dates are set on or after the dates of their respective plans.

If a benefit program and benefit plan combination is not effective when you think it should be and your
plan does not appear, check the effective dates of the benefit program and the benefit plan. The effective
date of the benefit plan must be earlier or the same as the effective date of the benefit program.

Loading History: A Warning

When you're setting up tables, you must set effective dates to reflect when you want the data to go into
effect. If you load employee history, make sure that you establish an early effective date. When preparing
for a conversion, set all effective dates to the same date. Most tables also have a status, which you would
normally leave as Active.

Building Benefit Programs

To define benefit programs, use the Benefit Program Table (BEN_PROG_DEFN) component.

This section discusses how to define benefit programs and associate plan types with a benefit program.

Pages Used to Build Benefit Programs

Page Name Definition Name Usage

Benefit Program Table - Benefit Program
Page

BEN_PROG_DEFN1 Define basic benefit program
information.

Benefit Program Table - Plan Type and
Option Page

BEN_PROG_DEFN2 Link plan types to the benefit program
and add important information about
plan types.
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Page Name Definition Name Usage

Benefit Program Table - Cost Page BEN_PROG_DEFN3 Link a benefit program and plan type to
rate and calculation rules.

Benefit Program Table - Benefit Program Page
Use the Benefit Program Table - Benefit Program page (BEN_PROG_DEFN1) to define basic benefit
program information.

Navigation:

Set Up HCM > Product Related > Base Benefits > Program Structure > Benefit Program Table >
Benefit Program

This example illustrates the fields and controls on the Benefit Program Table - Benefit Program page. You
can find definitions for the fields and controls later on this page.

Field or Control Description

Effective Date The date the row in the table becomes effective. This date
determines when you can view and change information.

Status as of Effective Date Indicates whether a row in the table is Active or Inactive.
Processes ignore benefit programs designated as Inactive, even
if the effective date defines the program as current.
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Field or Control Description

Program Type The type of program can be Manual or Automated. If you are
using only the Manage Base Benefits business process, this
option is automatically set to Manual. If you activate Benefits
Administration on the Installation Table, it is automatically set
to Automated.

Currency Code The type of currency that is used for this program's benefit and
deduction calculations.

COBRA

This group box defines the rules regarding the surcharge amounts that your organization imposes on
COBRA (Consolidate Omnibus Budget Reconciliation Act) plans.

Field or Control Description

COBRA Surcharge %  (COBRA surcharge percentage) Enter the percentage amount of the benefit cost that you want
added to the benefit cost. For example, if the cost of medical
coverage is 100 USD and the COBRA surcharge % is 30%,
 the cost for medical coverage for someone on COBRA would
be 130 USD.

COBRA Disabled Surcharge %  (COBRA disabled
surcharge percentage)

If you want a different percentage amount for a disabled
person, enter that percentage amount. If you leave the
field blank, the surcharge amount entered in the COBRA
Surcharge % field will be applied to a disabled person with
COBRA coverage.

FSA

For FSA (flexible spending account) Administration users. Use this group box to set up your
organization's business rules for flexible spending accounts.

Field or Control Description

Flexible Spending Acct Run ID  (flexible spending account
run ID)

For FSA Administration users. Enter the FSA run ID that you
created on the FSA Run Table.

FSA Maximum Annual Pledge Enter the maximum amount that an employee can contribute
across all flexible spending accounts within the Benefit
Program for a plan year.
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FMLA

Use this group box to define the rules for processing under FMLA (Family Medical Leave Act).

Field or Control Description

FMLA Plan ID (FMLA plan identification) Enter the FMLA plan ID that you created on the FMLA Plan
Table.

Benefits Administration

This group box is available if Benefits Administration is activated on the Installation Table. If you are
using flexible credits, it is used to define how the system will process excess flexible credit amounts when
an employee does not designate a rollover election during benefit enrollment.

Field or Control Description

Apply Excess Credits to The system can convert excess flexible credit amounts to:

C (Cash)

D (FSA-Dependent Care)

F (Forfeit Excess Credit)

H (FSA-Health Care)

R (FSA Retirement Counseling)

S (Savings-401(k))

Self-Service Configuration

Use this group box to define the rules for displaying and processing the PeopleSoft eBenefits application
pages.

Field or Control Description

Show Credits on Enrollmnt Form  (show credits on
enrollment form)

Select if you want credit amounts to appear on the enrollment
form. If you do not offer flexible credits, you may not want
this heading to appear on the form.

Include Can Sales Tax on Form  (include Canadian sales tax
on form)

Select if you want Canadian sales tax information to appear on
the eBenefits Enrollment Summary page.

Show Employer Costs on Form Select to display the employer's contributions (costs) on the
enrollment form
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Field or Control Description

Alert to Tax Impacts on Form Select to alert the employee to any potential tax impacts 
(due to the employer's contributions) on the enrollment form.
 Most typically, this would be if a T-Tax (imputed income)
component existed.

Cost Freq on Enrollment Form (cost frequency on
enrollment form)

This defines how the cost of the benefits appears on the
enrollment form. Values are

Annual: Displays the costs as annual amounts.

Deduction: Displays the costs as per-pay-period amounts.

Handbook URL ID (handbook uniform resource locator
identification)

Enter the URL ID that connects to your benefit handbook.
 URL IDs are set up in the URL Table.

Related Links
"Understanding Flexible Credits" (PeopleSoft Benefits Administration)

Benefit Program Table - Plan Type and Option Page
Use the Benefit Program Table - Plan Type and Option page (BEN_PROG_DEFN2) to link plan types to
the benefit program and add important information about plan types.

Navigation:

Set Up HCM > Product Related > Base Benefits > Program Structure > Benefit Program Table >
Plan Type and Option
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This example illustrates the fields and controls on the Benefit Program Table - Plan Type and Option
page. You can find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Benefit Program Table - Plan Type and Option
page. You can find definitions for the fields and controls later on this page.

Field or Control Description

Plan Type Select the plan type that you want to add or display.

DispPlnSeq  (display plan sequence) For Benefits Administration users. Indicates the order in which
benefit plans appear. The default value is the plan type.

Event Rules ID For Benefits Administration users. Select an event rule that
you want to link to this benefit plan. Event rules are set up on
the Event Rules Table.
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Field or Control Description

Dependent Rules ID Select the dependent rule to be used when determining
dependent age limits for this plan type. This field appears only
for 1X (health) plan types.

If you leave this field blank, the system uses the least
restrictive options as the default limits:

• Dependent Age Limit: 99

• Student Age Limit: 99

• Exclude Disabled from Age Limit: Selected

• Dependent Ineligible if Married: Deselected

Note: To generate COBRA event triggers during COBRA
overage processing, the system uses the most restrictive
settings from the dependent rules used by all of the 1X plan
types under the benefit program (for example, the lowest age
limits). The system uses these settings only when creating the
initial COBRA event triggers. When the system processes the
triggers to generate COBRA enrollments, it correctly applies
the rules for specific plan types.

HIPAA Plan  (Health Insurance Portability and
Accountability Act plan)

This check box applies only to health plans. Select this check
box if you want to designate that this plan be included in the
HIPAA Report.

Waive Coverage For Benefits Administration users. Select the option that
defines whether and when employees are permitted to waive
coverage for this plan type.

COBRA Plan Select to designate which health plan types (limited to Plan
Types 1x and 60) are COBRA-qualified plan types. If you
make this plan type COBRA-qualified, enter an option code
for each of your plans. Otherwise, the Option Code field will
be unavailable.

Load Cross Plan Values Click to automatically supply the cross-plan data for every
option in this plan type.

For Benefit Administration users only.

Self-Service Configuration

Use this group box to define the rules for displaying enrollment and plan information on the eBenefits
pages.
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Field or Control Description

Collect Dependent/Beneficiary Select this check box when you want the system to collect
information pertaining to dependents and benefits and display
that information on the eBenefit Summary and the eBenefit
Detail Information pages.

This works in conjunction with the Ignore Dep/Ben Edits
check box on the Event Rules page.

Collect Fund Allocations When this check box is selected, the system collects the
information pertaining to savings plans and displays that
information on the eBenefit Savings Summary and the Detail
Information pages.

Show if no choice This check box controls whether a plan type appears on
the enrollment when the employee has no option to choose
and cannot waive out of the option. A good example is paid
vacation. Employees receive the benefit, but you don't display
it on the enrollment form.

If the check box is selected, the system displays the plan
type in the enrollment form summary. When the check box is
deselected, the system will not display the plan type.

This setting is not relevant to 6x plans (flexible spending
accounts) and 9x plans (vacation buy/sell), which are always
shown in self-service.

Handbook URL If you have a special handbook for this plan type, you can
enter the URL ID. URL IDs are set up in the URL Table.

Additional Summary Configuration

Use this group box to define the rules for displaying information on the fluid Benefit plan pages within
Benefits Summary.

Field or Control Description

Update Dependent Information check box This check box controls if updating dependent information is
allowed or not.

Update Beneficiary Designation check box This check box controls if changing the beneficiary allocations
is allowed or not.
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Field or Control Description

Update Fund Allocations check box This check box controls if changing the fund allocations on 4X
plans are allowed or not.

Show Latest Deductions check box This check box controls if the latest deductions section 
(displaying deduction data from North America Payroll)
should be shown or not.

Update Beneficiary Information check box This check box controls if updating and adding beneficiary
information is allowed or not.

Update Savings Contributions check box This check box controls if changing the savings allocations on
4X plans are allowed or not.

Show Plan Details check box This check box controls if drill down is available to show
more details of a plan type or not.

Option – Eligibility Tab

Enter the options that are available to the employee for the designated plan type in this section.

Field or Control Description

Optn ID (option ID) As you define options for each of the plan types that are
offered, the system automatically enters the option ID.

Optn Type  (option type) Each option row needs to have an option type designation. The
Manage Base Benefits business process enables you to select
from the following list of values:

O: At least one option is required per plan type, except
for plan type 01. Plan type 01 is used only for Benefits
Administration. It is also called the Program level of the
benefits program and is used only by programs that run in
conjunction with Benefits Administration.

G: Designates that this option is a general credit and used only
in Benefits Administration.

P: This is used only for plan type 01. It designates that this is a
program and is required for automated benefit programs. Only
one P row is allowed per benefit program.

W: Designates that waiving coverage is an option and is used
only in Benefits Administration.
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Field or Control Description

Benefit Plan Enter the code for a benefit plan that was defined on the
Benefit Plan Table. If it is something other than a health plan,
 provide added detail in one of the various benefit plan detail
pages.

Covrg Code (coverage code) This applies only to health plan types. Indicate the level of
coverage for health plans. This is a required field for those
plan types. Coverage codes are defined on the Coverage Code
Table.

Deductn Cd  (deduction code) Links the deduction code to the option.

Option Code This field is available if the COBRA Plan check box is
selected, or if this is a Benefits Administration (Automated)
benefit program.

Default Option Applies to Benefits Administration. Select this check box
if you want this option to be used as the default when the
Benefits Administration process validates, loads, or finalizes
participant elections.

The default option is the benefit plan option that is given
to employees who do not make an election and is used if
the associated event rule has a default method of Option or
Current Else Option. Plan type defaults are used as substitutes
for a participant's election when you finalize the event. Here
are some guidelines for setting default options:

• Select a default option only for plan types 1x–3x, 5x, 7x,
 and 8x.

• For 2x plan types, do not define options that require
coverage to be specified at the employee level as defaults.

• Only the Waive Option Type is allowed as a default for
plan types 4x, 6x, and 9x.

• Options requiring proof should not be set as defaults,
 although it is an option.
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Field or Control Description

Opt Level (option level) Applies to Benefits Administration. Option level refers to
the level of benefits coverage provided by the option. For
example, suppose you're setting up a set of supplemental life
options that will enable employees to choose a coverage of 1,
 2, 3, or 4 times their annual salary. Set option level values for
these options of 1, 2, 3, and 4, respectively.

The option level values are used by the system during event
processing. The event rule, linked to the plan type to which
these options belong, checks the option level when evaluating
its change level rules. When an employee elects new coverage,
 the system compares the option level of the employee's new
option election in that plan type with the employee's current
option election. If the new election violates the associated
event rule's Participate and Waive change level rules, the
system rejects the employee's benefit option selection.

If, for example, the associated event rule's maximum number
of change levels is 2, the system prevents employees from
changing their coverage more than two option levels in either
direction. Therefore, an employee with coverage equal to
1 times her annual salary would not be allowed to select
coverage equal to 4 times her annual salary during open
enrollment.

Option Seq  (option sequence) Applies to Benefits Administration. Indicates the order in
which benefit options appear. The default value is the plan
type.

Geog Locn  (geographic location) Applies to Benefits Administration. If you want to link
a geographic location rule to this option, enter the code.
 Geographic location rules are set up on the Geographic
Location Table.

Elig ID  (eligibility ID) Applies to Benefits Administration. If you want to link an
eligibility rule to this option, enter the eligibility rule ID.
 Eligibility rules are created on the Eligibility Rules Table.

Option – Cross Plan Tab

This tab is only for Benefit Administration users.
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Field or Control Description

Optn ID  (option identification) As you define options for each of the plan types that are
offered, the system automatically enters the option ID.

Covrg Code  (coverage code) This applies only to health plan types. Indicate the level of
coverage for health plans. It is a required field for those plan
types. Coverage codes are defined on the Coverage Code
Table.

Deductn Cd  (deduction code) Links the deduction code to the option.

Option Code Displays the information created in the Eligibility section.

Cross Plan Type If a cross-plan requirement exists for this option, enter the
other plan type that must have an enrollment.

Cross Benefit Plan This field is for automated benefit programs and indicates
that enrollment in this option depends upon enrollment in a
particular benefit plan entered in the Cross-Plan Type field.

Coverage Limit This field is for automated benefit programs and indicates that
coverage is limited to a percentage of the employee's coverage
amount in the other plan type.

Check Dependents This field is for automated benefit programs and tells the
system to check the dependent's enrollment in this plan against
the dependent enrollments in the other plan type.

The following chart shows you how to fill out the Plan Type and Option page for plan types 01 through
9x:

Field Value for Plan Type 01 Value for Plan Types 1x–9x

Plan Type 01 (Plan type 01 not allowed within Base
Benefits)

1x−9x

Display Plan Sequence NA Not allowed

Event Rules ID NA Not allowed

Waive Coverage NA Not allowed
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Field Value for Plan Type 01 Value for Plan Types 1x–9x

COBRA Plan NA Allowed for plan types 1x and 6x

HIPAA Plan NA Allowed for 1x plan types

Option Type NA O - Only option type allowed for plan
types 1x–9x

Benefit Plan NA Required

Coverage Code NA Required for plan type 1x,

Not allowed for plan types 2x–9x

Default Option Indicator NA Not allowed

Deduction Code NA Required

Option Sequence NA Not allowed

Option Code NA Not allowed, unless plan type 1x or 60
has been designated as a COBRA plan,
in which case the option code is required.

Option Level NA Not allowed

Geographic Location Table ID NA Not allowed

Eligibility Rules ID NA Not allowed

Cross-PlanType NA Not allowed

Cross-Plan NA Not allowed

Cross-Plan Limit Percentage NA Not allowed

Cross-Plan Dependent NA Not allowed

Note: NA stands for "not applicable".
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Related Links
"Manage Base Benefit Reports" (Application Fundamentals)
Enrolling Participants in Benefit Programs and Plans

Benefit Program Table - Cost Page
Use the Benefit Program Table - Cost page (BEN_PROG_DEFN3) to link a benefit program and plan
type to rate and calculation rules.

Navigation:

Set Up HCM > Product Related > Base Benefits > Program Structure > Benefit Program Table >
Cost

This example illustrates the fields and controls on the Benefit Program Table - Cost page. You can find
definitions for the fields and controls later on this page.

Cost

Use this group box to identify the rate and calculation rules for each benefit program and option
combination.

158  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 5 Building Base Benefit Programs

Field or Control Description

Cost Type Identifies the cost type for this plan type and benefit option
combination. For Base Benefits, the value is always Price. The
system calculates deductions for employees who select this
option according to the deduction code linked to this benefit
option.

For Benefits Administration, the value can be Price or Credit.
 When you define a cost type as a credit, you must enter the
appropriate earnings code. Use the earnings code to tell the
system how to calculate the flexible credit earnings for a
participant. Use a different earnings code for each benefit
plan type within a benefit program. The system assigns the
frequency of the additional pay based on the deduction code
that you identify for this benefit option.

Cost ID When you enter a new cost row, this value is assigned
automatically by the system and cannot be updated.

Benefit Rate Type Identifies the type of rate (flat amount, age-graded, and so on)
associated with this plan type and benefit option combination.

Rate ID  (rate identification) Identifies which specific rate table is linked with this plan type
and benefit option combination. You need the identification
number because you may have established multiple tables for
a particular rate type. Only plan types 01 through 3X can use
rates.

Earnings Code Applies only to credits. Identifies the earning code that might
be tied to the plan type.

Calc TblID  (calculation table identification) Identifies the calculation rule linked to the plan type and
benefit option combination.

Rate Availability by Plan Type

This table lists the rates types that you use for each plan type:

Plan Type Flat Rate Age-Graded Service Rate Percent of Salary

01 For Benefit
Administration only.

For Benefit
Administration only.

For Benefit
Administration only.

For Benefit
Administration only.

1X Yes Yes Yes Yes
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Plan Type Flat Rate Age-Graded Service Rate Percent of Salary

2X Yes Yes Yes Yes

3X Yes Yes Yes Yes

4X−9X Not Used Not Used Not Used Not Used

For some plan types, you will need to specify the proper Calculation Rules Table identification to ensure
that the appropriate calculation rules are applied.

You don't have to indicate rates and calculation rules for all plan types. Certain rate types, on the other
hand, require calculation rules.

Rate and Calculation Rule Requirements by Plan Type

This table lists the rate tables and calculation rules that you can use for different plan types:

Plan Type Rate Tables Calculation Rules Table

01 Required Dependent on rate type.

1x Required Required

2x Required Required

3x Required Required

4x No Required

5x No Required (reserved for future use), but
not applied during calculations.

6x No Not Used

7x No Not Used

8x No Not Used

9x No Not Used
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Calculation Rule Requirements for Rate Types

Calculation rules are required for age-graded, flat-amount, salary-percentage, and service rate types.

Cloning Benefit Programs, Coverage Formulas, Eligibility Rules,
Event Rules, or Life Event Templates

Use the Benefit Clone Utility (BN_CLONE) component to clone a benefit program, coverage formula,
eligibility rule, event rule, or life event template.

Page Used to Clone Benefit Programs, Coverage Formulas, Eligibility
Rules, Event Rules, or Life Event Templates

Page Name Definition Name Usage

Benefit Clone Utility Page BN_CLONE • Clone a benefit program. Create a
copy of an existing benefit program.
 Give the duplicated program a new
effective date and choose whether to
give the program a new name.

• Clone a coverage formula. Create
a copy of an existing coverage
formula and give the duplicated
formula a new name and effective
date.

• Create a copy of an existing
eligibility or event rule for Benefits
Administration.

• Clone an existing life event template
for eBenefits. Create a copy of an
existing life event template. Give
the duplicated life event template
a new name and effective date
and indicate whether the life event
template is currently active.

Benefit Clone Utility Page
Use the Benefit Clone Utility (BN_CLONE) component to clone a benefit program, coverage formula,
eligibility rule, event rule, or life event template

Navigation:

Set Up HCM > Product Related > Base Benefits > Benefit Clone Utility > Benefit Clone Utility.
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This example illustrates the fields and controls on the Benefit Clone Utility page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Object Type to Clone Select a value:

• Benefit Program

• Coverage Formula

• Eligibility Rule (Benefits Administration only)

• Event Rule (Benefits Administration only)

• Life Event Template (eBenefits)

Copy From

Field or Control Description

Selected Select the check box for the object (benefit program, coverage
formula, eligibility rule, event rule, or life event template) that
you want to clone.
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Copy To

Field or Control Description

Copy To This group box enables you to define the name of the new
object being created. The fields in this group box vary
depending on the type of object you are cloning. You can
specify the effective date for a benefit program, coverage
formula, eligibility rule, or event rule. Additionally, for a
benefit program object, you can specify whether the program
type is automated or manual. For a life event template, you can
select the life event type and specify whether the template is
currently active.
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Setting Up Additional Manage Base
Benefits Features

Setting Up Benefits Billing

To set up benefits billing, use the Billing Parameters (BILLING_PARAMETERS) and Billing Calendar
(BILLING_CALENDAR) components.

This section provides an overview of setting up Benefits Billing and discusses how to set up billing
parameters and payment due dates.

Pages Used to Set Up Benefits Billing

Page Name Definition Name Usage

Billing Parameters Page BILL_PARMS Set up billing parameters.

Define Calendar Page BILL_CALENDAR Set up begin, end, and payment due
dates for individual billing periods.
 Also control billing statement printing
and enter comments that appear on
statements printed during a particular
billing period.

Understanding Benefits Billing Set Up
Benefits Billing enables you to bill employees and dependents directly for benefit plan elections instead
of paying through the payroll deduction process. Benefits Billing can be used for both regular and
COBRA (Consolidated Omnibus Budget Reconciliation Act) benefits.

To set up Benefits Billing:

1. Set up the rules for billing on the Billing Parameter page.

You establish only one set of billing parameters for your entire system.

2. Set up the billing cycle using the Define Calendar page.

Billing Parameters Page
Use the Billing Parameter page (BILL_PARMS) to set up billing parameters.

Navigation:
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Set Up HCM > Product Related > Base Benefits > Billing > Billing Parameters > Billing
Parameters

This example illustrates the fields and controls on the Billing Parameter page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Billing Frequency Indicate how often to calculate billing amounts.

Days Due Enter the number of days after the billing period begin date
that the payment is due. This value is used to determine the
default payment due date on the Define Calendar page.

Note: COBRA requirements mandate at least 30 days for
COBRA billing.

Days to Overdue Enter the number of days past the payment due date that
qualify a payment as overdue.

Define Calendar Page
Use the Define Calendar page (BILL_CALENDAR) to set up begin, end, and payment due dates for
individual billing periods.

Also control billing statement printing and enter comments that appear on statements printed during a
particular billing period.

Navigation:

Set Up HCM > Product Related > Base Benefits > Billing > Define Calendar > Define Calendar
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This example illustrates the fields and controls on the Define Calendar page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Billing Period When you first access the page, you must enter a billing period
code that identifies the billing period that you're setting up
the calendar for. The code can be any unique four-character
combination. Oracle recommends the format YYMM as an
identification code for monthly calendars.

Period Begin Date  and Period End Date The system uses the period begin date and the days due value
set on the Billing Parameter page to calculate default payment
due dates for regular and COBRA Benefits Billing processes.

The system uses the period end date to evaluate effective
dates. The period end date is also used as the posting date for
billing charges.

Note: The system does not edit the billing frequency to ensure
that it matches the begin and end dates.

Payment Due  and COBRA Payment Due The system automatically sets Payment Due and COBRA
Payment Due according to the days due values set in the
Billing Parameters page and the period begin date that you've
defined for this billing period. You can override the default
dates if necessary.

Note: You cannot set a COBRA due date that is fewer than 30
days past the begin date.

Comment (Optional) Enter text to appear on all of the billing statements
sent out for this billing period.

Billing Calculation Run and Billing Statements Printed Indicates the current processing stage for this billing calendar.
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Setting Up Internal Administrative Contact Information

To set up internal administrative contact information, use the Administrative Contacts
(BENEF_ADM_CONTACTS) component.

This section discusses how to set up internal administrative contact information.

Page Used to Set Up Internal Administrative Contact Information

Page Name Definition Name Usage

Administrative Contacts Page BENEF_ADM_CONTACTS Record internal contacts for HIPAA and
COBRA functions.

Understanding Internal Administrative Contact Information
The Administrative Contacts component is similar to the Vendor component. It is used to record internal
contacts for HIPAA (Health Insurance Portability and Accountability Act) and COBRA functions. This
internal contact structure enables you to identify a single contact person once and then to reference that
contact multiple times throughout the Manage Base Benefits business process.

For HIPAA, the internal administrative contact component is used to record the HIPAA administrator
that must be included on all printed HIPAA certificates. The COBRA function uses this component to
populate COBRA notification letters.

The contacts that are entered on the Benefits Administrative Contacts page can then be referenced on
the Benefits Plan Table page and the Benefit Program Definition page. Note that while only HIPAA and
COBRA currently use these contacts, they can be used for all benefit plan types.

Note: HIPAA reports BEN022 and BEN023 now expect to find a HIPAA administrative contact printed
on all certificates.

Administrative Contacts Page
Use the Administrative Contacts page (BENEF_ADM_CONTACTS) to record internal contacts for
HIPAA and COBRA functions.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plans and Providers > Administrative
Contacts > Administrative Contacts
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This example illustrates the fields and controls on the Administrative Contacts page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Benefits Contact ID Identifies the individual contact, and assigns the next available
contact ID.

Contact Description This is an alternative contact search description.

Contact Name Identifies the name of the internal contact. This contact can be
a person, a department, or another name. The contact name is
unlimited.

Child Support Indicator Indicate whether an employee is required by court order to
provide benefits to dependents and/or beneficiaries. If so,
 indicate whether the employee is the primary or secondary
provider.

Setting Up COBRA Administration

To set up COBRA administration, use the COBRA Event Rules (CBR_EVENT_RULES) component.

This section lists prerequisites and discusses how to set up COBRA Administration.
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Pages Used to Set Up COBRA Administration

Page Name Definition Name Usage

Event Rules Page COBRA_EVENT_RULES1 Identify the events that result in the loss
of health plan coverage for a qualified
beneficiary.

Administrative Contacts (benefit
administrative contacts)

BENEF_ADM_CONTACTS Define the COBRA administrator's name
and address. This information will print
on COBRA notification, enrollment, and
termination letters.

Prerequisites
Before you can set up COBRA Administration, complete the following steps.

1. Activate COBRA Administration on the Installation table.

a. Access the Installation Table - Product Specific page.

b. Select the COBRA Administration check box under the Benefits Functions group box.

2. Identify your company's COBRA administrator.

Identify your COBRA administrative personnel using the Benefits Administrative Contacts page.
When you have entered this information, you can reference these COBRA administrators within each
benefit program. This is the contact information (name and address) that will be included in printed
COBRA notification letters.

Linking COBRA to Benefit Packages
To link COBRA to your benefit package, use the Benefit Program Table to identify:

• The age at which a dependent is no longer considered a dependent.

• The age at which a dependent is no longer considered a student.

• Whether a disabled person is excluded from the age limits.

• Whether dependents are ineligible for regular benefits, if married.

Also identify any extra charges that you want added to the cost of the benefits for both disabled and
nondisabled persons.

Related Links
Building Benefit Programs
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Identifying COBRA-Eligible Benefit Plans
To identify which benefit plans offered within a benefit program are eligible for COBRA administration,
use the Benefit Program Table. When you design your benefit program, if you designate Health (1x) and
FSA (60) (flexible spending account) plan types as COBRA-qualified plan types, you must designate an
option code for those plan types. The system uses the option codes for the enrollment of employees into
COBRA benefit plans. This restriction applies only if you do not use PeopleSoft Benefits Administration.

In general, only medical and health plan types (plan types 1x and 6x) are designated as COBRA-
qualified plan types. However, the PeopleSoft application allows you to identify nonmedical plan types
as COBRA-qualified plans if your organization's policy is to offer them to your employees as part of their
COBRA coverage. You will need to modify the COBRA COBOL for plan types other than Medical (1x)
and FSA (6x) plan types.

For COBRA, medical coverage is a core benefit. COBRA administration defines non-core benefits such
as dental and vision care benefits. If your benefits program combines core and non-core benefits, you may
have to offer COBRA participants a core option that is not available to other active employees.

Nonqualified medical, dental, and vision plans are not currently supported for COBRA coverage. You
should not designate these plans as COBRA-qualified plans.

Related Links
Building Benefit Programs

Establishing Coverage Codes for COBRA
Coverage codes are created on the Coverage Code page. PeopleSoft software has four coverage codes that
work for COBRA Administration. You can add more codes as required by your organization; however,
the coverage codes for nonqualified dependents are not for use by COBRA Administration.

The COBRA Coverage Set field on the Coverage Code page is used during COBRA processing to
determine the type of coverage to offer a participant. To indicate that a coverage code is to be used during
COBRA processing, enter a two-digit code in the COBRA Coverage Set field.

Example:

Assume you have the following coverage codes:

• 1 – Employee only

• 2 – Employee + spouse

• 3 – Employee + dependents

• 4 – Family

• A – Employee only

• B – Employee + spouse

• C – Employee + dependents

• D – Family
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You want COBRA processing to consider only coverage codes A, B, C, and D as eligible codes and you
have decided that CO will represent COBRA eligible coverage codes. You will enter CO in the COBRA
Coverage Set field for coverage codes A, B, C, and D.

Defining COBRA-Qualifying Events
Oracle's PeopleSoft application delivers COBRA Administration with the following qualifying events:

• Voluntary termination.

• Involuntary termination.

• Reduction of hours.

• Death of an employee.

• Divorce and legal separation.

• Loss of dependent status (due to marriage or arrival at the age limit for benefit coverage).

• Medicare eligibility.

• Retirement.

According to federal government guidelines, employees and spouses of employees who undergo
voluntary or involuntary termination for gross misconduct are not eligible for COBRA coverage. The
PeopleSoft application does not deliver COBRA Administration with the capability to differentiate
between terminations for gross misconduct and other termination types, but you can set up action reason
codes and add PeopleCode to have the system perform this function.

You should review the set of events provided, change them, and add new events as necessary based on the
qualifying events that your organization recognizes. Then, for each valid event:

• Define when COBRA coverage begins and how long it will last.

• Define any grace periods.

• Define when the employee has to notify the organization of the event and when the organization has
to notify the employee of COBRA benefits.

• Define the qualified beneficiaries for the event.

• Define the secondary event rules for the event.

If you want to set up additional COBRA event rule records for a particular COBRA event classification,
insert a new row with a different effective date. The system will always use the record with the effective
date that is closest to the current date.

You can set up COBRA event rule records with future effective dates. This allows you to have the
definition of a COBRA event classification change on a predetermined date.
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Determining COBRA Coverage Period

COBRA coverage begins the day following the last day of regular active coverage and generally extends
for 18 or 36 months following a qualifying event. If an employee is terminated on the 15th, COBRA
coverage begins on the 16th.

The determination of the COBRA period begin date depends on several factors. The first factor is whether
the COBRA period includes alternative coverage. Alternative coverage is the grace period of continued
active coverage beyond the date when an employee's active health coverage would normally terminate.
Grace periods are provided either manually through the Manage Base Benefits business process or
automatically with the Benefits Administration system.

Regardless of whether the COBRA period includes the alternative coverage, the COBRA coverage begin
date is always set to the day following the last day of active coverage. The calculation of the COBRA
coverage end date depends on the inclusion or exclusion of alternative coverage.

In the case of disabled COBRA participants, however, regulations allow an extension up to 11 months
past the original 18 months for termination of employment and reduction in work hours events. You can
extend the coverage for disabled participants by completing the Additional Months if Disabled field on
the Event Rules page.

The date on which COBRA coverage ends is defined as the COBRA period begin date plus the number of
months of coverage plus any additional months if disabled.

Providing Grace Periods

Situations may occur when you want to provide grace periods for your employees that begin on the day
following the last day of regular coverage. During these grace periods, your organization pays all or part
of the employee benefits premiums. Extending the termination dates of an individual's health benefit
plans past the COBRA-qualifying event date sets grace periods. You can do this manually or arrange for
it to happen automatically through PeopleSoft Benefits Administration processes. To provide a grace
period, select the Include Alternative Coverage check box and specify when you want the COBRA
period to begin, which will be the day after the grace period ends. The system includes grace periods in
the COBRA coverage period. You can select to have COBRA begin on the day of the event, on the first
day of the month after the event, or on the first day of the pay period after the event day.

If you do not want a grace period to be included in the COBRA period, do not select Include Alternate
Coverage.The COBRA period begin date will be the same and COBRA coverage will start on the day
after the grace period ends. This means that if your organization paid for all or part of the employee
premiums during a grace period, the COBRA period does not begin until after the conclusion of
alternative coverage. The length of continued coverage from the qualifying event is the length of the grace
period plus 18 months of COBRA continuation coverage.

The system calculates the COBRA coverage end date according to a formula derived from the parameters
defined in the COBRA event rules.

Here are examples showing how COBRA can calculate COBRA coverage end dates for an employee who
experiences a COBRA qualifying event on March 15 and has a pay period on March 22, whose last day of
active coverage is on June 30, and who is allowed 18 months of COBRA coverage.
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Last Day of
Active Coverage

Include
Alternative
Coverage

COBRA Period
Begins Code

COBRA Period
Begin Date

COBRA
Coverage Begin
Date

COBRA
Coverage End
Date

June 30 N NA July 1 July 1 December 31

June 30 Y Event Date March 15 July 1 September 14

June 30 Y Month After April 1 July 1 September 30

June 30 Y Pay Period March 22 July 1 September 21

The coverage end date will always be equivalent to the COBRA period begin date plus the months of
coverage for each plan type, with two exceptions:

• For employees and spouses, COBRA coverage will end before the scheduled coverage end date on the
date that the employee or spouse turns 65 and becomes eligible for Medicare.

• For dependents of employees who become eligible for Medicare, the COBRA coverage end date will
be the latter of the COBRA period begin date or the employee's Medicare entitlement date plus 36
months.

Setting Rules for Secondary COBRA Events

Secondary COBRA-qualifying events are events that extend the amount of time a participant is eligible
for COBRA coverage

An event must fulfill the following basic qualifications for it to qualify as a COBRA secondary event:

• The initial COBRA event must be a COBRA event classification associated with a change to an
employee's job status, such as a reduction in hours, termination, or retirement.

• The employee and dependent must currently be participating in an active initial COBRA event and
have COBRA coverage.

• The secondary event must be one of the COBRA event classifications that involves loss of coverage
for the employee's dependent, such as divorce, marriage of dependent, overage dependent, death of
employee, or a Medicare entitlement.

For example, suppose a married employee is terminated. The employee and his spouse will receive 18
months of COBRA coverage after the termination. If the employee and spouse divorce, the divorce would
be considered a secondary event for the ex-spouse. If the divorce occurred before the termination, the
termination would not be a secondary event for the ex-spouse.

The classification of the event determines the amount of time for which coverage is extended and the
method by which coverage is extended. In the previous example, the secondary event would cause the
coverage of the ex-spouse to be extended from 18 to 36 months from the coverage begin date of the initial
event. In general, even with secondary events, a dependent's coverage cannot exceed 36 months.

The exception would be a case in which the secondary event is a Medicare entitlement. When a qualified
COBRA beneficiary turns 65, and is Medicare entitled, COBRA coverage ceases. In this case, the
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system adds the 36 months to the COBRA event date (the Medicare entitled date), thereby extending the
dependent's COBRA coverage past 36 months.

COBRA-Qualified Beneficiary

The following chart illustrates how the Benefit Lost Level and COBRA-Qualified Beneficiary relate to
one another. For each COBRA Event Classification, it displays the Benefit Lost Level and COBRA-
Qualified Beneficiaries typically associated with that event.

COBRA Event Classification Benefit Lost Level COBRA-Qualified Beneficiaries

TER, RET, RED, MIL Employee Employee, Spouse, Child

DEA, MED Employee Spouse, Child

OVG, DEP Dependent Child

DIV Dependent Ex-spouse

Related Links
"Defining Event Rules" (PeopleSoft Benefits Administration)

Event Rules Page
Use the Event Rules page (COBRA_EVENT_RULES1) to identify the events that result in the loss of
health plan coverage for a qualified beneficiary.

Navigation:

Set Up HCM > Product Related > Base Benefits > COBRA > Event Rules > Event Rules
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This example illustrates the fields and controls on the Event Rules page. You can find definitions for the
fields and controls later on this page.

COBRA Event Rules

Field or Control Description

Effective Date Enter or select the date on which this COBRA event goes into
effect. The system always uses the record with the effective
date that is closest to but not past the current date.

Status Select whether this COBRA event is Active or Inactive.

Description Enter a description of the COBRA event using up to 30
characters.

Short Description Enter a brief description of the COBRA event using up to 10
characters.

Response Days Allowed Specifies the maximum number of days that a beneficiary
has to elect coverage from the date of notification. COBRA
eligibility expires after the response period.

Days to Notify of Event Identifies the number of days an employee or dependent has to
notify the organization following a qualifying COBRA event.
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Field or Control Description

Payment Grace Days Enter the number of payment grace days employees will be
given to submit a payment after they send in an election.

Manual Events Allowed Select if you want to allow manual entry of the event.

Waive COBRA Surcharge Select if, for this event classification, you want the system to
disregard the COBRA surcharge percentages defined in the
Benefit Program Table.

Benefit Lost Level Define whether the COBRA event affects the employee only,
 the dependent only, or both. Values are Employee, Dependent 
(a COBRA-qualified beneficiary), and neither.

COBRA Period Determination

Field or Control Description

Months of Coverage Identifies how long coverage will extend for a particular
qualifying event. COBRA coverage generally extends for 18
or 36 months following a qualifying event.

Additional Months if Disabled Enter the extension for disabled participants. Regulations
allow an extension up to 11 months past the original 18
months for termination of employment and reduction in work
hours events for disabled participants.

Include Alternate Coverage Select to set up a grace period.

COBRA Period Begins Select a value to define when COBRA coverage begins.
 Values are:

On the Event Date: The COBRA period begin date is the same
as the day of the event. COBRA coverage actually begins the
day after the event date or the day after the grace period ends.

On Month-Begin After Event: The COBRA begin date is on
the first day of the month after the event.

On PayPeriod Begin After Event: The COBRA begin date is
on the first day of the pay period after the event day.

Copyright © 1988, 2022, Oracle and/or its affiliates. 177



Setting Up Additional Manage Base Benefits Features Chapter 6

Secondary Event Rules

Field or Control Description

Secondary Event Role Indicates whether the displayed COBRA event classification
can be considered a secondary event. Values are:

Succeeding Second Event (S): This indicates that the COBRA
event classification is a secondary event.

Preceding Initial Event (P): If this field has a value of P, then
the other two secondary event rules fields will be unavailable
for data entry.

Second Event Additional Months If Secondary Event Role is selected, the Second Event
Additional Months field defines the number of months that
the original COBRA coverage will be extended.

Secondary Event Add Mode Defines whether the system adds second event additional
months to the original coverage begin date of the initial event
or to the COBRA event date of the secondary event.

In the event classifications that the PeopleSoft application
delivers, the Death, Divorce, Married Dependent, and Overage
Dependent events have a Second Event Add Mode value of E 
(Extended) while the Medicare Entitlement event has a Second
Event Add Mode value of A (Added).

Note: For the Divorce COBRA Event Classification, the sole-
defined COBRA qualified beneficiary is X (Ex-Spouse).

COBRA Qualified Dependents

Field or Control Description

Covered Person Type Select from the following values to define the relationship you
have to the dependent.

Child, Domestic Partner, Employee, ExSpouse, Non-Qualified
Dependent, Other Qualified Dependent, Spouse.

Setting Up HIPAA Tables

Note: With the Affordable Care Act, HIPAA Certificates have become obsolete, and effective 1/1/2015,
they are no longer required.
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This section discusses how to set up HIPAA using the EDI Trading Partners (BN_EDI_PARTNERS) and
EDI 834 Transaction Map Table (BN_834_MAP_TBL) components.

Pages Used to Set Up HIPAA Tables

Page Name Definition Name Usage

EDI Trading Partners Page BN_EDI_PARTNERS Define the information needed for the
EDI Interchange Control segments for
each partner receiving 834 transaction
transmissions.

EDI 834 Transaction Map Table Page BN_834_MAP_TBL View the delivered code maps or set up
new code maps for any new codes you
have added to the system.

EDI Trading Partners Page
Use the EDI Trading Partners page (BN_EDI_PARTNERS) to define the information needed for the EDI
Interchange Control segments for each partner receiving 834 transaction transmissions.

Navigation:

Set UP HCM > Product Related > Base Benefits > EDI Trading Partners > EDI Trading Partners

This example illustrates the fields and controls on the EDI Trading Partners page. You can find definitions
for the fields and controls later on this page.
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Field or Control Description

Name Enter the name of the EDI trading partner.

A trading partner can be one of your health care providers but
doesn't have to be.

External Partner ID Identify the receiving partner.

This ID must be agreed upon by both the sender and receiver.

Internal Partner ID Identify the sending partner.

This ID must be agreed upon by both the sender and receiver.

Application Receiver's Code Enter a value.

Application Sender's Code Enter a value.

Use Alternate Group Number for Trans Set Identifier
Code

Select to enter a value in the Alternate Group Number field.

Alternate Group Number If you selected the Use Alternate Group Number for Trans
Set Indenitfier Code field, then you must enter a value. The
system uses the alternate group number in place of the external
partner ID when creating the concatenated transaction set
identifier code.

Security Password Required Select to enter a value in the Password field. This indicates
there is security information associated with the HIPAA file.

Password If you selected the Security Password Required field, then
you must enter a 10-character password. The systems sets
the ISA03 value to 01 in the ISA segment and then sends the
password value in position ISA04.

Master Policy Number Enter a value.

In the header of the HIPAAA file, the system includes a
new REF segment (Transaction Set Policy Number) with
a reference ID qualifier of 38 along with the master policy
number that you entered in this field.
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Field or Control Description

Subscriber Number Select from the following values:

EmplID: The HIPAA process uses the emplID of the
subscriber as the REF02 value in the REF*0F segment in loop
2000.

SSN The HIPAA process uses the social security or national ID
number of the subscriber instead of the emplID. The records
for dependents also use the subscriber's ID number for the
REF02 value.

Note: If you select SSN and the subscriber does not have
a social security number, the file uses the emplID for that
subscriber and his or her members' records.

Last Control Number The system increments this number with each transmission to
the partner.

Initially the control number is set to 0. You can manually reset
the control number, if necessary.

Field Separator Enter the character to use to separate fields in each segment of
the EDI file.

The default value is an asterisk (*), which is the value
suggested by the reporting standard.

Segment Terminator Enter the character to use to mark the end of each segment of
the EDI file.

The default value is a tilde (~), which is the value suggested by
the standard.

Subelement Separator Enter the character to use to separate component data elements
within a composite data structure of the EDI file.

The default value is a colon (:), which is the value suggested
by the standard.

Note: This delimiter is not used in PeopleSoft-delivered 834
transaction segments.

Repetition Separator Enter the character to use to separate repeated data in the EDI
file.

The default value is a carat (^). You can change this, but you
must not enter any character used as a delimiter or terminator
by another field.

File Name Enter the name for the EDI file.
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Field or Control Description

File Directory Enter the directory where the file will be created.

If this field is left blank, the file will be created in the directory
PS_SERVDIR.

EDI 834 Transaction Map Table Page
Use the EDI 834 Transaction Map Table page (BN_834_MAP_TBL) to view the delivered code maps or
set up new code maps for any new codes you have added to the system.

Navigation:

Set Up HCM > Product Related > Base Benefits > EDI 834 Transaction Map Table > EDI 834
Transaction Map Table

Some of the codes required by the ASC X12.834 Implementation Guide need to be mapped from
PeopleSoft codes or customer-defined codes. Oracle delivers the mapping for existing PeopleSoft codes.
If you add your own codes, you need to map those codes to EDI 834 codes.

This example illustrates the fields and controls on the EDI 834 Transaction Map Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Default EDI Code (default electronic data interchange code) Each plan type has one default EDI code used in the HIPAA
file, for example, HLT for Plan Type 10.

Note: If you do not enter a value in the EDI Insurance Line
Code field on the Benefit Plan Table page, the system uses
the mapped value for the plan type as the Default EDI Code
value in the HIPAA file.
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Field or Control Description

Original Description The description of the code that is being mapped.

EDI 834 Value The ASC X12.834 value corresponding to the PeopleSoft code
or customer-defined code.

EDI 834 Description The ASC X12.834 code description.

Setting Up Multiple Jobs

To set up multiple job features, use the Multiple Job Options (BAS_MJ_OPTIONS_PGP) component.

This section provides an overview of multiple jobs and discusses how to set up rules for multiple jobs.

Page Used to Set Up Multiple Jobs

Page Name Definition Name Usage

Multiple Jobs Options Page BAS_MJ_OPTIONS Define employee-level multiple jobs
options to use automatically whenever
a new job is entered into the system,
 or whenever an existing job is rehired
or terminated through the Administer
Workforce pages.

Understanding Multiple Jobs
Many organizations have employees who work in more than one job at the same time. The system needs
to know how to process these employees with more than one job. Rules need to be created to answer
questions such as:

• Which jobs should contribute salary information for calculating deductions that are based on the
employee's earnings?

• Which jobs should provide pay group information, hire date, and termination date?

Multiple Jobs Options Page
Use the Multiple Jobs Options page (BAS_MJ_OPTIONS) to define employee-level multiple jobs options
to use automatically whenever a new job is entered into the system, or whenever an existing job is rehired
or terminated through the Administer Workforce pages.

Navigation:

Set Up HCM > Product Related > Base Benefits > Multiple Jobs Options > Multiple Jobs Options
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This example illustrates the fields and controls on the Multiple Jobs Options page. You can find
definitions for the fields and controls later on this page.

When a Job is Hired, Re-Hired or Added

Field or Control Description

Eligibility and Deductions Set default rules for whether new concurrent jobs are included
or excluded during deduction processing and for Benefits
Administration users to determine benefit eligibility.

If assigned to an existing Benefit Record If an employee is hired into a concurrent job and the job is
linked to an existing benefit record number, indicate whether
the new job should be designated as the primary job.

When a Job Terminates

Field or Control Description

Eligibility and Deductions Set default rules for whether terminated jobs should continue
to contribute information during deduction processing and for
Benefits Administration users to determine benefit eligibility.
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Field or Control Description

If the Primary Job terminates Indicate how to reassign the primary job designation if the
terminating job is the primary job. Values are:

No Change: Don't reassign the primary job designation.

Lowest Active Job: Reassign the primary job designation to the
lowest active employee record number. If no jobs are active,
 the job with the lowest employee record number is designated
as the primary job.

Highest Active Job: Reassign the primary job designation
to the highest active employee record number. If no jobs are
active, the job with the highest employee record number is
designated as the primary job.

Explode activity triggers to all Benefit Records

Field or Control Description

Job Triggers,  Passive Service Triggers, and Multi-Job
Triggers  (multiple job triggers)

For Benefits Administration users only.

Select these options when you have an eligibility rule that
applies to all benefit programs and that crosses benefit record
numbers.

For example, suppose that an employee holds four jobs, is
enrolled in two benefit programs, and has two benefit records.

If the employee experiences a job data change for one job, and
eligibility rules cross benefit records, an event must be created
for all benefit records. A change to a job in benefit record A
might affect the employee's eligibility for benefits in benefit
record B if any eligibility rule in the benefit program for
benefit record B contains a grouping method of All Flagged.

Setting Up Retroactive Benefits and Deductions

This section lists prerequisites and discusses how to set up retroactive benefits and deductions
using the Retro Ben/Ded Program (RETRO_DED_TABLE) and Retro Ben/Ded Mass Request
(RETRODED_MASS_RQST) components.

To set up retroactive benefits and deductions, you:

1. Activate retroactive benefits and deductions on the Installation page.

2. Define retroactive benefits and deductions programs.
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3. If you are creating mass requests, define the retroactive benefit deduction selection criteria.

The Retroactive Benefit and Deduction Mass Request feature enables you to create a large number of
requests using a batch process. This is necessary when you retroactively update system-level pages
that affect multiple employees. Changes to the following system-level pages could generate mass
retroactive benefit and deduction requests:

• Deduction Table.

• General Deduction Table.

• Most benefit plan design tables (such as the Life and AD/D Plan Table).

• Calculation Rules Table.

• All rate tables.

Note: Because the Retroactive Benefit and Deduction feature involves PeopleSoft Payroll for North
America processes in the calculation of retroactive benefits and deductions and the loading of retroactive
benefit and deduction totals to payroll, it is unavailable to those users who do not currently implement
Payroll for North America
Deductions based on earnings (such as garnishments or savings plan deductions) are not included in the
retroactive benefits and deductions process. They are handled as part of the Payroll for North America
adjustment process.

Pages Used to Set Up Retroactive Benefit and Deduction Programs and
Mass Requests

Page Name Definition Name Usage

Retro Ben/Ded Program Page RETRODED_PGM_TBL Define high-level information for your
organization's retroactive benefit and
deduction programs.

Retro Ben/Ded Mass Request Page RETRODED_MASS_RQST Set up your mass retroactive benefit and
deduction programs by assigning them a
Mass Retro Request ID and by defining
detailed information.

To set up a new mass retroactive
deduction and benefit program, enter a
Mass Retro Request ID to open the page.
 The system uses the Mass Retro Request
ID to generate mass retroactive benefit
and deduction requests and to calculate
the retroactive benefit and deduction
earnings based on those requests.

Prerequisites
Before you can define retroactive benefits and deduction programs, you must:
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1. Activate retroactive benefits and deductions on the Installation table.

2. Set up core tables and benefit plans.

See "Setting Up Implementation Defaults" (Application Fundamentals).

See Understanding the Core Tables for PeopleSoft Manage Base Benefits.

See Defining Benefit Plans.

Retro Ben/Ded Program Page
Use the Retro Ben/Ded Program (retroactive benefit/deduction program) page (RETRODED_PGM_TBL)
to define high-level information for your organization's retroactive benefit and deduction programs.

Navigation:

Set Up HCM > Product Related > Payroll for North America > Retroactive Payroll > Retro Ben/
Ded Program > Retro Ben/Ded Program

This example illustrates the fields and controls on the Retro Ben/Ded Program page. You can find
definitions for the fields and controls later on this page.

Program Definition

Field or Control Description

Retro Program ID (retroactive program identification) When you first select this page from the menu, enter a new or
current Retro Program ID. This ID links the retroactive benefit
and deduction requests to a specific retroactive benefit and
deduction program, which helps the system identify which
benefits or deductions are eligible for retroactive processing.

Copyright © 1988, 2022, Oracle and/or its affiliates. 187



Setting Up Additional Manage Base Benefits Features Chapter 6

Field or Control Description

Retro Program Type  (retroactive program type) The system assigns each retroactive benefit and deduction
program a Retro Program type of Individual or Mass.

Individual programs apply to all of the employees and
companies in your database; therefore, define only one
individual program for that database.

Mass programs apply to different groups of employees;
therefore, you can define multiple mass programs with
different Retro Program IDs for the same database.

Warning! If you change the Retro Program ID after retroactive benefit and deduction processing begins,
improper retroactive benefit and deduction calculations will result.

Refunds Paysheet Processing

Field or Control Description

Off Cycle This check box enables you to manage your onetime deduction
refunds. In the event of a refund, the Off-Cycle field controls
whether the retroactive benefit and deduction calculation
program will create new onetime deduction refunds as an off-
cycle deduction or an on-cycle deduction.

Generally, use off-cycle or separate check processing of
retroactive benefits and deductions only when you are
processing retroactive pay in the same cycle as regular pay.
 If you select Off-Cycle, the system treats each retroactive
deduction associated with this program as an off-cycle onetime
deduction refund, and delivers the refunds to your employees
in checks that are separate from their regular paychecks.

If you do not select Off-Cycle, the system treats the retroactive
deductions associated with the program as on-cycle deductions
and combines employee refunds with their regular paychecks.

Note: When you load your retroactive benefits or deductions
to employee paysheets, the On-Cycle or Off-Cycle selection
for the Retro Ben/Ded Payroll Load run control must match
the On-Cycle or Off-Cycle selection for this field.

Sep Check  (separate check) Select to indicate that the onetime deduction refund records
associated with the retroactive benefit or deduction will be
loaded to a separate check on the employee paysheets.
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Deductions Tab

Field or Control Description

Base Flag Select to have the system process retroactive benefits or
deductions when the request is triggered by a change in the
annual benefits base rate.

Job Flag Select to have the system process retroactive benefits or
deductions for individual retroactive benefit and deduction
programs when the request is triggered by a change in the
compensation rate or any of its related fields.

Mass Retro Override Tab

If you are setting up a mass retroactive benefit and deduction program, complete the Start Date Ovrd for
Mass Retro (start date override for mass retroactive benefit/deduction) and End Date Ovrd for Mass
Retro (end date override for mass retroactive benefit/deduction) fields to override the process start date
and process end date for the requests that are created.

Refunds Versus Deductions

The system loads refunds to employee paysheets only. In situations in which the retroactive benefit and
deduction process finds that employees owe additional payments, the system collects these funds through
the PeopleSoft Payroll for North America arrears adjustment process. The system drops all employee
retroactive benefits and deductions into the arrears balance using arrears adjustments. If enough money
is available, the system collects the amounts during the current payroll run, according to the arrears rules
that you defined for that deduction.

Related Links
Understanding Retroactive Benefits and Deductions
Setting Up Deduction Codes

Retro Ben/Ded Mass Request Page
Use the Retro Ben/Ded Mass Request (retroactive benefit/deduction mass request) page
(RETRODED_MASS_RQST) to set up your mass retroactive benefit and deduction programs by
assigning them a Mass Retro Request ID and by defining detailed information.

To set up a new mass retroactive deduction and benefit program, enter a Mass Retro Request ID to open
the page. The system uses the Mass Retro Request ID to generate mass retroactive benefit and deduction
requests and to calculate the retroactive benefit and deduction earnings based on those requests.

Navigation:

Set Up HCM > Product Related > Payroll for North America > Retroactive Payroll > Retro Ben/
Ded Mass Request > Retro Ben/Ded Mass Request
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This example illustrates the fields and controls on the Retro Ben/Ded Mass Request. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Description Enter a description that explains the purpose of this mass
retroactive benefit and deduction ID.

Retro Ded Program ID (retroactive deduction benefit/
deduction program ID)

Select an appropriate ID from the list. Only those retroactive
benefit and deduction programs defined for Mass processing
appear.

Process Start Date  and Process End Dt (process end date) Define the period during which the mass request calculates
retroactive benefits or deductions. The process end date is
automatically set to today's date when a new mass request ID
is created. The process start date becomes the effective date of
the generated requests, except for cases in which the selected
employee begins to meet the criteria at some point after the
start date, in which case that latter date is used as the effective
date of the request.

Selection Start Date  and Selection End Dt (selection end
date)

During the processing period set up by the process start and
end dates, the system searches employee records that are
active between the selection start and selection end dates for
the information specified in the Selection Criteria group box.

First Hire Date (Optional) Use to select employees who have a hire date on the
Employment Table that is before or equal to this date. If this
field is blank, the system creates requests for employees who
have a hire date before or equal to the selection end date.

Service Date Functions the same way as the Hire Date field except that it
refers back to the Employment Table's Service Date field.
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Field or Control Description

Delete Request Use this check box to stop the mass retro benefit and
deduction process if you have not yet run the calculation
process for your Mass Retro ID. When you run the Mass Retro
batch process, it deletes every Mass Request ID and related
request that has this check box selected and has not yet been
through the calculation process.

Comments Describe the need for the particular mass retroactive benefit
and deduction program that you are creating.

Selection Criteria

The fields in this group box define the types of employees that the Mass Retro batch process looks for.
You can set up multiple rows of selection criteria for your mass retroactive benefit and deduction program
to open up a new one.

Field or Control Description

Company Use this required field to indicate the company whose
employees you want to process. You can have multiple rows of
selection criteria with the same company if you want to change
the values of the other fields.

Mass Sequence Number Each time that you enter a new row of selection criteria, the
mass sequence number will be incriminated by one.

Business Unit You must define a business unit before entering Department,
 Job Code, and Location Code values.

Department,  Job Code,  and Location Code These fields are linked to the Business Unit field.

Reg/Temp (regular/temporary), Full/Part Time,  Employee
Type,  Employee Class,  and  Pay Status

(Optional) Specify additional selection criteria using valid
values from the list boxes.

Enter the other selection criteria as necessary. Values for all selection criteria fields that are blank will be
selected by the system. If you want to use more than one of the available values of a particular field in
your selection request, enter an additional row.

The three Elig Cal Days (eligible calculation days) fields are linked to the Job Code, Location Code,
and Union Code fields. They each enable you to create selection requests for employees who have been
assigned a specific job code, location, or union code for a specific number of days. For each Elig Cal
Days field, the system looks at the effective date of the selected job record.
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Entering Dependent and Beneficiary
Information

Understanding Dependent and Beneficiary Information

Accurate dependent and beneficiary information—name, address, birth date, gender, and relationship—
helps ensure that benefit claims are quickly and correctly processed.

By setting up dependent and beneficiary information, you can:

• Simplify benefit enrollment for dependents and beneficiaries.

• Review data and print reports.

Additionally, requirements such as a Qualified Medical Child Support Order (QMCSO) and Qualified
Domestic Relations Order (QDRO) mandate that employees provide benefits to dependents and
beneficiaries. When you enter a court order, the system checks whether a court order is tied to an
employee record. If the system finds a court order, it checks whether any changes are allowed to the
benefit enrollments. If changes are not allowed, then a warning appears.

When you set up dependent and beneficiary information, you need an employee identification number. So
you need to enter employee administration data—personal information, compensation allowances, and job
data—first.

You can view basic human resources information for employees by using personnel administration
components such as Personal Data and Job Data in PeopleSoft HR or by viewing the Review HR/Job/
Payroll Data page in the Manage Base Benefits business process. Employees can review, update, and add
their own dependent and beneficiary information using the PeopleSoft eBenefits application pages.

Related Links
Auditing Your Benefit Information
"Adding a Person" (PeopleSoft Human Resources Administer Workforce)
"Reviewing Dependent and Beneficiary Information" (PeopleSoft eBenefits)

Entering Dependent and Beneficiary Information

You enter dependent and beneficiary information in the Dependent Information (DEPEND_BENEF)
component of PeopleSoft HR Administer Workforce and is fully documented in the PeopleSoft HCM:
Human Resources Administer Workforce documentation.

Related Links
"Tracking Dependent and Beneficiary Data" (PeopleSoft Human Resources Administer Workforce)
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Entering Dependent and Beneficiary Comments

Comments that you enter about dependents and beneficiaries are for your use only; they are not used by
the system.

Page Used to Enter Dependent and Beneficiary Comments

Page Name Definition Name Usage

Dependent/Beneficiary Comments Page BENEFIT_COMMENTS Enter notes about a dependent or
beneficiary.

Dependent/Beneficiary Comments Page
Use the Dependent/Beneficiary Comments page (BENEFIT_COMMENTS) to enter notes about a
dependent or beneficiary.

Navigation:

Benefits > Employee/Dependent Information > Dependent/Beneficiary Comments > Dependent/
Beneficiary Comments

Field or Control Description

Action Date Enter the date on which the comment becomes or became
effective.

Comments By Enter your name or the name of the person providing the
information.

Updating Benefits Certifications

This section discusses how to update employee benefit certifications.

Page Used to Edit Benefits Certifications

Page Name Definition Name Usage

Maintain Benefit Certification Page BN_CERTIF_PARTC Updating employee benefit certifications.
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Maintain Benefit Certification Page
Use the Maintain Benefit Certification page (BN_CERTIF_PARTC) to updating employee benefit
certifications.

Navigation:

Benefits > Employee/Dependent Information > Maintain Certifications > Maintain Benefit
Certification

This example illustrates the fields and controls on the Maintain Benefit Certification page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Certificate ID Enter the ID that represents a certificate created in the
Certification Definition page.

Status Select Active or Inactive.

Plan Type Select from all available plan types for a participant's assigned
benefit program with an associated certificate.

Effective Date A date the system uses to calculate the length of time from this
initial start date of a certificate.

Expiration Date An informational field that you can use to enter the expiration
date of the certificate.

Value Enter the minimum value to allow to consider the certificate as
complete or valid.

Certificate Maximum Value Displays the maximum value of the certificate as defined in
the Certificate Definition.

Dependent/Beneficiary ID Select from all available dependents or beneficiaries for the
participant.
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(USF) Designating Beneficiaries for a Final Check

You can designate dependents or beneficiaries to receive an employee's final check in the event that the
employee dies. This page is for informational purposes only; the system does not use the data entered on
this page for benefits processing.

This section discusses how to specify beneficiaries for a final check.

Page Used to Designate Beneficiaries for a Final Check

Page Name Definition Name Usage

Assign Final Check Beneficiary Page GVT_FIN_CHK_BEN Specify dependents or beneficiaries to
receive an employee's final check.

Assign Final Check Beneficiary Page
Use the Assign Final Check Beneficiary page (GVT_FIN_CHK_BEN) to specify dependents or
beneficiaries to receive an employee's final check.

Navigation:

Benefits > Employee/Dependent Information > Assign Final Check Beneficiary > Assign Final
Check Beneficiary

This example illustrates the fields and controls on the Assign Final Check Beneficiary page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Percent of Benefit  and Flat Amount Enter a flat amount or percentage for the beneficiary to receive
from the final paycheck.

The total percentage for all beneficiaries should equal 100,
 unless you have contingent beneficiaries. The sum of the flat
amounts cannot be greater than the paycheck.

196  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 7 Entering Dependent and Beneficiary Information

Field or Control Description

Excess If flat amounts are used, select to designate a beneficiary to
receive any excess funds.

Contingent Select if this dependent or beneficiary is not a primary
beneficiary.

Amounts attributed to contingent beneficiaries must also add
up to 100 percent.

Terminating Dependent Enrollments or Beneficiary Status

Remember that you enroll dependents and assign beneficiaries when you enroll employees. To terminate a
dependent enrollment or beneficiary status, you must enter a row of data with the termination date (just as
you do with employees). You make these changes on the enrollment page for the benefit in question, such
as the Life & AD/D Benefits page. You do not make the changes in the Update Dependent/Beneficiary
component.

If you try to delete dependent/beneficiary records on benefit enrollment pages that have court orders
applied to them, the system informs you that the dependent or beneficiary has a court order that provides a
legal right to benefit coverage.

Warning! If you delete dependent and beneficiary data using the Update Dependent/Beneficiary
component, you'll destroy history. After you change enrollment data, the fact that the dependent or
beneficiary data is available on the Update Dependent/Beneficiary component won't matter. In fact, it
must remain to provide correct historical information.

Entering Court Orders and Spousal Waivers

Spouses, ex-spouses, and children of employees may have court orders that provide them with a legal
right to benefit coverage from those employees. In addition, certain benefit plans may require that a
spouse have a required minimum coverage amount.

You enter court orders on the Dependent/Beneficiary Riders page, and minimal spousal amounts on the
Benefit Plan Table.

To track court-ordered benefits, print the Court Ordered Coverage Audit report.

Related Links
Setting Up Deduction Codes
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Approving Dependent Documents using Fluid Approval

This topic describes how to approve dependent documents using Fluid Approvals.

Understanding Dependent Document Approval
Employees upload required dependent documents when adding or modifying dependents. The document
has to be approved before the employee proceeds to enroll benefits. The Pending Approval - Dependent
Updates page enables the Benefits Administrator to approve the dependent documents. The page lists all
dependent documents that require approval. The Benefits Administrator can review and then approve or
deny the documents.

Page Used to Approve Dependent Documents

Page Name Definition Name Usage

Pending Approvals - Dependent Updates
Page

EOAWMA_MAIN_FL Approve a dependent document.

Pending Approvals - Dependent Updates Page
Use the Pending Approvals - Dependent Updates page (EOAWMA_MAIN_FL) to approve required
dependent documents uploaded by employees.

Navigation:

On the Workforce Administrator home page, click the Approvals tile to access the Pending Approvals
page. From the left panel, click Dependent Updates.

This example illustrates the Pending Approvals - Dependent Updates page.

The approval options on this page are common to all fluid approval transactions, as described
in the documentation for the "Using PeopleSoft Fluid User Interface Self-Service Approval
Transactions" (Application Fundamentals).
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Field or Control Description

Approve and Deny buttons Use these buttons to take action on the requested approval.

Approver Comments Enter any comments related to the approval action you take.
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Enrolling Participants

Reviewing Employee Eligibility

Before you can enroll a participant, your human resources department must set up personnel
administration data: personal information, compensation allowances, and job data.

This section discusses how to view personnel administration data.

Page Used to Review Employee Eligibility

Page Name Definition Name Usage

Employee HR and Payroll Data Page EMPLOYEE_SUMMARY1 View personnel administration data.

Employee HR and Payroll Data Page
Use the Employee HR and Payroll Data page (EMPLOYEE_SUMMARY1) to view personnel
administration data.

Navigation:

Benefits > Employee/Dependent Information > Employee HR and Payroll Data > Employee HR
and Payroll Data
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This example illustrates the fields and controls on the Employee HR and Payroll Data page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Annual Benefits Base Rate This field is blank if your organization uses a benefits base that
is different from regular pay.

Set up the primary annual benefits base rate in the Annual
Benefits Base Rate field on the Compensation page of the Job
Data (JOB_DATA) component.

Add multiple annual benefits base rates (ABBRs) using the
Update ABBR component.

Note: The only ABBR displayed on this page is the primary
ABBR entered in the Job component for the employee.
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Enrolling Participants in Benefit Programs and Plans

This section provides an overview of enrolling participants in Base Benefits and discusses how to enroll
an employee in a benefit program and benefit plans.

Pages Used to Enroll Participants in Benefit Programs and Plans

Page Name Definition Name Usage

Assign to Benefit Program Page BEN_PROG_PARTICPTN Enroll the employee in the appropriate
benefit program.

Health Benefits Page HEALTH_BENEFITS1 Enroll employees and dependents in
health plan types: medical, dental, and
vision.

Life and AD/D Plan Enrollment Page LIFE_ADD_BENEF1 Enroll participants in life plans and
assign beneficiaries to those plans.

Benefits Personal Data page BN_PERSON_EFFDT Enter Medicare information.

Update ABBRs Page BN_ANNL_BENEF_BASE Enter and maintain multiple ABBRs for
an employee.

Review ABBRs (review annual base
benefit base rates)

BN_ANN_BENBASE_INQ Review annual benefit base rate.

Disability Plan Enrollment Page DISABILITY_BENEFIT Enroll employees in disability benefit
plans.

Savings Plans Page SAVINGS_PLANS1 Enroll employees in savings benefit
plans, assign beneficiaries, and identify
investment elections.

Benefits Leave Plans Page LEAVE_PLANS Enroll employees in leave plans.

Spending Accounts Page FSA_BENEFITS Enroll employees in FSA plans.

Retirement Plans Page RTRMNT_PLANS Enroll employees in Public Employees
Retirement System (PERS) benefit plans.

Pension Plans USA Page

CAN-Pension Plans Page

PENSION_PLAN1 Enroll employees in benefit plans.
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Page Name Definition Name Usage

Vacation Benefits Page VACATION_BENEFIT Enroll employees in vacation buy and
sell plans.

Simple Benefits Page SIMPLE_BENEFIT Maintain employee enrollment in simple
benefit plans.

Understanding Enrolling Participants in Base Benefits
Using the Manage Base Benefits business process to enroll participants consists of two parts:

1. Enroll a participant in a benefit program.

Initially, an employee's benefit program assignment is assigned to the employee based on his or
her employee pay group, but you can override this assignment at the employee level. Verify that
the employee is enrolled in the correct benefit program, because you can enroll participants only in
benefit plans that are associated with their assigned benefit program.

2. Using individual benefit pages, enroll the participant in all appropriate benefit plans within the benefit
program.

When you enroll employees in health, life, savings, FSA (flexible spending account), and Canadian
pension benefit plans, you also enroll dependents and assign beneficiaries.

Note: You should set up that data before you start enrollments. That way, for each dependent enrollment
and beneficiary assignment, you can prompt for the data once rather than enter it several times.

Related Links
Defining Benefit Plans
"Setting Up Pay Groups" (PeopleSoft Payroll Interface)
"Defining Pay Groups" (PeopleSoft Payroll for North America)

Assign to Benefit Program Page
Use the Assign to Benefit Program page (BEN_PROG_PARTICPTN) to enroll the employee in the
appropriate benefit program.

Navigation:

Benefits > Enroll In Benefits > Assign to Benefit Program > Assign to Benefit Program
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This example illustrates the fields and controls on the Assign to Benefit Program page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Benefit Program Enter the benefit program for the employee.

Set up a default benefit program on the Pay Group table. If
you run a payroll before you enter a benefit program, payroll
cannot process the employee.

You can override the default benefit programs with the correct
benefit program.

Health Benefits Page
Use the Health Benefits page (HEALTH_BENEFITS1) to enroll employees and dependents in health plan
types: medical, dental, and vision.

Navigation:

Benefits > Enroll In Benefits > Health Benefits > Health Benefits
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This example illustrates the fields and controls on the Health Benefits page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Health Provider ID Tracks the primary care physician information for the
employee's health provider. Enter the name of the employee's
doctor, an ID number, or any other format the health provider
may require.

Previously Seen Select to indicate that the employee is a current patient of the
indicated physician.

Other Covrg  (other coverage) (USF) This check box indicates whether the dependent has
another active insurance plan.

Insurance Name (USF) Enter the name of the other insurance plan.

FEHB Ind  (Federal Employee Health Benefits indicator) (USF) This check box indicates whether the dependent in
enrolled in FEHB.

Life and AD/D Plan Enrollment Page
Use the Life and AD/D Plan Enrollment page (LIFE_ADD_BENEF1) to enroll participants in life plans
and assign beneficiaries to those plans.

Navigation:

Benefits > Enroll In Benefits >Life and AD/D Plan Enrollment > Life and AD/D Plan Enrollment
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This example illustrates the fields and controls on the Life and AD/D Plan Enrollment page. You can find
definitions for the fields and controls later on this page.

Coverage

Field or Control Description

Smoker Smoker is selected if you have indicated that the dependent is
a smoker in the Dependent/Beneficiary - Personal Profile page.

On this page, the Smoker check box is a display-only field.
 When Smoker is selected, the system uses the age-graded
rates that have been defined for smokers when calculating the
employee's life benefit cost.
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Coverage Options

Use these group boxes to define plan coverage and the benefits base calculation rules.

These sections are active only if, in the Life and AD/D Plan Table page, you indicate that coverage should
be Specified in Employee Record.

Field or Control Description

Flat Amount Enter an amount.

This example illustrates the fields and controls on the Flat Amount field opens to a Display in Other
Currency page for the option of converting currency. You can find definitions for the fields and controls
later on this page.

Dependent/Beneficiaries

Field or Control Description

ID Select the beneficiary ID. The selection list includes all of
the beneficiaries that you set up for the employee using the
Dependent/Beneficiary Data pages. Only beneficiaries that you
identified as Beneficiary or Both (beneficiary or dependent)
can be selected.

For more information on defining eligible beneficiaries, see
Setting Up Life Insurance and Accidental Death Plans.

To delete a dependent enrollment, position the cursor at the
line for the dependent that you want to delete and click Delete.

Percent of Benefit  and Flat Amount Define the distribution benefit as a percent of benefit or a
flat amount. If you enter a flat amount and more than one
beneficiary, select one of the beneficiaries to receive any
excess funds. Select the beneficiary by selecting the Excess
check box.
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Field or Control Description

Contingent (Optional) Select to Indicate whether a beneficiary is primary
or contingent (secondary to a primary beneficiary).

If you set up a primary beneficiary to receive 100 percent of
the benefit, all other beneficiaries have Contingent selected.

Note: If you are working with a dependent life plan, add dependent IDs of eligible dependents that will
be covered by the plan. In dependent life plans, the dependents are covered by life insurance, and the
employee is the beneficiary.
For more information on defining eligible dependents, see Setting Up Life Insurance and Accidental
Death Plans.
If you have defined the coverage method of the life or AD/D plan that you're working with to be the sum
of dependent coverage in the Life and AD/D Plan Table, the Percent of Benefit field is not available for
entry.
The totals for all beneficiaries must equal 100 percent. If they do not, the system displays an error
message and does not allow you to save your entries. To correct the entry, change one or more of the
percentages so that the totals are equal to 100 percent.

Benefits Personal Data page
Use the Benefits Personal Data page (BN_PERSON_EFFDT) to enter Medicare information.

Navigation:

Benefits > Employee/Dependent Information > Benefits Personal Data > Benefits Personal Data
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This example illustrates the fields and controls on the Benefits Personal Data page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Medicare Number  and Alternate Medicare Number Enter the medicare number, for example Health Insurance
Claim Number (HICN) or Medicare Beneficiary Identifier.

Medicare A Indicator Select to indicate Enrollment in Medicare A.

Medicare Reason A The administrator enters a description.

Medicare B Indicator Select to indicate supplemental governmental insurance other
than hospitalization costs

Medicare Reason B The administrator enters a description.

Medicare D Indicator Select to indicate enrollment in the Medicare D prescription
drug plan.

Medicare Reason D The administrator enters a description.
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Field or Control Description

HIPAA Medicare Elig Reason (HIPPA Medicare eligibility
reason)

Select the reason for a qualifying employee’s or dependent’s
Medicare eligibility. Available values include: Age, Disability,
 and End Stage Renal Disease.

This field is Situational. No eligibility code is generated in
the HIPAA EDI 834 file if the HIPAA Medicare Eligibility
Reason field is not entered for the Person ID here, and on
the Dependent/Beneficiary - Personal Profile page. For
information about Situational fields, see Sending HIPAA Data
to Providers.

Related Links
"Setting Up Eligibility Rules" (PeopleSoft Benefits Administration)

Update ABBRs Page
Use the Update ABBRs (update annual benefit base rates) page (BN_ANNL_BENEF_BASE) to enter
and maintain multiple ABBRs for an employee.

Navigation:

Benefits > Employee/Dependent Information > Update ABBRs > Update ABBRs

This example illustrates the fields and controls on the Update ABBRs page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Annual Benefits Base Rate Type Select the ABBR type.

ABBR types are defined on the Annl Benef Base Rt Type Tbl
page.

Annual Benefits Base Rate Enter the amount of the ABBR.

Note: The Primary ABBR can be set only in the Job
component.
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Disability Plan Enrollment Page
Use the Disability Plan Enrollment page (DISABILITY_BENEFIT) to enroll employees in disability
benefit plans.

Navigation:

Benefits > Enroll in Benefits > Disability Plan Enrollment > Disability Plan Enrollment

This example illustrates the fields and controls on the Disability Plan Enrollment page. You can find
definitions for the fields and controls later on this page.

Savings Plans Page
Use the Savings Plans page (SAVINGS_PLANS1) to enroll employees in savings benefit plans, assign
beneficiaries, and identify investment elections.

Navigation:

Benefits > Enroll In Benefits > Savings Plans > Savings Plans
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This example illustrates the fields and controls on the Savings Plans page. You can find definitions for the
fields and controls later on this page.

Copyright © 1988, 2022, Oracle and/or its affiliates. 213



Enrolling Participants Chapter 8

Before Tax Investment and After Tax Investment

Field or Control Description

Flat Amount  and Percent of Earnings Define investment contributions as a flat amount or percent of
earnings.

The system compares the percent of earnings to the percent of
gross limits for employee before-tax and after-tax investment
values. The system also verifies that the sum of the before-tax
and after-tax investment values does not exceed the overall
investment limit percentage that you defined for the savings
benefit plan on the Savings Plan Table.

Dependent/Beneficiaries

Field or Control Description

ID Select the beneficiary ID. The selection list includes the
beneficiaries that you set up for the employee using the
Dependent/Beneficiary Information component.

To delete a beneficiary, position the cursor at the line for the
beneficiary that you want to delete and click the Delete icon.

Beneficiary Percentage Enter the percent of benefit for each beneficiary.

Note: The total for all beneficiaries must equal 100 percent. If it does not, the system displays an error
message and does not allow you to save your entry. To correct the entry, change one or more of the
percentages so that the total equals 100 percent.

Investments

Field or Control Description

Investment Option Select an investment option and allocate an investment
percentage. Investment percentages must total 100 percent
before they can be saved in the system. If more than one
investment option is associated with the chosen employee's
savings plan, add more rows.

Rollover Options

You can enter rollover options only if Specified at Employee Level is selected on the Savings Plan Table
- Rollover of Funds page.
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Enter the plan type, benefit plan, deduction, and deduction class values for before tax and after tax
rollovers.

Benefits Leave Plans Page
Use the Benefits Leave Plans page (LEAVE_PLANS) to enroll employees in leave plans.

Navigation:

Benefits > Enroll In Benefits > Benefits Leave Plans > Benefits Leave Plans

This example illustrates the fields and controls on the Benefits Leave Plans page. You can find definitions
for the fields and controls later on this page.

Spending Accounts Page
Use the Spending Accounts page (FSA_BENEFITS) to enroll employees in FSA plans.

Navigation:

Benefits > Enroll In Benefits > Spending Accounts > Spending Accounts
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This example illustrates the fields and controls on the Spending Accounts page. You can find definitions
for the fields and controls later on this page.

Note: The FSA Benefits (CAN) page is essentially the same as the page for U.S. users with two
exceptions: It offers a choice between Canadian Health Care and Canadian Retirement Counseling plan
types (plan types 65 and 66) instead of Health and Dependent Care plan types (plan types 60 and 61), and
it displays a Carryforward option of either Claim or Credit, if applicable.

Contribution Level

Field or Control Description

Annual Pledge Enter the employee's annual pledge amount.

Credit Rollover Included in Pledge (Used by Benefits Administration) Displays the amount of
the excess benefits credits that have been assigned to an
FSA plan at the end of a plan year. The PeopleSoft Benefits
Administration system automatically provides the credit
rollover included in pledge from the previous year if you have
designated that excess credits should be assigned to FSA plans
in the Benefit Program Table.
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Field or Control Description

Empl Contribution Override (employee contribution
override)

If you do not implement PeopleSoft Payroll for North America
or Payroll Interface, this is optional.

Enter a value to have the system use this amount to calculate
the employee's spending account contribution.

Leave the field blank to have the system use the annual
pledge amount to calculate the employee's spending account
contribution.

Account Information

The system reflects the FSA account status of the employee's FSA plan, as well as the employee's FSA
contributions IT'D (contributions year-to-date).

Employees cannot transfer FSA funds from one account to another. As a rule, unused funds in an account
at the end of a plan year are transferred to the employer.

Carryforward

This value appears for Canadian pension plans and is automatically set to the value that you entered for
the employer carryforward choice in the FSA Benefits Table (Canada).

Retirement Plans Page
Use the Retirement Plans page (RTRMNT_PLANS) to enroll employees in Public Employees Retirement
System (PERS) benefit plans.

Navigation:

Benefits > Enroll In Benefits > Retirement Plans > Retirement Plans

This example illustrates the fields and controls on the Retirement Plans page. You can find definitions for
the fields and controls later on this page.

Copyright © 1988, 2022, Oracle and/or its affiliates. 217



Enrolling Participants Chapter 8

Pension Plans USA Page
Use the Pension Plans USA page (PENSION_PLAN1) to enroll employees in benefit plans.

Navigation:

• Benefits > Enroll In Benefits > USA-Pension Plans > Pension Plans USA

• Benefits > Enroll in Benefits > CAN-Pension Plans > CAN-Pension Plans

For Canadian users, the plan types are 80 and 81. For U.S. users, the plan types are 82 through 87.

This example illustrates the fields and controls on the Pension Plans USA page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Voluntary Contributions Enter an amount that the employee voluntarily contributes
to the pension plan. This is an amount over the amount that
you define in the Pension Plan Table. Enter a flat amount or a
percent of earnings.

Salary for Pension Calculation Use to calculate the pension using a salary other than the
employee pay rate.

218  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 8 Enrolling Participants

Dependent/Beneficiaries

Field or Control Description

ID Select the beneficiary ID.

The selection list includes the beneficiaries that you set up for
the employee using the dependent and beneficiary data pages.

To delete a beneficiary, position the cursor at the line for the
beneficiary that you want to delete and click Delete.

Percent of Benefit  and Flat Amount Define the distribution benefit as a percent of benefit or a
flat amount. If you enter a flat amount and more than one
beneficiary, select one of the beneficiaries to receive any
excess funds. Select the beneficiary by selecting the Excess
check box.

Note: The total for all beneficiaries must equal 100 percent. If it does not, the system displays an error
message and does not allow you to save your entry. To correct the entry, change one or more of the
percentages so that the total equals 100 percent.

Vacation Benefits Page
Use the Vacation Benefits page (VACATION_BENEFIT) to enroll employees in vacation buy and sell
plans.

Navigation:

Benefits > Enroll In Benefits > Vacation Benefits > Vacation Benefits
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This example illustrates the fields and controls on the Vacation Benefits page. You can find definitions for
the fields and controls later on this page.

When you define vacation buy or sell benefit plans with the Vacation Buy/Sell Table, you define
increments for the vacation hours and minimum and maximum amounts that an employee can buy or sell.

Field or Control Description

Vacation Hours The number of hours that an employee buys or sells for the full
plan year (a 12-month period).

The vacation hours that you enter must be at least the
minimum and not more than the maximum numbers of
vacation hours that are defined in the Vacation Buy/Sell Table.
 In addition, they must be entered in the increment specified in
the Vacation Buy/Sell Table.

Goal Balance Updated by payroll. The system automatically stops
deductions when the current goal balance equals the goal
balance.

Vacation Accrual Processed During the first payroll processing cycle of the plan year,
 PeopleSoft Payroll calculates bought and sold vacation
earnings for each participant. The system automatically selects
this check box.

You will not see the buy or sell transactions reflected in
employee leave balances until after you perform leave accrual
processing, at which time the system deselects the check box.
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Note: If you change employee job data after the system performs vacation buy and sell processing, it does
not update its calculations based on the new job data. For example, an employee is hired on September 1
and is paid monthly, at a rate of $20.00 per hour. The employee wants to buy 40 hours of vacation. The
system assumes a 12-month period in which to spread the deduction. It calculates the goal amount as
$800.00 (40 hours × $20 an hour), and calculated the pay period deduction as $66.67 (40 hours × $20
an hour/12 monthly periods per year). However, the company wanted the vacation amount based on the
hire date. Because 4 months remained in the year, September through December, the company manually
calculated and entered $200, or $800 divided by 4.

Simple Benefits Page
Use the Simple Benefits page (SIMPLE_BENEFIT) to maintain employee enrollment in simple benefit
plans.

Navigation:

Benefits > Enroll in Benefits > Simple Benefits > Simple Benefits

This example illustrates the fields and controls on the Simple Benefits page. You can find definitions for
the fields and controls later on this page.

No attributes are required for creating a simple benefit plan and costs are calculated from the Benefit Rate
table.

(USF) Enrolling Employees in Benefit Programs and Plans

This section describes how to enroll employees in benefit programs and plans.
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Pages Used to Enroll Employees in Benefit Programs and Plans Through
the PAR

Page Name Definition Name Usage

Benefits/FEHB Data Page GVT_BENDATA_SEC Enroll participants into benefit programs
and plans.

FEGLI/Retirement Data/FICA Page GVT_BENDATA1_SEC Select the participant's FEGLI plan
coverage, manage the employee's
retirement coverage, and designate FICA
status.

FEGLI Assignments - Assignee Page GVT_ASSIGNEE Designate one or more assignees for an
employee's FEGLI benefits coverage.
 Each assignee is given a share of the
total coverage being assigned. The total
of these percentages must be 100.

FEGLI Assignments - Assignee Benef
Page

GVT_ASSIGNEE_BEN Designate one or more beneficiaries.

Use to assign the FEGLI benefits of U.
S. federal government employees and
retirees.

TSP Agency Basic Page GVT_TSP_AUTO Enroll employees in the TSP Agency
Automatic 1% Contribution plan.

TSP Investment Allocations Page GVT_TSP_INVEST Select investment options.

Benefits/FEHB Data Page
Use the Benefits/FEHB Data (benefits/federal employee health benefits data) page
(GVT_BENDATA_SEC) to enroll participants into benefit programs and plans.

Navigation:

Workforce Administration > Job Information > HR Processing USF

Select the Job Data tab.

Click the Benefits/FEHB Data link.
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This example illustrates the fields and controls on the Benefits/FEHB Data page. You can find definitions
for the fields and controls later on this page.

Benefits Control

This group box is used for Benefits Administration processing.

Field or Control Description

BAS Group ID  (benefits administration group identification) Applies only if your benefits system uses Benefits
Administration. Use it to link the participant to a particular
benefits administration group for Benefits Administration
processing later.

Benefit Program Automatically set to the benefits program specified for the
employee's pay group, which you specify in the Position Data
page.

FEHB Eligibility

This group box identifies FEHB eligibility.
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Field or Control Description

Permanent Select this option for employees with a career conditional
career appointment. Employees are eligible for FEHB if fields
1−9 in the Eligibility group box are also for users of Benefits
Administration. Here you enter eligibility values that refer to
eligibility configuration values in the Eligibility Rules Table.

Continuing Coverage Select this option for employees who are transferring into
a position from another agency without a break in service
and for rehires with a break in service of fewer than 30 days.
 Employees are eligible for FEHB.

Temporary Appointment > 1 yr  (temporary appointment
greater than one year)

Select this option for an employee with a temporary
appointment greater than one year. Employees are eligible for
FEHB.

Temporary Appointment < 1 yr + FedSvc > 1 yr  
(temporary appointment less than one year plus federal service
greater than one year)

Select this option for an employee with a temporary
appointment less than one year and continuous service greater
than one year. Employees with this eligibility pay the entire
cost of their FEHB coverage.

Not Eligible Select this option for employees who are ineligible for FEHB
plan coverage. This option is most commonly used for
employees with a temporary appointment of less than one year
of service.

Eligibility

This group box is for Benefits Administration only. You enter the eligibility values that refer to the
eligibility configuration values in the Eligibility Rules Table.

FEHB Date

This group box is for Federal users. Enter the future date on which an employee will be eligible for FEHB
coverage. Typically, the FEHB Date is one year from the employee's hire date.

Benefits System

Benefits System

Select the appropriate benefits system. Select Not Managed in PeopleSoft (benefits managed by a
system other than PeopleSoft) to filter out persons who have insufficient employment and job information
to support benefit enrollment.
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FEGLI/Retirement Data/FICA Page
Use the FEGLI/Retirement Data/FICA (federal employee government life insurance/retirement data/
Federal Insurance Contributions Act) page (GVT_BENDATA1_SEC) to select the participant's FEGLI
plan coverage, manage the employee's retirement coverage, and designate FICA status.

Navigation:

Workforce Administration > Job Information > HR Processing USF

Select the Job Data tab.

Click the FEGLI/Retirement/FICA link.

This example illustrates the fields and controls on the FEGLI/Retirement Data/FICA page. You can find
definitions for the fields and controls later on this page.
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FEGLI

Field or Control Description

FEGLI Code Use this field to select the participant's FEGLI (Federal
Employees' Group Life Insurance ) plan coverage, including
termination, waiving coverage, and coverage ineligibility.

Only active employees are allowed to increase their FEGLI
coverage.

You can assign beneficiaries and allocate survivor benefits
through the Life and AD/D Benefits - Beneficiaries page.

Note: When you have two or more FEGLI-related transactions
to process for one employee that are effective on the same
date, each one must be processed separately. You must enter
the first transaction and save it before inserting a row to
process the second transaction. When a second transaction is
entered without saving the first, the system returns a message
reporting that the transaction will be canceled.
Federal employees may assign their FEGLI benefits to another
person, trust, or settlement company that will pay them a cash
amount for these benefits. Assignation of benefits is handled
in the FEGLI Assignments page group of the Administer Base
Benefits (USF) menu.

Post 65 Basic Life Reduction After federal employees pass the age of 65, their basic life plan
coverage may be reduced. In the Post 65 Basic Life Reduction
field, determine whether the chosen employee's life plan value
will be reduced by 50%, 75%, or not at all.

Living Benefits Select for terminally ill federal employees and retirees who
have a life expectancy of nine months or less. With living
benefits, a full or partial payment of the FEGLI Basic Life
Insurance benefit is paid directly to the employee or retiree.

When an employee's request for living benefits has been
approved by OFEGLI, use the PAR pages to process the
election. Select an NOA code of 805 (Elect Full Living
Benefit) or 806 (Elect Partial Living Benefit).

When you select Living Benefits to process a partial living
benefit, the Coverage Amount field becomes available.

After an employee selects living benefits, the only FEGLI
code values available to the employee are Terminate All and
Waive All Life Insurance.
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Field or Control Description

Coverage Amount Used for employees who elect a partial living benefit. In this
field, enter the Basic Insurance Amount (BIA). This is the
balance of the coverage amount remaining.

Retirement

Field or Control Description

Retirement Plan Select the employee's retirement plan coverage. You can
select from an entire list of available U.S. federal government
retirement programs that may be available to your employees.
 Whether your agency actually offers all of these programs
depends upon whether you have set them up in the Retirement
Plan Table and have associated them with the benefit programs
that your agency offers.

FERS Coverage (federal employees retirement system
coverage)

Indicate the level of FERS coverage allocated to employees
who had federal retirement plan coverage prior to 1984.
Employees who had this coverage before 1984 can select from
the following values: Elected Coverage Under FERS or Not
Covered by FERS.

All employees who started federal retirement coverage after
1984 have a FERS coverage of Automatically Covered by
FERS.

Previous Retirement Coverage Employees transferring from another agency previously
covered by a federal benefit plan should select Previously
Covered. If the employee was not covered, select Never
Covered.

Annuitant Indicator Use for employees who are being rehired from retirement. If
a formerly retired employee is receiving an annuity such as
a pension plan payment, his or her pay may be offset by that
annuity amount.

Determine whether the retirement annuity is applicable to
the employee's wages. Indicate the former employment
status of the employee, regardless of whether the employee
was a retired enlisted or military officer, and the employee's
retirement plan type (CSRS or FERS).
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Field or Control Description

Annuity Commencement Date The date when retirement annuities for a retired or soon-to-
be-retired employee began or will begin. The system uses this
date when determining how to calculate agency contributions
and employee deductions for FEHB and FEGLI during the
employee's last pay period.

Note: When an employee has worked less than a full pay
period, the PeopleSoft Payroll Pay Calculation process
prorates FEHB and FEGLI deductions according to OPM 
(Office of Personnel Management) rules.

CSRS Frozen Service (civil service retirement system frozen
service)

Frozen service is the U.S. federal government term for the
total years and months of civilian and military service that
is creditable in a CSRS component of an FERS employee 
(retirement plans FERS and FICA, FERS and FICA - Air
Traffic Control, FERS and FICA - Special, and FERS and
FICA - Reserve Tech), or in the case of a CSRS offset
employee (retirement plans FICA + CSRS – Partial and FICA
+ CSRS Special – Partial), the service that would be covered
in a CSRS component if the employee ever became covered by
FERS.

In the CSRS Frozen Service field, enter this time span as a
four-number code. The first and second positions indicate the
number of years, while the third and fourth positions indicate
the number of months. For example, a time span of five years
and three months would be entered in CSRS Frozen Service as
0503.

FICA Status - Employee

Select the employee's FICA status. Select from the following values: E − Exempt, M − Medicare only, or
N − Subject.

After you set up an employee's initial benefit program and plan enrollments through the PAR, you can
proceed to the individual benefit pages to continue benefit plan enrollments, add plan coverage detail,
enroll dependents, and assign beneficiaries. You can make changes in these pages without opening a PAR.

FEGLI Assignments - Assignee Page
Use the FEGLI Assignments - Assignee (federal employee government life insurance - assignee) page
(GVT_ASSIGNEE) to designate one or more assignees for an employee's FEGLI benefits coverage.

Each assignee is given a share of the total coverage being assigned. The total of these percentages must be
100.

Navigation:
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Benefits > Enroll in Benefits > Assign FEGLI Beneficiaries > Assignee

Field or Control Description

Assignee Number This number is designated automatically by the system; it
automatically increases by one with each new assignee that
you designate for an employee.

Assignee Name, National ID, and Assignee Share (Pct)  
(assignee share percentage)

Enter the information for each assignee.

The total assignee shares for all assignees associated with an
employee should equal 100.

After you enter assignee information and save it, the system selects the Assigned check box in the FEGLI
- Elections page for coverage that has been assigned, with the exception of FEGLI plan options that
have been Waived. When an employee elects a partial living benefit, the BIA is assigned along with any
optional insurance. This is with the exception of Option C - Family coverage.

FEGLI Assignments - Assignee Benef Page
Use the FEGLI Assignments - Assignee Benef (federal employee government life insurance - assignee
beneficiary) page (GVT_ASSIGNEE_BEN) to designate one or more beneficiaries.

Use to assign the FEGLI benefits of U.S. federal government employees and retirees.

Navigation:

Benefits > Enroll In Benefits > Assign FEGLI Beneficiaries > Assignee Benef

Field or Control Description

Assignee Beneficiary Number The system designates and automatically increases this number
by one for each beneficiary added to an assignee.

Assignee Name, Relationship, and Benef Share (Pct)  
(benefit share percentage)

Enter the information for each assignee.

Same Address as Assignee Select this check box if the beneficiary shares this information
with the assignee. While this check box is selected, the
Address and Phone Information fields are unavailable.

TSP Agency Basic Page
Use the TSP Agency Basic (thrift savings plan - agency basic) page (GVT_TSP_AUTO) to enroll
employees in the TSP Agency Automatic 1% Contribution plan.

Navigation:

Benefits > Enroll In Benefits > Thrift Savings Plan Agency > Thrift Savings Plan Agency
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This example illustrates the fields and controls on the TSP Agency Basic page. You can find definitions
for the fields and controls later on this page.

Enter the effective date. By default, the system sets Participation Election to Elect and the elect date to
the system date.

Use Benefit Plan to enroll the employee in the TSP 1% Agency Contribution plan. TSP 1% Agency
Contribution plans have a plan type of 7Z.

Employees typically must complete a waiting period of two open seasons after their hire date before they
can be enrolled in the TSP 1% Agency Contribution plan.

TSP Investment Allocations Page
Use the TSP Investment Allocations (thrift savings plan investment allocations) page
(GVT_TSP_INVEST) to select investment options.

Navigation:

Benefits > Enroll In Benefits > Thrift Saving Plan Allocations > Thrift Saving Plan Allocations
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This example illustrates the fields and controls on the TSP Investment Allocations page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Option Enter the type of investment in which you are allocating an
investment percentage. If more than one investment option is
associated with the chosen employee's savings plan, you can
add more rows.

Percent Enter the investment percentage allocated for each option
associated with this savings plan. Investment percentages must
total 100 before they can be saved into the system.

Terminating Dependent Enrollments or Beneficiary Status

Remember that you enroll dependents and assign beneficiaries when you enroll employees. To terminate
a dependent enrollment or beneficiary status, you must enter a row of data with the termination date (just
as you do with employees). You make these changes on the benefit enrollment page for the benefit in
question, such as Life & AD/D Benefits. You do not make the changes in the Dependent/Beneficiary
Information component.

If you try to delete dependent/beneficiary records on benefit election pages that have court orders applied
to them, the system informs you that the dependent or beneficiary has a court order that provides a legal
right to benefit coverage.

Warning! If you delete dependent/beneficiary data using the Dependent/Beneficiary Information
component, you will destroy history. After you change enrollment data, the fact that the dependent or
beneficiary data is available in the Dependent/Beneficiary Information component won't matter. In fact, it
must remain to provide correct historical information.
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Generating HIPAA Certificates

Note: With the Affordable Care Act, HIPAA Certificates have become obsolete, and effective 1/1/2015,
they are no longer required.

This section discusses how to generate a HIPAA Certificate and view HIPAA letter printing dates.

Pages Used to Generate HIPAA Certificates

Page Name Definition Name Usage

HIPAA Compliance Report Page RUN_CNTL_HIPAA Run the report of the history of a former
employee's group health coverage.

Notification Letters Page BENEF_LETTER_HIST View HIPAA certificate printing for an
employee and dependents.

HIPAA Compliance Report Page
Use the HIPAA Compliance Report page (RUN_CNTL_HIPAA) to run the report of the history of a
former employee's group health coverage.

Navigation:

Benefits > Reports > Regulatory and Compliance > HIPAA Compliance Report > HIPAA
Compliance Report

This example illustrates the fields and controls on the HIPAA Compliance Report page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

From Date Enter the beginning date of the time period for which you want
to generate HIPAA certificates.

Thru Date Enter the ending date of the time period for which you want to
generate HIPAA certificates.
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Notification Letters Page
Use the Notification Letters page (BENEF_LETTER_HIST) to view HIPAA certificate printing for an
employee and dependents.

Navigation:

Benefits > Review Employee Benefits > Notification Letters > Notification Letters

This example illustrates the fields and controls on the Notification Letters page. You can find definitions
for the fields and controls later on this page.
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Reviewing Enrollments and Benefit
Calculations

Auditing Your Benefit Information

PeopleSoft software uses the same set of audits for both the Manage Base Benefits business process and
PeopleSoft Benefits Administration.

Audits identify errors that would occur when you try to process enrollments or changes. Some of these
audits can be used at any time and others are for a specific purpose, such as eligibility analysis or
enrollment.

If you review the audits, you see the importance of auditing your data and making corrections before you
process enrollments.

These tables list the PeopleSoft HR audits and corrective actions. Perform these audits regardless
of whether you use the PeopleSoft Manage Base Benefits business process or PeopleSoft Benefits
Administration to enroll participants.

• Benefit Tables audit functions and corrective actions:

Audit Functions Corrective Actions

Identifies vacation plans in the Benefit Program Table with
an associated Calculation Rules code for which rounding
rules are defined in the Calculation Rules Table.

Set up the Calculation Rules Table information without
rounding rules.

Identifies health plans in the Benefit Program Table with a
rate unit that is not set to None in the Rate Schedule Table.

Correct the information in the Rate Schedule Table.

• Employee Data audit functions and corrective actions:

Audit Functions Corrective Actions

Identifies employees with personal data but no employment
data.

Enter employee employment data.

Identifies employees with personal and employment data but
no job data.

Enter employee job data.

Identifies employees with birth dates fewer than or equal to
16 years from the current date.

Verify that the employee should be 16 years old or less or
correct the error.
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• Enrollment Data audit functions and corrective actions:

Audit Functions Corrective Actions

Identifies participants with a nonstandard dependent—not a
spouse, child, parent—enrolled in health benefits.

Verify that the person should be a dependent or correct the
error.

Identifies participants that work in the same company as
their dependents, elect the same health coverage in the same
plan type as their dependents, and cover the health benefits
of their dependents. For the system to perform this check,
 enter both national IDs in employee personal data and
dependent data.

Verify that the enrollments are correct or correct the error.

Identifies participants with dependents enrolled in health
benefits who are older than 25 (or older than 19 and not
a student), not a spouse, and not handicapped. The audit
identifies persons who typically are not dependents.

Correct the dependent information.

Where Employee Benefits Data Is Controlled: PAR Versus the Individual Benefit
Plan

The following table lists the plan types delivered with the Manage Base Benefits business process for the
U.S. federal government and describes how benefit plan information is controlled by the PAR process and
the individual benefit plan pages.

Note: Benefit plan enrollments for FEGLI and retirement are made in the PAR while benefit plan
enrollments for FEHB, TSP, and leave are performed through the individual benefit plan pages.

Plan Type Benefits Data Controlled in PAR Benefits Data Controlled in
Individual Plan Pages

FEHB FEHB Eligibility • Coverage begin and end date 
(elections).

• Deduction begin and end date 
(elections).

• Plan type (FEHB election).

• Coverage code (elections).

• Dependent ID (dependents).

FEGLI FEGLI Coverage Living Benefits
Enrollment

• FEGLI assignments (beneficiaries).

• Percent of benefit allocation 
(beneficiaries).
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Plan Type Benefits Data Controlled in PAR Benefits Data Controlled in
Individual Plan Pages

TSP • Coverage begin and end date (TSP
employee/matching - elections).

• Deduction begin and end data (TSP
employee/matching - elections).

• Benefit plan (TSP election, TSP
employee/matching - elections).

• Before tax investment (TSP
employee/matching - elections).

• After tax investment (TSP
employee/matching - elections).

• Investment option/investment
percent (TXP employee/matching -
investments).

• Beneficiary ID/Percent of benefit 
(TSP employee/matching -
beneficiaries).

Leave Plans • Effective date, end date (leave
plans).

• Benefit plan (leave plan election,
 leave plans).

• Grandfathered carryover (leave
plans).

Retirement Plans Retirement Plan FERS Coverage
Annuitant Indicator Previous Retirement
Coverage CSRS Annuity Offset Amount

TSP 1% Agency Contribution (TSP
Agency Basic).

Note: PeopleSoft software provides audits for your benefit information. Some audits are specifically for
the Manage Base Benefits business process and others are for Benefits Administration. After you enroll
participants, check your data using the HR audits.

Viewing Current Benefits Summary Data

During regular payroll processing cycles, the system uses all relevant human resources, benefits, and
payroll table information and employee data to process deductions and compensation.

Copyright © 1988, 2022, Oracle and/or its affiliates. 237



Reviewing Enrollments and Benefit Calculations Chapter 9

Regardless of whether your organization uses PeopleSoft Payroll for North America or PeopleSoft Payroll
Interface, you can view a summary of employee benefit data, including the most recent payroll deduction.
You can view the Benefits Summary page.

This section provides an overview of benefits deduction calculations and lists the pages used to view
benefits summary data.

Warning! The Benefits Summary USA (GPUS_BEN_SMRY) component is for use with GP-US only.

Pages Used to View Benefits Summary Data

Page Name Definition Name Usage

Benefit Enrollment Summary Page BN_ENRL_SUMMARY View benefit enrollment summaries for
employees.

Benefit Deduction Summary Page BN_DEDN_SUMMARY Display any deductions taken against
those enrollments on the last run of
either PeopleSoft North American
Payroll or PeopleSoft Payroll Interface,
 as applicable to the employee.

Benefits Summary USA GPUS_BEN_SMRY View GP-USA employee benefit
summary information for a specified
time period.

Benefits Deduction Calculations
As a general rule, each phase of deduction calculation (for example, maximum limit rules, annualize and
deannualize, rate rules, and so forth) resolve to a precision of 2 decimals to represent cents.

For example, a monthly employee rate of 203.3692 will result in weekly deduction of 46.93 and a semi-
monthly deduction of 101.69.

Employer Rate to use: 203.3692 is rounded to 2 decimal places to reflect the base dollar amount to
calculate deduction, giving $203.37.

This monthly rate of $203.37 is annualized to $2,440.44 (203.37 × 12 = 2,440.44).

$2,440.44 is deannualized by dividing by 24 (2,440.44 / 24 = 101.685).

$101.685 is then rounded to 2 decimal places, equaling $101.69.

Benefit Enrollment Summary Page
Use the Benefit Enrollment Summary page (BN_ENRL_SUMMARY) to view benefit enrollment
summaries for employees.

Navigation:
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Benefits > Review Employee Benefits > Current Benefits Summary > Benefit Enrollment
Summary

This example illustrates the fields and controls on the Benefit Enrollment Summary page. You can find
definitions for the fields and controls later on this page.

Benefit Deduction Summary Page
Use the Benefit Deduction Summary page (BN_DEDN_SUMMARY) to display any deductions taken
against those enrollments on the last run of either PeopleSoft North American Payroll or PeopleSoft
Payroll Interface, as applicable to the employee.

Navigation:

Benefits > Review Employee Benefits > Current Benefits Summary > Benefit Deduction Summary
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This example illustrates the fields and controls on the Benefit Deduction Summary page. You can find
definitions for the fields and controls later on this page.

Viewing Enrollment Statistics Using the Health Benefits Pagelet

The Health Benefits pagelet displays overall enrollment statistics for specified health plans. As delivered,
this pagelet is not available for users to add to their home page, but this topic provides instructions for
making the pagelet available.

Use the Include in Health Pagelet check box on the Benefit Plan Table Page to choose which health
plans to include on the Health Benefits pagelet. Note that plan selection is a system-wide setting, so
individual users cannot personalize the pagelet with a different group of plans.
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Pages Used to View Enrollment Statistics Using the Health Benefits Pagelet

Page Name Definition Name Usage

Health Benefits Pagelet HC_BN_HEALTH_BENEFITS_HMPG View summary statistics about the
number of employees enrolled in your
health plans

HEALTH_BENEFITS- Health Benefits
Page

View enrollment counts for included
health plans, and to export that data in
various formats.

Making the Health Benefits Pagelet Available to Users

Note: An administrator must perform this task.

To make the Health Benefits pagelet available to users:

1. Select PeopleTools >Portal >Structure and Content

2. Click the Portal Objects link (the name, not the Edit link) in the Folders grid.

3. Click the Homepage link in the Folders grid.

4. Click the Tabs link in the Folders grid.

5. Click the Edit link for the My Page row in the Content References grid.

6. Access the Tab Content page.

7. Locate the Benefits group box, and select the Health Benefits check box.

8. In the drop-down list box for the pagelet, indicate whether home pages show the pagelet by default
and which personalization options are allowed.

The pagelet is visible only to users with the proper security access, regardless of the option you
choose. The available options are:

• Opt-Dflt (Optional - Default): The pagelet is shown on users’ home pages by default, but users
can remove it through personalization.

• Optional: The pagelet is not shown on user’s home pages by default, but users can add it through
personalization.

• Req-Fix (Required - Fixed): The pagelet is always shown on users’ home pages, and users cannot
change the position of the pagelet.

• Required: The pagelet is always shown on users’ home pages, but users can change the position of
the pagelet through personalization.

9. Save the page.
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Health Benefits Pagelet
Use the Health Benefits pagelet (HC_BN_HEALTH_BENEFITS_HMPG) to view summary statistics
about the number of employees enrolled in your health plans.

This example illustrates the Health Benefits pagelet.

The pagelet displays a pie chart that illustrates the enrollment volume for each included health plan. To
view the source data in a grid format (including the exact enrolment count for each plan), click the Health
Enrollment Details link.

HEALTH_BENEFITS- Health Benefits Page
Use the HEALTH_BENEFITS- Health Benefits page to view enrollment counts for included health plans,
and to export that data in various formats.

This example illustrates the HEALTH_BENEFITS- Health Benefits page.
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Field or Control Description

Excel SpreadSheet, CSV Text File, and XML File Click any of these links to export the health enrollment
statistics in the indicated format.

Count ID Displays the number of employees who have enrolled in the
specified plan.

Overriding the Frequency of Benefit Deductions

After the system has performed benefit deductions for your employees, you can override the frequency of
a deduction amount for individual employees using the Set Max Arrears/Frequency Ovrd page.

Page Used to Override the Frequency of Benefit Deductions

Page Name Definition Name Usage

Arrears/Frequency Override Page BENEF_DED_OVERRIDE Manage overrides to benefit deduction
frequency and arrears processing.

Arrears/Frequency Override Page
Use the Arrears/Frequency Override (set maximum benefit arrears/frequency override) page
(BENEF_DED_OVERRIDE) to manage overrides to benefit deduction frequency and arrears processing.

Navigation:

Benefits > Enroll In Benefits > Arrears/Frequency Override > Arrears/Frequency Override
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This example illustrates the fields and controls on the Arrears/Frequency Override page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Maximum Payback Amount  and Maximum Arrears
Payback

When employee net pay is insufficient to cover a deduction
and deducting all appropriate amounts is not possible, the
employee is in arrears. That is, the employee owes the
employer for a deduction that could not be made.

Use these fields, to specify how the system handles the
payback of arrears balances by indicating the maximum
amount of arrears payback that can be taken out of an
employee's paycheck.

Deduction Period

This group box enables you to override the deduction frequency. Normally, the frequency with which a
deduction is taken from an employee's paycheck is controlled through the deduction table and paygroup.
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Performing Nondiscrimination Testing

Understanding Section 401 Nondiscrimination Tests

This section describes:

• Basic and Alternate Section 401(k) Tests.

• Basic and Alternate Section 401(m) Tests.

• The Aggregate Limit Test.

Important! PeopleSoft Benefits provides these nondiscrimination tests for your use as a template, not to
be used for actual reporting.

Basic and Alternate Section 401(k) Tests
To be considered nondiscriminatory, a 401(k) plan must meet one of two tests:

• The basic Actual Deferral Percentage (ADP) test for Section 401(k) states that the average ADP for
highly compensated employees (ADP HCE) cannot be more than a certain percentage of the average
ADP for employees who are not highly compensated (ADP NHCE).

• The alternate ADP test requires that the ADP HCE cannot exceed the ADP NHCE by more than a certain
percentage, provided that the difference between the ADP HCE and the ADP NHCE does not exceed a
certain percentage point.

Basic and Alternate Section 401(m) Tests
The basic Actual Contribution Percentage (ACP) test for Section 401(m) states that the average ACP for
highly compensated employees (ACP HCE) cannot be more than a certain percentage of the average ACP
for employees who are not highly compensated (ACP NHCE ).

According to the alternate 401(m) test, the ACP HCE cannot exceed the ACP NHCE by more than a certain
percentage, provided that the difference between the ACP HCE and the ACP NHCE does not exceed a
certain percentage point.

The Aggregate Limit Test
If both the ADP and ACP tests do not pass the basic percentage test and both pass the alternative
percentage test, the system automatically runs the new Aggregate Limit test when you run the 401(k)
or 401(m) NDT report. The Aggregate Limit Test indicates that the sum of the ADP and ACP for the
entire group of eligible highly compensated employees cannot exceed the aggregate limit of the nonhighly
compensated group, which is the greater of:
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1. The sum of 1.25 times the greater of the ADPNHCE or the ACPNHCE and 1.25 times the greater of the
ADPNHCE or the ACPNHCE AND

2. Two percentage points plus the lesser of the ADPNHCE or the ACPNHCE, with the exception that this
cannot exceed two times the lesser of the ADPNHCE or the ACPNHCE OR

3. The sum of 1.25 times the lesser of the ADPNHCE or the ACPNHCE AND

4. Two percentage points plus the greater of the ADPNHCE or the ACPNHCE, with the exception that this
cannot exceed two times the greater of the ADPNHCE or the ACPNHCE.

The results of the Aggregate Limit Test appear on the new Section 401 Results page after the 401(k) and
401(m) reports have been run. If you view the Section 401 Results page before you run one or both of
these reports, the Aggregate Limit Test portion of the Section 401 Results page will be blank.

Defining Highly Compensated Earnings

Before you run a nondiscrimination test, define the highly compensated earnings to be processed in the
nondiscrimination test.

To define highly compensated earnings:

1. Define a special accumulator for highly compensated earnings.

2. Link that special accumulator to the appropriate earnings.

Important! PeopleSoft software provides these nondiscrimination tests for your use as a template, not to
used for actual reporting.

Related Links
"Establishing Earnings Programs" (PeopleSoft Payroll for North America)

Identifying Highly Compensated Employees

Now that the parameters for running nondiscrimination testing are defined, you must identify employees
who are highly compensated employees (HCE) using the Job Data (JOB_DATA) component.

A highly compensated employee is defined as someone who meets one of the following criteria:

• Was a 5 percent (or more) owner of the organization at any time during the current or preceding year.

• Received more than an indexed compensation amount in the preceding year.

• Received more than an indexed compensation amount in the preceding year, and was among the most
highly paid 20 percent of employees in the organization.

An active employee is not treated as highly compensated in the current (determination) year if that
employee was not considered highly compensated in the preceding (look-back) year. This rule does not
apply if the employee is a 5 percent (or more) owner. The system does not classify employees hired
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during the current year as highly compensated employees unless they also are or were a 5 percent (or
more) owner during the current year.

To identify employees who are 5 percent (or more) owners:

1. Access the Work Location - Employment Information: Employment Data page.

2. Select the Owns 5% (or More) of Company check box to identify an employee as a 5 percent or
more owner.

For additional information, see "Understanding Job Data" (PeopleSoft Human Resources Administer
Workforce).

Setting Up Test Criteria and Plans

To set up nondiscrimination testing, use the nondiscrimination testing (NDT_HCE_TABLE_GBL)
component.

You can perform nondiscrimination tests for 401(k) and 401(m) plans. For 401(k), the system uses before-
tax amounts. For 401(m), it uses after-tax amounts. Perform these tests according to IRS criteria that you
define, for the benefit plans that you identify.

Important! PeopleSoft software provides these nondiscrimination tests for your use as a template, not to
use for actual reporting.

Page Used to Set Up Test Criteria and Plans

Page Name Definition Name Usage

Nondiscrimination Rules Page NDT_HCE_TABLE Define the regulatory rules governing
your nondiscrimination testing.

Nondiscrimination Rules Page
Use the Nondiscrimination Rules page (NDT_HCE_TABLE) to define the regulatory rules governing
your nondiscrimination testing.

Navigation:

Set Up HCM > Product Related > Base Benefits > Nondiscrimination Rules > Nondiscrimination
Rules
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This example illustrates the fields and controls on the Nondiscrimination Rules page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Effective Date Enter the effective date for your nondiscrimination test criteria.
 The effective date enables you to maintain a history of your
test criteria.

HCE Determination Criteria

Field or Control Description

Compensation Minimum Set up the system to account for all employees who have
received the compensation minimum, or narrow the
determination down to those employees who received the
compensation minimum and who are among the most highly
paid (top 20 percent) employees in your organization. You can
change this percentage.
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Field or Control Description

Minimum Age and Minimum Service Months To set up your system to exclude certain employees from the
determination of the top paid 20 percent of employees in your
organization, enter the appropriate minimum age or minimum
service months.

Because HCE determination is based upon the previous year's
wages, the system refers to the end of the previous year when
checking these values against the employee population. If you
are running your nondiscrimination test for the current plan
year and you've set a minimum age of 21, the top 20 percent
group will be reduced by the number of employees who have
not reached age 21 by the end of the previous plan year.

ADP Calculation Criteria

Field or Control Description

Annual Compensation Lmt  (annual compensation limit) and
Annual Contribution Lmt   (annual contribution limit)

Enter the annual compensation limit and annual contribution
limit for the test.

Calculate using Select which year's data to use to perform the ADP and ACP
calculations.

The options are Current Year and Previous Year.

Note: Because the nondiscrimination testing procedure for 401(k) and 401(m) plans includes
compensation data from the preceding plan year, you should use the results of the tests to better forecast
for the current year. This is because the preceding year compensation data is used to calculate actual
deferral percentages and actual contribution percentages for the nonhighly compensated employee
(NHCE) population, upon which nondiscrimination test results are based. With these figures defined, you
can monitor your HCE population for compliance.
If you choose to perform nondiscrimination testing using previous year NHCE data, You do not need to
perform NHCE forecasting; you need to forecast only HCE data and compare it to the previous year's
data. You can still elect to test based on the current year's data, however, and use the forecasting feature to
help monitor your plan's nondiscrimination status throughout the year.

Identifying Benefit Plans to Include in a Test
To identify benefit plans to include in NDT testing:

1. Access the Benefit Plan Table page.

2. Select the Include in Nondiscrimination Testing check box.
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The test will include all of the benefit plans with this check box selected. This option is available for
all savings plans.

Related Links
Defining Benefit Plans

Defining the Nondiscrimination Test Run Control

After you set up your special accumulators and their associated earnings, set up the parameters for your
nondiscrimination test through run control pages.

Important! PeopleSoft software provides these nondiscrimination tests for your use as a template, not to
use for actual reporting.

This section discusses how to define the nondiscrimination test run control.

Pages Used to Define the Nondiscrimination Test Run Control

Page Name Definition Name Usage

Section 401 Define Test Page RUNCTL_NDT Define the special accumulator that you
want the system to use, and identify the
company and pay group combinations
that you want to include in your test.

Section 129 Define Test Page RUNCTL_129 Define Section 129 rules to
specify information that controls
nondiscrimination testing for Section 129
dependent care reimbursement accounts.

Section 401 Define Test Page
Use the Section 401 Define Test page (RUNCTL_NDT) to define the special accumulator that you want
the system to use, and identify the company and pay group combinations that you want to include in your
test.

Navigation:

Benefits > Conduct Nondiscrimination Tsts > Section 401 Testing >Section 401 Define Test >
Section 401 Define Test
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This example illustrates the fields and controls on the Section 401 Define Test page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Plan Year Begin Date Enter the first day of the plan year to use for the test.

Month End Date Enter the month end date through which compensation data
will be in the database.

Year End Projection Percentage Enter the percentage that you want the system to use.

When testing for the current year, this field enables you to
define whether the system projects until year-end.

Special Accumulator Code Enter the special accumulator code for the test. The system
uses this accumulator to determine employee compensation for
the test.
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Field or Control Description

Benefits Base Enter the benefits base that you want to use, either Annual
Rate or Annual Benefits Base Rate. For example, suppose that
you initiate a test for the current year on May 31, but you want
projections until the end of the plan year. You need to project
for the remaining 7 of the total 12 months, which means that
you enter 58.33% as the year end projection percentage.

Year Code Indicate whether testing is for the Current and Prior Plan
Year, the Current Plan Year, or the Prior Year. Because the
rules for the determination of highly compensated employees
determines HCE status based primarily upon the previous
year's data, the system must gather salary information for the
previous year and store it. When you run a Section 401 test
for the first time in the testing year, always select Current
and Prior Plan Year on the 401 NDT Run Control page. In
subsequent testing throughout that year, you can select Current
Plan Year.

NDT Section 401

Field or Control Description

Company  and Pay Group Identify the companies and the pay groups that you want to
include in this test.

Section 129 Define Test Page
Use the Section 129 Define Test page (RUNCTL_129) to define Section 129 rules to specify information
that controls nondiscrimination testing for Section 129 dependent care reimbursement accounts.

Navigation:

Benefits > Conduct Nondiscrimination Tsts > Section 129 Testing >Section 129 Define Test
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This example illustrates the fields and controls on the Section 129 Define Test page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Special Accumulator Code Enter the special accumulator code for the test. The system
uses this accumulator to determine employee compensation for
the test.

Plan Year Begin Date Enter the beginning date for the plan year that you want to use
for the test.

Month End Date Enter the month end date through which compensation data
will be in the database.

Benefits Base Enter the benefits base—either Annual Rt or Benef Base.
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Field or Control Description

Year Code When you run a Section 129 test for the first time in the testing
year, always select Both Years on the 129 NDT Define Test
Information page. In subsequent testing throughout that year,
 you can select Current Yr.

Note: The system requires you to always select the Both
Years option if you will be testing based on Separate Lines of
Business (SLOB). You can choose from Both Years, Current
Yr, or Prior Yr.

Exclusion Min Service Months  (exclusion minimum service
months)

Enter the minimum length of service for employees included
in the test.

Exclusion: Minimum Age Enter the minimum age limit for the employees included in the
test.

Employee Test Population

Field or Control Description

Company  and Pay Group Identify the companies and the pay groups that you want to
include in this test.

SLOB (Separate Line of Business) Criteria for the 55% Test

Select the method of restricting the test population. You can restrict the test population by company and
pay group or by SLOB.

Field or Control Description

Cafeteria Plan Select this check box if you have a flexible benefits or
cafeteria plan.

Dollar Limit Enter the earnings amount below which you want the system
to exclude employees from the Section 129 test.

Companies that have cafeteria plans typically set the dollar
limit to $25,000, but it can be set lower. If you set the limit to
$25,000, employees who earn less than that amount will be
excluded from the Section 129 test.

Minimum Employee Count Enter the minimum number of employees for a separate line of
business to be included in the test.
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Field or Control Description

Company  and Pay Group If you use SLOB, indicate the company and pay group that are
associated with each separate line of business.

Running Nondiscrimination Tests

This section discusses how to run nondiscrimination tests.

Important! PeopleSoft software provides these nondiscrimination tests for your use as a template, not to
use for actual reporting.

Pages Used to Run Nondiscrimination Tests

Page Name Definition Name Usage

Section 129 Highly Compensated Page RUNCTL_NDT001 Determine the number of highly
compensated employees in your
organization before you perform Section
401 or Section 129 nondiscrimination
tests.

401(k) Nondiscrimination Test - Run
Control Page and NDT Section 401(m)
Testing Page

PRCSRUNCNTL Initiate 401(k) testing.

NDT Section 401(m) Testing PRCSRUNCNTL Run 401(m) testing.

Eligibility Cross Section Test PRCSRUNCNTL Run Section 129 nondiscrimination
eligibility cross section testing.

Section 129 Benefits Test PRCSRUNCNTL Run Section 129 nondiscrimination 55%
average benefits testing.

Concentration Test PRCSRUNCNTL Run Section 129 nondiscrimination
concentration testing.

Section 129 Highly Compensated Page
Use the Section 129 Highly Compensated page (RUNCTL_NDT001) to determine the number of
highly compensated employees in your organization before you perform Section 401 or Section 129
nondiscrimination tests.

Navigation:
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• Benefits > Conduct Nondiscrimination Tsts > Section 129 Testing > Section 129 Highly
Compensated > Section 129 Highly Compensated

• Benefits > Conduct Nondiscrimination Tsts > Section 401 Testing > Section 401 Highly
Compensated >Section 401 Highly Compensated

This example illustrates the fields and controls on the Section 129 Highly Compensated page. You can
find definitions for the fields and controls later on this page.

Warning! Before determining the number of highly compensated employees, first set the
nondiscrimination test parameters.

Field or Control Description

NDT Test Type Choose from the following values: Std NDT (Standard
Nondiscrimination Test, for Section 401 plans), 129 NDT 
(Section 129 Nondiscrimination Test), and 129 SLOB (Section
129 Separate Line of Business Nondiscrimination Test).

401(k) Nondiscrimination Test - Run Control Page and NDT Section 401(m)
Testing Page

Use the 401(k) Nondiscrimination Test - Run Control page (PRCSRUNCNTL) to initiate 401(k) testing.

Navigation:

Benefits > Conduct Nondiscrimination Tsts > Section 401 Testing > 401(k) Nondiscrimination
Test > Run Control

Use the NDT Section 401(m) Testing page (PRCSRUNCNTL) to run 401(m) testing.

Navigation:

Benefits > Conduct Nondiscrimination Tsts > Section 401 Testing > 401(m) Nondiscrimination
Test > NDT Section 401(m) Testing
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Warning! Before running a nondiscrimination test using this page, you must first set the
nondiscrimination test parameters in the 401 NDT Run Control page and determine the number of highly
compensated employees in the NDT 401 HCE Test page.

When the system performs a test, it uses the total eligible earnings for employees. For total earnings, the
system uses the earnings balance for the special accumulator that you defined in the run control for this
test.

If an employee works in multiple companies, the system accumulates earnings for all the companies that
you marked for nondiscrimination testing.

Running Section 129 Nondiscrimination Testing
Access the appropriate Section 129 NDT page.

Note: For SLOB users, the SLOB rules apply only to the NDT 129 55% Average Benefits test. If you
want to run this test for separate lines of business, use the following procedure:

To run the Section 129 SLOB testing process:

1. Run the Highly Compensated Employees determination test.

Select 129SLOB as your NDT Test Type.

2. Run the NDT 129 55% Average Benefits test.

3. Rerun the Highly Compensated Employees Determination test.

This time, select 129NDT as your NDT Test Type.

4. Run the remaining NDT 129 tests.

Warning! Before running a nondiscrimination test using this page, first set the nondiscrimination
test parameters in the 129 NDT Define Test Information page and determine the number of highly
compensated employees in the 129 Identify Highly Comp Employees page.

When the system performs a test, it uses the total eligible earnings for employees. For total earnings, the
system uses the earnings balance for the special accumulator that you defined in the run control for this
test.

If an employee works in multiple companies, the system accumulates earnings for all the companies that
you marked for nondiscrimination testing.

Understanding Nondiscrimination Test Results

As a result of a nondiscrimination test, the system updates employee data for the current and previous
year tests using these codes:

N Indicates that an employee is not eligible for the plan.
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E Indicates a highly compensated employee who is not a 5
percent owner.

H Indicates a highly compensated employee (who may be a 5
percent owner).

The Savings Plan election page displays the Highly Compensated check box for the current year only. The
previous year's highly compensated flag is not available online.

Important! PeopleSoft software provides these nondiscrimination tests for your use as a template, not to
use for actual reporting.

Viewing Nondiscrimination Test Results

This section discusses how to view nondiscrimination test results.

Important! PeopleSoft provides these nondiscrimination tests for your use as a template, not to use for
actual reporting.

Pages Used to View Nondiscrimination Test Results

Page Name Definition Name Usage

Savings Plan Page SAVINGS_PLANS1 View nondiscrimination test results for
an individual.

Review Section 401 Test Result Page NDT_401_RESULTS View the nondiscrimination test results
for all employees in 401(k) and 401(m)
tests.

Review Section 129 Test Result Page NDT_129_RESULTS View the nondiscrimination test results
for all employees.

Savings Plan Page
Use the Savings Plans page (SAVINGS_PLANS1) to view nondiscrimination test results for an
individual.

Navigation:

Benefits > Enroll In Benefits > Savings Plans > Savings Plans

As a result of the last nondiscrimination test that you performed, the system indicates that an employee is
highly compensated (based on the current year) by displaying the Highly Compensated indicator at the
top of the page.
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Related Links
Enrolling Participants in Benefit Programs and Plans

Review Section 401 Test Result Page
Use the Review Section 401 Test Result page (NDT_401_RESULTS) to view the nondiscrimination test
results for all employees in 401(k) and 401(m) tests.

Navigation:

Benefits > Conduct Nondiscrimination Tsts > Section 401 Testing > Review Section 401 Test
Result > Review Section 401 Test Result

This example illustrates the fields and controls on the Review Section 401 Test Result page for 401(k).
You can find definitions for the fields and controls later on this page.

Field or Control Description

Average for HCE (average for highly compensated
employees) and  Average for NHCE  (average for nonhighly
compensated employees)

The system report the average actual contribution percentage 
(ACP) and actual deferral percentage (ADP) for highly
compensated and nonhighly compensated employees.

Basic 125% Test and Alternate 2% Test The systems automatically indicate a Pass or Fail status.

Discriminatory Excess If both the Basic and Alternate 2% tests failed, the system
displays the discriminatory excess percentage.

Aggregate Limit Test If the system runs this test, it automatically indicates a Passed
or Failed status.

Review Section 129 Test Result Page
Use the Review Section 129 Test Result page (NDT_129_RESULTS) to view the nondiscrimination test
results for all employees.
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Navigation:

Benefits > Conduct Nondiscrimination Tsts > Section 129 Testing > Review Section 129 Test
Result > Review Section 129 Test Result

This example illustrates the fields and controls on the Review Section 129 Test Result page. You can find
definitions for the fields and controls later on this page.

This page displays the results of the Eligibility Cross-Section test, the 55% Average Benefit test, and the
5% Owner Concentration test. If you elected to test for separate lines of business, the Separate Line of
Business check box is selected.

Running Nondiscrimination Test Reports
You can produce nondiscrimination testing reports that provide a breakdown of the testing results by
employee (divided into highly compensated employee and nonhighly compensated employee groups) as
well as a display of the calculations involved in the test.

401 Nondiscrimination Testing reports also show the results of the Aggregate Limit test if test result
conditions require this test to be performed.

Related Links
Defining Benefit Plans

Setting Limits to Comply with Test Results

To comply with the regulations governing nondiscrimination testing, you may need to change the savings
limits for a highly compensated employee for a specific benefit plan. This applies only to 401(k) and
401(m) plans.

Related Links
Savings Plans Page
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Managing Life Events

Understanding Life Events

Life Events transactions can streamline the life event process for employees by enabling them to update
personal data and then change their benefit enrollments, all from one self-service transaction. PeopleSoft
eBenefits, by default, delivers four major life event transactions that have immediate impact on benefits
enrollment of an employee:

• Getting married

• Giving birth to a child

• Adopting a child

• Getting divorced

Oracle’s PeopleSoft eBenefits has two user interfaces:

• PeopleSoft Classic User Interface, which was designed to be used on a laptop and desktop.

• PeopleSoft Fluid User Interface, which was designed to be used on mobile devices, but can also be
used on a laptop and desktop.

While most of the setup tables are located within the Life Event menu category (Set Up HCM >Product
Specific >eBenefits >Life Events) you will used different pages within the components to set up Life
Events for classic versus Life Events for fluid. Regardless of the interface you choose to use, you will
start by defining rules in the Life Event Rules table. If you are setting up life events for fluid, you will
use the Activity Guide Composer pages (to set up your templates and steps. Next, you will access the
Template component to identify the template as a Life Event template. This component consists of two
pages: one for classic setup and one for fluid setup. To define the steps for classic life events, use the
Action Item pages. Finally, use the Event Category pages to set up life event categories for the employee
self service Life Event selection menu landing page.

In addition to the out-of-the-box life events, benefits administrators can create other life events based on
the requirements of their organization. To create a life event, benefits administrators can:
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• Define and maintain life event templates and then create action items or steps that form part of the
template.

• Clone an existing life event to create a new life event with similar requirements.

Defining Life Event Rules

These topics provide overview and setup information for life event rules.

Use the Life Event Rules (W3EB_LE_RULES) component to set up life event rules.

Page Used to Define Life Event Rules

Page Name Definition Name Usage

Life Event Rules Page W3EB_LE_RULES Set up rules that control how data and
information is processed for life events
such as changes in marital status, birth,
 or adoption.

Understanding Life Event Rules
Life Event Rules enable organizations to control what an employee can perform on a life event. By
default, PeopleSoft eBenefits supports four Life Event Types: Marriage, Birth, Adoption, and Divorce.
Customers can add new life event types and define a set of rules for each life event type according to the
practices established by the organization.

Life event rules enable organizations to control whether an employee can automatically update the HR
database while processing a life event, based on the practices established by the organization.

The following table summarizes how the HR database is updated using the life event rules that are defined
on the Life Events Rules page, what applications are selected on the Installation table, and other flags that
are set in the HR database.

Update to HR Database Requirement

Create BAS_ACTIVITY trigger • Benefits Administration is selected on the Installation
Table.

• The employee has at least one job managed by PeopleSoft
Benefits Administration as of the life event effective date.

• Allow Event Creation is selected on the Life Event Rules
page.

• The employee enters the transaction within the period
described by the Maximum Days to Notify parameter.
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Update to HR Database Requirement

Create COBRA_ACTIVITY trigger If an employee is managed by PeopleSoft Base Benefits, a
COBRA activity is triggered when:

• COBRA Administration is selected on the Installation
Table.

• Benefits Administration is not selected on the
Installation Table.

• Proof Requiredis not selected on the Life Events Rules
page.

If the employee is managed by PeopleSoft Benefits
Administration, a COBRA Activity is triggered when:

• Benefits Administration is selected on the Installation
page.

• The employee has at least one job managed by PeopleSoft
Benefits Administration as of the Life Event effective
date.

• Proof Required is not selected on the Life Event Rules
page.

• Allow Event Creation is selected on the Life Event Rules
page.

• A COBRA action code is entered on the Life Event Rules
page.

• The Benefits Administration event finalizes.

Employee's marital status is updated in the PERS_DATA_
EFFDT table

• For marital status change only.

• Proof Required is not selected on the Life Event Rules
page.

Current spouse's marital status is changed to Divorced and
relationship is changed to Ex Spouse in the DEPENDENT_
BENEF table

• The Life Event Type is Divorce.

• Proof Required is not selected on the Life Event Rules
page.

Note: If you have purchased PeopleSoft eProfile or PeopleSoft eProfile Manager Desktop and have set
up the Workflow Configuration for self-service transactions, setting these life event rules will override the
rules that you set for the marital status transaction on the Workflow Configuration page.

Life Event Rules Page
Use the Life Event Rules page (W3EB_LE_RULES) to set up life event rules that affect how data and
information is processed for changes in marital status, birth, or adoption.

Navigation:
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Set Up HCM > Product Related > eBenefits >Life Event > Life Event Rules > Life Event Rules

This example illustrates the fields and controls on the Life Event Rules page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Life Event Type Specify the life event type. Four different types of life events
are available by default - Adoption, Birth, Divorce, and
Marriage. You can modify existing life event types or define
new life event types according to your organization’s needs.

Maximum Days To Notify Specify the maximum number of days that can elapse between
the date of the event and the date that the transaction is
entered by the employee through the self-service transaction.
 Exceeding this time period does not prevent the employee
from entering basic information, but a BAS Activity trigger
will not be created even if Allow Event Creation is selected.
 If the employee enters the event after the maximum days
allowed, the system displays a message on a self service page
notifying the employee that his or her benefit elections cannot
be changed.

Notify Administrator Select to send an e-mail to the benefits administrator when this
type of life event occurs informing him or her of the event.

Additionally, if Proof Required is selected for an event, the
administrator is automatically notified of the event regardless
of the setting of Notify Administrator.

Proof Required Select to indicate whether this type of life event requires proof
before it is processed. If this field is selected, the HR database
is not updated, BAS Activity and Cobra Activity triggers are
not generated, and the administrator is notified of the event by
e-mail.

Approve Document(s) Select to enable the benefits administrator to approve, deny, or
push back the uploaded life event documents. The employee
can proceed to benefits enrollment only after the benefits
administrator approves the document.
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Field or Control Description

Allow Event Creation This field is available if Benefits Administration is selected
on the Installation table and Proof Required is not selected.
 A BAS Activity trigger is created only if the employee has at
least one job managed by Benefits Administration as of the life
event effective date.

Selecting this field indicates that you want the system to
trigger a BAS Activity for this type of life event and allows
the employee to change benefit election through the eBenefit
election pages.

Source of Action This field is available and is required if Benefits
Administration is selected on the Installation table and Allow
Event Creation is selected. For a BAS Activity trigger to be
created, you must enter Manual in the field.

BAS Action This field is available and required if Benefits Administration
is selected on the Installation table and Allow Event Creation
is selected. Enter a BAS action code that is appropriate for this
life event. Typically, this is FSC - Family Status Change.

COBRA Action This field is available if both COBRA Administration
andBenefits Administration are selected on the Installation
table. This field is used only when the life event is for an
employee managed by PeopleSoft Benefits Administration,
Create Event is selected, and the resulting Benefits
Administration event should create a COBRA Activity trigger
when it finalizes.

Configuring A Life Event

Configuring a life event includes setting up templates and steps for a template. How you go about setting
up templates and steps varies slightly based on whether end users will use the classic or fluid pages to
enter life event changes:

• For classic life events:

1. Use the Template (W3EB_LE_LIST) component to identify life event templates for classic users.

2. After setting up templates, use the Action Item (W3EB_LE_ITEM02) component to set up life
event action items for classic life events.

• For fluid life events:

1. Set up the Activity Guide Composer Categories and Templates components to define
the respective life event templates and steps. See the "Understanding the Activity Guide
Composer" (Enterprise Components) documentation for the setup of these components.
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2. Use the Template (W3EB_LE_LIST) component to identify life event templates for fluid users.

Note: Fluid life events does not use action items as described in these topics. Instead it uses the
Activity Guide Composer Template to identify steps.

These topics provide an overview of life event templates and discusses the Life Events configuration
pages in Benefits.

Pages Used to Configure Life Event Templates and Action Items in Benefits

Page Name Definition Name Usage

Classic Templates Page W3EB_LE_LIST Define life event templates for the classic
Life Event pages.

Fluid Templates Page W3EB_LE_FLU_LIST Associate an Activity Guide Composer
template with the Benefits Life Event
template for the fluid Life Event pages.

Action Item Page W3EB_LE_ITEM02 Create action items that define the steps
an employee will perform to record and
complete a life event using the classic
Life Events pages.

Child Action Item Page W3EB_LE_ITEM_SEC Create sub-steps for a life event action
item using the classic Life Events pages.

Dependent Action Item Page W3EB_LE_DEPEND_SEC Specify which life event action items
must be completed by the employee
prior to completing this action item when
using the classic Life Events pages.

Understanding Life Event Templates (Including Action Items / Steps)
A template corresponds to a life event category type, such as a birth, death, marriage, or divorce. You can
define a life event template and then specify action items or steps that form part of the template, based on
your business requirements. For example, you can define an Adoption Event template and specify action
items or steps that need to be processed to complete the adoption life event. Employees can then use the
available life event template to process their life events.

The PeopleSoft application delivers the Adoption Event, Birth Event, Divorce Event, and Marriage Event
templates for both classic and fluid users.

Action items or steps constitute the individual tasks that an employee needs to perform in order to
complete a life event. When using classic Life Events, you will create action items. When using fluid Life
Events, you will assign steps to your templates. Customers can define and group action items or steps to
configure a life event based on their business needs. You can assign the order these should appear within a
life event, indicate whether a task is required or not, define parent and child (subsidiary) relationships, and

266  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 11 Managing Life Events

specify a dependent relationship to indicate if an action item or step can be started only after completing
another item.

Note: In addition to defining a life event template and creating action items or steps for the template
manually, you can also duplicate an existing life event with similar action items by cloning a life event.
– (Classic) Use the Benefit Cloning Utility in Benefits. Select the Life Event Template type to clone, and
then modify the cloned life event to suit the business needs. For more information, see "Cloning Benefit
Programs, Coverage Formulas, Eligibility Rules, Event Rules, or Life Event Templates" (PeopleSoft
Human Resources Manage Base Benefits).
– (Fluid) Use the "Clone Template Page" (Enterprise Components) in the Activity Guide Composer.
Click the Clone Template button for a template, enter the new template ID (following the naming format
guidelines for life events), a description, and the effective date. The system will take you to the Activity
Guide Composer Template pages to make modifications. For more information, see "Managing Activity
Guide Templates" (Enterprise Components).

The setup steps for templates are different based on whether you are a classic or fluid user. Use the
following information to set up templates and action items or steps for your life events.

Classic Setup Steps

Follow these steps to create templates and action items for a classic life event:

1. Define a life event template on the Classic Templates Page from the eBenefits, Life Event setup menu.

2. Create action items that form the steps of the template using the Action Item Page within the
eBenefits, Life Event setup menu.

Note: You cannot delete or modify the delivered Life Event templates or action items. To make changes
to a delivered template and its action items, copy the delivered templates by using the "Benefit Clone
Utility Page" (PeopleSoft Human Resources Manage Base Benefits) to copy and update the template. You
can also create your own Life Event templates for classic.

Fluid Setup Steps

Follow these steps to create templates and steps for a fluid life event:

1. Create Activity Guide Composer categories using the Categories component (see "Setting Up Activity
Guide Categories" (Enterprise Components)).

Categories contain the technical components that are utilized to define an activity guide template. This
also means the category definition contains the steps that can be included as steps to define a Life
Event template (activity guide).

The PeopleSoft application delivers the LIFEEVENT Activity Guide Category. You can use this
category for your Life Events template needs, update it through new effective dated rows, clone
a category using the Activity Guide Composer "Clone Category Page" (Enterprise Components),
or create your own categories. To modify the delivered system data, you will need to insert a new
effective dated record of the Life Event category or clone a category, and make the changes. You
cannot modify the initial row of the system delivered data.
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Important! When you include a change like adding additional steps in a category, you will need to
clone or insert a new effective dated row in the templates that use this category with an effective date
equal to or greater than the effective date of the category to utilize the new step in your templates. The
system will not automatically insert steps into the template. By inserting a new effective dated row
that is equal to or greater than that of the category, you can now opt to include the new steps into the
template.

The following table lists the delivered steps for the LIFEEVENT category:

Step Description

ADDRESS Home and Mailing Address

BENEFIT ENROLL Benefit Enrollment

BENEFIT SUMMARY Benefit Summary

BIRTH DATE Birth/adoption Date

CONTACT INFO Contact Information

DEPBENE SUMMARY Dependent/Beneficiary Coverage

DEPENDENTBENEF Dependent and Beneficiary

DIRECT DEPOSIT Direct Deposit

DOCUMENT UPLOAD Document Upload

ELECTION REVIEW Benefit Election Review

EMERGCONTACT Emergency Contact

MARITAL STATUS Marital/Divorce Status

NAME Name

SUMMARY Summary

TAX WITHHOLDING Tax Withholding
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Step Description

WELCOME Welcome

2. Define Activity Guide Composer templates using the "Activity Guide Templates Page" (Enterprise
Components).

This process has you identify the layout of the activity guide, security roles to access the template,
and determine the exact steps and their order within the template. The PeopleSoft application delivers
the following Life Event templates and documentation that list the delivered steps for the Life Event
templates:

• Life Event: Adoption Event (Processing the Adoption Event)

• Life Event: Birth Event (Processing the Child Birth Event)

• Life Event: Divorce Event (Processing the Divorce Event)

• Life Event: Marriage Event (Processing the Marriage Event)

Note: You cannot delete or modify the delivered Life Event activity guide templates. To make
changes to a delivered template, insert a new effective dated row or use the cloning option through the
Activity Guide Composer to copy and update the template. You can also create your own Life Event
templates for fluid.

Important! Life events must use the following seven (7) character template ID naming convention to
ensure that Life Event activity guides are processed correctly:
EF_x ( where x equals either A for adoption, B for birth, D for divorce, or M for marriage) followed
by three additional numbers or characters to uniquely identify the template.
The first four characters of the template ID are used during processing of Life Event activity guides
and you can use the remain three characters for your own tracking purposes.
When creating classic Life Event templates in the Benefits application, the system automatically
generates a unique template ID base on the template type (A, B, D or M). For example, a classic Life
Event template ID could be EF_M5LLLLL - where EF_M specifies it to be a Marriage life event, 5
is an incremental number, and the system pads it with LLLLL. Fluid Life Event templates are created
and cloned using the Activity Guide Composer, where the administrator defines the template ID.
However, this same formatting must be used to correctly process the life event.
For example, the template administrator may create the Activity Guide composer template ID
EF_B100 for a birth, or EF_D200 for a divorce life event. This naming convention, with the first 4
characters starting as such, must be followed to ensure that the Life Event templates are processed
correctly. .

3. Identify the template as a fluid Life Event template in Benefits on the Fluid Templates Page in the
eBenefits, Life Event setup pages.

Note: If you create your own Activity Guide Composer Life Event templates, it is recommend that
you do not opt to display the templates on the "My Processes Page" (Enterprise Components), which
is a centralized location where you can deploy various activity guide templates to your users. Instead,
have your users access it only through the Benefit Details Tile.
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Classic Templates Page
Use the Classic Templates page (W3EB_LE_LIST) to define a life event template for the classic Life
Event pages.

Navigation:

Set Up HCM >Product Related >eBenefits >Life Event >Template >Classic Templates

This example illustrates the fields and controls on the Classic Templates page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Template Title Enter a description for the life event template. The template
title is the high level key you will use to create action items for
a life event. Action items define the transactions a user may
need to process to record a life event change, such as updating
marital status, changing benefits enrollment, or uploading a
life event document.

The template title will also be displayed as the header of the
Life Event component.

Welcome Text ID Specify the text to be displayed on the Welcome page of the
Life Event component. Text IDs and the corresponding text are
maintained in the Text Catalog.

Note: Only those text IDs where the owner ID is equal to HEB
and the sub ID is equal to LE on the Text Catalog are available
for selection.

Print Text ID Specify the text to be displayed on the completion and exit
page of the Life Event component.

Life Event Type Specify a life event type for each template. The HCM
application provides Marriage, Birth, Adoption, and Divorce
life events by default. In addition, you can create other life
events specific to your organization using the Life Event Rules
table.

Description Displays the description for the selected life event type.
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Field or Control Description

Active Select whether this template is active or inactive. Only active
templates will be available for selection on the Event Category
- Classic Category Page, and therefore eligible to be included
in the life event selection menu for the end user.

For more information, see: Setting Up the Life Event Selection
Menu

Action Item(s) Select this link to access the Action Item component to create
a list of transaction pages that should be part of the life event
template. Action items are the various tasks a user may need to
complete to record a life event change.

Fluid Templates Page
Use the Fluid Templates page (W3EB_LE_FLU_LIST) to associate an Activity Guide Composer
template with the Benefits Life Event template for the fluid Life Event pages.

Navigation:

Set Up HCM >Product Related >eBenefits >Life Event >Template >Fluid Templates

This example illustrates the fields and controls on the Fluid Templates page. You can find definitions for
the fields and controls later on this page.

The page will display the delivered life event templates and any templates you have added. To add
additional templates click the Add (+) button at the end of a row.
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Field or Control Description

Template Title Note: Life event templates for fluid must first be created using
the Activity Guide Composer (AGC).

Select from a list of active life event template descriptions.
 Only active Activity Guide Templates are available for
selection. The PeopleSoft application delivers the following
life event templates for fluid:

• Adoption Event

• Birth Event

• Divorce Event

• Marriage Event

To create, update, delete, or clone an existing template, use the
"Activity Guide Templates Page" (Enterprise Components).

Important! Strict template ID formatting must be used to
ensure that the life event templates are processed correctly in
Benefits. See the Important note under the Fluid Setup Steps
section of Understanding Life Event Templates (Including
Action Items / Steps) for more information.

The template contains activity guide steps for a life event.
 Activity guide steps define the transactions a user may need
to update to record a life event change, such as update marital
status, change benefit enrollments, or have the ability to
upload a document. This title will also appear in the header of
the fluid Life Events pages.

Life Event Type Specify a life event type for each template. The PeopleSoft
HCM application delivers the Marriage, Birth, Adoption,
 and Divorce life events, but you can create other life events
specific to your organization using the Life Event Rules table.

Description Displays the description for the selected life event type.
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Field or Control Description

Active Select whether this template is active or inactive. Only active
templates will be available for selection on the Event Category
- Fluid Category Page, and therefore eligible to be included
in the life event selection menu for the end user. Likewise,
 you cannot inactivate a template that is already assigned
on the Fluid Category Page. For more information on event
categories, see: Setting Up the Life Event Selection Menu.

Note: Inactivating a fluid life event template from this
page does not inactivate the template in the Activity Guide
Composer, just as an option from Event Categories. To
inactivate an actual template, click the Template Composer
link to access the Activity Guide Composer - Templates
component and change the status. You cannot inactivate
the delivered life event templates within the Activity Guide
Composer.

Template Composer Select this link to access the Activity Guide Composer -
Templates pages for this template to view or modify aspects of
the template, such as steps. Steps are the various tasks a user
should complete to record a life event change.

Action Item Page
Use the Action Item page (W3EB_LE_ITEM02) to create action items that define the steps an employee
will perform to record and complete a life event using the classic Life Events pages.

Important! This page is for classic life events. Do not use this page if you are creating templates
and steps for fluid Life Events. Use the "Activity Guide Composer - Select Steps Page" (Enterprise
Components) to add steps to a fluid template.

Navigation:

• Set Up HCM >Product Related >eBenefits >Life Event >Action Item >Action Item

• Click the Action Item(s) link from the Classic Templates Page.

This example illustrates the fields and controls on the Action Item page. You can find definitions for the
fields and controls later on this page.
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Field or Control Description

Copy Existing Item Copy an existing action item for reuse. To copy, select the
action item from a list of all action items that have been
created for other templates. This will copy all the fields from
the selected action item with the exception of the Depend
Action Exist and the Depend Action Item fields.

The Copy Existing Item field is available only when you are
managing a template created by your organization.

Sequence Number Enter the order in which the list of action items, or pagelets,
 should appear in the Life Event component navigation in self
service. The action items are listed in the increasing order of
sequence number. When an action item is identified as a parent
action item and has child action items associated with it, the
sequence number of the parent action item must be lesser than
that of the child action items.

Action Item Title Enter the name of the action item. These titles will appear as
links on the left-hand side navigation tree in the employee self
service home page for this life event type.

Required Action Item Select to indicate that the user is required to complete this
transaction in order to save and complete the life event. If
not selected, the user may complete the action item, but
completing it is not mandatory in order to complete the life
event.

Parent Action Item Select to indicate that this action item has sub-steps. The
parent action item serves as a heading that groups the child
items. When you select this check box, the Transaction Page
field is no longer available for the parent action item.

Child Action Item Select this link when the Parent Action Item check box has
been selected to open the Child Action Item page and enter the
sequence numbers and transaction page information for each
child item. Child items appear as subset items of a parent item.
 Child item sequence numbers must be greater than that of the
parent item.

Depend Action Exist Select this check box to indicate that the user must complete
another task prior to the current task. For example, an
employee may need to enter a child’s birth date before being
eligible to change benefit elections. This check box is not
available until at least one other action item has been defined
for this template.
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Field or Control Description

Depend Action item Select this link to open the Dependent Action Item page and
select from a list of other action items you have identified
for this template. The link and valid options are not available
until at least one other action item has been defined for this
template with a sequence number lower than this action item.
 The dependency item you select here must be completed by
the user prior to completing this action item.

Transaction Page Enter the transaction page that the user will access to perform
this action item.

For more information about transaction/application pages and
related content, see:PeopleTools: Applications User's Guide

For more information about developing and deploying action items, see: PeopleTools: Portal Technology

Child Action Item Page
Use the Child Action Item page (W3EB_LE_ITEM_SEC) to define sub-steps of a life event action item
when using the classic Life Events pages. Child item sequence numbers should have a number greater
than the parent item.

Note: This page if for classic life events. Do not use this page if you are creating templates and steps for
fluid Life Events. Use the "Activity Guide Templates Page" (Enterprise Components) to create fluid life
event templates. Use the "Activity Guide Composer - Organize and Configure Steps Page" (Enterprise
Components) to manage steps for fluid.

Navigation:

Select the Child Action Item link on the Action Item page.
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This example illustrates the fields and controls on the Child Action Item page.

Field or Control Description

Sequence Number Enter the order in which the child action items should be listed
within the action item. The sequence number of the child
action items must be greater than that of the parent action item.

Action Item Title Enter the name of the action item. These titles will appear
as pagelet links on the left-hand side navigation tree in the
employee self service home page for this life event type.

Required Action Item Select to indicate that the user is required to complete this
transaction in order to save and complete the life event. When
deselected, the user has the option to complete this task but
does not need to in order to complete the event.

Transaction Page Specify the transaction pagelet that the user will access to
perform this action item.

Dependent Action Item Page
Use the Dependent Action Item page (W3EB_LE_DEPEND_SEC) to indicate if another action item must
be completed by the user prior to processing this action item when using the classic Life Events pages.
The action item can be processed only after completing the action item on which it is dependent.

Note: This page if for classic life events. Do not use this page if you are creating templates and steps for
fluid Life Events. Use the "Activity Guide Templates Page" (Enterprise Components) to create fluid life
event templates. Use the "Activity Guide Composer - Organize and Configure Steps Page" (Enterprise
Components) to manage steps for fluid.
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Navigation:

Select the Depend Action Item link on the Action Item page.

This example illustrates the fields and controls on the Dependent Action Item page. In this example, the
Marital Status action item must be completed before starting Benefit Enrollment.

Field or Control Description

Title Select the action item which the current action item is
dependent on.

Sequence Indicates the sequence number of the selected action item.

Configuring Fluid Life Event Document Upload

Use the PeopleSoft Fluid Attachment Framework to configure life event document upload for fluid
interface.

Pages Used to Configure Fluid Life Event Documents Upload

Note: Refer the documentation for "Configuring Attachments in Fluid Framework" (Application
Fundamentals) for detailed information on configuring the common attachment framework.

Page Name Definition Name Usage

"Define Attachments Page" (Application
Fundamentals)

HR_ATT_CNFG Create configuration ID based on the
required attachment type.
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Page Name Definition Name Usage

Maintain Definitions Page HR_ATT_DEFN Associate the configuration ID to a
specific Life Event. You can also specify
upload and approval requirements for
each configuration ID.

Note: To configure life event
attachments, access this page for the
HBN owner ID.

Review Benefits Attachment Page BEN_ATTACH_EVNT_FL

BEN_ATTACH_IDE_FL

View the documents attached by the
employees.

Understanding Fluid Life Event Document Upload
Employees are required to upload life event documents like, certificates of marriage, adoption, divorce
etc when processing their life events. As an administrator, you can:

• Define categories for document upload based on each life event type.

• Specify if the document upload is mandatory for a specific life event type

• Specify If approval is required for a specific life event type.

• Access the uploaded document

Note: The Fluid Review Benefits Attachment component can be accessed by administrator through the
Benefits WorkCenter Tile if the employee has granted ‘Benefits Administrator Fl WC’ role.

Roles and Permission List

Roles Permission List

My Benefits Fluid

This role is necessary for employees accessing the Benefits
Attachment in Benefits Details tile.

HCCPSS1021

My Benefits Fluid HCCPSS1022

This permission list is necessary for employees to use the
Benefits Details Dashboard Tile.

Benefits Administrator Fluid

This role is necessary for administrator accessing the Review
Benefits Attachment in Benefits Administrator tile.

HCCPBN1020
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Roles Permission List

Benefits Administrator Fluid HCCPBN1050

This permission list is necessary to use the Benefits
WorkCenter.

Maintain Definitions Page
Use the Maintain Definitions page (HR_ATT_DEFN) to link the configuration ID to a specific life event.
You can indicate the upload requirement and approval requirement for each configuration ID.

Establish the contexts in which the defined attachment types are to be available and associate specific
attachments with each context.

Navigation:

Set Up HCM >Common Definitions >Attachments >Maintain Definitions >Maintain Definitions 

This example shows the fields and controls on the Maintain Definitions page when Object Owner ID is
selected as HBN and Sub Id is selected as LE. This is specific to Life Event.

In the Key Value field, select the required life event type. Here, in this example ‘M’ – Marriage is selected
as the Life Event Type.
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Attachments

Field or Control Description

Configuration ID Select the required configuration ID. This indicates the
documentation type.

Upload Requirement Select the option to indicate the requirement for document
upload under this category. Available options are:

• If the status is ‘Required’, it is mandatory to upload a
document under this category for the selected life event.

• If the status is ‘Optional’, it is optional to upload a
document under this category for the selected life event.

• If the status is ‘Required at least one’, it is mandatory to
upload at least one document under this category for the
selected life event.

Approval Required Specify if this document requires approval. If selected,
 the document will be send to the approver(s) based on the
configured approval framework. The system marks the Upload
Document step as complete only if all the documents that are
required to upload are uploaded and all the documents that
require approval are approved.

For more information on other fields and controls, see "Maintain Definitions Page" (Application
Fundamentals)

Review Benefits Attachment Page
Use the Review Benefits Attachment page to view the documents uploaded by the employees.

Note: To activate the Review Benefits Attachment component on the Benefits WorkCenter, activate the
Link section.
Go to Enterprise Component > WorkCenter/Dashboards > Configure Pagelets
Configuration ID = BEN_FL Table

Navigation:

• Benefits WorkCenter >Links >Employee Dependent Information >Review Benefits
Attachment

• Workforce Administrator >Benefits Administrator >Review Benefits Attachment

Administrator can search for the required employee.
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This example illustrates the Review Benefits Attachment page.

Attachment details of the selected employee is displayed.

This example illustrates the Review Benefits Attachment page.

Click the row to open the Transaction Details page.

This example illustrates the Transaction Details page

This page lists the documents uploaded by the employee with details like document type, category and
status. Click the document to open the attachment.

Setting Up the Life Event Selection Menu

This topic discusses how to set up the Employee Self Service Life Event Selection menu.

The Employee Self Service Life Event Selection menu is the menu available to employees on the Life
Event main page. You can define life event categories and link life event templates to each category, to set
up the employee self service life event selection menu. The life event categories define the menu groups
and the templates linked to them define the menu items. Employees can then select which life event to
process from the available menu.
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PeopleSoft eBenefits provides one category EMPL (Employee) by default, but you can define other
categories relevant to your organization.

To set up the life event selection menu, use the Event Category (W3EB_LE_EVT_CAT) page.

Page Used to Define the Life Event Selection Menu

Page Name Definition Name Usage

Classic Category Page W3EB_LE_EVT_CAT Set up life event categories for the
classic employee self service Life Event
selection menu.

Fluid Category Page W3EB_LE_FLU_CAT Set up life event categories for the
fluid employee self service Life Event
selection menu.

Classic Category Page
Use the Classic Category page (W3EB_LE_EVT_CAT) to set up life event categories for the classic
employee self service Life Event selection menu.

Note: This page is for classic setup. If you want to set up categories for fluid Life Events, use the Fluid
Category Page.

Navigation:

Set Up HCM > Product Related > eBenefits >Life Event > Event Category > Classic Category

This example illustrates the fields and controls on the Classic Category page.

Use this page to set up the templates that should appear for this category on the classic life event self-
service home page.
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Field or Control Description

Category Sequence Enter the order in which the event categories should appear
on the classic employee self service life event home page. The
categories will be displayed on the home page based on the
increasing order of the sequence number.

SeqNum Enter a number to determine the order in which a life event
should be displayed within the category, in the self service
selection menu.

Description Enter a description for the life event change that the user needs
to perform. The class life event home page displays these
descriptions as radio buttons from which a user selects the
required life event.

Template Title Select from a list of active life event templates defined on the
Classic Templates Page that have action items defined.

Note: A template associated with an event category cannot be
modified or made inactive.

The same template may be used for multiple life event
descriptions.

Fluid Category Page
Use the Fluid Category page (W3EB_LE_FLU_CAT) to set up life event categories for the fluid
employee self service Life Event selection menu.

Note: This page is for fluid setup. If you want to set up categories for classic Life Events, use the Classic
Category Page.

Navigation:

Set Up HCM > Product Related > eBenefits >Life Event > Event Category > Fluid Category
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This example illustrates the fields and controls on the Fluid Category page.

Use this page to create fluid self service event categories and link templates to the category. The Life
Events landing page in fluid displays the life event template descriptions you associate with this category.

Field or Control Description

Category Sequence Enter the order in which the event categories should appear on
the Employee Self Service, Life Events landing page in fluid.
 The categories will appear on the landing page based on the
increasing order of the sequence number.

SeqNum Enter a number to determine the order in which a life event
should appear within the category. The page displays the life
events with the lowest numbers first.

Description Enter a description for the life event change that the user may
need to perform. The fluid Life Events home page displays
these descriptions as radio buttons from which a user selects
the required life event. For example, for a birth event you can
enter the text, 'I had a baby'.

Template Title Select from a list of active templates that have activity guide
steps defined. Template titles are defined using the "Activity
Guide Templates Page" (Enterprise Components).

Note: A template associated with an event category cannot be
modified or made inactive on the Fluid Templates Page.

The same template may be used for multiple life event
descriptions.
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Field or Control Description

Template ID Displays the ID that was used when creating the template in
the Activity Guide Composer.

Important! Strict template ID formatting must be used to
ensure that the life event templates are processed correctly
in Benefits. All fluid Life Event template IDs must start with
the following four characters: EF_, x (where x equals A for
adoption, B for birth, D for divorce, or M for marriage). For
example, an organization may create the template ID EF_
B100 for a birth, or EF_D200 for a divorce life event. This
naming convention, with the first 4 characters starting as such,
 must be followed to ensure that the Life Event templates are
processed correctly. Activity Guide Composer template IDs
must be seven characters in length so you can use the remain
three characters for your own purposes.

Related Links
"Managing Activity Guide Templates" (Enterprise Components)

Creating Life Event Descriptive Pages

These topics describe how to create life event descriptive pages.

Understanding Life Event Descriptive Pages
Create life event descriptive pages to guide employees through the action items (pages) that they will
need to complete for a self-service life event. After selecting a life event on the Life Event main page, the
employee needs to follow a vertical pagelet containing action items to process the event. You can create
descriptive Life Event pages such as a Welcome page to include a greeting, a brief description of the steps
involved in this event, and any additional information the employee may want to read before proceeding
to the actual event, or a custom Exit page to conclude the life event.

Page Used to Create Life Event Descriptive Pages

Page Name Definition Name Usage

Maintain Text Catalog Page HR_SSTEXT_TEXT Create life event descriptive pages.

Maintain Text Catalog Page
Use the Maintain Text Catalog page (HR_SSTEXT_TEXT) to create the descriptive pages. The Maintain
Text Catalog page provides the flexibility to present custom instructions to the employees.

Navigation:
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Set Up HCM >Product Related >eBenefits >Maintain Text Catalog >Maintain Text Catalog

This example illustrates the fields and controls on the Maintain Text Catalog page. You can find
definitions for the fields and controls later on this page.

Field and Control Definitions

Field and Control Definitions

Field or Control Description

Description Enter the description for the text ID displayed on the life event
descriptive page.

The text ID identifies a life event descriptive page. Different
text IDs can be created for different life events. For example,
 you can set up a custom welcome text ID for Marriage and
a different welcome text id for Birth. Additionally, you can
modify the default text IDs for the welcome page (Welcome)
and the exit page (Print).

Effective Date Select a date from which the descriptive page is active.
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Context Keys and Text

Field or Control Description

Life Event Type Select the life event type for which the descriptive page is
being created. If the life event type is left blank, the text that
you enter will be applicable to all life event types.

In the descriptive text box, enter the custom text to be
displayed to the employee on the life event page.

For more information about Text Catalog, see: "Establishing Text Catalog Data" (PeopleSoft eBenefits)

Configuring the Employee Enrollment Summary Statement

These topics describe how to configure the Employee Enrollment Summary Statement.

Understanding the Enrollment Summary Statement
After an employee completes a life event, a new Benefit Preliminary Enrollment Summary Statement
report will be generated.

This report provides a summary of the employee’s benefit election data and enables the employee to view
the new elections after a life event change. The enrollment statement displays four main sections - the
personal information, dependent information, investment, and dependent/beneficiary sections. You can
configure the report to display or hide any of the four sections using the Enrollment Statement Controls
setup page. The Enrollment Statement Controls setup page enables you to display or hide sections based
on the life event type.

Page Used to Configure the Employee Enrollment Summary Statement

Page Name Definition Name Usage

Enrollment Statement Controls Page W3EB_SMRY_CNTRL Configure the preliminary benefit
enrollment summary statement.

Enrollment Statement Controls Page
Use the Enrollment Statement Controls page (W3EB_SMRY_CNTRL) to configure the Benefit
Preliminary Enrollment Summary Statement.

Navigation:

Set Up HCM >Product Related >eBenefits >Enrollment Statement Controls >Enrollment
Statement Controls

Copyright © 1988, 2022, Oracle and/or its affiliates. 287



Managing Life Events Chapter 11

This example illustrates the fields and controls on the Enrollment Statement Controls page. You can find
definitions for the fields and controls later on this page.

Enrollment Statement Controls

Field or Control Description

Effective Date Select the effective date from which the enrollment statement
controls take effect.

Personal Information Section Select to always display or always hide this section in all
reports.

Dependent Information Select to always display this section, hide this section in all
reports, or hide this section only when the employee does not
have dependent or beneficiary information recorded in the
system.

Investment Section Select to always display this section or to hide this section
when no investment allocations have been specified.

Dependent/Beneficiary Section Select to always display this section or to hide this section
when there are no dependents or beneficiaries enrolled under
this employee’s benefit package.
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Plan Type Controls

Field or Control Description

Plan Type Select a specific benefit plan type to be excluded from the
Enrollment Summary Statement when an employee has opted
to waive coverage.

Hide Waived Select to exclude the plan from the Enrollment Summary
report when coverage is waived.

Understanding Life Event Processing

Employees process a self service life event when there is a change in their benefits enrollment as a result
of a life event, for example, change in marital status, child birth or adoption. An employee will access the
Life Events pages differently based on the interface they are using:

• Classic Life Events

To access the classic Life Events pages, select the NavBar Navigator to select Employee Self Service,
eBenefits, Life Events (see "Using PeopleSoft eBenefits Pages" (PeopleSoft eBenefits)).

• Fluid Life Events

To access the fluid Life Events pages, from the fluid Employee Self Service landing page (or the
landing page where you have placed the tile), select the Benefit Details Tile, and then select the Life
Events option.

To process a life event, select your life event from the list of available life event on the selection page. An
activity guide process guides you through the required sub-steps or action items to complete the life event.
An activity guide page lists all the steps, or action items, within the life event. The status of each action
item in the activity guide page changes as you navigate through the activity guide. The system provides
easy navigation through the activity guide steps. You can stop processing a life event temporarily and
continue at a later point, or you can completely cancel (delete) the life event instance. When you complete
a life event, the activity guide provides a visual indication that all the action items and steps are complete.

You can perform the following activities while processing a life event:

• Upload documents required to process the life event. Based on the type of the employee life event
being processed, the system displays the required document type(s) to be uploaded.

• Change benefits enrollment.

• Review your benefits election and go back to previous steps to make additional changes if necessary.

Note: At any given time, you can execute only one instance of a life event at a time (in either classic or
fluid).

These topics describe how to process the following out-of-the-box life events:
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• Marriage

• Child birth

• Adoption

• Divorce

Note: By default, four life events — Marriage, Child birth, Adoption, and Divorce are available out-of-
the-box. Life events available to you will vary depending on the life events defined by your organization
based on your business needs. Additionally, the action items within each life event may also vary
depending on the modifications made to them by your organization.

Processing the Marriage Event

Employees begin the Marriage life event process by navigating to the Life Events page and then selecting
the marriage transaction.

After the employee accesses the transaction, the system displays the Change Status Date page on which
the employee needs to enter the date of the marital status change. The Change Status Date page indicates
the maximum number of days after the life event within which the employee needs to complete the
self service life event. A series of pages that direct the employee through the life event process will be
displayed. Rules that are set on the Life Event Rules page and the Action Items for the marital status
change transaction determine which pages will be displayed by the system.

Pages Used to Process the Marriage Event

Classic Page Name Classic Definition
Name

Fluid Page Name Fluid Definition
Name

Usage

Welcome Page W3EB_LE_
WELCOME

Welcome to
<Transaction Name>
Event Page

AGC_INFO_FL Read the instructions
on the Welcome page to
initiate your Marriage
life event. This page
contains custom
information about the
life event.

Marital Status Change
Page

HR_EE_MAR_
STATUS

Marital Status Page 
(Marital Status or
Divorce Status Page)

HR_EE_MARITAL_
FL

Enter changes for
a marital status and
submit the changes.

Life Events —
Document Upload Page

HR_ATT_DD_HDR "Life Events -
Document Upload
Page" (PeopleSoft
eBenefits)

HR_ATT_DD_HDR Upload a proof
document, for example,
 marriage certificate for
the life event, or enter
a note relevant to the
marriage event.

290  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 11 Managing Life Events

Classic Page Name Classic Definition
Name

Fluid Page Name Fluid Definition
Name

Usage

Benefits Summary Page W3EB_GRID Benefits Summary Page BEN_SUMM_GRID_
FL

Review current
benefits.

Name Change Page HR_EE_NAME Personal Information
- "Name (Summary)
Page" (PeopleSoft
eProfile)

HR_EE_NAME_FL Enter name change
information.

Home and Mailing
Address Page

HR_HOME_MAILING Personal Information
- Home and mailing
Addresses Page (see
"Addresses (Summary)
Page" (PeopleSoft
eProfile))

HR_EE_ADDR_FL Enter valid home and
mailing addresses.

Phone Numbers Page HR_PERSONAL_
PHONE

Personal Information
- Contact Information
Page (see
"Contact Details
Page" (PeopleSoft
eProfile))

HR_EE_CONTACTS_
FL

Enter valid phone
numbers.

Emergency Contacts
Page

HR_EMERGENCY_
CNTCT

Personal Information
- "Emergency
Contacts (Summary)
Page" (PeopleSoft
eProfile))

HR_EMERG_CNTCT
_FL

Enter emergency
contact information.

Add/Review
Dependent/Beneficiary
Page

W3EB_DEPBEN_
RVW

Dependent/Beneficiary
Info Page

W3EB_DEPBNSMRY
_FL

Update dependent/
beneficiary
information.

W-4 Withholding
Certificate Page

PY_IC_W4_DATA_
2020

Pay and Compensation
- "Tax Withholding
Page" (PeopleSoft
ePay)

PY_IC_W4_FL Review and change tax
information.

Direct Deposit Page PY_IC_DD_LIST Pay and Compensation
- Direct Deposit Page

PY_IC_DIR_DEP_FL Review direct deposit
information.
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Classic Page Name Classic Definition
Name

Fluid Page Name Fluid Definition
Name

Usage

Benefit Enrollment
Page

W3EB_LE_ENROLL Benefits Enrollment
Page

BNE_LE_ENROLL1_
FL

Start benefits
enrollment and enroll
for available benefits.

Note: A dependency
relationship is defined
on the Marital Status
Change action item
and benefit enrollment.
 Hence, benefits
enrollment will be
available only if you
have updated and
submitted the martial
status.

Benefits Election
Review Page

W3EB_LE_CONFIRM Benefits Statement
Page

BAS_STATMNTS_FL Review benefits
election. Click Print to
generate a preliminary
Benefits Enrollment
Summary Statement
containing your
personal information
and information
about dependent/
beneficiary enrollment,
 benefits elections, and
investment choices.

Go back to any
previous steps and
make additional
changes before
completing the benefits
enrollment.
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Classic Page Name Classic Definition
Name

Fluid Page Name Fluid Definition
Name

Usage

Event Completion and
Exit Page

W3EB_LE_PRINT Summary Page AGC_SUMMARY_FL Complete and
exit the life event.
 View confirmation
of the life event
process completion.
 Additionally, view
custom information
about any additional
tasks that you need to
do related to this life
event.

When you click
Complete, the system
verifies whether all the
required action items
have been completed
and displays an error
message if any are
incomplete.

See product documentation for PeopleTools: Workflow Technology for related information.

Processing the Child Birth Event

Employees begin the Child Birth transaction by navigating to Life Events and then selecting the I had a
baby radio button. The system displays the Change Status Date page on which the employee needs to
enter the date of child birth.

Note: An employee can also add a new spouse and other dependents from the life event for Marriage.

After the employee accesses the transaction, the system displays a series of pages that direct the employee
through the life event process. The system determines which pages will be displayed according to the
rules that are set for the Child Birth transaction on the Life Event Rules Page and:

• (Classic) Action Item Page.

• (Fluid) Activity Guide Composer pages (see "Managing Activity Guide Templates" (Enterprise
Components), the Life Event Rules page and the Action Items for the Child Birth transaction).
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Pages Used to Process the Child Birth Event

Classic Page Name Classic Definition
Name

Fluid Page Name Fluid Definition
Name

Usage

Welcome Page W3EB_LE_
WELCOME

Welcome to
<Transaction Name>
Event Page

AGC_INFO_FL Read the instructions
on the Welcome page
to initiate your child
birth event. This
page contains custom
information about the
life event.

Birth Date Page W3EB_BRTH_ADPT
_DT

Birth Date Page (Birth
Date or Adoption Date
Page)

W3EB_BR_ADPT_FL Enter the date of child
birth and submit.

Life Events —
Document Upload Page

HR_ATT_DD_HDR "Life Events -
Document Upload
Page" (PeopleSoft
eBenefits)

HR_ATT_DD_HDR Upload a proof
document, for example,
 birth certificate for
the life event, or enter
a note relevant to the
event.

Benefits Summary Page W3EB_GRID Benefits Summary Page BEN_SUMM_GRID_
FL

Review your current
benefits.

Dependent and
Beneficiary Coverage
Summary Page

W3EB_DEPBEN_
SUM

Dependent and
Beneficiary Coverage
Summary Page

W3EB_DEPBEN_
SUM

Review summary
information about
dependent/beneficiary
benefits.

Add/Review
Dependent/Beneficiary
Page

W3EB_DEPBEN_
RVW

Dependent/Beneficiary
Info Page

W3EB_DEPBNSMRY
_FL

Update dependent/
beneficiary
information.

W-4 Withholding
Certificate Page

PY_IC_W4_DATA_
2020

Pay and Compensation
- "Tax Withholding
Page" (PeopleSoft
ePay)

PY_IC_W4_FL Review and change
W-4 tax information.

Direct Deposit Page PY_IC_DD_LIST Pay and Compensation
- Direct Deposit Page

PY_IC_DIR_DEP_FL Review and change
direct deposit
information.
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Classic Page Name Classic Definition
Name

Fluid Page Name Fluid Definition
Name

Usage

Benefit Enrollment
Page

W3EB_LE_ENROLL Benefits Enrollment
Page

BNE_LE_ENROLL1_
FL

Start benefits
enrollment and enroll
for available benefits.

Note: A dependency
relationship is defined
on the Birth Date
action item and benefit
enrollment. Hence,
 benefits enrollment
will be available only
if you have updated
and submitted the birth
date.

Benefits Election
Review Page

W3EB_LE_CONFIRM Benefits Statement
Page

BAS_STATMNTS_FL Review benefits
election. Click Print to
generate a preliminary
Benefits Enrollment
Summary Statement
containing your
personal information
and information
about dependent/
beneficiary enrollment,
 benefits elections, and
investment choices.

Go back to any
previous steps and
make additional
changes before
completing the benefits
enrollment.

Event Completion and
Exit Page

W3EB_LE_PRINT Summary Page AGC_SUMMARY_FL View confirmation
of the child birth
event completion.
 Additionally, view
custom information
about any additional
tasks that you need to
do related to this life
event.

When you click
Complete, the system
verifies whether all the
required action items
have been completed
and displays an error
message if any are
incomplete.
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Processing the Adoption Event

Employees begin the Adoption transaction by navigating to Life Events and then selecting the I adopted
or gained legal custody/guardianship of a child radio button. The system displays the Change Status
Date page on which the employee needs to enter the date of adoption.

After the employee accesses the transaction, the system displays a series of pages that direct the employee
through the adoption process. Rules that are set on the Life Event Rules page and the Action Items for the
Adoption transaction determine which pages will be displayed by the system.

Pages Used to Process the Adoption Event

Page Name Definition Name Fluid Page Name Fluid Definition
Name

Usage

Welcome Page W3EB_LE_
WELCOME

Welcome to
<Transaction Name>
Event Page

AGC_INFO_FL Read the instructions
on the Welcome
page to initiate the
adoption event. This
page contains custom
information about the
life event.

Adoption Date Page W3EB_BRTH_ADPT
_DT

Adoption Date Page 
(Birth Date or Adoption
Date Page)

W3EB_BR_ADPT_FL Enter the date of
adoption and submit.

Life Events —
Document Upload Page

HR_ATT_DD_HDR "Life Events -
Document Upload
Page" (PeopleSoft
eBenefits)

HR_ATT_DD_HDR Upload a proof
document, for example,
 adoption certificate, or
enter a note relevant to
the event.

When you upload
a document, a
notification is sent
to the Benefits
Administrator to
approve the document.
 After the document
is approved, you will
receive an e-mail
notification to return
to the Adoption event
to continue benefits
enrollment.

Benefits Summary Page W3EB_GRID Benefits Summary Page BEN_SUMM_GRID_
FL

Review your current
benefits.
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Page Name Definition Name Fluid Page Name Fluid Definition
Name

Usage

Dependent and
Beneficiary Coverage
Summary Page

W3EB_DEPBEN_
SUM

Dependent and
Beneficiary Coverage
Summary Page

W3EB_DEPBEN_
SUM

Review summary
information about
dependent/beneficiary
benefits.

Add/Review
Dependent/Beneficiary
Page

W3EB_DEPBEN_
RVW

Dependent/Beneficiary
Info Page

W3EB_DEPBNSMRY
_FL

Update dependent/
beneficiary
information.

W-4 Withholding
Certificate Page

PY_IC_W4_DATA_
2020

Pay and Compensation
- "Tax Withholding
Page" (PeopleSoft
ePay)

PY_IC_W4_FL Review and change
W-4 tax information.

Direct Deposit Page PY_IC_DD_LIST Pay and Compensation
- Direct Deposit Page

PY_IC_DIR_DEP_FL Review and change
direct deposit
information.

Benefit Enrollment
Page

W3EB_LE_ENROLL Benefits Enrollment
Page

BNE_LE_ENROLL1_
FL

Start benefits
enrollment and enroll
for available benefits.

Note: A dependency
relationship exists
between the Adoption
Date action item and
benefit enrollment.
 Hence, benefits
enrollment will be
available only if you
have updated and
submitted the adoption
date.
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Page Name Definition Name Fluid Page Name Fluid Definition
Name

Usage

Benefits Election
Review Page

W3EB_LE_CONFIRM Benefits Statement
Page

BAS_STATMNTS_FL Review benefits
election. Click Print to
generate a preliminary
Benefits Enrollment
Summary Statement
containing your
personal information
and information
about dependent/
beneficiary enrollment,
 benefits elections, and
investment choices.

Go back to any
previous steps and
make additional
changes before
completing the benefits
enrollment.

Event Completion and
Exit Page

W3EB_LE_PRINT Summary Page AGC_SUMMARY_FL View confirmation
of the adoption
event completion.
 Additionally, view
custom information
about any additional
tasks that you need to
do related to this life
event.

When you click
Complete, the system
verifies whether all the
required action items
have been completed
and displays an error
message if any are
incomplete.

Processing the Divorce Event

Employees begin the Divorce transaction by navigating to Life Events and then selecting the I got
divorced/legally separated radio button. The system displays the Change Status Date page on which the
employee needs to enter the date of divorce.

After the employee accesses the divorce transaction, the system displays a series of pages that direct the
employee through the life event process. Rules that are set on the Life Event Rules page and the Action
Items for the Divorce transaction determine which pages will be displayed by the system.
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Pages Used to Process the Divorce Event

Classic Page Name Classic Definition
Name

Fluid Page Name Fluid Definition
Name

Usage

Welcome Page W3EB_LE_
WELCOME

Welcome to
<Transaction Name>
Event Page

AGC_INFO_FL Read the instructions
on the Welcome
page to initiate the
divorce event. This
page contains custom
information about the
life event.

Marital Status Change
Page

HR_EE_MAR_
STATUS

Divorce Status Page 
(Marital Status or
Divorce Status Page)

HR_EE_MARITAL_
FL

Enter the date of
divorce and the
changed marital status.

Life Events —
Document Upload Page

HR_ATT_DD_HDR "Life Events -
Document Upload
Page" (PeopleSoft
eBenefits)

HR_ATT_DD_HDR Upload a proof
document for the life
event, or enter a note
relevant to the event.

Benefits Summary Page W3EB_GRID Benefits Statement
Page

BEN_SUMM_GRID_
FL

Review your current
benefits.

Name Change Page HR_EE_NAME Personal Information
- "Name (Summary)
Page" (PeopleSoft
eProfile)

HR_EE_NAME_FL Enter name change
information.

Home and Mailing
Address Page

HR_HOME_MAILING Personal Information
- Home and mailing
Addresses Page (see
"Addresses (Summary)
Page" (PeopleSoft
eProfile))

HR_EE_ADDR_FL Enter home and mailing
address changes.

Phone Numbers Page HR_PERSONAL_
PHONE

Personal Information
- Contact Information
Page (see
"Contact Details
Page" (PeopleSoft
eProfile))

HR_EE_CONTACTS_
FL

Enter valid phone
numbers.

Emergency Contacts
Page

HR_EMERGENCY_
CNTCT

Personal Information
- "Emergency
Contacts (Summary)
Page" (PeopleSoft
eProfile))

HR_EMERG_CNTCT
_FL

Enter emergency
contact information.

Add/Review
Dependent/Beneficiary
Page

W3EB_DEPBEN_
RVW

Dependent/Beneficiary
Info Page

W3EB_DEPBNSMRY
_FL

Update dependent/
beneficiary
information.
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Classic Page Name Classic Definition
Name

Fluid Page Name Fluid Definition
Name

Usage

W-4 Withholding
Certificate Page

PY_IC_W4_DATA_
2020

Pay and Compensation
- "Tax Withholding
Page" (PeopleSoft
ePay)

PY_IC_W4_FL Review and change
W-4 tax information.

Direct Deposit Page PY_IC_DD_LIST Pay and Compensation
- Direct Deposit Page

PY_IC_DIR_DEP_FL Review and change
direct deposit
information.

Benefit Enrollment
Page

W3EB_LE_ENROLL Benefits Enrollment
Page

BNE_LE_ENROLL1_
FL

Start benefits
enrollment and enroll
for available benefits.

Note: A dependency
relationship is defined
on the Marital Status
Change action item and
benefits enrollment.
 Hence, benefits
enrollment will be
available only if you
have updated and
submitted the marital
status.

Benefits Election
Review Page

W3EB_LE_CONFIRM Benefits Statement
Page

BAS_STATMNTS_FL Review benefits
election. Click Print to
generate a preliminary
Benefits Enrollment
Summary Statement
containing your
personal information
and information
about dependent/
beneficiary enrollment,
 benefits elections, and
investment choices.

Go back to any
previous steps and
make additional
changes before
completing the benefits
enrollment.
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Classic Page Name Classic Definition
Name

Fluid Page Name Fluid Definition
Name

Usage

Event Completion and
Exit Page

W3EB_LE_PRINT Summary Page AGC_SUMMARY_FL View confirmation
of the divorce event
completion.

When you click
Complete, the system
verifies whether all the
required action items
have been completed
and displays an error
message if any are
incomplete.

Using the PeopleSoft Fluid User Interface to Enter Life Events

This topic discusses how employees use the PeopleSoft Fluid User Interface to enter life event changes.

For general information about Fluid pages in PeopleSoft HCM, see "Understanding PeopleSoft Fluid User
Interface Home Pages" (Application Fundamentals)

Video: PeopleSoft Fluid User Interface Experience in HCM

Pages Used to Enter Life Events Using the PeopleSoft Fluid User Interface
These pages are available for all life event transactions unless otherwise noted.

Page Name Definition Name Usage

Benefit Details Tile HC_EBEN_SS_NAVCOLL_FL (cref for
the tile)

W3EB_ENR_TILE_FLU (page for
dynamic data)

Access benefits-related self-service
transactions.

Life Events Page W3EB_SEL_EVNT_FLU Initiate processing for a life event that
affects benefits.

The Activity Guide Composer
Framework for Life Events

(common elements on pages used to
apply for jobs)

N/A In the Life Events fluid pages, the
application appears within the context
of the Activity Guide Composer
framework. The Activity Guide
Composer shows the steps in the
Life Events transactional process
and provides navigation buttons for
proceeding through the steps.
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Page Name Definition Name Usage

Welcome to <Transaction Name> Event
Page

AGC_INFO_FL Read the instructions on the Welcome
page to initiate your life event.

Marital Status or Divorce Status Page HR_EE_MARITAL_FL (Marriage and Divorce events) Enter the
new marital status and as of date.

Birth Date or Adoption Date Page W3EB_BR_ADPT_FL (Birth and Adoption events) Enter the
date of child birth or the date of adoption
and submit.

Life Event Document Upload Page BEN_ATTACH_FL Upload a proof document, for example,
 marriage certificate for the life event, or
enter a note relevant to the event.

When document approval is required,
 the system uses the Fluid Approval
framework to notify the appropriate
parties that you have uploaded a
document. For more information, see
Approving Life Event Documents Using
Fluid Approvals

Benefits Summary Page BEN_SUMM_GRID_FL Review current benefit enrollments.

Personal Information - "Name
(Summary) Page" (PeopleSoft eProfile)

HR_EE_NAME_FL (Marriage and Divorce events) View
your current name, any pending name
change submissions, and initiate a name
change.

"Name (Detail) Page" (PeopleSoft
eProfile)

NAME_EDIT_SCF (Marriage and Divorce events) Enter
name change information.

Personal Information - Home and
mailing Addresses Page (see "Addresses
(Summary) Page" (PeopleSoft eProfile))

HR_EE_ADDR_FL (Marriage and Divorce events) View
your home address and mailing address,
 or initiate updates to an address.

"Address (Detail) Page" (PeopleSoft
eProfile)

ADDRESS_DFT_SCF (Marriage and Divorce events) Update
address information.

Personal Information - Contact
Information page (see "Contact Details
Page" (PeopleSoft eProfile))

HR_EE_CONTACTS_FL (Marriage and Divorce events) Review
your phone numbers, email addresses,
 and instant messaging IDs and initiate a
change to your contact information.

"Phone Number Page" (PeopleSoft
eProfile)

HR_CNCT_PHONE_SCF (Marriage and Divorce events) Add,
 update, or delete a phone number.
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Page Name Definition Name Usage

"Email Address Page" (PeopleSoft
eProfile)

HR_EMAIL_ADDRS_SCF (Marriage and Divorce events) Add,
 update, or delete an email address.

"Instant Message Page" (PeopleSoft
eProfile)

HR_IM_CHAT_SCF (Marriage and Divorce events) Add,
 update, or delete an instant messaging
ID.

Personal Information - "Emergency
Contacts (Summary) Page" (PeopleSoft
eProfile)

HR_EMERG_CNTCT_FL (Marriage and Divorce events) View a
list of your emergency contacts.

"Emergency Contact (Detail)
Page" (PeopleSoft eProfile)

HR_EMERG_CNTCT_SCF (Marriage and Divorce events) Add,
 update, or delete an emergency contact.

Dependent and Beneficiary Coverage
Summary Page

W3EB_DEPBEN_SUM (Birth and Adoption events) Review
dependent/beneficiary summary
coverage information.

Dependent/Beneficiary Info Page W3EB_DEPBNSMRY_FL Review a summary of dependent/
beneficiary information or add new
dependents or beneficiaries.

Add Individual Dependent/Beneficiary
Information Page

W3EB_DEPBEN_DTL_FL Review and update detailed dependent
and beneficiary personal information.

Pay and Compensation - "Tax
Withholding Page" (PeopleSoft ePay)

PY_W4_MAIN_FL Review and change tax information.

View a list of the tax withholding
information and access their Tax
Withholding Forms page for a
jurisdiction.

"Federal Tax Withholding Forms
Page" (PeopleSoft ePay)

PY_W4_MAIN_FED_SCF View a list of updateable federal tax
forms and additional agency links, if any,
 and access the form or URL.

"State Tax Withholding Forms
Page" (PeopleSoft ePay)

PY_W4_MAIN_ST_SCF View a list of updateable state tax forms
for that jurisdiction and additional
agency links, if any, and access the form
or URL.

Pay and Compensation - Direct Deposit
Page

PY_IC_DIR_DEP_FL Review and update direct deposit
information.
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Page Name Definition Name Usage

Benefits Enrollment Page BNE_CARD_SUMM_FL Start the benefits enrollment process and
enroll for available benefits.

Note: A dependency relationship
exists between either the marital status,
 adoption date, or birth date and the
benefit enrollment, depending upon the
transaction you are performing. Hence,
Benefit Enrollment will be available only
if you have updated and submitted the
marital status, adoption or birth date for
the life event you are entering.

Benefits Statement Page BAS_STMT_LIST_FL View a list of benefits enrollment
previews, submitted enrollments and
confirmation statements.

Summary Page AGC_SUMMARY_FL Complete and exit the life event.

See product documentation for PeopleTools: Workflow Technology for related information.

The Activity Guide Composer Framework for Life Events
In the Life Events fluid pages, the application appears within the context of an Activity Guide Composer
framework to display the steps a user has to perform.

The Activity Guide Composer framework shows a list of application steps in the left panel and the page
that corresponds to the current step in the right panel. The Activity Guide also provides navigation buttons
in the page banner.

To set up templates using the Activity Guide Composer, see the "Understanding the Activity Guide
Composer" (Enterprise Components) documentation.
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This example illustrates the layout of the Life Events pages for a large form factor device.
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This example illustrates the layout for the Life Events page on a small form factor device. In the first
image, the left panel is hidden. In the second image, the left panel is exposed.

Note: Throughout this topic, the page illustrations show the page sections of the Life Events process
without the context of the Activity Guide Composer step list. Even though the Activity Guide Composer
framework is not illustrated, remember that all steps appear within that framework.

Page Banner

The top of PeopleSoft pages is called the page banner. In other PeopleSoft applications, the banner
displays several standard icon buttons. The banner will display the name of the life event transaction you
are performing.

On most pages, users see the standard set of banner icon buttons.
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Field or Control Description

 or Exit button

Click this button to exit the Life Events data entry and
summary pages. If you have not clicked the Complete button
on the Summary page before exiting, you can resume this
life event data entry at a later time. You cannot start another
life event transaction until you have either completed this life
event transaction or cancelled this transaction by selecting the
Cancel menu list option from the Actions Menu, which will
delete this enter life events transaction and everything you
have entered.

 or  Previous button

Click this button to save changes to the current step and
navigate to the previous step or substep. The button is not
visible on the first step in the request.

 or  Next button

Click this button to save changes to a current step or substep
and navigate to the next step or substep.

On the last step of the request (the Summary step), the Next
button does not appear. The page displays a Complete  button
on the Summary page to complete and submit the life event
transaction request.

 Complete button

This button appears only on the Summary step page. This
button will not appear until all required steps are completed.

Click this button to submit the life event details to Benefits.
 You cannot make any further changes to a life event that has
been submitted.

 Cancel menu item from the
Actions Menu list

Select the Cancel menu item to delete all items you have
entered on these pages thus far and cancel this life event
transaction.

List of Steps

The Activity Guide Composer framework includes a left panel that lists the steps in the life event process.
This panel appears on the left of larger devices. On a small form factor such as phone, the panel is initially
hidden. Click the Item/Sub-Item Section tab to expand and view the steps and navigate to other step
pages.
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Field or Control Description

<Step or Substep Name> The left panel has individual steps that are labeled. The
delivered life event templates do not require a sequential order
to complete steps, however, your organization may define life
event templates that require the user to follow a prescribed
order. In this case, the steps are numbered and labeled. To
define sequential or non-sequential steps, see the "Activity
Guide Composer - Activity Guide Type Page" (Enterprise
Components) documentation.

Some steps will have substeps. Steps with substeps are
indicated by an expand/collapse icon before the step name.
The step is automatically expanded when you reach it. You can
also click the parent step at any time to expand or collapse it.
 The page will highlight the current step or substep.

When a step is grayed out and unavailable for selection, you
need to complete a required step prior to accessing this step
page. Click the step to receive a message stating the required
step or steps you need to complete first to access this page.

 Required icon
This icon represents that the step is required. You cannot
complete and submit a life event transaction until all required
steps are completed.

<Step Status> Each step and substep has a status. These statuses include:

• Not Started: These are unvisited steps.

• Visited: When you first reach a step, the status changes to
this.

• Complete: In some instances, the system will
automatically mark the step as Complete where the
system can correctly infer that the task for the step is
done. If it is uncertain whether a step is complete, the
system will mark it as Visited.

• In Progress: This status appears for required steps that
you have visited, but you have not entered the required
data and saved.

Users can return to steps and substeps by clicking the step.

For more information on how to display steps and selecting and organizing steps, see the "Activity Guide
Composer - Activity Guide Type Page" (Enterprise Components), "Activity Guide Composer - Select
Steps Page" (Enterprise Components), and "Activity Guide Composer - Organize and Configure Steps
Page" (Enterprise Components).
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<Transaction Name> Pages

Within the Activity Guide Composer framework, the right main panel displays the page for the current
step in the life event transaction.

Field or Control Description

<Title Text> Displays a page title that includes the step name.

For substeps, the page title includes both the step and
substep name, separated by a hyphen. For example, Pay and
Compensation - Direct Deposit indicates that the step title is
Pay and Compensation and the substep title is Direct Deposit.

Welcome to <Transaction Name> Event Page
Use the Welcome to <Transaction Name> Event page (AGC_INFO_FL) to read the instructions on the
Welcome page to initiate your life event.

Navigation:

• Click the Benefit Details Tile from the Employee Self Service home page in fluid. Select the Life
Events tab category from the left panel of the Benefits Details page. Then select the appropriate life
event., enter an as of date, and click Continue Life Event.

• From the <Transaction Name> Event pages, click the Welcome to <Transaction Name> Event step
from the left panel, or use the Previous button, as needed.

This example illustrates the Welcome to <Transaction Name> Event page.

This page contains custom information about the specific life event.

Marital Status or Divorce Status Page
Use the Marital Status page (HR_EE_MARITAL_FL) to enter the new marital status and as of date.

Note: The delivered marital and Divorce events display this step.
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Navigation:

Select the Marital Status or Divorce Status step from the left panel or use the Next and Previous buttons
to navigate to the page.

This example illustrates the Marital Status page.

Note: The Marital Status and Divorce Status pages display the same information. The Marital Status page
is depicted in the previous example.

Field or Control Description

New Status Enter marital status change information, such as married or
divorced, and submit the changes directly from this page.

As Of Enter the event date in the As Of field and click the Save
button. If another step is contingent only upon this step, when
you save this page that step will become available.

Save Click this button to submit your new marital status.

Note: By clicking the Save button on this page, you are
updating your marital status in the system, even if you do not
submit this life event transaction.

For information about the pages used for the two delivered marital status change events, see the following
topics:

• Processing the Marriage Event

• Processing the Divorce Event

Birth Date or Adoption Date Page
Use the Birth Date or Adoption Date page (W3EB_BR_ADPT_FL) to enter the date of child birth or the
date of adoption and submit.

Note: The delivered Birth and Adoption events will display this step.
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Navigation:

Select the Birth Date or Adoption Date step from the left panel or use the Next and Previous buttons to
navigate to the page.

This example illustrates the Birth Date page.

This example illustrates the Adoption Date page.

Enter the event date, such as the birth date of your child or the date the child was placed in your home for
adoption, in the date field and click the Submit button.

Note: If your organization’s Life Events Rules setting has the Notify Administrator checkbox selected,
then when an employee enters the Birth or Adoption date and submits the date, the Benefits Administrator
receives an alert in the Notifications area of the top banner and an email notification.
If your organization’s Life Events Rules setting has the Proof Required checkbox selected, then when an
employee enters the Birth or Adoption date and submits the date, the Benefits Administrator receives an
action notification, as well as an email notification.

This example illustrates the alert displayed when the Benefits Administrator clicks the Notification icon.
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This example illustrates the action notification displayed when the Benefits Administrator clicks the
Notification icon.

For information about the pages used for the two delivered marital status change events, see the following
topics:

• Processing the Adoption Event

• Processing the Child Birth Event

Dependent and Beneficiary Coverage Summary Page
Use the Dependent and Beneficiary Coverage Summary page (W3EB_DEPBEN_SUM) to review
dependent/beneficiary summary coverage information.

Note: The delivered Adoption and Birth events display this step.

Navigation:

Select the Dependent and Beneficiary Coverage Summary step from the left panel, or use the Next and
Previous buttons to navigate to the page.
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This example illustrates the Dependent and Beneficiary Coverage Summary page.

Field or Control Description

As Of Date Initially, the page displays benefits as of the current date. To
view dependent and beneficiary coverage as of a different
date, choose a new as of date and click the Go button.

The grid that summarizes the employee’s dependent and beneficiary benefit coverage shows the type of
benefit and a description of the benefit.

Click an existing dependent or beneficiary name link to access the Add Individual Dependent/Beneficiary
Information Page and view and update the person’s information.

To add a dependent or beneficiary, access the Dependent/Beneficiary Info Page step.

Add Individual Dependent/Beneficiary Information Page
Use the Add Individual Dependent/Beneficiary Information page (W3EB_DEPBEN_DTL_FL) to review
and update detailed dependent and beneficiary personal information.

Navigation:

• Select a name row or click the Add Individual button from the Dependent/Beneficiary Info Page.

• Select a name link from the Dependent and Beneficiary Coverage Summary Page.
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This example illustrates the Add Individual Dependent/Beneficiary Information page.

Use this page to enter personal details, status information, and contact information for a dependent or
beneficiary.

Pay and Compensation - Direct Deposit Page
Use the Pay and Compensation - Direct Deposit page (PY_IC_DIR_DEP_FL) to view current direct
deposit information.

Navigation:

Select the Pay and Compensation step, then the Direct Deposit substep from the left panel, or use the
Next and Previous buttons to navigate to the page.
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This example illustrates the Pay and Compensation - Direct Deposit page.

Use this page to view your direct deposit elections or add new direct deposit information.

Select the account row to access the Edit Account Page and view details about each item. Select the Edit
(pencil) icon to update information for an existing entry.

Click the + (Add Account) button to add a new direct deposit.

Note: Multiple direct deposit changes are not allowed in the same day.

Select ‘Yes’ in the Print Option for a paper copy of the direct deposit pay statement.

Summary Page
Use the Summary page (AGC_SUMMARY_FL) to complete and exit the life event.

Navigation:

Select the Summary step from the left panel, or use the Next button to navigate to the page.
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This example illustrates the Summary page.

View confirmation of the life event process completion. Additionally, view custom information about any
additional tasks that you need to do related to this life event.

Use the Steps section to view a summary of the statuses of each step in this life event process and what is
required and when.

Field or Control Description

Mark Complete When available, click this button to indicate that a step is
complete.

Go to Step Easily navigate back to a step by clicking this button. If you
select to go to a step that’s due date has passed, the system will
issue the message that the task is overdue.

Complete When you click this button, the system verifies whether all
the required action items have been completed and displays
a message if any are incomplete. This closes the life event
transaction.
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Uploading Fluid Life Event Documents

As an employee, while creating a life event, you can attach multiple documents at the same time based
on customized classification. You can also view the uploaded documents and status using the Benefits
Attachment Page.

This topic discusses how employees upload life event documents using fluid interface.

Page Used to Upload Fluid Life Event Documents

Page Name Definition Name Usage

Life Event Document Upload Page HR_ATT_CNFG Define attachment types as configuration
ID.

Life Event Document Upload Page
Use the Life Event Document Upload page (BEN_ATTACH_FL) to upload attachments required to
support the life event you are creating. You can attach multiple documents at the same time based on
different available classifications.

Navigation:

Employee Self Service >Benefit Details > Life Events > Life Event Document Upload

This example illustrates the Document Upload page.
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Field or Control Description

Qualifying Period Qualifying Period indicates the enrollment period begin date
and enrollment period end date. Event Date is the enrollment
period begin date. Enrollment period end date is calculated by
adding the number of qualifying days to the event date.

By default, the number of qualifying days is 31. This value is
defined using the ‘Maximum Days to Notify’ field on the Life
Event Rules Page.

Document List

This section lists the type of documents required to support the selected life event. Administrators can
customize the document types to be listed here.

Field or Control Description

Document Indicates the documentation type.

Upload Requirement Indicate the requirement for document upload under this
category.

• If the status is ‘Required’, it is mandatory to upload a
document under this category for the selected life event.

• If the status is ‘Optional’, it is optional to upload a
document under this category for the selected life event.

• If the status is ‘Require at least one’, it is mandatory to
upload at least one document under this category for the
selected life event.

Approval Required Indicates if this document requires approval. The document
uploaded for this type, will be send to the approver(s) based on
the configured approval framework.

Note: The system marks the Upload Document step as complete only when all the required documents
are uploaded and all the documents that require approval are approved.

Document

Field or Control Description

Type You can select the category to which your document belongs.
 Options are displayed based on the configuration done at the
definition level.
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Field or Control Description

Category You can select the sub category to which the documents
belong. For example, here, when we select ‘Miscellaneous
Document’ as the Type, the field ‘ Category’ is displayed.
 You can select one of the options to specify the type of the
document.

Note: Options are displayed based on the configuration done
at the definition level.

Add Attachment Use this button to open the File Attachment page. You can
attach the document here.

This example illustrates the File Attachment modal.

Field or Control Description

Add Note Use this button to open the Note modal window and add
additional information regarding the attached file.
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This example illustrates the Note modal.

View Document

Field or Control Description

View All Indicates whether you need to see all the attached documents
or only the documents that belong to a specific type.

• If you select ‘Yes’, all the documents attached for the life
event will be displayed.

• If you select No, only the documents that belong to the
attachment type selected in ‘Type’ field will be displayed.

Based on the value in the ‘View All’ field, the documents
are listed with details like description, Type, Attached By,
 Attached date, and Status of the approval.

Note: If at least one of the attached document is in ‘Pending’ for approval status, the ‘Document Upload’
step shows ‘Visited’ status. The system automatically marks the step as Complete, when the document is
approved.

To view more details on each attached document, click the corresponding row.
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Alert

This example illustrates the Alert message when the Life Event Document is approved

Click the link to open the Transaction Details page directly from the notification link.

This example illustrates the Transaction Details page.

Benefits Attachment Page
As an employee, you can use the Benefits Attachment page to review the uploaded documents and status.

Navigation:

Open the Benefits Attachment tile from Benefit Details Dashboard or Benefits Details Navigation
collection.
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This example illustrates the Benefit Details Dashboard with Benefit Attachment Tile

This example illustrates the Benefits Attachment page.

Approving Life Event Documents

These topics describe how to approve or reject life event documents uploaded by employees.

Understanding Document Approval
Employees upload required life event documents when processing their life events. During life event
setup, if Approve Document(s) is marked as required on the Life Event Rules table, then the Benefits
Administrator will be notified when an employee uploads a document for this event. The document
has to be approved before the employee proceeds to enroll benefits. The Approve Document Upload
page enables the Benefits Administrator to approve life event documents. The page lists all life event
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documents that require approval. The Benefits Administrator can review and then approve or deny the
documents.

Page Used to Approve Life Event Documents

Page Name Definition Name Usage

Approve Life Event Document Page W3EB_APPR_SUMMARY Approve or reject life event documents
uploaded by employees.

Approve Life Event Document Page
Use the Approve Life Event Document page (W3EB_APPR_SUMMARY) to approve required life event
documents uploaded by employees.

Navigation:

Benefits >Approve Life Event Document >Approve Life Event Document

This page enables the Benefits Administrator to approve required life event documents uploaded by
employees.

Field and Control Definitions

Document Filing(s) - Needs Approval

Field or Control Description

Select Select the documents to be processed from the list.

Name This field displays the name of the employee.
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Field or Control Description

Employee ID This field displays the employee ID.

Life Event Type This field indicates the life event type.

Description This field contains the description for the life event.

Document Click the link to review the life event document.

Approval

Field or Control Description

Select All Select all documents pending approval.

Deselect All Deselect all documents pending approval.

Approve Approve selected documents.

On approval, an e-mail notification will be sent to the
employee. An entry for the employee will be inserted in the
BAS_ACTIVITY table. This allows the employee to start the
benefits enrollment process within the life event.

Deny Deny selected documents.

On denial, an e-mail notification will be sent to the employee.
 The employee will have to upload a new document for
approval.

Push Back If more than one approver need to approve a document, click
this button to push it back to the previous approver to review
again.

Approving Life Event Documents Using Fluid Approvals

This topic describes how to approve Life Event documents like, certificates of marriage, adoption, divorce
etc using Fluid Approvals.

See also "Using PeopleSoft Fluid User Interface Self-Service Approval Transactions" (Application
Fundamentals)
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Pages Used to Approve Life Event Documents Using Fluid Approvals

Page Name Definition Name Usage

Pending Approvals — Benefits
Document Filing Page

EOAWMA_TXNHDTL_FL Approve a life event document uploaded
through fluid life event page.

Pending Approvals — Benefits Document Filing Page
Use Pending Approvals — Benefits Document Filing page (EOAWMA_TXNHDTL_FL ) to approve a
life event document uploaded through fluid life events page.

Navigation:

On the Workforce Administrator home page, click the Approvals tile to access the Pending Approvals
page. From the left panel, click Benefits Document Filing.

Note: Approver(s) get notification as alerts and can directly click the link to open the Benefits Document
Filing Page to approve or deny the document upload.

This example illustrates the Pending Approvals- Benefits Document Filing page.

The approval options on this page are common to all fluid approval transactions, as described
in the documentation for the"Using PeopleSoft Fluid User Interface Self-Service Approval
Transactions" (Application Fundamentals).

Note: You can also take action (for e.g. approve or deny) on multiple approval requests at the same time
by selecting the check box before each item then tapping the appropriate action button on the page. Select
or deselect all check boxes at once by tapping the top check box in the gray header.

To view details for each request, tap a row and access the Benefits Document Filing Page.
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This example illustrates the Benefits Document Filing Page.

Here, you can view the attachment type, subject, created date and name of the attached file. Click a row
to open the Attachment modal window, where more details of the document is displayed. You can also
access the document uploaded from this Attachment modal window.

Field or Control Description

Approve and Deny buttons Use these buttons to take action on the requested approval.

Approver Comments Enter any comments related to the approval action you take.

Approver Chain Click this item to open the Approval Chain page, where
you can review information about all the approver(s) for
the transaction.

Delegating Life Events Document Approval

These topics describe how eBenefits uses delegation to enable a Benefits Administrator to authorize
another person to approve Life Events documents on his/her behalf.

Understanding Document Approval Delegation
A Benefits Administrator can delegate the authority to approve Life Events documents uploaded by
employees to another user if required. The Life Events document approval workflow integrates with
the HCM Delegation Framework, thus enabling the Benefits Administrator to delegate authority of Life
Events document approval. The Benefits Administrator can create a delegation request to allow a proxy
to approve Life Events documents on his/her behalf. The Benefits Administrator can set a date range for
the proxy to complete the delegation request. The proxy can accept or reject the delegation request, and
can approve, deny, or push back the Life Events document on behalf of the delegator. The delegator can
revoke or withdraw the delegated authority when required.
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Email notifications will be sent to the delegator when new delegation requests are made. The proxy will
in turn be notified of any pending approval requests through email.

The following terms are important to understand the delegation feature:

• Delegation: The act of giving the authority to approve Life Events documents to another user.

• Delegator: A person who delegates authority to another user.

• Proxy: A person who is granted the authority to act on behalf of the delegator.

• Delegated Authority: The rights and privileges that are given from the delegator to the proxy.

• Delegation Request: A request from the delegator to the proxy to take on delegated authority.

• Delegation Period: The time range in which the delegated authority is in effect.

• Delegation Administrator: The system administrator who is responsible for configuring, managing,
and maintaining delegated authorities.

• Revoke: When a delegator withdraws delegated authority.

Note: To prevent situations of cascading or circular delegation chains, once the delegation framework
passes delegated authority over an absence transaction to a proxy, the proxy cannot delegate authority
over that transaction to another user. The delegation framework only passes authority over transactions
from the initial delegator to the initial proxy.

Reviewing Delivered Document Approval Delegation Setup
The delegation framework for Life Events document approval is delivered with the system. To review this
framework:

1. Review the delegation transaction for workflow on the Workflow Transactions page.

2. Review the delegation permission list and role through PeopleTools Security components.

3. Review the delegation transaction on the Configure Delegation Transaction page.

Reviewing the Delegation Workflow Transaction

The PeopleSoft system delivers a pre-configured transaction for the Life Events document approval
delegation framework. This table lists the delivered delegation transaction:

Transaction Name Transaction Type Description

W3EB_APPR_SUMMARY Approve Delegate approval of Life Events
documents.

Use the Approval Workflow Engine (AWE) and Delegation Transactions grid to register self-service
transactions that use the AWE framework and delegation framework. The data that you enter into this grid
links the transaction name and accompanying tables for HCM self-service transactions to the approval
process IDs that you create for these transactions on the Register Transactions page.
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Reviewing the Permission List and Role for Delegation

PeopleSoft eBenefits delivers the permission list and role that are required for the Delegation framework
as system data. This table describes the delivered permission list and role for the delegation framework:

Role Name Attached Permission List Description

Delegate Manage Appr Document HCCPDL2068 Enables a user to access the components
to approve employee Life Events
documents on behalf of another user
when the authority is delegated.

Reviewing the Delegation Transaction

This table lists the delegation transaction delivered for Life Events document approval:

Transaction Name Transaction Type Role

Manage Approve Document Approve Delegate Manage Appr Document

Steps to Set Up a Delegation Request
A delegator follows these steps to delegate Life Event document approval requests using self-service:

1. Navigate to the Manage Delegation page.

2. Click the Create Delegation Request hyperlink.

3. Enter the From Date and To Date for the delegation request, and then click the Next button.

4. Select the transaction(s) to delegate authority. For Life Event document approval delegation, select the
Approve Life Event Documents transaction. Click the Next button.

5. Review the proxy list and select a proxy to whom the authority for document approval will be
delegated.

6. Select the Notify Delegator check box to receive a courtesy email notification on delegation and then
click Submit.

7. View the confirmation message and click OK.

Delegating Document Approval Requests
Life Events document approval delegation enables the Benefits administrator to:

• Create a delegation request to allow a proxy to approve the document on his/her behalf.

• Review the list of transactions delegated and the proxy assigned for each transaction.
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• Revoke or withdraw the delegated authority when required.

The following illustrations display the steps to delegate authority for employee Life Event document
approval:

Managing Delegations

Use the Manage Delegation page to create the delegation request.

This example illustrates the fields and controls on the Manage Delegation page.

Entering Dates for the Delegation Request

Use the Enter Dates page to select the date range for delegation.
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This example illustrates the fields and controls on the Create Delegation Request — Enter Dates page.

Selecting Transactions for the Delegation Request

Use the Select Transactions page to select the transaction to be delegated authority. Select the Approve
Life Event Documents transaction for Life Events document approval delegation.
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This example illustrates the fields and controls on the Create Delegation Request — Select Transactions
page.

Selecting Proxy by Hierarchy

Use the Select Proxy by Hierarchy page to select the proxy to whom the authority of document approval
should be delegated.

Copyright © 1988, 2022, Oracle and/or its affiliates. 331



Managing Life Events Chapter 11

This example illustrates the fields and controls on the Create Delegation Request — Select Proxy by
Hierarchy page.

Viewing Delegation Detail

Use the Delegation Detail page to review the transactions selected for delegation and submit or cancel the
delegation request depending on whether changes are needed. Select the Notify Delegator check box to
receive a courtesy email notification on delegation. On submitting the request, the system automatically
sends an email notification to the proxy to review and either accept or reject the delegation.
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This example illustrates the fields and controls on the Create Delegation Request - Delegation Detail
page.

Viewing Proxies

Use the My Proxies page to view all the proxies and request status for the delegation request.
Additionally, use the My Proxies page to revoke any of the delegated transactions at any point in time
during the delegation period.

This example illustrates the fields and controls on the My Proxies page.
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Viewing Delegation Authorities

After the proxy receives the email notification for the delegation request, he/she can access the My
Delegated Authorities page to accept or reject the request.

Use the My Delegated Authorities page to manage delegated authorities.

This example illustrates the fields and controls on the My Delegated Authorities page.

Selecting the Role for Document Approval

When approving employee Life Event documents, use the Select Role page to determine whether to
process your own employee document approval transactions or the delegated approval transactions.

This example illustrates the fields and controls on the Select Role page.

Click Continue to navigate to the Approve Document Upload page to approve Life Event documents. For
more information, see section “Approving Life Event Documents”.

Managing Delegation Authorities
To maintain delegations and update any invalid rows, the HCM Delegation Administrator needs to run the
Manage Delegated Authorities process on a daily basis.

Use the Maintain Delegation Authority page to run the Manage Delegated Authorities process.
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This example illustrates the fields and controls on the Maintain Delegation Authority page.

Run the Manage Delegated Authorities process to:

• Update the request status and delegation status.

• Revoke all delegation requests that have expired as of the current date.

• Search for and update inactive proxies.

• Insert or delete delegation permissions within the proxy’s role.

Managing Benefits Instances

These topics describe how to manage Benefits Instances, such as Life Events and Open Enrollment
activity guide instances.

Understanding Benefits Instances Maintenance
When an employee starts processing a life event using self-service or an Open Enrollment activity, an
instance of the event is stored in the system so that the employee can continue the event later. When the
event is completed, the instance is deleted. If an employee started a life event or an Open Enrollment
activity unintentionally, and had not deleted or canceled the event, the Benefits Administrator can delete
the event using the Manage Benefits Instances page.

Note: The Manage Benefits Instances page is only for the use of the Benefits Administrator for
maintenance purposes. Before deleting any life event or an Open Enrollment activity using this page,
ensure that the event is not required and is not in use.

Page Used to Manage Benefits Instances

Page Name Definition Name Usage

Manage Benefits Instances Page W3EB_LE_INSTANCE Delete benefits instances (for example,
 Life Events and Open Enrollment
activity guide instances) that are no
longer required.
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Manage Benefits Instances Page
Use the Manage Benefits Instances page (W3EB_LE_INSTANCE) to delete benefits instances (for
example, Life Events and Open Enrollment activity guide instances) that are no longer required.

Navigation:

Benefits >Manage Benefits Instances >Manage Benefits Instances

This page enables the Benefits Administrator to manage Benefits Instances in progress.

Filters

Field or Control Description

Template Select the template on which the benefits instances to be
filtered are based on.

Display Instances with Items On or Older Than Enter a date to filter benefits instances with event dates on or
before the specified date.

Display Instances Created By Select to filter benefits instances created by a specific
employee.

Display Instances Administered By Select to filter benefits instances administered by a specific
Benefits Administrator.

Active Select to include active benefits instances in the filter.

Inactive Select to include inactive benefits instances in the filter.
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Field or Control Description

Filter Click to filter benefits instances based on the specified criteria.

Reset Reset the fields to create a new filter.

Activity Guide Instances

Field or Control Description

Title Title of the benefits instance.

Template Template on which the benefits instance is based.

Status Status of the benefits instance.

User ID User ID of the employee who created the benefits instance.

Last Updated Date Date on which the benefits instance was last updated.

Delegating Life Events Document Approval Using Fluid
Delegations

These topics describe how to use the fluid delegation framework to enable a Benefits Administrator to
authorize another person to approve Life Events documents on his/her behalf.

Related Links
"Understanding Delegation" (Enterprise Components)
"Working with Self-Service Delegation" (Enterprise Components)

Pages Used to Delegate Life Events Document Approval Using Fluid
Delegations

Page Name Definition Name Usage

"Manage Delegation Page" (Enterprise
Components)

EODL_LANDING_FL View the delegation activity associated
with a user.
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Page Name Definition Name Usage

"Manage Delegation - Learn More
about Delegation Page" (Enterprise
Components)

EODL_DLGT_INSTR_FL View help for delegation. You can
view an instructive description of the
delegation functionality.

"Create Delegation Request - Delegation
Dates Page" (Enterprise Components)

EODL_DLGRQST_DT_FL Enter delegation dates by specifying
the From Date and To Date, which
defines the delegation authority period
for a transaction. You can create an open-
ended delegation by not specifying a To
Date.

"Create Delegation Request - Delegates
Page" (Enterprise Components)

EODL_PROXY_SEL_FL Select a delegate.

"Create Delegation Request -
Transactions Page" (Enterprise
Components)

EODL_TRANS_SEL_FL Select one or more transactions for
delegation.

"Create Delegation Request - Review
and Submit Page" (Enterprise
Components)

EODL_DLGRQST_SM_FL Review and submit a delegation request.

"My Delegates Page" (Enterprise
Components)

EODL_MY_PROXIES_PG Manage delegates/proxies for delegation.

Understanding Document Approval Delegation
A Benefits Administrator can delegate the authority to approve Life Events documents uploaded by
employees to another user if required. The Life Events document approval workflow integrates with the
HCM Delegation Framework (Classic) and HCM Fluid Delegation Framework, thus enabling the Benefits
Administrator to delegate authority of Life Events document approval. The Benefits Administrator can
create a delegation request to allow a delegate to approve Life Events documents on his/her behalf. The
Benefits Administrator can set a date range for the delegate to complete the delegation request. The
delegate can accept or reject the delegation request, and can approve, deny, or push back the Life Events
document on behalf of the delegator. The delegator can revoke or withdraw the delegated authority when
required.

Email notifications will be sent to the delegator when new delegation requests are made. The delegate will
in turn be notified of any pending approval requests through email.

The following terms are important to understand the delegation feature:

• Delegation: The act of giving the authority to approve Life Events documents to another user.

• Delegator: A person who delegates authority to another user.

• Delegate/Proxy: A person who is granted the authority to act on behalf of the delegator.

• Delegated Authority: The rights and privileges that are given from the delegator to the delegate.
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• Delegation Request: A request from the delegator to the delegate to take on delegated authority.

• Delegation Period: The time range in which the delegated authority is in effect.

• Delegation Administrator: The system administrator who is responsible for configuring, managing,
and maintaining delegated authorities.

• Revoke: When a delegator withdraws delegated authority.

Note: To prevent situations of cascading or circular delegation chains, once the delegation framework
passes delegated authority over an absence transaction to a delegate, the delegate cannot delegate
authority over that transaction to another user. The delegation framework only passes authority over
transactions from the initial delegator to the initial delegate.

Reviewing Delivered Document Approval Delegation Setup
The delegation framework for Life Events document approval is delivered with the system. To review this
framework:

1. Review the delegation transaction for workflow on the "Workflow Transactions Page" (Enterprise
Components).

2. Review the delegation permission list and role through PeopleTools Security components.

3. Review the delegation transaction on the "Configure Delegation Transaction Page" (Enterprise
Components).

Reviewing the Delegation Workflow Transaction

The PeopleSoft system delivers a pre-configured transaction for the Life Events document approval
delegation framework. This table lists the delivered delegation transaction:

Transaction Name Transaction Type Description

W3EB_APPR_SUMMARY Approve Delegate approval of Life Events
documents.

Use the Approval Workflow Engine (AWE) and Delegation Transactions grid to register self-service
transactions that use the AWE framework and delegation framework. The data that you enter into this grid
links the transaction name and accompanying tables for HCM self-service transactions to the approval
process IDs that you create for these transactions on the Register Transactions page.

Reviewing the Permission List and Role for Delegation

PeopleSoft Enterprise Components delivers the permission list and role that are required for the
Delegation framework as system data. This table describes the delivered permission list and role for the
delegation framework:
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Role Name Attached Permission List Description

Delegate Manage Appr Document HCCPDL2068 Enables a user to access the components
to approve employee Life Events
documents on behalf of another user
when the authority is delegated.

Reviewing the Delegation Transaction

This table lists the delegation transaction delivered for Life Events document approval:

Transaction Name Transaction Type Role

Manage Approve Document Approve Delegate Manage Appr Document

Steps to Set Up a Delegation Request
A delegator follows these steps to delegate Life Event document approval requests using self-service:

1. Navigate to the Manage Delegation page.

2. Click the Create Delegation Request hyperlink.

3. Enter the From Date and To Date for the delegation request, and then click the Next button.

4. Review the delegates list and select a delegate to whom the authority for document approval will be
delegated.

5. Select the transaction(s) to delegate authority. For Life Event document approval delegation, select the
Approve Life Event Documents transaction. Click the Next button.

6. Review the delegation details and then click Submit.

7. View the confirmation message and click OK.

Delegating Document Approval Requests
Life Events document approval delegation enables the Benefits administrator to:

• Create a delegation request to allow a delegate to approve the document on his/her behalf.

• Review the list of transactions delegated and the delegate assigned for each transaction.

• Revoke or withdraw the delegated authority when required.

The following illustrations display the steps to delegate authority for employee Life Event document
approval:
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Managing Delegations

Use the Manage Delegation page to create a delegation request.

This example illustrates the fields and controls on the Manage Delegation page.

Entering Dates for the Delegation Request

Use the Delegation Dates page to select the date range for delegation.

This example illustrates the fields and controls on the Delegation Request — Delegation Dates page.

Selecting Delegates

Use the Delegates page to select the delegate to whom the authority of document approval should be
delegated.
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This example illustrates the fields and controls on the Delegation Request — Delegates page.

Selecting Transactions for the Delegation Request

Use the Transactions page to select the transaction to be delegated authority. Select the Approve Life
Event Documents transaction for Life Events document approval delegation.
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This example illustrates the fields and controls on the Delegation Request — Transactions page.

Viewing Delegation Detail

Use the Review and Submit page to review the transactions selected for delegation and submit the
delegation request. On submitting the request, the system automatically sends an email notification to the
delegate to review and either accept or reject the delegation.
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This example illustrates the fields and controls on the Delegation Request - Review and Submit page.

Viewing Delegates

Use the My Delegates page to view all the delegates for the delegation request. Additionally, use the My
Delegates page to revoke any of the delegated transactions at any point in time during the delegation
period.

This example illustrates the fields and controls on the My Delegates page.

Viewing Delegation Authorities

After the delegate receives the email notification for the delegation request, he/she can access the My
Delegated Authorities page to accept or reject the request.

Use the My Delegated Authorities page to manage delegated authorities.
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This example illustrates the fields and controls on the My Delegated Authorities page.

Selecting the Role for Document Approval

When approving employee Life Event documents, use the Select Role page to determine whether to
process your own employee document approval transactions or the delegated approval transactions.

This example illustrates the fields and controls on the Select Role page.

Click Continue to navigate to the Approve Document Upload page to approve Life Event documents. For
more information, see section "Approving Life Event Documents Using Fluid Approvals" (PeopleSoft
eBenefits).

Managing Delegation Authorities
To maintain delegations and update any invalid rows, the HCM Delegation Administrator needs to run the
Manage Delegated Authorities process on a daily basis.

Use the Maintain Delegation Authority page to run the Manage Delegated Authorities process.
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This example illustrates the fields and controls on the Maintain Delegation Authority page.

Run the Manage Delegated Authorities process to:

• Update the request status and delegation status.

• Revoke all delegation requests that have expired as of the current date.

• Search for and update inactive delegates/proxies.

• Insert or delete delegation permissions within the delegate’s role.
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Managing Savings Plans

Understanding Savings Plan Management

The Savings Management (SAVINGS_PLANS) component enables the user to review, override, and
extend government regulated limits for qualified savings plans. The Manage Base Benefits business
process provides the following limit extensions and adjustments.

• 402(g) 15-year catch-up extension for 403(b) plans.

• 457 3-Yr catch-up extension for 457 eligible governmental plans.

• 402(g) Age-50 extension for 401(k) and 403(b) plans.

• 457 Age-50 extension for 457 eligible governmental plans.

• 401(a) eligible earnings adjustment for 401(k), 403(b), and 457 plans.

• 402(g) hardship withdrawal limit reduction.

The following diagram illustrates the process flow for managing savings plans from calculating 403(b)
and 457 extensions and identifying age-50 extensions:

For additional information, see:

Understanding the Core Tables for PeopleSoft Manage Base Benefits

Setting Up Limits for Qualified Savings Plans

Calculating 403(b) and 457 Extensions

This section provides an overview of 403(b) and 457 extensions and discusses how to run the 403(b) and
457 extensions process.

Copyright © 1988, 2022, Oracle and/or its affiliates. 347



Managing Savings Plans Chapter 12

Pages Used to Calculate 403(b) and 457 Extensions

Page Name Definition Name Usage

Calculate 403(b) Extensions Page RUNCTL_SV403B Calculate the company's or an individual
employee's balances for service years,
eligible earnings, and projected limits for
the current or next year.

Employees don't need to be enrolled
in the 403(b) Savings Plan to run the
Balance process. This process updates
the Savings Management page.

Review 403(b) Process Messages SV403_MESSAGES Review any error message that was
issued during the savings management
process.

Understanding the 403(b) and 457 Extensions
The Savings Management Balances process updates year-to-date and life-to-date balances for 403(b) and
457 plans and records them on the Savings Management Balances page. The process uses the balances
on the savings management record for the prior year and current year payroll IT'D deduction balances to
update the current year's record each time the process is run. It also uses the prior year's record to update
the service year's LTD field. (The first run of each year is slightly different because it deselects some
fields and carries over others.)

The Savings Management process does not update current year deduction balances on the Savings
Management record until PeopleSoft Payroll for North America is confirmed and the process is run.

The Savings Management Balances process creates 403(b) limit extension records for all employees in
the specified company in PeopleSoft Payroll for North America. The records produced are identified as
Limit Type 402, Limit Extension Type A. If an employee has 15 or more years in a 403(b) plan, the limit
extension amount (EXT_AMOUNT) is populated by the 402(g) Annual Cap Expansion amount on the
403(b) Limit Table. If the employee has fewer than 15 years of service, the EXT_AMOUNT is zero.

The Savings Management Balances process creates 457 limit extension records only if the employee
had 457 balances in the previous year or, if this is the first year of enrollment in a 457 plan, after the first
payroll is confirmed and the process is run. The records produced are identified as Limit Type 457, Limit
Extension Type A. The EXT_AMOUNT is used in the calculation of the three-year catch-up. It is empty
until the employee is eligible for the catch-up. You must manually enter the EXT_AMOUNT. The amount
entered is the employee's underutilized amount that is applicable.

Note: PeopleSoft software requires you to maintain your own records for underutilization. When an
employee is enrolled in more than one 457 plan, you must determine which plan's underutilized amount is
used.

To monitor 403(b) and 457 plan balances:

1. Run the Calculate 403(b) Extensions process on the Savings Management Balances page
(RUNCTL_SV403B) to create the initial 403(b) row. The process creates the initial row on the
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Savings Management page and is identified with a limit type of 402(g). The Exception Reason A —
Catch Up Extend Limit is reflected.

The SavingsManagement row for 457 plans is identified with a limit type of 457. The Exception
Reason A — Catch Up Extend Limit is reflected.

2. Make any adjustments that should be considered during the 403(b) calculation process using the
403(b) Adjustments page.

3. After each confirmed payroll period, run the Calculate 403(b) Extensions process on the Savings
Management Balances page (RUNCTL_SV403B) to update balances for both the 403(b) and 457
plans.

4. Review employee contributions and deferrals on the 403(b) Adjustments page for 402(g) Catch-up
Limit Extension Type.

5. Review 403(b) error messages.

This process creates a single 403(b) record for employees in PeopleSoft Payroll for North America. If an
employee has fewer than 15 years of service, the extension amount is 0. If an employee has 15 years or
more of service, the extension amount is equal to the 402(g) Annual Cap Expansion amount on the 403(b)
Limit Table.

The process deselects the Ext Election (extend election) check box. If the election extension check box is
selected at year-end, the process deselects it when run in the subsequent year.

Related Links
Setting Up Limits for Qualified Savings Plans

Calculate 403(b) Extensions Page
Use the Calculate 403(b) Extensions page (RUNCTL_SV403B) to calculate the company's or an
individual employee's balances for service years, eligible earnings, and projected limits for the current or
next year.

Employees don't need to be enrolled in the 403(b) Savings Plan to run the Balance process. This process
updates the Savings Management page.

Navigation:

Benefits > Monitor Savings Pln Extensions > Calculate 403(b) Extensions > Calculate 403(b)
Extensions
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This example illustrates the fields and controls on the Calculate 403(b) Extensions page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Chk Point Interval in Minutes  (check point interval in
minutes)

Because this is a long process, you can indicate how often
the system should save or update information to the database
during the process.

In case of unexpected system failure, this could limit the
amount of reprocessing that the system would have to repeat.

Restart Employee ID  and Process to Restart The system enters the last successful employee ID processed if
the process did not successfully finish.

The Calculate 403(b) Extensions process deselects the Ext Election (extension election) field on the Limit
Exceptions grid. You can manually reset this value.

The 402(g) catch-up record is generated for all employees in PeopleSoft Payroll for North America.
If the employee has 15 or more years of service, the extension amount is supplied with the 402(g) cap
expansion from the 403(b) Limit Table. If the employee has fewer than 15 years of service, the extension
amount is zero.

The 457 catch-up record is produced only for employees in PeopleSoft Payroll for North America with a
457 record in the prior year or 457 deductions in the current year.

Identifying Age-50 Extensions

This section provides an overview of the Age-50 extension and describes how to run the Age-50 process.
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Page Used to Identify Age-50 Extensions

Page Name Definition Name Usage

Savings Plan Age-50 Extensions page BN_AGE50_RUNCTL • Identify employees in PeopleSoft
Payroll for North America who are
age 50 or more.

• Create Age-50 limit extension
records that increase the 402(g)
Savings Plan limits, 457 Savings
Plan limits, or both for elective
deferrals as authorized by IRS
regulations.

You run the process separately for each
limit type. For each limit type, a single
Age-50 extension record is produced for
each year for each eligible employee in
PeopleSoft Payroll for North America.
 The process changes the election to ON
by default.

Understanding Age-50 Extension
The Age-50 process produces two types of age 50 limit extension types. The process assumes that an
eligible employee has elected the age-50 extension. The election can be manually deselected on the
Savings Management page.

• Select the 402(g) option for 401(k) plans, 403(b) plans, or both. One record with Limit Type 402,
Limit Extension Type B is produced for any employee in PeopleSoft Payroll for North America who
is age 50 or more by the date specified on the run control.

• Select the 457 option for 457 plans. One record with Limit Type 457, Type B is produced for any
employee in PeopleSoft Payroll for North America who is age 50 or more by the date specified on the
run control.

The Identify Age-50 Extensions process:

• Identifies the employees in PeopleSoft Payroll for North America who are age 50 or more.

• Creates Age-50 limit extension records that increase the 402(g) Savings Plan limits, the 457 Savings
Plan limits, or both for elective deferrals as authorized by IRS regulations. The limit extension records
are displayed on the Limit Exceptions grid.

• Always selects the Ext Election (extend election) field on the Limit Exceptions grid. This value can
be reset manually.

Age-50 records can be added manually. For employees who are not eligible for either a catch-up or
Age-50 extension, the added record can be used to enter either of the following override amounts:

• 402(g) limit amount override amount on the Age-50 402(g) row.

• 457 limit amount override amount on the Age-50 457 row.
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To set up the Age 50 catch-up for an employee through the Savings Management table, enter the
employee ID and add the extension limit (for example, $5500). Alternatively, run the Identify Age 50
Extensions process for the appropriate annual cap expansion amount.

Savings Plan Age-50 Extensions page
Use the Savings Plan Age-50 Extensions page (BN_AGE50_RUNCTL) to you run the process separately
for each limit type.

For each limit type, a single Age-50 extension record is produced for each year for each eligible employee
in PeopleSoft Payroll for North America. The process changes the election to ON by default.

Navigation:

Benefits > Monitor Savings Pln Extensions > Savings Plan Age-50 Extensions > Identify Age-50
Extensions >Savings Plan Age-50 Extensions

This example illustrates the fields and controls on the Savings Plan Age-50 Extensions page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

As Of Date Enter the last day of the calendar year for which the Age-50
extension applies.

402(g) Limit  and 457 Limit Select the limit extension that you want to run.

Two separate runs are required to produce each type of the
Age-50 limit extension.

Annl Cap Expsn (annual cap expansion) Enter the amount specified by the IRS.
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Managing Savings Plan Limits

This section discusses how to Manage Savings Plan Limits.

Pages Used to Manage Savings Plan Limits

Page Name Definition Name Usage

Benefits Savings Management Page SAVINGS_MGT_EE Review and update savings plan limits.
 Manage the 402(g), 457 and 401(a) limit
extensions and overrides for 401(k), 403
(b), and 457 Savings Plans. Suspend
savings plan contribution.

403(b) Adjustments Page SAVINGS_MGT_EE_SP1 Monitor 403(b) balances. Review the
year-to-date (IT'D) and life-to-date 
(LTD) balances from the 403(b) process,
 enter contributions made at another
company, and review an employee's
contribution amount for each applicable
limit.

457 Adjustments Page SAVINGS_MGT_EE_SP2 Monitor the 457 catch-up limit extension
and election for 457 plans.

Understanding Managing Savings Plan Limits
Use the Savings Management page to:

• Review 402(g) and 457 limit extension amounts.

• Manually enter 402(g), 457, and 401(a) limit extension amounts.

• Override limits.

• Manage hardship withdrawals.

Review 402(g) and 457 Limit Extension Amounts

Two processes are used to automatically generate 402(g) and 457 limit extension amounts. The processes
can be run for a company's employee population or for an individual employee. These are the processes:

• The Calculate 403(b) Extensions process generates both the 402(g) catch-up records and the 457
catch-up records when it runs.

• The Identify Age-50 Extension process generates either the 402(g) age extension or the 457 age-50
extension.

These system-calculated limits appear in the Limit Extensions group box on the Savings Management
page.
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Manually Enter 402(g), 457, and 401(a) Limit Extension Amounts

You can manually enter 401(a), 402(g), and 457 limit extension amounts by adding a row to the Limit
Extensions group box on the Savings Management page. Enter the company, calendar year, limit type,
and exception reason.

• If you select 401(a) as the limit type, the system automatically supplies Adjust Eligible Earnings IT'D
as the exception reason and you enter the adjustment amount.

• If you select 402(g) as the limit type and A, B, or H as the exception reason, enter the adjustment
amount.

Note: Use the 403(b) link to review and adjust data related to the catch-up limit.

• If you select 457 as the limit type and A or B as the exception reason, enter the adjustment amount.

Note: Use the 457 link to review and adjust data related to the catch-up limit.

Managing Overrides

The override capability on the Savings Management page affects only those deductions that are subject to
the 402(g) or 457 limits. The override function works like this for the two limits:

• The EXT_ELECTION must be selected (ON) for the override to be recognized.

• When the Age-50 process or the Calculate 403(b) Extensions process is run for a subsequent year, the
override amount will be cleared.

• The override fields on the SAVINGS_MGT_EE records are used instead of the 402(g) regular/
extended limit, the 457 regular/extended limit, or both.

• If the employee is not age 50, the client can manually add an Age-50 record to enter an override.

Multiple Expenses

• You cannot use the 403(b) catch-up and the Age-50 403(b) extension in the same year. If an extension
exists on both 402 Limit Type records, the sum of the extensions will apply to 403(b) plans.

• You cannot use the 3-year 457 catch-up and the Age-50 457 extension in the same year. If a value is in
the Extension Override, then this value is used; otherwise, the limit is calculated as the higher of the
three-year catch-up amount and the age-50 extension amount.

Example: Determining 3-Year Catch-Up Limit for 403(b) Plan

The following example illustrates limit determination when both 403(b) limit extension type records are
selected. The example uses the following parameters:

• Calendar Year 2006

• 403(b) 15 Year Catch up extension $3,000

• Age-50 extension $5,000

• 402(g) Maximum Yearly Deduction $15,000
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The 403(b) 15 Year catch up and the Age-50 extension can be used in the same year if the employee
is eligible. If an extension exists on both 402 Limit Type records, the sum of the extensions applies to
403(b) plans. If the employee qualifies for both extensions then (15,000 + 5,000 + 3,000) = $23,000.

Example: Determining the 3-Year Catch-Up Limit for 457 Plans

The following example illustrates limit determination when both 457 limit extension type (catch-up)
records are selected. The example uses the following parameters:

• Calendar Year: 2006

• 457 Limit: $15,000

• Max. Annual 457 Catch-up: $30,000

• Age-50 extension: $5,000

• Employee's Underutilized 457 Amount: $10,000

To determine the 3-Year Catch-up Limit, the system:

1. Determines the lesser of:

• Regular 457 Limit + Underutilized Amount (for example, $15,000 + $10,000 = $25,000)

• Max. Annual 457 Catch-up ($30,000)

2. Determines the higher of the 3-Year Catch-up Limit versus the Age-50 Catch-up Limit:

• The result from Step 1 (for example, $25,000) (This record is represented by LIMIT_TYPE 402,
LIMIT_EXT_TYPE A.)

• Regular 457 Limit + Age 50 extension (for example, $15,000 + $5,000 = $20,000) (This record is
represented by LIMIT_TYPE 402, LIMIT_EXT_TYPE B.)

3. The higher record, $25,000, in Step 2 is the override that is used when both catch-up records are
selected.

Manage Hardship Withdrawals

IRS regulations require that employee contributions be suspended for a period following a hardship
withdrawal from a qualified savings plan. To set the parameters for the employee contribution's
suspension due to hardship, use the Contribution Suspension group box on the Savings Management
page.

Use the 402(g) limit type with the Hardship - Reduce Limit exception reason to adjust the 402(g) limit
following a hardship withdrawal. Regulations require that the 402(g) dollar limit be reduced by the
amount contributed to the plan by the participant prior to the hardship withdrawal.

Benefits Savings Management Page
Use the Benefits Savings Management page (SAVINGS_MGT_EE) to review and update savings plan
limits.
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Manage the 402(g), 457 and 401(a) limit extensions and overrides for 401(k), 403(b), and 457 Savings
Plans. Suspend savings plan contribution.

Navigation:

Benefits > Enroll in Benefits > Benefits Savings Management

This example illustrates the fields and controls on the Benefits Savings Management page. You can find
definitions for the fields and controls later on this page.

Limit Exceptions

Field or Control Description

Company Select the company.

Calendar Year Select the calendar year.

Limit Type Select the limit type you want to adjust. Choose from:

• 401(a)

• 402(g)

• 457
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Field or Control Description

Exception Reason and  Description Select the reason for the exception. Choose from:

• A: This option is available if you select 402(g) or
457 in the Limit Type field. The Description field is
automatically populated with Catch Up Extend Limit.

• B: This option is available if you select 402(g) or
457 in the Limit Type field. The Description field is
automatically populated with Age 50 Extend Limit.

• E: This option automatically appears if you select 401
(a) in the Limit Type field. The Description field is
automatically populated with Adjust Eligible Earnings
Year to Date.

To give flexibility in controlling the eligible earnings, the
Limit Type 401(a) Adjust Eligible Earnings IT'D amount
can be used to adjust the eligible earnings accumulated in
a positive or negative amount. The special accumulators
used to define eligible earnings for the purpose of
measuring the 401(a) limit begin accumulating at the start
of the calendar year regardless of whether the employee is
contributing.

• H: This option is available if you select 402(g) in the
Limit Type field. The Description field is automatically
populated with Hardship Reduce Limit.

Extension Election If applicable, select this check box.
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Field or Control Description

Adjustment Amount (extension amount) For 403(b) plans, the amount displayed here represents the
15-year catch-up extension amount as generated by the 403
(b) process. This field is used as an extension to the 402(g)
limit when you select the Extension Election check box. The
system uses the lesser of the following three:

• The amount entered in the 402(g) Annual Cap
Expansion field located on the 403(b) Limit Table.

• The amount entered in the 402(g) Lifetime Cap
Expansion field located on the 403(b) Limit Table minus
the amount in the Life-To-Date 402(g) Cap Used field
displayed on the 403(b) Balances page.

• The employee's years of service multiplied by the amount
entered in the 402(g) Per Year Max Average field
located on the 403(b) Limit Table, minus the amount in
the Life-To-Date Employee Elective Deferrals 402(g)
field displayed on the 403(b) Balances page.

For 457 plans, the underutilized 457 plan amount for previous
years is entered here. The amount represents the three-year
catch-up extension amount.

Limit Amount Override The override amount entered here is used instead of the 402
(g) limit or extended 402(g) limit if the Ext Election option is
selected. It will apply to only 403(b) plans.

Updated On The system enters a date when new information is saved.

User ID The system identifies the user who updated the information.
 Options are:

• SYS, which indicates that either the Age-50, 403(b), or
457 processes created the record.

• <user ID>, which indicates that a user manually added
the row.

Contribution Suspension

Field or Control Description

Ben Record (benefit record)  Plan Type,  and Benefit Plan Select the desired plan type and benefit plan for which
contributions should be suspended.
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Field or Control Description

Start Date and End Date Indicate the dates through which to suspend the contributions.
 Indicate the tax class for which to suspend contributions.

Field or Control Description

Before Tax Select to suspend the employee's before tax contribution.

Field or Control Description

After Tax Select to suspend the employee's after tax contribution.

Field or Control Description

NonTaxable Btax Benefit Select to suspend the employer before-tax contribution.

Nontaxable Benefit Select to suspend the employer after tax contribution.

Field or Control Description

Taxable Benefit Select to suspend the employer after-tax contribution.

403(b) Adjustments Page
Use the 403(b) Adjustments page (SAVINGS_MGT_EE_SP1) to monitor 403(b) balances.

Review the year-to-date (IT'D) and life-to-date (LTD) balances from the 403(b) process, enter
contributions made at another company, and review an employee's contribution amount for each
applicable limit.

Navigation:

Click the 403(b) link on the Savings Management page.
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This example illustrates the fields and controls on the 403(b) Adjustments page. You can find definitions
for the fields and controls later on this page.

Balance Information

The system displays the IT'D and LTD balances calculated from the 403(b) process.

Balance Adjustments (This Company Only)

Use to enter employee contributions from a previous employer. The Calculate 403(b) Extensions process
uses these figures.

Field or Control Description

Elective Deferrals Adjustment,   Non-Elective Deferrals
Adjustment,  and Employee Contribution Adjustment

Enter the new amounts. Both the Calculate 403(b) Extensions
and Pay Calculations processes use these fields.

Vesting Adjustments Enter the new amount. Both the Calculate 403(b) Extensions
and Pay Calculations processes use these fields. A vesting
adjustment is considered to be a type of employer contribution,
 so it is used along with the Employer Contribution
YTD/LTD balance fields and the Employee Contribution
Adjustment field.
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General / Alternative Election Data (all Applicable Companies)

Field or Control Description

Override Service Years Calc  (override service years
calculation)

Select this check box if you need to override the system-
calculated Service Years IT'D field, the Service Year LTD
field, or both displayed on the 403(b) Projections page.

Employer Contribution Maximum This is the amount entered in the Maximum Yearly
Deduction field located on the 415(c) Limit Table.

Termination Date  (403[b] expected termination date) If applicable, enter the date.

Current Year Contribution Subject to 415 Limit This is the year-to-date deductions that are subject to the 415
(c) limit.

457 Adjustments Page
Use the 457 Adjustments page (SAVINGS_MGT_EE_SP2) to monitor the 457 catch-up limit extension
and election for 457 plans.

Navigation:

Click the 457 link on the Savings Management page.

This example illustrates the fields and controls on the 457 Adjustments page. You can find definitions for
the fields and controls later on this page.

457 Adjustments

This group box appears if you selected 457 in the Savings Plan Type field.

Field or Control Description

Other Employer Deferrals The amount deferred to a 457 plan with another employer
during the years of service with the current employer.
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Field or Control Description

457 IT'D Deferrals and 457 LTD Deferrals 457 year-to-date and life-to-date balances are automatically
maintained as part of the 403(b) Extensions process for those
employees who are enrolled in both a 457 and 403(b) plan.
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Managing FMLA Plans

Understanding FMLA Plan Administration

The FMLA (Family Medical Leave Act) protects benefits and job restoration for employees who take
a leave from work to care for themselves or family members. This law went into effect August 5, 1993,
and contains provisions regarding employer coverage, employee eligibility and entitlement, notice and
certification, continuation of health benefits, and job restoration.

Before you can actively manage FMLA information for your workforce, you must first activate FMLA
Administration and then define your organization's FMLA plans. Use the Installation Table and the
FMLA Plan Table to perform these steps. You also need to associate FMLA plans with benefit programs,
using the Benefit Program Table.

After setting up your plans, use their parameters to determine employee eligibility and to calculate
available FMLA leave.

Related Links
Setting Up FMLA Plans
Building Benefit Programs

Entering FMLA Leave Requests

This section describes how to enter FMLA Leave Requests.

Page Used to Enter FMLA Leave Requests

Page Name Definition Name Usage

Request/Authorize/Track Leave -
Request Page

FMLA_LV_REQUEST1 Request employee leaves for FMLA.

Request/Authorize/Track Leave - Request Page
Use the Request/Authorize/Track Leave - Request page (FMLA_LV_REQUEST1) to request employee
leaves for FMLA.

Navigation:

Benefits > Track FMLA (Family Medical Lv) > Request/Authorize/Track Leave > Request
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This example illustrates the fields and controls on the Request/Authorize/Track Leave - Request page.
You can find definitions for the fields and controls later on this page.

Field or Control Description

FMLA Request ID Displays an initial default value of NEW.

When the request is saved, the system assigns a unique FMLA
request ID. IDs are assigned sequentially from 001 to 999
within each employee record.

Note: If you are processing employees with multiple jobs,
 FMLA Administration does not use the employee record
number. The system tracks FMLA leave requests by individual
employees rather than by job.

Request

Field or Control Description

Request Date Enter the date on which the employee made the FMLA-
protected leave request.
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Field or Control Description

Begin Date Enter the first day of the employee's requested leave.

The system uses the begin date for any record that requires
an effective date. Because eligibility and entitlement can be
affected when the begin date is edited, you cannot edit it after
the request's approval status changes to approved or denied, or
after the request has been completed or canceled.

To change the begin date after one of these events has taken
place, change the approval status back to open, edit the begin
date, recalculate eligibility and entitlement with the Leave
Request Eligibility page, and manually adjust the leave
schedule.

Return Date Enter the date that the employee is scheduled to return from
leave.

The return date is not the day of FMLA protected leave, but
rather the first day of work after the leave is completed.

Select Expected/Open if the request is still pending or in
process.

Select Actual/Completed when the employee actually returns
from leave.

Time Requested For reference only.

Leave Reason Select the appropriate leave reason. You can add more valid
reasons through the PeopleTools Data Designer.

Leave Type Indicate the regularity of the requested leave.

• Continuous leave is unbroken full-day leave.

• Irregular leave is broken, but on a regular schedule, for
example, every Thursday and Friday for eight weeks.

• Irregular/Intermittent leave involves unspecified times
during the planned leave period.

Note: If you change this field after the leave is completed,
 the system displays a warning.
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Approval

Field or Control Description

Approval Status Specify whether the leave request is approved. When you
select Approved or Denied, the system automatically populates
the Approver and Apprvl Dt (approval date) fields with your
employee ID and the current date.

Note: You can approve requests for employees determined to
be ineligible for FMLA coverage.

Leave Canceled On If the employee cancels the leave request before taking any
leave, enter the date of this decision.

Do not use this field to indicate denial of the request or to
record the employee's early return from leave.

Monitoring Leave Requests
Use the Monitor Leave Requests Workflow process to locate new requests and notify the benefits
administrator through email. This flowchart illustrates the Monitor Leave Requests Workflow process:

This example illustrates the fields and controls on the Monitor Leave Requests Workflow. You can find
definitions for the fields and controls later on this page.

For additional information, see product documentation for PeopleTools: Workflow Technology.

Determining FMLA Eligibility

The system uses data from a selected FMLA plan, the leave request, and job and payroll information to
determine leave eligibility.

This section discusses how to determine eligibility.
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Page Used to Determine FMLA Eligibility

Page Name Definition Name Usage

Request/Authorize/Track Leave -
Eligibility Page

FMLA_LV_REQUEST2 Determine FMLA leave eligibility and
entitlement.

Request/Authorize/Track Leave - Eligibility Page
Use the Request/Authorize/Track Leave - Eligibility page (FMLA_LV_REQUEST2) to determine FMLA
leave eligibility and entitlement.

Navigation:

Benefits > Track FMLA (Family Medical Lv) > Request/Authorize/Track Leave > Eligibility

This example illustrates the fields and controls on the Request/Authorize/Track Leave - Eligibility page.
You can find definitions for the fields and controls later on this page.
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Field or Control Description

FMLA Plan ID (family medical leave act plan ID) Attach the FMLA leave request to a specific FMLA leave
plan. The system uses the parameters defined for the chosen
plan to calculate eligibility and entitlement values. You cannot
edit the FMLA plan ID after the request has been approved,
 denied, completed, or canceled.

If you change the FMLA plan ID when the approval status
is open and the Eligibility and Entitlement process has been
run, the system resets all fields associated with eligibility and
entitlement to their default values and displays a warning
informing you that eligibility and entitlement must be
reexamined.

Note: The default value for this field comes from the
employee's benefit program, but you can override it here.

Eligibility and Entitlement Click to start the eligibility and entitlement processes.
 These processes use employee job history, the FMLA plan
parameters, payroll data, and data on the Request page to
populate all of the other fields on the Eligibility page with
the exception of the Std Hours Override (standard hours
override) field.

Note: The Eligibility and Entitlement button is not available
if the prerequisite data for the leave request is not entered in
the Request page. It is also unavailable if the request's status is
completed, denied, or canceled.

FMLA Eligible Hours Displays the results of the system's determination of the
employee's FMLA eligible hours. The eligible hours are
defined as the hours worked during the 52 weeks before
the leave effective date. Depending on the rules that you've
established for the associated FMLA plan, the system
determines the eligible hours using either the employee's job
history or Payroll data. The system selects the Eligible check
box if the employee has worked enough hours to be eligible
for FMLA protected leave.

Note: The Eligible check boxes are indicators of the system's
determination based on the FMLA Plan rules, and are
informational only. They have no effect on your ability to
approve or deny the request.

FMLA Eligible Serv Weeks  (family leave medical act
eligible service weeks)

Displays the results of the system's determination of
the employee's FMLA-eligible service weeks. FMLA
Administration determines service weeks using information
from the employee's job history and the rules for the associated
FMLA plan. The system selects the Eligible check box if the
employee has worked enough service weeks to be eligible for
FMLA-protected leave.
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Field or Control Description

As of Requested Begin Dt  (as of requested begin date) Displays the weeks and hours of FMLA protected leave that
the employee is entitled to as of the leave's begin date.

To determine whether the request can be approved, compare
the values displayed here to the time requested in the
employee's FMLA-protected leave request.

As of Expected Return Date Displays the weeks and standard hours of entitled protected
leave remaining for the employee in the current FMLA year
as of the leave's expected return date. This value is used only
for leaves requested under plans that use a Roll-Backward
calendar year.

The Roll-Backward calendar is dynamic, such that a leave
request using it might appear to demand denial based on
an apparent lack of entitlement; however, the employee in
question could gain the necessary entitlement during the
course of the leave.

Original Hire Date,  Officer Code, and Stnd Hours / Week 
(standard hours per week)

The Job and Employment Data group box displays basic
job and employment information for the employee as of the
leave effective date and the last determination of eligibility and
entitlement.

The system enters the average number of hours that the
employee works per workweek as of the leave effective date in
the Std Hours/Week field.

Stnd Hours Override  (standard hours override) Sometimes system-computed standard hours values are not
accurate. Employees often request leave well in advance of
their leave's begin date, and part-time employees' weekly
hours can be variable.

Enter a new value when appropriate.

Note: This field does not affect eligibility or entitlement—the
system uses it only to more accurately convert between the
display of weeks and hours.

Related Links
Setting Up FMLA Plans

Scheduling FMLA Leave

This section describes how to schedule FMLA Leave.
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Pages Used to Schedule FMLA Leave

Page Name Definition Name Usage

Request/Authorize/Track Leave - History
Page

FMLA_LV_HISTORY Schedule and track FMLA leave.

Schedule Leave Days Page FMLA_LV_SCHED_DLG Create repeating weekly FMLA
schedules.

Mark Paid Leave Page FMLA_LV_PAID_DLG After creating a repeating schedule,
 designate specific days as paid leave.

Request/Authorize/Track Leave - History Page
Use the Request/Authorize/Track Leave - History page (FMLA_LV_HISTORY) to schedule and track
FMLA leave.

Navigation:

Benefits > Track FMLA (Family Medical Lv) > Request/Authorize/Track Leave > History

This example illustrates the fields and controls on the Request/Authorize/Track Leave - History page. You
can find definitions for the fields and controls later on this page.

Field or Control Description

Leave Summary Tracks the weeks and hours of FMLA-protected leave that are
scheduled and that have already been taken.

Entitlement Summary Tracks the total amount of FMLA protected leave that the
employee is entitled to (for all leaves, including the current
one).
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Field or Control Description

Schedule Leave Click to create template schedules for repeating leave.

Mark Paid Leave Click to designate a portion of the FMLA leave as paid leave.

Week Begin Date and  Sunday  through  Saturday Enter the start date of each scheduled week of FMLA-
protected leave and the hours of leave for each leave day.

To specify certain days of leave as paid leave, select the check
box for those days. (Some employers require that employees
use paid leave before they can use FMLA leave.)

Note: You can use these fields to manually schedule a leave
request on a day-by-day basis. You can also use it to adjust
a previously scheduled leave. If you use the automatic
scheduling capabilities of the Schedule Leave Days and Mark
Paid Leave pages (discussed later in this section), keep in mind
that the system overwrites previously scheduled days with the
template schedules that you design through these pages.

Schedule Leave Days Page
Use the Schedule Leave Days page (FMLA_LV_SCHED_DLG) to create repeating weekly FMLA
schedules.

Navigation:

Click Schedule Leave on the History page.

This example illustrates the fields and controls on the Schedule Leave Days page. You can find definitions
for the fields and controls later on this page.
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Field or Control Description

Weekly Template Enter the number of hours for each day in the schedule.

Repeat Template From and Through Enter the begin and end dates during which you want the
schedule to repeat. The leave request's scheduled begin and
return dates are the defaults.

Repeat Template For Select a time period for the schedule to repeat. If you select
an option other than Every Week, you can plan the intervening
weeks with separate rounds of scheduling.

For example, if you have an employee with four weeks of
FMLA leave, you can schedule the first and third weeks with
one Schedule Leave Days template that repeats for every other
week and starts on the first day of the first week. You can then
schedule the second and fourth weeks with another template.

Entitlement Displays the weeks and hours of FMLA leave that the
employee is entitled to.

Scheduled Displays FMLA leave hours currently scheduled for the
employee.

Unscheduled Displays FMLA leave weeks and hours remaining for the
employee. This value can be negative if more hours are
scheduled than are available to the employee.

Mark Paid Leave Page
Use the Mark Paid Leave page (FMLA_LV_PAID_DLG) to after creating a repeating schedule, designate
specific days as paid leave.

Navigation:

Click Mark Paid Leave on the History page.
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This example illustrates the fields and controls on the Mark Paid Leave page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Summary of Paid Leave Accrued Displays the various leave plan types and the hours accrued by
the employee.

The accrual date is current as of, and based on, the date when
the employee's FMLA leave request was submitted, which
means that the Hours Accrued values might be inaccurate by
the begin date of the leave.

Mark first (mark first [number of] scheduled days [number of
hours] as paid leave)

Enter the number of days to be considered as part of the
employee's paid leave.

The system assumes that the paid leave days are substituted
only for the beginning of the leave.

Only whole eight-hour days can be marked as paid leave days.
 The number of scheduled hours represented by those days can
be compared with the leave accrual balances, which are always
calculated as hours. When you enter a certain number of days
in this field, the number of hours that they represent appears in
the (Hrs) box.

When you return to the History page, days that you selected as
paid leave days have their check boxes selected.

Tracking FMLA Activity

You can record significant events that affect FMLA leaves, such as employee inquiries, requests for
extensions, and the sending and receiving of notices and medical documents. This information is for
reference only; it does not affect processing.
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Page Used to Track FMLA Activity

Page Name Definition Name Usage

Request/Authorize/Track Leave -
Activity Page

FMLA_LV_ACTIVITY Log events that affect an FMLA leave.

Request/Authorize/Track Leave - Activity Page
Use the Request/Authorize/Track Leave - Activity page (FMLA_LV_ACTIVITY) to log events that affect
an FMLA leave.

Navigation:

Benefits > Track FMLA (Family Medical Lv) > Request/Authorize/Track Leave > Activity

This example illustrates the fields and controls on the Request/Authorize/Track Leave - Activity page.
You can find definitions for the fields and controls later on this page.

Field or Control Description

Activity Date and  Activity Type More than one activity type can occur on the same date, but
only one type can be entered per dated row.

You can add or change activity types with the PeopleTools
Data Designer.

Follow Up Required Specify whether the activity requires follow-up action (as in
the case of requests for medical certification, for example).

Note: This is informational. You can create queries against this
field to report upcoming events.

374  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 14

Managing Leave Plans

Understanding the Leave Process

The purpose of leave accrual processing is to maintain employee leave balances. When you initiate leave
accrual processing, the system calculates the leave accrual award and the resulting leave balance.

To properly process leave accruals, the system needs to obtain information from your payroll system,
including hours taken, hours adjusted, hours bought, hours sold, and service hours for each employee
involved in the process. If your organization implements PeopleSoft Payroll for North America, the
system gets this information from Payroll for North America during the normal run of the process.

The system processes leave accruals depending on how you define your leave accrual plans. You can base
how you want employees to earn leave on one of two things: the length of the service they've provided to
your organization or the total number of hours they've worked.

You can accrue leave based on length of service without using payroll data because the system refers to
the Employment Data Table for each employee's service date. However, if you're planning to accrue leave
based on service hours, your system needs to obtain data from your payroll application to determine how
many hours a particular employee has worked.

Related Links
Setting Up Leave Plans
Understanding the Vacation Buy/Sell Process

Processing Leave Accruals

To process leave accruals:

1. Set up operating parameters for an accrual cycle on the Calculate Periodic Accrual run control page.

2. Run the Leave Accrual process with the Process Scheduler.

Page Used to Process Leave Accruals

Page Name Definition Name Usage

Leave Accrual Process Page RUNCTL_ACCRUAL Set up the operating parameters for an
accrual cycle.
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Leave Accrual Process Page
Use the Leave Accrual Process page (RUNCTL_ACCRUAL) to set up the operating parameters for an
accrual cycle.

Navigation:

Benefits > Manage Leave Accruals > Leave Accrual Process > Leave Accrual Process

This example illustrates the fields and controls on the Leave Accrual Process page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Run Control ID The system prompts you to enter an existing ID or add a new
one

Company Enter the company that you want to process. You can leave
this field blank, which means that employees in all companies
will be processed for the specified plan type and benefit plan.

Plan Type  and  Benefit Plan Enter the plan type and benefit plan that you want to process.

Last Process Date Displays the date that you last ran the Leave Accrual process
for this plan type and benefit plan.
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Field or Control Description

Accrual Process Date Date upon which you want the leave accrual calculations to be
based. The system automatically sets the accrual process date
to the current date, but you can change it as long as the date
that you enter is later than the last process date.

Process leave accruals for a given company, plan type, and
benefit plan for a maximum of once per accrual process date
and for a minimum of once per the award frequency that
you've defined on the Leave Plan Table. The leave accrued is
awarded only once per the award frequency for each employee
participating in the plan as of the accrual process date, but all
other leave processing—the maintenance of the leave taken,
 leave adjusted, leave bought, and leave sold balances—takes
place each time that you run the Leave Accrual process.

Note: The Leave Accrual process processes all employees
who are currently enrolled in the selected plan type and benefit
plan. It does not check the employment status of the employee.

For example, suppose your leave balance available is 10
hours, your unprocessed leave taken is 8 hours, your award
frequency is the first run of the month, your last process date
is November 1, 2003, and you run the Leave Accrual process
with an accrual process date of November 15, 2003. In this
case, no leave is awarded, but the unprocessed leave taken is
moved from unprocessed data to the leave accrual balances
and the resulting leave balance available is 2 hours.

Viewing Employee Balances

View the results of leave accrual processing for an employee using the Leave Accrual page. You can print
a report. Employees can also view their leave balances through PeopleSoft ePay or the PeopleSoft HCM
Portal Pack 9.1 PeopleBook

See PeopleSoft ePay 9.1 PeopleBook

See PeopleSoft HCM Portal Pack 9.1 PeopleBook.

Page Used to View Employee Balances

Page Name Definition Name Usage

Review Leave Accrual Balances Page LEAVE_ACCRUALS View employee leave balances.

Review Leave Accrual Balances Page
Use the Review Leave Accrual Balances page (LEAVE_ACCRUALS) to view employee leave balances.
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Navigation:

Benefits > Manage Leave Accruals > Review Leave Accrual Balances > Review Leave Accrual
Balances

This example illustrates the fields and controls on the Review Leave Accrual Balances page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Accrual Date The last date that you initiated a leave accrual for this
employee.

Accrual Balances - Hours

Field or Control Description

Carried over from previous year This field is updated only during the first run of the year.

Earned Year-to-Date Maintains the accrued leave awarded and is updated only once
per award frequency. If you find that you need to modify the
earned year-to-date balance, use the earnings code that you
defined to adjust the accrual balance on Earnings Table 4.

Taken Year-to-Date,   Adjusted Year-to-Date,   Bought
Year-to-Date,  and  Sold Year-to-Date

Updated each time the Leave Accrual process is run and
values are moved from the corresponding Unprocessed Data
fields.
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Accrual Totals

Field or Control Description

Hours Balance The employee's current accrued time available.

The system calculates the Hours Balance by totalling:

(Carried Over from Previous Year) + (Earned Year-to-Date)
− (Taken Year-to-Date) + (Adjusted Year-to-Date) + (Bought
Year-to-Date) − (Sold Year-to-Date) − (Unprocessed Hours
Taken) + (Unprocessed Hours Adjusted) + (Unprocessed
Hours Bought) − (Unprocessed Hours Sold).

Hours Value Current monetary value of the hours balance.

The system calculates the hours value, or value of the unused
hours, by multiplying the leave balance by the current hourly
rate for hourly employees or the hourly equivalent for salaried
employees.

Service Data

Field or Control Description

Service Date The date used for length-of-service calculations when the
service unit is defined as Months.

Service Hours The number of hours used for length-of-service calculations
when the service unit is defined as Hours.

Unprocessed Data

This group box displays the hours that you have not yet processed using the accrual process. These are
hours passed from the Payroll Pay Confirmation process since the accrual date.

Field or Control Description

Hours Taken,  Hours Adjusted, Hours Bought, and Hours
Sold

Updated each time the Pay Confirmation process is run.

Service Hours The Pay Confirmation process updates the service hours only
when the employee is participating in the leave plan as of the
pay end date.
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Managing Vacation Buy/Sell Plans

Understanding the Vacation Buy/Sell Process

This section outlines the vacation buy/sell process, which enables employees to buy or sell vacation time.

To process vacation buy/sell earnings:

1. Enroll eligible employees into vacation buy/sell benefit plans using the Vacation Benefits page and
enter their vacation buy and sell elections.

Employees normally elect to buy or sell vacation once at the beginning of the plan year. When an
employee buys vacation, your PeopleSoft HR system spreads the cost over the plan year, deducting
from employee pay based on the frequency that you define on the Deduction Table. The same is true
for vacation sell. The system refunds the money over the plan year according to the frequency that
you define.

2. Use PeopleSoft Payroll for North America during the first payroll cycle of the plan year to calculate
the effect of the buy or sell transaction on the employee's leave balance.

3. Run the Leave Accrual process, which updates employee leave balances with the results of the buy or
sell transaction.

Working with Mid-Year Buy or Sell Transactions

In the Manage Base Benefits business process, if an employee elects to enroll in a Vacation Buy/Sell
plan at a time other than the beginning of the plan year, you have to calculate the buy or sell amount to
be deducted from or added to employee pay, spread out over the remainder of the plan year. Enter this
amount in the Vacation Benefits page.

In PeopleSoft Benefits Administration, the system calculates the per-pay-period amount based on the
beginning of the plan year. If an employee buys or sells vacation at another time, you need to calculate the
buy or sell amount to be deducted from or added to employee pay, spread out over the remainder of the
plan year. Then override the amount calculated by the system on the Vacation Benefits page.

Related Links
Setting Up Vacation Buy/Sell Plans
Setting Up Deduction Codes
Understanding the Leave Process
"Understanding the Benefits Administration Preparation Process" (PeopleSoft Benefits Administration)

Reviewing Vacation Buy/Sell Calculation Results

This section describes how to review vacation buy/sell calculation results.
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Page Used to Review Vacation Buy/Sell Calculation Results

Page Name Definition Name Usage

Vacation Benefits Page VACATION_BENEFIT Review leave accrual processing status
for a specific employee.

Related Links
Auditing Your Benefit Information

Vacation Benefits Page
Use the Vacation Benefits page (VACATION_BENEFIT) to review leave accrual processing status for a
specific employee.

Navigation:

Benefits > Enroll In Benefits > Vacation Benefits > Vacation Benefits

This example illustrates the fields and controls on the Vacation Benefits page. You can find definitions for
the fields and controls later on this page.

When you enroll an employee, the system deselects the Vacation Accrual Processed check box.
Vacation Accrual Processed is selected after payroll has been processed for the employee and the Leave
Accrual process has been run.

Viewing the Number of Vacation Hours Bought or Sold
During the first payroll run for the employee after enrollment, PeopleSoft Payroll for North America
creates other earnings data for the total vacation bought or sold hours. This data is used for accrual
purposes.
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You can view the other earnings data on the employee's paysheet in the Manage Payroll Process page. For
example, if an employee sells 10 hours of vacation, Payroll for North America creates other earnings data
to reflect the 10 hours, using the earnings code that you defined in the Vacation Buy/Sell Table for the
vacation sell benefit plan.

Note: You can also see the total number of hours bought and sold using the Benefits Summary page.

Related Links
"Understanding Compensation Rates" (PeopleSoft Payroll for North America)
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Chapter 16

Managing Benefits Billing

Understanding Benefits Billing

You use Benefits Billing to process billing for employees and dependents who are charged directly for
benefit plan elections instead of paying through payroll deductions. You can use Benefits Billing for
either regular benefits or COBRA benefits.

Prerequisite
Before you begin using the Benefits Billing feature, set up the rules for benefits billing.

Related Links
Setting Up Benefits Billing
Understanding the Core Tables for PeopleSoft Manage Base Benefits

Understanding the Billing Calculation Process

The Billing Calculation process creates billing charge records for a selected billing calendar. Each billing
charge record contains charge information for an individual plan type and billing period combination.

The system queries the Manage Base Benefits business process tables to determine the coverage that is
in effect for the plan type as of the end date of the billing calendar. It passes the coverage code and other
relevant data to the Deduction Calculation (DedCalc) programs. The DedCalc programs calculate the
billing amount using normal rules, which the billing system then modifies based on the rate qualifier.

Rerunning the Billing Calculation Process

Just as with PeopleSoft Payroll for North America, you can rerun billing calculations repeatedly for
a given billing calendar until you print billing statements for that calendar. The system backs out any
previously calculated charges as well as any open credit that it applied previously to the charges.

The system cannot reprocess charges for a billing calendar if you have made adjustments to the charges or
have applied payments.

Retroactive Processing

When retroactive processing is called for, the Billing Calculation process compares:

• Billing calendar dates.

• The date that billing begins for the plan type.
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• The dates of any charge records for the plan type.

The system then generates retroactive billing charge records for all previous billing periods that:

• Have passed since the billing begin date.

• Do not have billing charge records.

Billing Calculation Limitations

The Billing Calculation process calculates payments based on employee enrollments in the Manage
Base Benefits business process tables and the rates that are specified in benefit programs. The Billing
Calculation process does not:

• Include any offset from credits when calculating deductions.

You enter flat amounts into Billing Enrollment records to simulate the use of credits.

• Calculate imputed income or any other taxable or nontaxable benefit calculations.

The process calculates before-tax and after-tax deduction classifications only.

• Bill benefit programs, leave plans, and vacation buy and sell plans (plan types 01, 5x, and 9x).

• Update any deduction or other payroll balances.

You have to do this manually. Not making these adjustments can affect imputed income reporting,
savings plan limit testing, and flexible savings plan (FSA) claims processing.

• Check group limits on life and AD/D insurance plans.

The Billing Calculation process bills only flat-dollar amounts for savings plans, FSA plans, retirement
plans, and pension plans (plan types 4x, 6x, 7x, and 8x).

Enrolling Participants

This section discusses how to enroll participants and override Benefits Billing parameters for individual
enrollees.

Pages Used to Enroll Participants

Page Name Definition Name Usage

Enroll in Benefits Billing Page BILL_ENROLL Enroll participants manually into the
Benefits Billing system and update
previous enrollments.
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Page Name Definition Name Usage

Billing Hold/Alternate Address Page BILL_EMPL_PARM Override Benefits Billing parameters
at the individual enrollee level. Set
up comments, designate an alternate
address, or hold statements for an
individual enrollee.

Locating Eligible Participants
A typical Benefits Billing population might include:

• Employees on leave without pay.

• Employees on reduced schedules who do not earn enough to pay for coverage.

• Retirees who continue company-sponsored coverage.

• Terminated employees who are enrolled in COBRA.

• Dependents of employees who are enrolled in COBRA.

• Survivors of deceased employees and retirees.

Note: Dependents of active employees cannot be billed through Benefits Billing. Only dependents who
have been given a nonemployee status through COBRA processing or some other means can be enrolled
in Benefits Billing.

Enrolling Participants Automatically
If you currently implement PeopleSoft Benefits Administration, you can use Event Maintenance
processes to locate employees and dependents who are eligible for Benefits Billing and enroll them into
the Benefits Billing system.

You can also use COBRA Administration processes to locate and enroll COBRA participants who are
eligible for Benefits Billing.

Related Links
Understanding COBRA Management
"Defining Event Rules" (PeopleSoft Benefits Administration)

Enroll in Benefits Billing Page
Use the Enroll in Benefits Billing page (BILL_ENROLL) to enroll participants manually into the Benefits
Billing system and update previous enrollments.

Navigation:

Benefits > Benefits Billing > Manage Acct Status and Balance >Enroll in Benefits Billing > Enroll
in Benefits Billing
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This example illustrates the fields and controls on the Enroll in Benefits Billing page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

ID When you first enter the Enroll in Billing page, you are
prompted for the ID of the employee whom you want to enroll
or update.

You cannot create Benefits Billing enrollment records that
cover all of an employee's multiple jobs at once.

Plan Type You can enter multiple plan types, including:

• Simultaneous active and COBRA billing enrollments.

• Multiple COBRA billing enrollments.

COBRA Event ID This value is automatically assigned by the COBRA batch
process, but can also be entered. The value is 0 for non-
COBRA billing.

Effective Date You can have multiple effective-dated billing records for
COBRA and non-COBRA events.

Event Identification Indicates whether the record was created through Event
Maintenance or Open Enrollment. This field is for records
created through Benefits Administration processes only.
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Field or Control Description

Billing Status Controls billing calculations for each plan type. Values are:

Active:  You are billing the employee for this plan type.

Hold Billing: Charges are not calculated for this plan type. If
you change the status to Active after Hold Billing has been in
effect, the system retroactively calculates charges the next time
that you run the Benefits Billing calculation process. While
Hold Billing is selected for a particular plan type, the system
continues to bill for other plan types and continues to produce
statements.

Inactive: You are no longer billing for this plan type.

Billing Reason Identifies the source of the billing entry and the reason that the
employee is being billed; for reference only. Values are:

Manual: Indicates that you are entering the billing enrollment
record manually.

Arrears: Indicates that the participant cannot gross enough to
cover deductions.

If the system has automatically enrolled the employee
or dependent into Benefits Billing through Benefits
Administration or COBRA batch processes, the system selects
either Benefits Administration or COBRA to identify the
process by which this enrollment record was entered into the
system.

Percent Calculation  and Flat Amount Determine how to modify the deduction calculation for billing
purposes.

Select Percent Calculation to use the system deduction
calculation routines with either the normal Employee Rate or
the Total Rate to calculate the amount that is owed for each
billing period. The system then multiplies the calculated value
by the percentage that is entered. The percentage can be more
than 100 percent.

Select Flat Amount to add a dollar amount to the amount
calculated by the Percent Calculation settings. If the Percent
Calculation check box is deselected, the system bills the
employee the flat amount for each billing period. The amount
can be a negative number.

Related Links
Setting Up Calculation Rules

Billing Hold/Alternate Address Page
Use the Billing Hold/Alternate Address page (BILL_EMPL_PARM) to override Benefits Billing
parameters at the individual enrollee level.
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Set up comments, designate an alternate address, or hold statements for an individual enrollee.

Navigation:

Benefits > Benefits Billing > Manage Acct Status and Balance > Billing Hold/Alternate Address >
Billing Hold/Alternate Address

This example illustrates the fields and controls on the Billing Hold/Alternate Address page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Effective Date You can enter more than one set of override parameters per
employee and order them by effective date.

Hold Billing Select to halt billing for all plan types.

When you hold billing and run the Benefits Billing calculation
process, the system retroactively calculates charges that
occurred during the period that the hold was in effect.

Hold Statements Select to stop printing billing statements for this employee.

Comments Enter comments that are to be printed on upcoming billing
statements for this employee.

Calculating Charges

This section discusses how to calculate charges automatically, and manually for individual participants.
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Pages Used to Calculate Charges

Page Name Definition Name Usage

 Calculate Billing Charges Page BILL_RUNCTL Calculate charges automatically and
create billing charge records for a
selected billing calendar.

Enter Billing Manual Charges Page BILL_CHRG_ADD Manually post new billing charge records
to the system.

 Calculate Billing Charges Page
Use the Calculate Billing Charges page (BILL_RUNCTL) to calculate charges automatically and create
billing charge records for a selected billing calendar.

Navigation:

Benefits > Benefits Billing > Calculate and Review Charges > Calculate Billing Charges >
Calculate Billing Charges

This example illustrates the fields and controls on the Calculate Billing Charges page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Billing Period Select the period that indicates the billing calendar for which
you want to calculate benefits billing charges.

Note: You can rerun the Billing Calculation process until you
run the Statement Print process for that billing period.

Payment Due  and COBRA Payment Due Automatically populated with the dates that were defined for
this billing calendar. These fields can be modified if necessary.

Enter Billing Manual Charges Page
Use the Enter Billing Manual Charges page (BILL_CHRG_ADD) to manually post new billing charge
records to the system.

Navigation:

Benefits > Benefits Billing > Calculate and Review Charges > Enter Billing Manual Charges >
Enter Billing Manual Charges

This example illustrates the fields and controls on the Enter Billing Manual Charges page. You can find
definitions for the fields and controls later on this page.

You can use this page to enter a partial charge for an employee's first billing period and start automatic
billing for that employee in the next billing period. You can also use this page to enter a partial month
billing for the last billing period.

If you enter a Billing Charge record manually for an employee, the Billing Calculation process does
not automatically calculate the same billing period's charges for that employee. The Billing Calculation
process never deletes manual charge entries, even when the process is rerun for a particular billing period.
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Field or Control Description

Empl ID  (employee ID) Enter the ID of the employee who is to be billed.

Billing Period Select the billing period from the billing calendar.

Plan Type Determine the plan type.

(CAN) Sales Tax Canadian users can enter charges that represent various
Canadian sales taxes that are associated with another benefits
charge.

For example, a billing charge for a medical plan may have a
Canadian sales tax associated with it. You enter this tax as a
separate charge and identify the type of sales tax here.

This field can be used for the Goods and Services Tax (GST),
 the Provincial Sales Tax (PST), the Provincial Premium Tax 
(PPT), the Provincial Sales Tax on Insurance (PSTI), and the
Harmonized Sales Tax (HST).

Note: You always enter sales tax as a separate charge, because
this is the only way that the system can track it. On all Benefits
Billing pages dealing with benefits charges, sales tax charges
are identified with their sales tax type.

Charge Enter the total charge for this employee and billing period.

Note: After you save a charge entry record, you cannot directly change the amount of that charge. Any
changes must be made through the Adjust Charges page.

Reviewing Charges

This section discusses how to review charges.

Pages Used to Review Charges

Page Name Definition Name Usage

Charge Page BILL_CHRG_VW View how Benefits Billing charges
and payments add up for a selected
employee.

Charge Detail Page BILL_CHRG_DET View details of charge actions.
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Page Name Definition Name Usage

Charge Summary by Bill Period Page BILL_CSUM_BY_BPER Arranges a participant's charges by
billing period.

Charge Summary by Plan Type Page BILL_CSUM_BY_PTYPE Arranges a participant's charges by plan
type.

Charge Page
Use the Charge page (BILL_CHRG_VW) to view how Benefits Billing charges and payments add up for
a selected employee.

Navigation:

Benefits > Benefits Billing > Calculate and Review Charges > Review Billing Charge Details >
Charge

This example illustrates the fields and controls on the Charge page. You can find definitions for the fields
and controls later on this page.

Field or Control Description

Charge ID A system-generated number that ensures the uniqueness of
Billing Charge records.

CBR Evt ID (COBRA event ID) If this coverage is calculated under COBRA, provides a link to
the COBRA event.
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Field or Control Description

Benefit Program, Coverage Code, Benefit Plan, and
Deduction Code

Obtained from the participant's Manage Base Benefits
business process records.

These fields can be used to trace back to the rate tables and
calculation rules that created the charge.

(CAN) Sales Tax Appears if the charge is for Canadian sales tax associated with
another benefits charge.

Date Due  and Date Overdue You can modify these dates.

Print Period Indicates the begin and end dates of the billing calendar during
which the statement for this charge was sent.

Charge The original charge calculated by the batch calculation process
or entered in the Charge Entry page.

Charge Adjustments From the Adjust Charges page.

Payment Adjustments From the Adjust Payments page.

Note: Participants who are billed for more than one billing period, or who are billed for more than one
plan type, employee record number, or COBRA event within a particular billing period, have multiple
billing charge records.

Charge Detail Page
Use the Charge Detail page (BILL_CHRG_DET) to view details of charge actions.

Navigation:

Benefits > Benefits Billing > Calculate and Review Charges > Review Billing Charge Details >
Charge Detail

Copyright © 1988, 2022, Oracle and/or its affiliates. 395



Managing Benefits Billing Chapter 16

This example illustrates the fields and controls on the Charge Detail page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Posting Date Displays the dates on which actions were entered into the
system.

For detail records with an action type of Charge, the posting
date is the last day of the billing cycle.

Action Type Possible actions include Charge, Charge Adjustment, Payment,
 and Payment Adjustment.

Charge The amount of the original charge. If the charge is associated
with a Canadian sales tax, the sales tax type (GST, PST, PSTI,
 and so on) is indicated as well.

Charge Summary by Bill Period Page
Use the Charge Summary by Bill Period page (BILL_CSUM_BY_BPER) to arranges a participant's
charges by billing period.

Navigation:

Benefits > Benefits Billing > Calculate and Review Charges > Charge Summary by Bill
Period >Charge Summary by Bill Period
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This example illustrates the fields and controls on the Charge Summary by Bill Period page. You can find
definitions for the fields and controls later on this page.

(CAN) If the charge is associated with a Canadian sales tax, the sales tax type (GST, PST, PSTI, and so
on) is indicated before the Charge column.

Charge Summary by Plan Type Page
Use the Charge Summary by Plan Type page (BILL_CSUM_BY_PTYPE) to arranges a participant's
charges by plan type.

Navigation:

Benefits > Benefits Billing > Calculate and Review Charges > Charge Summary by Plan Type >
Charge Summary by Plan Type

This example illustrates the fields and controls on the Charge Summary by Plan Type page. You can find
definitions for the fields and controls later on this page.

(CAN) If the charge is associated with a Canadian sales tax, the system displays the sales tax type (GST,
PST, PSTI, and so on) of the charge to the left of the charge amount.
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Generating Benefits Billing Statements

This section discusses how to generate benefits billing statements.

Pages Used to Generate Benefits Billing Statements

Page Name Definition Name Usage

Print Billing Statement Page RUNCTL_BEN040 Print and reprint billing statements.

Reprint Billing Statements Page BILL_PRINT Set up print IDs and select employees for
reprinting billing statements.

Print Billing Statement Page
Use the Print Billing Statement page (RUNCTL_BEN040) to print and reprint billing statements.

Navigation:

Benefits > Benefits Billing > Create Statements > Print Billing Statement > Print Billing
Statement

This example illustrates the fields and controls on the Print Billing Statement page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Billing Period Select from the billing calendar.

Statement Date and Date for determining Past Due Used to determine which charges are overdue. The system
totals charges with due dates prior to the as of date and prints
the total as the amount overdue. This date has been kept
separate because some organizations bill in advance for
benefits.
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Field or Control Description

Reprint  and Print ID If you want to reprint statements, select the Reprint check box
and enter a print ID. You define reprint report print IDs in the
Reprint Statement page, which is explained in the following
section.

The printed statements include all plan types that are being billed. They do not differentiate between
COBRA and non-COBRA charges, and they don't itemize the charges by an employee's different
employee record numbers (if the employee has multiple jobs). The inclusion of a due date on each item
allows for separate due dates for COBRA coverage.

Billing statements can also include statement comments. You can use the Billing Parameter page to create
global comments that appear on the statements of all employees who are participating in a given billing
calendar, and you can use the Employee Override page to compose a statement comment that appears on
an individual employee's billing statement.

Note: The system produces statements only for individuals who have active billing enrollments or
outstanding balances in the Benefits Billing system. The system does not print statements for employees
who are inactive with a zero balance or who have Hold Statements selected in the Employee Override
page. If a charge that is displayed on the statement is subject to a Canadian sales tax, the system displays
the charge's sales tax type (GST, PST, PSTI, and so on) to the left of the charge amount.

Reprint Billing Statements Page
Use the Reprint Billing Statements page (BILL_PRINT) to set up print IDs and select employees for
reprinting billing statements.

Navigation:

Benefits > Benefits Billing > Create Statements > Reprint Billing Statements > Reprint
Statements >Reprint Billing Statements

This example illustrates the fields and controls on the Reprint Billing Statements page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Billing Period Select from the billing calendar.
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Field or Control Description

Empl ID  (employee ID) Select the employees for whom Billing Statements need to be
reprinted.

Processing Payments

This section discusses how to process payments.

Pages Used to Process Payments

Page Name Definition Name Usage

Allocate Billing Payments Page BILL_PAYMENT Log individual payments from a
participant and allocate those payments
to separate charges.

Review Billing Payment Details Page BILL_PAYMENT_VW Examine charge payment history for a
selected participant.

Billing Summary by Post Date BILL_PSUM_BY_PTDT Review payments for a specific
participant, arranged by posting date.

Allocate Billing Payments Page
Use the Allocate Billing Payments page (BILL_PAYMENT) to log individual payments from a
participant and allocate those payments to separate charges.

Navigation:

Benefits > Benefits Billing > Apply Payments > Allocate Billing Payments > Allocate Billing
Payments
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This example illustrates the fields and controls on the Allocate Payments to Charges page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Posting Sequence Provided by the system. Enables you to enter multiple
payments on the same day.

Form of Payment You can enter either Check or Cash, but the interface value
can be set automatically only by the Billing Calculation batch
process.

Payment Enter the total payment that the employee provides. The
system automatically allocates this payment to the oldest
charges. You can redistribute the payment among the
participant's various charges manually in the Allocations
group box.

Allocation Details This group box enables you to manually distribute the
payment to the various open charges. When a charge is paid
in full, it is closed by the system and does not appear the next
time that you access the Allocate Payments to Charges page.
 If, after allocation of the payment, a charge is not paid in full,
 it remains open for the next payment.

Applied to Open Credit If payment exceeds the total amount owed, the system posts
the excess payment here.

Note: The system does not allow participants to have
payments applied to open credit as long as they have unpaid
charges.

Note: Any changes to saved payment entries must be made through the Adjust Payments page.
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Review Billing Payment Details Page
Use the Review Billing Payment Details page (BILL_PAYMENT_VW) to examine charge payment
history for a selected participant.

Navigation:

Benefits > Benefits Billing > Apply Payments > Review Billing Payment Details > Review Billing
Payment Details

This example illustrates the fields and controls on the Review Billing Payment Details page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Posting Date The date when the payment was actually applied to the
charges.

Entry Date The date when you entered the payment record into the
system.

Print Period The billing period during which information about this
payment appeared on the participant's billing statement.

Payment The payment amount that was originally entered.

Payment Adjustments Adjustments made on the Adjust Payments page.

Actual Payment The amount of the payment that was actually applied against
charges. This value is identical to either the Payment or
Payment Adjustments value, except in cases in which
overpayments were applied to open credit.
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Adjusting Charges and Payments

This section discusses how to adjust charges and payments.

Pages Used to Adjust Charges and Payments

Page Name Definition Name Usage

Billing Charges Adjustment Page BILL_CHRG_ADJUST Adjust charges on existing Billing
Charge records.

Billing Payment Adjustment Page BILL_PAY_ADJUST Adjust payments to existing Billing
Payment records.

Billing Adjustment Summary BILL_ADJ_SMRY View a summary of all adjustments for a
participant.

Billing Charges Adjustment Page
Use the Billing Charges Adjustment page (BILL_CHRG_ADJUST) to adjust charges on existing Billing
Charge records.

Navigation:

Benefits > Benefits Billing > Make Adjustments > Billing Charges Adjustment > Billing Charges
Adjustment

This example illustrates the fields and controls on the Billing Charges Adjustment page. You can find
definitions for the fields and controls later on this page.
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Note: You can apply only one charge adjustment at a time.

Field or Control Description

Post Date Automatically set to today's date, but you can change it.

Post Seq  (post sequence) Assigned by the system. Enables you to schedule more than
one charge adjustment for a particular post period.

Adj Amt  (adjustment amount) Enter the amount of the adjustment.

If you increase the charge, the system checks to determine
whether the participant has any overpayments allocated to
open credits. It applies open credits to the increase in the
charge, updates the charge balance, and inserts detail rows
showing the allocation of the open credits to the charge.

If you reduce a charge that has already been paid, you end up
with an overpayment. The system checks to determine whether
the employee has other open charges. If open charges exist,
 the system requests that you make a payment adjustment. If
no open charges exist, the system selects a payment that is
allocated to the charge that is being adjusted and automatically
creates a payment adjustment that reduces the payment. The
system then increases the open credit balance by the amount
by which the payment was reduced.

Adjustment Description Enter the reason for the adjustment.

Billing Payment Adjustment Page
Use the Billing Payment Adjustment page (BILL_PAY_ADJUST) to adjust payments to existing Billing
Payment records.

Navigation:

Benefits > Benefits Billing > Make Adjustments > Billing Payment Adjustment > Billing Payment
Adjustment
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This example illustrates the fields and controls on the Billing Payment Adjustment page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Payment Adjustments Distribute the total adjustment among the charges.

Post Date Automatically set to today's date, but you can change it.

Post Seq (post sequence) Assigned by the system. Enables you to schedule more than
one charge adjustment for a particular post period.

Payment Change Enter the total adjustment.

Net Adjustment The net adjustment is equal to the payment change if the
adjustment increases the payment or if no open credit is
associated with the payment.

If the payment adjustment reduces the payment or an open
credit exists, the Net Adjustment field represents the amount
that is left over when the open credit has been used up, which
then has to be subtracted from charges.

The system requires that the value in the Net Adjustment
field equal the value in the Net Adjustment Allocated field,
 except when the total adjustment exceeds the total due on
charges. In this case, as with payments, the system requires
that all the charges are paid off, and it applies the remainder to
open credit.
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Field or Control Description

Adjustment Distribution You can redistribute the payment to other charges through the
adjustment.

Reviewing Charge and Payment History

You can view a history of all payments, charges, and remaining balances for an employee.

This section discusses how to review employee billing history.

Page Used to Review Charge and Payment History

Page Name Definition Name Usage

Employee Billing Balances Page BILL_BLNC_SMRY View charges, payments, and grand totals
that are associated with an individual
employee.

Employee Billing Balances Page
Use the Employee Billing Balances page (BILL_BLNC_SMRY) to view charges, payments, and grand
totals that are associated with an individual employee.

Navigation:

Benefits > Benefits Billing > Manage Acct Status and Balance > Employee Billing Balances >
Employee Billing Balances
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This example illustrates the fields and controls on the Employee Billing Balances page. You can find
definitions for the fields and controls later on this page.

The charge and payment values that appear are accounted for in all adjustments previously posted
against them. The Net column displays the balance that is still outstanding for each charge and payment
combination.

Note: Canadian sales tax types (GST, PST, PSTI, and so on) appear to the left of the charge listing when
appropriate.

The Grand Total field adds the Total Charge, Total Payment, and Net columns.
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Managing COBRA

Understanding COBRA Management

The system searches the database for COBRA qualifying events that you define and identifies those
employees and dependents who are eligible for COBRA benefits. When these qualified beneficiaries are
identified, you can retrieve data through the COBRA pages and track the qualifying event, the calculated
coverage begin and end dates, and COBRA status for each beneficiary. You can also enter health and
flexible spending account (FSA) benefit elections.

To administer COBRA:

1. Perform PeopleSoft HR functions as usual.

For example, terminate employees, retire employees, and record marital status changes. These
functions trigger COBRA activity.

2. Run the COBRA process to identify qualifying events and beneficiaries.

3. Generate COBRA notification letters and enrollment forms.

4. Enter COBRA elections or coverage waivers.

5. Manage COBRA benefits for nonemployee COBRA beneficiaries and their dependents.

6. Terminate COBRA enrollment for beneficiaries who lose their coverage due to lack of payment or
voluntary termination.

Determining Qualified COBRA Events

This section provides an overview of COBRA events and discusses how to determine qualified COBRA
events.

Page Used to Determine Qualified COBRA Events

Page Name Definition Name Usage

Review COBRA Triggers Page COBRA_ACTIVITY Add, delete, and review COBRA events.

Understanding COBRA Events
A qualified COBRA event:
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• Is defined in the COBRA Event Rules Table.

• Results in a recognized loss of coverage in a health or FSA plan.

In the Manage Base Benefits business process, qualifying events are triggered through PeopleCode.
In PeopleSoft Benefits Administration, qualifying events are triggered after Event Maintenance has
been finalized. The exception (for both the Manage Base Benefits business process and Benefits
Administration) is overage dependent processing. Overage dependent events are identified during the
COBRA batch process and are automatically adjusted.

Information about triggered events is transferred to the COBRA Activity table for further analysis during
the COBRA process.

Two types of COBRA events exist: initial and secondary. An initial event is the first qualifying event for
an employee.

Understanding Initial COBRA Events

The following table shows the initial qualifying COBRA events that PeopleSoft software delivers, the
user actions that trigger them, and the potential COBRA beneficiaries of each event.

Qualifying COBRA Event User Action Trigger Potential COBRA Beneficiaries

Loss of eligibility due to termination Employee status changes to Terminated
or Suspended.

Employee and dependents

Loss of eligibility due to reduction in
hours

Employee status remains Active;
standard hours decrease.

Employee and dependents

Loss of eligibility due to retirement Employee status changes to Retired. Employee and dependents

Loss of eligibility due to military leave Leave of Absence/Military Leave action/
action reason combination is entered for
the employee.

Employee and dependents

Death of employee Employee status changes to Deceased
or a Family Status Change/Death action/
action reason combination is entered for
an employee.

All dependents

Divorce Marital status changes to Divorced;
spouse becomes ex-spouse.

Spouse

Marriage of dependent Dependent marital status changes to
Married.

Individual dependent
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Qualifying COBRA Event User Action Trigger Potential COBRA Beneficiaries

Dependent reaches coverage age limit 
(overage dependent)

No user action; current age of dependent
exceeds maximum dependent age or
maximum student dependent age. (The
system checks whether the dependent is
a student.)

Individual dependent

Employee becomes entitled to Medicare Medicare entitlement date is entered. All dependents

Note: According to federal government guidelines, employees who undergo voluntary or involuntary
termination for gross misconduct and their spouses are not eligible for COBRA coverage. COBRA
Administration does not differentiate between terminations for gross misconduct and other termination
types, but you can set up action reason codes and add PeopleCode to perform this function.

Understanding Secondary COBRA Events

Secondary events extend coverage eligibility and are limited to dependents who are currently enrolled in
COBRA coverage. A secondary event must meet the following requirements:

• The dependent must currently be enrolled in COBRA coverage as a result of an initial COBRA event.

• The initial COBRA event must be associated with a change to an employee's job status (such as a
reduction in hours, termination, or retirement), and the secondary event must involve loss of coverage
for the employee's dependent (such as divorce, marriage of dependent, overage dependent, death of
employee, or a Medicare entitlement).

The triggers for secondary events are identical to the triggers for initial events, with one exception: If the
initial event is a termination and the secondary event is a death, you must use the delivered action/action
reason combination of FSC/DEA (family status change/death) to successfully process the event.

Related Links
Processing Enrollments for Secondary Events

Review COBRA Triggers Page
Use the Review COBRA Triggers page (COBRA_ACTIVITY) to add, delete, and review COBRA
events.

Navigation:

Benefits > Administer COBRA Benefits > Manage Automated Participation > Review COBRA
Triggers > Review COBRA Triggers
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This example illustrates the fields and controls on the Review COBRA Triggers page: Activity tab. You
can find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Review COBRA Triggers page: Coverage Override
tab. You can find definitions for the fields and controls later on this page.

Activity Tab

Field or Control Description

CBR Action (COBRA action) Describes the type of event that took place.

Activity Source Indicates who or what initiated the event.

Ben Record (benefit record number) Indicates the benefit record affected by the event.
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Coverage Override Tab

Field or Control Description

Coverage Override Select when to use an alternate coverage termination date to
determine qualified COBRA coverage.

Alt Covrg Term Date  (alternate coverage termination date) The date when coverage was previously terminated. Required
when the coverage override flag is selected.

Coverage As-Of Date The date that coverage should begin if the event is fully
qualified. The system sets the COBRA event date if this field
is left blank.

Related Links
"Understanding Eligibility Rules" (PeopleSoft Benefits Administration)
"Understanding Event Rules" (PeopleSoft Benefits Administration)
"Event Maintenance" (PeopleSoft Benefits Administration)

Overriding Initial and Secondary COBRA Events
The system assumes that the date of the event and the date that an employee's benefits terminate are the
same, which is not always true.

For example, suppose that an employee drops spousal coverage during Open Enrollment and then later
gets divorced. The benefit plan must make COBRA coverage available upon receiving notice of the
divorce.

Another example is when an employee decides not to return to work from FMLA. COBRA coverage
becomes available on the day human resources is notified that the employee is not returning, not on the
last day of the FMLA, unless notification is made on the last day of FMLA. The maximum coverage
period usually begins on that day also.

For the COBRA process to recognize these events as enabling dependents to become eligible for COBRA
benefits, you must enter the event directly into the COBRA Activity Table.

You cannot enter an event unless you have selected Manual Events Allowed in the COBRA Event Rules
Table for the COBRA event classification. You may want to add a new COBRA event classification to
identify these specific situations. COBRA events triggered through the Manage Base Benefits business
process or Benefits Administration can be deleted on the COBRA Activity Table, but not modified.
COBRA events that you enter through the Review COBRA Triggers page can be changed.

Running the COBRA Process

This section provides an overview of the COBRA process and describes how to run it.
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Pages Used to Run the COBRA Process

Page Name Definition Name Usage

COBRA Qualifying Process Page COBRA_RUNCTL Run the COBRA process to determine
eligibility.

COBRA Processing Messages Page COBRA_MESSAGES View error messages for the COBRA
process.

Understanding the COBRA Process
The COBRA process determines employee and dependent eligibility for COBRA benefit coverage.

For an employee or dependent to become a qualified COBRA beneficiary, the following two requirements
must be met:

• The person must have experienced a qualifying event.

• The person must have had health coverage on the day of the qualifying event and have lost coverage.

If these requirements are met, the COBRA process assigns the beneficiary a benefit program and allows
that person to elect COBRA health coverage.

COBRA Qualifying Process Page
Use the COBRA Qualifying Process page (COBRA_RUNCTL) to run the COBRA process to determine
eligibility.

Navigation:

Benefits > Administer COBRA Benefits > Manage Automated Participation > COBRA Qualifying
Process > COBRA Qualifying Process
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This example illustrates the fields and controls on the COBRA Qualifying Process page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

COBRA Processing Phase Displays the phase where processing begins. Possible phases
are:

Ready: Ready for processing.

Overage: Processing overage dependents.

Activity: Processing COBRA activity.

Qualify: Processing qualifying events.

Participant: Processing COBRA participants.

Complete: Processing completed.

Process Overage Dependents Deselect to skip overage-dependent processing during the
batch run.

Chk Point Interval in Minutes (check point interval in
minutes)

Enter the number of minutes before the process commits
information that's been processed so far and updates the
information displayed in the Restart Position group box.

If an error occurs, the system restarts the process from the last
checkpoint.

Restart Position Displays the position from which to restart the COBRA
process if a system failure occurs.

Note: On the Process Scheduler page, select COBRA Admin & Non Employee to run the COBRA
process. This runs both the COBRA Administration and COBRA Non Employee processes. The COBRA
Administration process takes the relevant data and puts it into a temporary table. The COBRA Non
Employee process writes the data to the correct PERSON table.
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Understanding COBRA Event Status
When a COBRA event has been triggered (online or through Benefits Administration), the COBRA
process determines whether any employees or dependents have lost health coverage due to the event. The
system considers these people to be qualified COBRA beneficiaries.

Each person analyzed by the COBRA process receives three status values:

• Event qualification status

• Initial event status

• Secondary event status

The event qualification status identifies participants who qualify for COBRA. Statuses are:

• Not COBRA Qualified

• COBRA Qualify Error

• COBRA Qualified

• Qualify Pending

• Unprocessed

The initial event status tracks the process of the event in the COBRA cycle; it also marks whether
participants have their options prepared and are notified of coverage. Values include:

• Qualify Pending

• Qualified

• Not Qualified

• Options Prepared

• Notified

• Election Entered

• Election Error

• Election Enrolled

• Enrollment Complete

The secondary event status is always Not Qualified unless the COBRA participant has been affected by a
secondary event, such as divorce or Medicare entitlement. Other values include:

• Qualify Pending

• Qualified

• Notified

• Coverage Extended

416  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 17 Managing COBRA

When a participant is enrolled in COBRA coverage through an initial event and a qualified secondary
event occurs for all of that participant's plans, the system sets the participant's initial event status to Not
Qualified.

In the case of a combination event, which acts as an initial event for certain plans and as a secondary
event for other plans, plans for which the combination event acts as a secondary event are set to Not
Qualified. Initial event status values for plans for which the combination event acts as an initial event are
set to appropriate levels for the current stage of processing.

Status values for initial and secondary events are updated as participants move through the COBRA
process.

Related Links
Processing Enrollments for Secondary Events

Assigning Qualified COBRA Beneficiaries to Benefit Programs
Benefit program assignment differs for COBRA events initiated by the Manage Base Benefits business
process and Benefits Administration.

If a COBRA event is initiated by the Manage Base Benefits business process, the system assigns each
qualified beneficiary to the benefit program that the employee was enrolled in on the day prior to the
COBRA event date.

If the event is processed through Benefits Administration, then the system determines benefit program
eligibility for each qualified COBRA beneficiary, using the eligibility parameters from the latest run
of Benefits Administration and the qualified beneficiary's ZIP code. If no benefit programs satisfy this
eligibility criteria, then the participant is assigned to the benefit program enrolled in on the day prior to
the COBRA event date.

Note: This process occurs only for qualified participants who have a COBRA process status of Open For
Processing (as opposed to Closed or Void).

Related Links
Update COBRA Event Status Page
"Event Maintenance" (PeopleSoft Benefits Administration)

Determining Eligible Plan Types
Beneficiaries are eligible for all COBRA-qualified group health plan types that they were enrolled in prior
to the COBRA event. This includes all Health (1x) plan types and the Health FSA (60) plan type.

For a plan type within a specific benefit program to be designated as COBRA-qualified, you must
select the COBRA Plan check box in the Plan Type and Option page of the Benefit Program Table
(BEN_PROG_DEFN) component.

Determining Eligible Options
Eligible options are determined for each qualified plan type.
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For employees, spouses, and ex-spouses, eligible options must satisfy the following criteria:

• The benefit plan associated with the options matches the benefit plan of the lost coverage of the
employee, spouse, or ex-spouse.

• The coverage code has the COBRA Coverage Set field selected and is less than or equal to the
coverage code of the lost coverage of the employee, spouse, or ex-spouse.

• For spouses and ex-spouses, the coverage code selected cannot require a spouse or ex-spouse (Spouse
Only Coverage codes).

For all dependents besides spouses and ex-spouses, eligible options must satisfy the following criteria:

• The benefit plan associated with the options matches the benefit plan of the dependent's lost coverage.

• The dependent's coverage code is Employee Only (Dependent Only Coverage).

Note: The Employee Only code is used when the dependent is covered on his or her own and as a
dependent of the COBRA participant. The code is used to indicate the coverage of a single person.

Benefits Administration uses a different method to determine option eligibility.

Related Links
"Event Maintenance" (PeopleSoft Benefits Administration)

Calculating COBRA Costs for Eligible Options
This section describes how to calculate COBRA costs.

To calculate COBRA cost:

1. Access the Benefit Program page.

2. Enter the COBRA percentage amount.

The COBRA process calculates a charge for each option using the sum of the total coverage costs
(employee plus employer) multiplied by the surcharge defined here.

3. Enter the COBRA disabled surcharge percentage.

If the COBRA participant is disabled, the COBRA cost for months 19–29 is multiplied by this
surcharge.

When you select Waive COBRA Surcharge on the COBRA Event Rules Table page for a specific
COBRA event classification, the system does not add the COBRA surcharge or disabled surcharge.

COBRA charges are sent to the COBRA beneficiary through Benefits Billing processes, as long as
Benefits Billing is selected in the Products page of the Installation table.

Related Links
Understanding Benefits Billing
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Processing Secondary COBRA Qualifying Events
Although COBRA governmental regulations describe how secondary COBRA qualifying events should
be processed, PeopleSoft event rules allow for a different implementation of secondary event processing.

Three fields defined on the Event Rules page are used to process secondary events.

Field or Control Description

Secondary Event Role Identifies whether the event can be considered a secondary
event.

Second Event Additional Months Defines by how many months the secondary event extends a
COBRA participant's coverage.

Secondary Event Add Mode Defines whether the additional months extend the coverage 36
months from the coverage begin date of the initial event or add
36 months to the COBRA event date of the secondary event.

Related Links
Setting Up COBRA Administration
Processing Enrollments for Secondary Events

COBRA Processing Messages Page
Use the COBRA Processing Messages page (COBRA_MESSAGES) to view error messages for the
COBRA process.

Navigation:

Benefits > Administer COBRA Benefits > Review Processing Results > Review Processing
Messages > COBRA Processing Messages

Field or Control Description

Benefit Rcd# (benefit record number) The employee benefit record number that was affected by the
COBRA event.

CBR Evt ID  (COBRA event identification) The identification number assigned to the event by the
COBRA process.

Dep/Benef  (dependents/beneficiaries) Any relevant dependents or beneficiaries.

Creating Notification Letters

This section describes how to create notification letters.
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Pages Used to Create Notification Letters

Page Name Definition Name Usage

COBRA Notification Letter Page RUNCTL_CBR001 Print notification letters for initial
COBRA events.

COBRA Secondary Letter Page RUNCTL_CBR002 Print notification letters for secondary
COBRA events.

Reprint COBRA Letter Page CBR_PRT Select parameters for reprinting
notification letters.

Related Links
Processing Enrollments for Secondary Events
"Manage Base Benefit Reports" (Application Fundamentals)

Determining Notification Recipients
The qualifying event determines recipients.

• For termination, reduction in hours, and retirement events, the employee and each covered dependent
are notified.

• When Medicare entitlement or death of employee events occur, each dependent is notified.

• When divorce or loss of dependent status events occur, the spouse or dependent is notified.

COBRA Notification Letter Page
Use the COBRA Notification Letter page (RUNCTL_CBR001) to print notification letters for initial
COBRA events.

Navigation:

Benefits > Administer COBRA Benefits > Manage Automated Participation > COBRA
Notification Letter > COBRA Notification Letter
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This example illustrates the fields and controls on the COBRA Notification Letter page. You can find
definitions for the fields and controls later on this page.

The Initial Notification Letter process generates letters for COBRA participants with an initial event
status of Options Prepared and an event status of Open For Processing. Letters include:

• The nature of the qualifying event and the date it occurred.

• The last day of active coverage of the qualified participant's original benefit plans.

• The plan types for which the qualified participant is eligible to receive COBRA coverage.

• The COBRA coverage start and end dates for each plan, and the response date by which the qualified
participant must notify you of his or her elections.

Along with each initial notification letter, the system prints a COBRA continuation coverage election
form for employees to record their elections.

When an initial notification letter is generated for a qualified COBRA participant, the initial event status
is changed to Notified. The election end date is calculated for each plan type as 60 days past the latter of
the notification date (on the notification letter) or the loss of coverage.

Field or Control Description

As Of Date Enter the date for the time period during which you want the
letters.

'Reprint' Appears on Letters Select this check box if you want the word Reprint to appear
on the letter.

Reprint ID Select the ID number associated with the letters that you want
reprinted.

COBRA Secondary Letter Page
Use the COBRA Secondary Letter page (RUNCTL_CBR002) to print notification letters for secondary
COBRA events.

Navigation:
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Benefits > Administer COBRA Benefits > Manage Automated Participation > COBRA Secondary
Letter > COBRA Secondary Letter

The process for printing notification letters for secondary events is identical to that for initial events.

The secondary notification letter includes information about how long COBRA coverage is to be
extended.

Recipients have their secondary event status changed to Notified and their process status changed to
Closed for Processing.

Reprint COBRA Letter Page
Use the Reprint COBRA Letter page (CBR_PRT) to select parameters for reprinting notification letters.

Navigation:

Benefits > Administer COBRA Benefits > Manage Automated Participation > Reprint COBRA
Letter > Reprint COBRA Letter

This example illustrates the fields and controls on the Reprint COBRA Letters page. You can find
definitions for the fields and controls later on this page.

This page enables you to reprint all letters, or to select specific employees for whom letters are to be
reprinted. You can specify a notification date range during which the reprint is to occur.

Entering COBRA Elections and Waivers

This section describes how to enter COBRA elections and waivers.

Page Used to Enter COBRA Elections and Waivers

Page Name Definition Name Usage

COBRA Participant Elections Page COBRA_PARTIC_ENT1 Record elections or waivers for COBRA
coverage.
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Understanding COBRA Elections
Qualified COBRA beneficiaries can:

• Select COBRA for one or more plan types.

• Waive COBRA for all plan types.

• Revoke a waiver for one or more plan types.

Unlike PeopleSoft Benefits Administration, COBRA participants can make enrollment decisions at the
plan type level.

Employees and dependents are individually qualified for COBRA coverage, and they can choose to be
covered as individuals.

For example, suppose that an employee with Employee plus Spouse coverage terminates employment and
loses all regular health coverage. The employee and the spouse both qualify for COBRA coverage. The
spouse can select either to be covered individually as a nonemployee (even if the employee doesn't elect
coverage), she can continue to be covered under the employee as a dependent, or the spouse may elect
Spouse Only coverage (if the terminated employee coverage code is set to Spouse Allowed).

When you enter elections for qualified COBRA participants, the system sets their initial event status to
Election Entered.

Related Links
Managing Nonemployee COBRA Participants

COBRA Participant Elections Page
Use the COBRA Participant Elections page (COBRA_PARTIC_ENT1) to record elections or waivers for
COBRA coverage.

Navigation:

Benefits > Administer COBRA Benefits > Manage Automated Participation > COBRA
Participant Elections >COBRA Participant Elections

Field or Control Description

COBRA Election Indicate whether to elect or waive COBRA coverage.

To revoke a waiver of coverage, change the selection from
Waive to Elect. Waivers cannot be revoked after the election
end date.

The current date is automatically set as the election, waive, or
revoke date, although you can override that value for elections.
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Participant Enrollment

Field or Control Description

Plan Type Enter the elected option choices.

Covrg Begin (coverage begin), Covrg End  (coverage end),
 and  Election End

Predetermined by the COBRA process.

COBRA Election Elect or waive each plan type.

The election or waive date is automatically set, although you
can override the election date.

Provider ID For health plan types. Enter the name of the employee's doctor,
 an ID number, or any other format that the health provider
requires.

Previously Seen Select to indicate that the employee is a current patient of the
indicated physician.

When an election has been entered, validated, and enrolled, the election cannot be changed without
COBRA reprocessing. After reprocessing, you can add new elections or make election changes if the
coverage election date is on or before the coverage election end date and if the elections have not been
entered.

Validating and Enrolling Elections
The system reviews plan type, option code, and dependent/beneficiary elections made for qualified
COBRA participants when their elections are saved. If all of the plan types for which the participant is
eligible reflect either an enrollment election or waiver, the system changes the participant's initial event
status to Enrollment Completed and the process status to Closed for Processing. If some of the plans have
not had an entry made, the participant's initial event status changes to Enrolled (for the specific plan), and
the process status remains Open for Processing. In either case, if errors are discovered, the initial event
status becomes Election Error.

Enrollment in Health or FSA Plans

If the initial election status is Enrollment Completed or Enrolled, you can access health plan information,
FSA plan information, or both in the Health Benefits and FSA Benefits pages.

Creation of Non-Employee Status

If a dependent elects individual COBRA coverage or has a qualifying second event, then that
nonemployee participant receives a system-generated employee ID.
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Notification to Billing System

If Benefits Billing is selected in the Installation Table, the system enrolls validated and enrolled COBRA
participants in the Benefits Billing system for elected plan types. The system also sends COBRA
surcharges and coverage start and end dates to Benefits Billing.

Validation and Enrollment Error Messages

You can view error messages generated during validation and enrollment either by using the Process
Messages page or by running the COBRA Error report. Each time the COBRA validation and enrollment
process runs, it deletes error messages from the previous run.

Related Links
Managing Nonemployee COBRA Participants
COBRA Processing Messages Page
Understanding Benefits Billing

Processing Enrollments for Secondary Events

This section discusses:

• Initial event status and secondary events.

• How to identify differences in individual and dependent coverage processing.

• Combination events.

Understanding Initial Event Status and Secondary Events
When a secondary event is processed, the system reviews the initial event to determine whether its event
status is Closed to Processing (indicating that the participant has made an election or waived COBRA
coverage). If the initial event is not closed, the secondary event's status becomes Qualified Pending. The
secondary event needs to be reprocessed after the initial event is closed.

This can happen if dependents are covered under an employee's coverage instead of electing independent
coverage.

For example, suppose that an employee and her dependents become qualified beneficiaries after she
terminates her employment. She enrolls in family coverage for plan types 10 and 11—covering herself,
her spouse, and her daughter—and waives plan type 14. As a result, the terminated employee's record
is Closed to Processing. But the dependents' records remain Open for Processing because they have not
independently elected or waived coverage.

To close an initial event and reprocess a secondary event:

1. A secondary event, such as a divorce or dependent marriage, occurs.

The HR system processes the personnel action.

The COBRA process evaluates the secondary event and returns a status of Qualified Pending.
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2. Determine whether the initial event is still Open for Processing because the dependent records were
not waived or enrolled.

3. Waive or elect options for the dependents and run the COBRA process to close the initial event.

4. Use the Update Event Status page to reprocess the secondary event by changing the reprocess status
for the secondary event to Qualify Event.

After you run the COBRA process again, the secondary event should be set to Qualified.

Related Links
Update COBRA Event Status Page

Identifying Differences in Individual and Dependent Coverage Processing
When secondary events occur, COBRA participants with individual coverage are processed differently
from those with dependent coverage.

For participants with individual coverage, a secondary event extends coverage according to the defined
secondary event rules. The system deletes the existing termination record, reinserts it into the coverage
begin date, and sets an effective date equal to the extended COBRA coverage end date + 1. The COBRA
enrollment status is set to Coverage Extended.

Participants with dependent coverage are switched to individual COBRA participants, with individual
COBRA coverage as of the COBRA event date of the secondary event. The system automatically
establishes the participant as a nonemployee in the system and enrolls the participant in employee-only
coverage for all plan types that meet this condition. The employee-only coverage is within the same
benefit plan under which the participant was covered as a dependent under COBRA. The coverage end
date is calculated based on the predefined secondary event rules, and the COBRA enrollment status is set
to Coverage Inserted.

Understanding Combination Events
A COBRA event can be an initial event for one plan type and a secondary event for another type. For
example, suppose that an employee has Employee Plus Spouse coverage for plan types 10, 11, and 14.
Then the employee transfers and both the employee and the spouse lose coverage under plan types 11 and
14; they are eligible for 18 months of COBRA coverage for these types, and they elect this coverage.

The employee divorces while the COBRA coverage is still active. The divorce event causes the
employee's ex-spouse to lose coverage for plan type 10 (an initial event); the ex-spouse is qualified for
36 months of COBRA coverage under that plan. The divorce is also a secondary event for plan types 11
and 14; the ex-spouse is qualified to have coverage extended for those plans for up to 36 months from the
original coverage begin date.

The two events—the initial event for plan type 10 and the secondary event for plan types 11 and 14—
progress through the COBRA system independently in terms of notification letters and ongoing status
indicators.
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Managing COBRA Events

This section describes how to manage COBRA events.

Pages Used to Manage COBRA Events

Page Name Definition Name Usage

Review COBRA Event Summary Page COBRA_EVENT_INQ1 Review information about COBRA
events and associated beneficiaries.

Update COBRA Event Status Page COBRA_STATUS1 Adjust, reprocess, and void COBRA
events.

Review COBRA Event Summary Page
Use the Review COBRA Event Summary page (COBRA_EVENT_INQ1) to review information about
COBRA events and associated beneficiaries.

Navigation:

Benefits > Administer COBRA Benefits > Review Processing Results > Review Event Summary >
Review COBRA Event Summary
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This example illustrates the fields and controls on the Review Event Summary. You can find definitions
for the fields and controls later on this page.

Update COBRA Event Status Page
Use the Update COBRA Event Status page (COBRA_STATUS1) to adjust, reprocess, and void COBRA
events.

Navigation:

Benefits > Administer COBRA Benefits > Manage Automated Participation > Update COBRA
Event Status > Update COBRA Event Status
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This example illustrates the fields and controls on the Update COBRA Event Status page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Reprocess Indicator Set to reprocess a COBRA phase for events, participants, or
plan types.

To reprocess any level, the process status for that level and any
above it must be Open for Processing.

You cannot reprocess initial events that have secondary events
dependent on them.

At the event level, you can reprocess to Prepare Options  only
if the Option Prepare phase has already been completed.

At the participant plan type level, you can select Elect Options
only when the plan type is Enrolled and the associated event is
an initial event.

After choosing a value, run the COBRA process again to
reprocess to the selected status.

COBRA Event Conflict Selected if the system determines that two or more events are
in conflict with each other. An example is when an event is
entered and processed, and another event is entered with an
earlier date than the first event.

The system sends a message to the COBRA administrator
to analyze the conflicting events and take any appropriate
actions.

Voiding Events, Participants, or Benefit Plans

When you enter Void Event in the Reprocess Indicator at the COBRA event level, the system ignores
all reprocessing indicators at the lower levels. It voids all COBRA participants and participant plans,
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and deletes all enrolled COBRA benefits. Notification is sent to the Benefits Billing system to terminate
billing for voided participants.

When you enter Void Event in the Reprocess Indicator at the COBRA participant level, the result is
similar to voiding a COBRA event. The COBRA participant record and all COBRA benefit plan records
associated with that participant are deleted. Benefits Billing is notified to terminate billing.

Voiding a COBRA benefit plan associated with an initial event deletes all enrolled COBRA benefit
records associated with that plan; Benefits Billing is notified to terminate billing. Voiding a COBRA
benefit plan associated with a secondary event readjusts termination dates back to those associated with
the initial plan; Benefits Billing is notified to adjust billing.

Qualifying Events

When you enter Qualify Event in the Reprocess Indicator at the COBRA event level, all reprocessing
indicators at the lower levels are ignored. All enrolled COBRA benefits are deleted.

Preparing and Electing Options

When you set Prepare Options at the event level, if a participant or plan has a Reprocess Indicator setting
of Void Event, that reprocessing command takes precedence over Prepare Options. For example, if you
want to void the COBRA election plan type 10 and prepare options for plan type 11, the system first voids
plan type 10 and then prepares options for plan type 11.

Prepare Options reprocessing deletes all of the plan, option, and dependent records associated with that
event. Benefits Billing is notified to terminate billing.

Related Links
Running the COBRA Process

Managing COBRA Benefit Plan and Dependent Information

This section describes how to manage COBRA benefit plan and dependent information.

Pages Used to Manage COBRA Benefit Plan and Dependent Information

Page Name Definition Name Usage

Assign COBRA Benefit Program Page COBRA_PROG_PARTIC1 Change benefit program participation
for Open Enrollment and Family Status
Change events.

COBRA Health Plan Enrollment COBRA_HEALTH1 View or update health plan elections and
enroll dependents.

COBRA FSA Plan Enrollment Page COBRA_FSA View or update FSA enrollments.
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Page Name Definition Name Usage

Name Page COBRA_DEP_BENEF1 Add or Update COBRA dependent/
beneficiary information.

Address COBRA_DEP_ADDR Enter or update COBRA dependent
address information.

Personal Profile COBRA_DEP_BENEF2 Enter or update COBRA dependent
details.

Assign COBRA Benefit Program Page
Use the Assign COBRA Benefit Program page (COBRA_PROG_PARTIC1) to change benefit program
participation for Open Enrollment and Family Status Change events.

Navigation:

Benefits > Administer COBRA Benefits > Enroll in Benefits > Assign COBRA Benefit Program >
Assign COBRA Benefit Program

This example illustrates the fields and controls on the Assign COBRA Benefit Program page. You can
find definitions for the fields and controls later on this page.

Health Plan Enrollment Page
Use the Health Plan Enrollment page (COBRA_HEALTH1) to view or update health plan elections and
enroll dependents.

Navigation:

Benefits > Administer COBRA Benefits > Enroll in Benefits > Health Plan Enrollment > Health
Plan Enrollment
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This example illustrates the fields and controls on the Health Plan Enrollment page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Coverage Begin Date Automatically set to the date in the Review Event Summary
page.

Coverage Election Displays whether the COBRA health benefit record in view is
currently elected or terminated.

Coverage Code When you exit this field, the system calculates the monthly
cost of the benefit.

Health Provider ID Enter the name of the employee's doctor, an ID number, or any
other information that the health provider may require.

Previously Seen Indicate that the employee is a current patient of the indicated
physician. This field becomes available when a health provider
ID is entered.

HIPAA Report Date (Emp) (Health Insurance Portability and
Accountability Act report date [employee])

Displays the date that the employee's certificate of creditable
health coverage was printed if health coverage was terminated.
 These certificates are guaranteed to employees by HIPAA of
1996; you can print them by running HIPAA reports.

Note: The certificate of creditable coverage lists all group
health coverage that an employee had for the 18 month period
prior to the date on which coverage ended.
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Dependent/Beneficiaries

Field or Control Description

ID Select a dependent ID to add available beneficiaries to the
selected COBRA plan.

Health Provider ID Enter the name of the dependent's doctor, an ID number, or
any other information that the health provider may require.

Previously Seen Select to indicate that the dependent is a current patient of the
indicated physician. This check box becomes available when a
health provider ID is entered.

COBRA FSA Plan Enrollment Page
Use the COBRA FSA Plan Enrollment (flexible spending account benefits) page (COBRA_FSA) to view
or update FSA enrollments.

Navigation:

Benefits > Administer COBRA Benefits > Enroll in Benefits >COBRA FSA Plan Enrollment >
COBRA FSA Plan Enrollment

This example illustrates the fields and controls on the COBRA FSA Plan Enrollment page. You can find
definitions for the fields and controls later on this page.

Use the Coverage Election field to view and change whether the displayed COBRA FSA plan is elected
or terminated.

Name Page
Use the Name page (COBRA_DEP_BENEF1) to add or Update COBRA dependent/beneficiary
information.
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Navigation:

Benefits > Administer COBRA Benefits > Maintain COBRA Non-Employees > Modify COBRA
Dependent > Name

This example illustrates the fields and controls on the Name page. You can find definitions for the fields
and controls later on this page.

Managing Nonemployee COBRA Participants

When a COBRA-qualified dependent selects individual coverage after an initial event or undergoes
an event that involves a loss of dependent status, that dependent becomes a nonemployee COBRA
participant. Nonemployee COBRA participants can declare their own dependents and change benefit
programs and plans.

This section describes how to manage non-employee COBRA participants.

Note: When you add a nonemployee through COBRA, the nonemployee record may not show in other
PeopleSoft HR processes until the Refresh Personal Data process is run.

Pages Used to Manage Non-Employee COBRA Participants

Page Name Definition Name Usage

Name and Contact PERSONAL_DATA1 Update COBRA-qualified dependent
name and biographical information.

Medicare and Job Page CBR_PERSONAL_DATA3 Maintain department security
information for nonemployee COBRA
participants.

Related Links
"Adding a Person" (PeopleSoft Human Resources Administer Workforce)
"Understanding Job Data" (PeopleSoft Human Resources Administer Workforce)
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Medicare and Job Page
Use the Medicare and Job page (CBR_PERSONAL_DATA3) to maintain department security
information for nonemployee COBRA participants.

Navigation:

Benefits > Administer COBRA Benefits > Maintain COBRA Non-Employees > Modify COBRA
Non-Employee > Medicare and Job

This example illustrates the fields and controls on the Medicare and Job page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Employment Information During the COBRA processing, automatically populated with
the original data of the employee that experienced the COBRA
event.

Job Information Review and update a historical record of the nonemployee
participant's business unit and department affiliations.

Converting Nonemployee Individual Coverage to Dependent Coverage
When a spouse or ex-spouse COBRA participant enrolls in individual nonemployee COBRA coverage,
the child dependents of the employee are inherited as dependents for the nonemployee.

All nonemployee participants are assigned a unique system-generated employee ID for which the
numbering convention is established in the Installation Table. All dependents of the nonemployee
participant also have this new COBRA employee ID, along with their original dependent/beneficiary ID.

When a secondary event occurs, however, all of an employee's dependents become independently
covered. For example, a former employee elects COBRA coverage for himself, his spouse, and his child.
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He later dies, which qualifies as a secondary event for the dependents. The spouse and child become
nonemployee participants, and are assigned IDs as shown in the following table.

Person Employee ID Dependent/Beneficiary ID

Employee (Deceased) Z001 00

Spouse (Nonemployee) C00015 01

Child (Nonemployee) C00016 02

If no further action is taken, the system creates COBRA health benefit records with employee-only
coverage for the spouse and dependents, with their COBRA coverage extended to a total of 36 months
from the initial event.

However, the spouse can also enroll the children as dependents under her coverage. To change from
independent coverage for nonemployees to dependent coverage, follow these steps.

To convert nonemployee independent coverage to nonemployee dependent coverage:

1. Access the COBRA health benefit record for the nonemployee who is remaining independently
covered.

2. Change the coverage code to an appropriate coverage code for dependent coverage for the plan types
affected and add the dependent IDs to cover.

3. Access the Participation Termination page and create Voluntary Termination records for the
dependents who are now covered under the spouse. The termination date for each termination record
should be the same date that dependent coverage begins.

Related Links
Managing COBRA Benefit Plan and Dependent Information

Terminating COBRA Coverage

COBRA can be terminated:

• Automatically, when the COBRA coverage end date is reached.

• Manually, when the COBRA participant fails to pay bills or requests to terminate coverage ahead of
the scheduled end date.

This section describes how to terminate COBRA coverage.
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Pages Used to Terminate COBRA Coverage

Page Name Definition Name Usage

Terminate COBRA Participants Page COBRA_PARTIC_TERM Terminate COBRA coverage manually
if bills are unpaid or on participant's
request.

COBRA Termination Letter Page RUNCTL_CBR003 Send letters to COBRA participants with
plans about to expire.

Terminate COBRA Participants Page
Use the Terminate COBRA Participants page (COBRA_PARTIC_TERM) to terminate COBRA coverage
manually if bills are unpaid or on participant's request.

Navigation:

Benefits > Administer COBRA Benefits > Terminate COBRA Coverage > Terminate COBRA
Participants >Terminate COBRA Participants

This example illustrates the fields and controls on the Terminate COBRA Participants page. You can find
definitions for the fields and controls later on this page.

For each plan type to terminate, enter the termination date and reason.

When you save this page, the coverage end date on the enrollment table (Health Benefits, for example) for
the enrolled plan type is adjusted to the early termination date.

COBRA Termination Letter Page
Use the COBRA Termination Letter page (RUNCTL_CBR003) to send letters to COBRA participants
with plans about to expire.

Navigation:

Benefits > Administer COBRA Benefits > Terminate COBRA Coverage > COBRA Termination
Letter > COBRA Termination Letter
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This example illustrates the fields and controls on the COBRA Termination Letter page. You can find
definitions for the fields and controls later on this page.

Termination letters are printed for employees whose coverage ends during the period between the start
and end dates.

Related Links
"Generating Form Letters for PeopleSoft Human Resources" (Application Fundamentals)
"Manage Base Benefit Reports" (Application Fundamentals)

Enrolling Participants in COBRA Coverage Manually

You can bypass the automated COBRA Administration batch process and force the system to enroll
employees and dependents into COBRA health benefits.

When you bypass the batch process, participants do not require COBRA-qualifying events in order to be
eligible for COBRA benefits. Instead, the system automatically gives all participants enrolled in COBRA
coverage through these pages a COBRA event ID of 900.

Note: When you manually enroll an employee or dependent in COBRA coverage, subsequent COBRA
processing, such as secondary event processing, is not aware of the manually enrolled COBRA coverage.
When you add a nonemployee through COBRA, the nonemployee record may not show in other HR
processes until the Refresh Personal Data process is run.

Warning! Because these pages ignore the processing rules that regulate COBRA coverage eligibility,
manually process COBRA coverage only after careful consideration.

This section describes how to enroll participants in COBRA coverage manually.
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Pages Used to Enroll Participants in COBRA Coverage Manually

Page Name Definition Name Usage

Create COBRA Non-Employee Page CBR_MANUAL_ENT1 Manually establish an employee
dependent as a nonemployee in
preparation for manually enrolling the
dependent into COBRA coverage.

Manual COBRA Benefit Program Page CBR_MANUAL_PARTIC1 Manually assign an employee or
COBRA nonemployee to a benefit
program or make changes to that manual
assignment over time.

Select Health Benefits Page CBR_MANUAL_HEALTH1 Enroll participants in COBRA health
benefits manually.

Related Links
Managing COBRA Benefit Plan and Dependent Information
Managing Nonemployee COBRA Participants
"Adding a Person" (PeopleSoft Human Resources Administer Workforce)

Create COBRA Non-Employee Page
Use the Create COBRA Non-Employee page (CBR_MANUAL_ENT1) to manually establish an
employee dependent as a nonemployee in preparation for manually enrolling the dependent into COBRA
coverage.

Navigation:

Benefits > Administer COBRA Benefits > Maintain COBRA Non-Employees > Create COBRA
Non-Employee > Create COBRA Non-Employee

This example illustrates the fields and controls on the Create COBRA Non-Employee page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Empl ID  (employee ID) and Empl Record  (employee record
number)

Enter the ID and employee record number for the employee
whom the nonemployee participant is a dependent or
beneficiary of.

Dep/Benef (dependent/beneficiary) Enter the dependent or beneficiary number.

COBRA Event Date Enter the event date for the nonemployee participant's COBRA
enrollment.

Save and Add Next Click to save the information. A message appears informing
you of the COBRA employee ID assigned to this person.

Note the new employee ID for the COBRA nonemployee and
click OK.

Manual COBRA Benefit Program Page
Use the Manual COBRA Benefit Program page (CBR_MANUAL_PARTIC1) to manually assign an
employee or COBRA nonemployee to a benefit program or make changes to that manual assignment over
time.

Navigation:

Benefits > Administer COBRA Benefits > Enroll Manually > Manual COBRA Benefit Program >
Manual COBRA Benefit Program

This example illustrates the fields and controls on the Manual COBRA Benefit Program page. You can
find definitions for the fields and controls later on this page.

The benefit program is assigned a COBRA event ID of 900.

Select Health Benefits Page
Use the Select Health Benefits page (CBR_MANUAL_HEALTH1) to enroll participants in COBRA
health benefits manually.

Navigation:

Benefits > Administer COBRA Benefits > Enroll Manually > Select Health Benefits > Select
Health Benefits
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This example illustrates the fields and controls on the Select Health Benefits page. You can find
definitions for the fields and controls later on this page.

The health benefit record of the selected participant receives a COBRA event ID of 900.

Field or Control Description

Coverage Begin Date Automatically set to the current date.

Coverage Election Elect or terminate a benefit plan.

Option The system displays the COBRA option that goes with the
selected benefit plan.

Health Provider ID Enter the name of the employee's doctor, an ID number, or any
other format that the health provider may require.

Previously Seen Select to indicate that the employee is a current patient of
the indicated physician. Becomes available when you enter a
health provider ID.

HIPAA Report Date (Emp) Displays the date on which the employee's certificate of
creditable health coverage was printed if health coverage was
terminated. These certificates are guaranteed to employees by
the Health Insurance and Accountability Act of 1996, and you
can print them by running HIPAA reports.

Note: The certificate of creditable coverage lists all group
health coverage that an employee had for the 12–month period
prior to the date that coverage ended.
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Dependent/Beneficiaries

Field or Control Description

ID Select the dependent ID to add available beneficiaries to
the selected COBRA participant/plan type/benefit plan
combination.

Relationship to Employee Identifies the dependent's relationship to the participant.

Health Provider ID Enter the name of the employee's doctor, an ID number, or any
other information that the health provider may require.

Previously Seen Select to indicate that the employee is a current patient of
the indicated physician. Becomes available when you enter a
health provider ID.
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Processing Retroactive Benefits and
Deductions

Understanding Retroactive Benefits and Deductions

A retroactive change to employee or benefit-related data has an effective date prior to the last confirmed
pay end date of the employee's pay group. Retroactive changes to benefits and deductions might become
necessary for a variety of reasons: late paperwork, data-entry errors, modified union contracts, and
changes to employment laws, for example.

The Manage Base Benefits business process retroactive benefits and deduction features flag these events
internally and create retroactive benefit/deduction requests that you can view by employee.

Triggers for individual events and mass events are defined differently. The system identifies individual
events without any user intervention, while mass event processing occurs only by user request.

Note: Retroactive benefits and deductions features are available only if you also use PeopleSoft Payroll
for North America. Payroll for North America processes are used to calculate retroactive benefits and
deductions and to load retroactive benefit/deduction totals to payroll.

Triggering Individual Retroactive Benefit/Deduction Requests

Retroactive changes to the following pages and fields trigger PeopleCode to automatically generate an
individual retroactive benefit/deduction request:

Application Component Page Trigger Fields

Employee Pay Data General Deduction Data All fields

Enroll in Benefits Health Benefits All fields

Enroll in Benefits Life AD/D Elections All fields

Enroll in Benefits Disability Benefits All fields

Enroll in Benefits Vacation Benefits All fields

Enroll in Benefits Assign to Benefit Program All fields
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Application Component Page Trigger Fields

Job Data Work Location Effective Date

Job Data Compensation Compensation Rate

Frequency

Change Amount

Change Percent

Job Data Benefit Program Participation All fields

Note: With PeopleSoft Benefits Administration, retroactive changes can be made to the preceding pages
and fields as a result of open enrollment or event maintenance. System requests for retroactive benefits
and deductions are created exactly as if you had made these changes manually.

(USF) Pages That Trigger Individual Retroactive Benefit and Deduction Requests

Application Component Page Trigger Fields

Employee Pay Data (USF) General Deduction Data All fields

Enroll in Benefits Health Benefits All fields

FEGLI Benefits All fields

Assign to Benefit Program All fields

HR Processing USF Data Control Effective Date

Compensation Pay Rate Determinant

Pay Basis

Base Pay

FEGLI Base
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Application Component Page Trigger Fields

Current Job Compensation Compensation Rate

Frequency

Change Amount

Change Percent

Benefit Program Participation All fields

Triggering Mass Retroactive Benefit/Deduction Requests

This section discusses how to trigger mass retroactive benefit/deduction requests.

Page Used to Trigger Mass Retroactive Benefit/Deduction Requests

Page Name Definition Name Usage

Process Mass Retro Deductions Page RUNCTL_RTRODEDMASS Generates mass retroactive benefit/
deduction requests.

Related Links
Setting Up Retroactive Benefits and Deductions

Setting Up Mass Retroactive Benefit/Deduction Programs and Requests
Use the Process Mass Retro Deductions (process mass retroactive deductions) page
(RUNCTL_RTRODEDMASS) to set up:

• A mass retroactive benefit/deduction program.

• A mass retroactive benefit/deduction request with selection criteria that involve the benefit program
changes.

Related Links
Setting Up Retroactive Benefits and Deductions

Process Mass Retro Deductions Page
Use the Process Mass Retro Deductions (process mass retroactive deductions) page
(RUNCTL_RTRODEDMASS) to generate mass retroactive benefit/deduction requests.

Navigation:
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Payroll for North America > Retroactive Payroll > Retro Benefits/Deductions > Process and
Review Requests > Process Mass Retro Deductions > Process Mass Retro Deductions

Field or Control Description

Pay Calendar Validation Select to validate that the selected employees are hired into a
confirmed pay calendar before generating a request for them.

Deselect to select employees who have been placed in a
special pay group that does not yet have a confirmed pay
calendar.

Handling Duplicate Requests

A request that affects the same retroactive benefit/deduction information as a previous request is
considered a duplicate request.

The duplicate resolution process differs, depending upon the types of request that are involved (individual
or mass) and the status of the initial request.

Individual Requests

When the system encounters duplicate individual requests with different effective dates, it attempts to use
the earlier date for processing.

When a duplicate individual request is triggered and the initial individual request is not processed, the
system compares the effective dates of the two requests, keeps the request with the earlier effective date,
and deletes the request with the later effective date.

If the initial request is calculated, the system compares the effective dates of the two requests, marks the
previously calculated request Not OK to Process, sets the status to Invalidated, sets the Duplicate Flag to
Y (yes), and gives the new request the earlier of the two effective dates.

Mass Requests

For duplicate mass requests, the system checks the status of the initial request. If it is Not Processed or
Calculated, the system marks both requests Not OK To Process. You will have to examine both requests
and decide which one to run.

This process is also followed when one of the duplicate requests (either the original or the duplicate) is an
individual request, while the other is a mass request.

Related Links
Reviewing and Updating Calculated Retroactive Benefits and Deductions

Viewing Retroactive Benefit/Deduction Requests

This section discusses how to view retroactive requests.

446  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 18 Processing Retroactive Benefits and Deductions

You can view requests by employee, mass retroactive request ID, effective date, or process status.

Page Used to View Retroactive Benefit/Deduction Requests

Page Name Definition Name Usage

Retro Ben/Ded Request Summary Page RETRODED_RQST_SUMM View retroactive benefit/deduction
requests by employee, mass retro request
ID, effective date, or process status.

Retro Ben/Ded Request Summary Page
Use the Retro Ben/Ded Request Summary (retroactive benefit/deduction request summary ) page
(RETRODED_RQST_SUMM) to view retroactive benefit/deduction requests by employee, mass retro
request ID, effective date, or process status.

Navigation:

Payroll for North America > Retroactive Payroll > Retro Benefits/Deductions > Process and
Review Requests > Retro Ben/Ded Request Summary

This example illustrates the fields and controls on the Retro Ben/Ded Request Summary page. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Retro Effective Date  (retroactive effective date) and Process
End Date

Displays the date range for which retroactive benefits and
deductions will be calculated.
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Field or Control Description

Retro Request Type (retroactive request type) Displays the action that generated the request. Possible types
include:

• Benefit Deduction

• General Deduction

• Job Change

• Mass Request

Retro Program ID (retroactive program ID) The retroactive benefit/deduction program against which the
request is validated.

Only one retroactive program ID is defined for individual
requests, which are generated online. If the employee was
selected through a mass request, the mass request's mass
request ID is displayed.

Duplicate Flag Automatically set to Y when a duplicate request is identified.

Retro Ded Sequence Number (retroactive sequence number) A system-assigned sequence number that links retroactive
benefit/deduction requests with actual retroactive benefits and
deductions.

Process Flag Indicates the processing status of the request. Values include:

• Not processed: The request has been triggered but no
processing has occurred.

• Extracted: The request is in the middle of the calculation
process.

• Calculated: The request has been successfully run
through the calculation process.

• Loaded to Payroll:

• Invalidated: The request is a duplicate individual request.

• Rejected: The request cannot be processed because it
contains incorrect data.

Plan Type Appears only for requests that involve changes to general
deduction and benefit plan information.

Deduction Code Appears only for requests that involve changes to general
deduction information.

Benefit Plan Appears only for benefit plan-related requests.
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Related Links
Setting Up Retroactive Benefits and Deductions

Calculating Retroactive Benefits and Deductions

For each pay period after the process start date through the process end date, the retroactive benefit/
deduction calculation process determines:

• The original benefit and deduction amounts.

• The retroactive benefit and deduction amounts.

This section discusses how to calculate retroactive benefits and deductions.

Pages Used to Calculate Retroactive Benefits and Deductions

Page Name Definition Name Usage

Calculate Retroactive Ben/Deds Page RUNCTL_RTRODEDCALC Run the Retroactive Benefits and
Deductions Process. Set up calculation
processes for individual and mass
retroactive benefit/deduction requests.

Viewing Error Messages RETRODED_MESSAGES View error messages for the calculation
process.

Calculate Retroactive Ben/Deds Page
Use the Calculate Retroactive Ben/Deds (calculate retroactive benefit/deduction) page
(RUNCTL_RTRODEDCALC) to run the Retroactive Benefits and Deductions Process.

Set up calculation processes for individual and mass retroactive benefit/deduction requests.

Navigation:

Payroll for North America > Retroactive Payroll > Retro Benefits/Deductions > Process and
Review Requests > Calculate Retroactive Ben/Deds > Calculate Retroactive Ben/Deds
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This example illustrates the fields and controls on the Retro Ben/Ded Calculation page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Individual  and Mass Select to run an individual or a mass request. You can run all
requests or a request that is associated with a specific ID.

To process several individual employees, set up multiple run
controls for each, and then run the process several times.

Viewing Error Messages
Use the Retro Benefit/Ded Messages (retroactive benefit/deduction process) page
(RETRODED_MESSAGES) to view error messages for the calculation process.

Navigation:

Payroll for North America > Retroactive Payroll > Retro Benefits/Deduction > Process and
Review Requests > Retro Benefit/Ded Messages > Retro Benefit/Ded Messages
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This example illustrates the fields and controls on the Retro Benefit/Ded Messages page. You can find
definitions for the fields and controls later on this page.

You can select specific sets of error messages on this page. The system prompts you to search for error
messages based on aspects of the retroactive benefit/deduction requests involved. For example, you can
select error messages for retroactive benefit/deduction requests that have a specific company, pay group,
and pay end date combination.

Reviewing and Updating Calculated Retroactive Benefits and
Deductions

This section discusses how to review calculation details and override deduction totals.

Pages Used to Review and Update Calculated Retroactive Benefits and
Deductions

Page Name Definition Name Usage

Update Retro Ded Calc Results Page RETRODED_DEDS Review individual line items for each
pay end date and override deduction
amounts.

Retro Benefit/Ded Calc Summary 
(retroactive benefit/deduction calculation
summary)

RETRODED_SUMMARY View summaries of calculation totals.
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Update Retro Ded Calc Results Page
Use the Update Retro Ded Calc Results (update retroactive deduction calculation results) page
(RETRODED_DEDS) to review individual line items for each pay end date and override deduction
amounts.

Navigation:

Payroll for North America > Retroactive Payroll > Retro Benefits/Deductions > Process and
Review Requests > Update Retro Ded Calc Results > Update Retro Ded Calc Results

This example illustrates the fields and controls on the Update Retro Ded Calc Results page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Retroactive Deduction Data Results are broken up by pay end date and then further by
deduction code and deduction classification.

Use the scroll arrow to see calculations for each available
combination.

Pay End Date Derived from the employee's actual pay history, unless none
exists. This can happen if the employee is a retroactive
hire, for example. In these cases, the pay end date from the
appropriate pay calendar is used.

Company, Pay Group, Benefit Program, Plan Type, Benefit
Plan, Coverage Code, Deduction Code, Page Number (page
number), Line Number  (line number), and  Off Cycle

Populated with values from the employee's actual pay history.

If the employee has no pay history, the data is obtained from
the job row that are effective for the selected record's pay end
date. The page number and line number are set to zero, and the
Off Cycle box is deselected.
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Field or Control Description

Old Ded Amount  (old deduction amount) Shows the actual amount that was calculated in the displayed
pay period for the displayed deduction code and deduction
class.

New Ded Amount  (new deduction amount) Shows the amount that should have been deducted, according
to the current data.

Override Ded Amount  (override deduction amount) Enter a new amount to override the value in the New Ded
Amount field.

Note: For you to enter a new amount, the request must have
reached Calculation status, but cannot have reached Loaded
status.

Retro Ded Amount (retroactive deduction amount) Displays the difference between the new and old deductions.

Exception Selected for duplicate requests.

OK To Process Selected for all requests that aren't duplicates.

Note: Use the scroll arrow to see calculation amounts for each deduction code/deduction classification
combination.

Related Links
Handling Duplicate Requests

Loading Calculations into PeopleSoft Payroll for North America

This section discusses how to load calculations into PeopleSoft Payroll for North America.

Page Used to Load Calculations into Payroll for North America

Page Name Definition Name Usage

Load Retro Deductions Page RUNCTL_RTRODEDPSHT Load retroactive benefit/deduction
calculations into payroll.

Load Retro Deductions Page
Use the Load Retro Deductions (load retroactive deductions paysheets) page
(RUNCTL_RTRODEDPSHT) to load retroactive benefit/deduction calculations into payroll.
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Navigation:

Payroll for North America > Retroactive Payroll > Retro Benefits/Deductions > Process and
Review Requests > Load Retro Deductions > Load Retro Deductions

Warning! Before loading retroactive benefits and deductions to payroll, you must run Paysheet Creation
to create paysheets with normal pay for this period.

You can load employee retroactive benefit calculations by pay run ID or by company, pay group, and pay
end date. You can use either method to process an off-cycle pay run; use the pay run ID method for on-
cycle pay runs.

Note: Off-cycle payroll runs are generally used to handle one-time deduction refunds, and the resulting
refunds are delivered on separate checks from the regular payroll checks that employees receive. You
should process off-cycle retroactive benefits and deductions in conjunction with off-cycle retroactive pay
processing. When you load benefits or deductions for a particular retroactive benefit/deduction program
to Payroll for North America, the on-cycle or off-cycle selection here must match the selection for the
same program on the Retroactive Benefit/Deduction Table.

Use the same pay run ID that you set up in your regular on-cycle or off-cycle pay run. The employees
included under the ID must:

• Have already had their retroactive benefits and deductions calculated through the Retroactive Benefit/
Deduction Calculation process.

• Have at least one of their calculated benefits and deductions marked OK To Process on the Retro Ben/
Ded Calc page.

For the company, pay group, or pay end date method, if you leave a field empty, the system processes all
appropriate values for that field during the load.

Select Process Terminated Employees to have paysheets created for employees who are receiving
refunds and have been retroactively terminated.

For additional information, see product documentation for .

Setting Up Retroactive Benefits and Deductions

PeopleTools: Process Scheduler

PeopleSoft HCM: Global Payroll US

Processing Payroll for Retroactive Benefits and Deductions
After calculations are loaded, Payroll for North America processes the retroactive benefits and deductions
in the next payroll cycle. Retroactive benefits and deductions owed to the employer are collected by way
of arrears processing. You can use the arrears processing pages to control how much money is deducted
from employee paychecks.

For on-cycle processing, retroactive benefits that are owed to the employee are reimbursed in the next
paycheck. If you have used off-cycle processing, refunds are delivered in a separate check.
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Note: You can use the Retro Ben/Ded Review page to review the results of the Retroactive Benefit/
Deduction Payroll Load process at any time after it has been run. The status of the request is Loaded to
Payroll.

Related Links
Setting Up Retroactive Benefits and Deductions
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Managing Multiple Jobs

Understanding Multiple Jobs

Many organizations have employees who work in more than one job at the same time. Calculating benefit
deductions and determining benefit eligibility requires special considerations. When an employee is hired
into another position, use the Add New Assignment page in PeopleSoft HRAdminister Workforce. Each
job is assigned an employee record number and a benefit record number.

A benefit record number is used to group several jobs together for benefit purposes. Each employee
record number is unique. However, a benefit record number can be assigned to multiple employee record
numbers.

• If the new job entitles the employee to a new set of concurrent benefits, use a new benefit record
number.

• If the job does not entitle the employee to new benefits, use an existing benefit record number.

Each benefit record number must have a designated primary job. The primary job is used to process
benefit information.

• Service and termination dates are pulled from the primary job and used by the deduction processes.

• During deduction processing, the primary job determines when to take a deduction from an
employee's check.

Warning! Do not confuse the benefits-related primary job with the primary/secondary job indicator found
on the Job Data pages. These are separate fields with very different functionality.

For PeopleSoft Benefits Administration, the primary job is used to:

• Supply company and BAS (Benefits Administration) group data to the processing schedule. If a
schedule specifies a particular BAS group ID, then the BAS group ID of the primary job within a
benefit record number determines whether that employee's benefit record number is processed by the
schedule.

• Determine how credits (additional pay) for benefits are paid.

You need to determine how to group jobs for calculating benefit deductions or determining benefit
eligibility. For example, suppose a professor has three jobs:

• A dean at a college.

• A faculty member at the college.

• A physician at a hospital associated with the college.
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When the professor's job data is entered in Administer Workforce, the system updates the Primary Jobs
Table with information regarding the relationships between jobs and their benefit groups. For example,
the following attributes might result:

Job Description Employee
Record Number

Benefit Record Primary Job
Indicator

Include for
Eligibility

Include for
Deductions

Professor 0 0 Yes Yes Yes

Dean 1 0 No Yes Yes

Physician 2 1 Yes Yes Yes

The following diagram shows the employee's three jobs and two benefit records. The first two jobs as
a university professor and university dean share the same benefit record number for benefit enrollment
purposes. However, the third job as a physician at the university has its own unique benefit record number
and therefore the job is processed separately from the other jobs. Each benefit record corresponds to a set
of benefits enrollments:

You can set default rules on the Multiple Jobs Options page to determine the setting and management of
these options automatically for hires, rehires, and terminations.

458  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 19 Managing Multiple Jobs

Related Links
"Understanding Job Data" (PeopleSoft Human Resources Administer Workforce)
Setting Up Multiple Jobs

Changing Benefit Record Numbers
You should not change the benefit record number of an existing job. Doing so invalidates primary job
indicators on the effective-dated Primary Jobs Table and can result in erroneous processing within
PeopleSoft Benefits Administration and PeopleSoft Payroll for North America, which may lead to
abnormal termination of some processes.

Whenever changes are made through the Job Data, Assign Additional Jobs, or Current Job components,
the system verifies that only one job within a given benefit record is designated as the primary job. If the
system finds a problem, such as no primary job or multiple primary jobs, a worklist entry tells the benefits
administrator to run the Primary Jobs Audit Report.

Related Links
Setting Up Multiple Jobs

Understanding Multiple Jobs Data and Calculating Deductions
To calculate deductions for multiple jobs, the system needs to know the job or jobs that contribute salary
information for calculating the deduction or coverage amount for salary-based plans.

To keep track of this information, the system uses the:

• Primary Jobs Table, which is automatically maintained whenever a job is added using the Add New
Assignment page or whenever a job is terminated or rehired. This table indicates whether a job is:

• Included for Benefits Administration eligibility processing.

• Included in the deduction calculation.

• The primary job.

• Multiple Jobs Options Table, which holds the rules that are used to automatically set the flags in the
Primary Jobs Table in response to a hire, rehire, or termination. You can override these flags on the
Primary Jobs Maintenance page.

• Calculation rules, which specify how to add the employee's jobs together during the deduction
calculation process.

Even if Multiple Jobs processing is not enabled, the system populates the Primary Jobs Table whenever
employees are hired; you then have a base of primary job data if you later decide to enable multiple jobs.

Understanding Calculation Rules
The calculation rules specify how to group jobs when calculating deductions based on an employee's
salary. The following fields determine deduction or coverage amounts for salary-based plans:

• Combine Salaries check box on the Calculation Rules Table.
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• Grouping Method on the Calculation Rules Table.

• Deductions check box on the Primary Jobs Table.

The primary job indicator controls the frequency of benefit deductions. Nonearnings-based benefit
deductions (for example, rate-based deductions) are taken only when the primary job for the enrollment's
benefit record is part of the payroll calculation. Benefit deductions that are based upon actual employee
earnings, such as savings, retirement, or pension plans, are taken according to how those plans are set up,
or in some cases, according to the contribution method—either percentage of earnings or a flat amount—
that the employee selects upon enrollment.

• If the contribution is based on a percentage, the deduction is taken on every check that the employee
receives for all jobs for the benefit record associated with the enrollment.

• If the contribution is based on a flat amount, the deduction is taken only when the primary job for the
enrollment benefit record is paid.

Summary of Calculating Deductions by Plan Type

Here's how these fields are used to calculate coverage and deductions for each plan type series:

Plan Type Basis/Type Usage

Health (1x) Flat amount or compensation rate based To calculate the premium if a Salary Rate
Table is specified, salaries are combined
using the Include flag for each job along
with the combination parameters on the
Calculation Rule Table.

Life/AD&D (2x) Flat amount or compensation rate based If the coverage is based upon a factor
of salary, salaries are combined using
the Include flag for each job along with
the combination parameters on the
Calculation Rule Table.

If a Salary Rate table is specified,
 salaries are combined using the Include
Flag along with the combination
parameters on the calculation rule to
calculate the premium.
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Plan Type Basis/Type Usage

Disability (3x) Flat amount or compensation rate based To determine coverage, salaries are
combined using the Include flag for
each job along with the combination
parameters on the Calculation Rule
Table.

To calculate the premium if a Salary Rate
table is specified, salaries are combined
using the Include flag for each job along
with the combination parameters on the
Calculation Rule Table.

Savings (4x) Flat amount or earnings-based The combination parameters on the
Calculation Rules Table, as well as
the Include for Deductions flag, are
ignored: all jobs within the benefit record
contribute earnings to the deduction and
limits.

Savings plans contributions can be
expressed as either a flat amount or
a percentage of eligible earnings 
(controlled by special accumulators).
 Contributions expressed as a percentage
of eligible earnings are calculated based
upon the earnings from all jobs in the
enrollment's benefit record number in
the current check, without regard to the
setting of the Include flag for each job.
 Limits are determined using year-to-
date deductions across all benefit record
numbers.

Leave (5x) NA Not applicable. No coverage amount or
deduction exists with these plans.

FSA (6x) Flat amount Not applicable. No coverage amount
exists, and deductions are not based upon
salary or earnings.
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Plan Type Basis/Type Usage

Retirement (7x) Earnings-based The combination parameters on the
Calculation Rules Table, as well as
the Include for Deductions flag, are
ignored: all jobs within the benefit record
contribute earnings to the deduction.

Contributions are expressed as a
percentage of eligible earnings 
(controlled by a special accumulator),
 and are calculated based upon the
earnings from all jobs in the enrollment's
benefit record number, in the current
check. Limits (if any) are determined
using year-to-date deductions across all
benefit record numbers.

Pension (8x) Earnings-based The combination parameters on the
Calculation Rules Table, as well as
the Include for Deductions flag, are
ignored: all jobs within the benefit record
contribute earnings to the deduction.

Contributions expressed as a percentage
of eligible earnings are calculated based
upon the earnings from all jobs in the
enrollment's benefit record number, in
the current check. Limits (if any) are
determined using year-to-date deductions
across all benefit record numbers.

Vacation Buy/Sell (9x) CompRate-based Calculation rules are not used for
these plans, and the Include flag is
ignored. The cost is calculated by adding
compensation rates across all active
jobs in the enrollment's benefit record
number.

Related Links
Setting Up Benefit Rates
Setting Up Calculation Rules
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Changing Primary Job Data

Changing an employee's primary job indicator, Include for Eligibility flag, or Include for Deductions flag
can affect deduction calculation and processing, and benefit eligibility in Benefits Administration. This
section describes how to change an employee’s primary job data.

Pages Used to Change Primary Job Data

Page Name Definition Name Usage

Maintain Primary Job Flags Page BN_PRIJOBS_MAINT Change primary job data. Change an
employee's primary job indicator, the
Include Eligibility check box, and
the Include Deductions check box
manually.

Job Data Page BN_ADDL_DATA_INQ View job details.

Maintain Primary Job Flags Page
Use the Maintain Primary Job Flags page (BN_PRIJOBS_MAINT) to change primary job data.

Change an employee's primary job indicator, the Include Eligibility check box, and the Include
Deductions check box manually.

Navigation:

Benefits > Maintain Primary Jobs > Maintain Primary Job Flags > Maintain Primary Job Flags

This example illustrates the fields and controls on the Maintain Primary Job Flags page. You can find
definitions for the fields and controls later on this page.

Because the settings on this page are critical to the proper operation of Benefits Administration and
Payroll for North America, PeopleCode handles most of the data manipulation in the database.

Use the forward and reverse buttons to navigate through the different effective dates for which changes
to the primary jobs data have occurred. Add a new row to change the primary job designation. When you
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save the page, PeopleCode turns off the primary job designation of the previously designated job and
ensures that all of the rules for data integrity are maintained.

Field or Control Description

Job Data and Detail Click Detail to view additional job information in the Job Data
page.

Primary Job Select this check box if you want this job to be flagged as the
primary job for this benefit record number.

Include Eligibility For Benefits Administration only. Select this check box if
you want this job to be included by the system when it is
determining the employee's benefit eligibility.

Include Deductions Select this check box if you want this job to be included when
the system calculates the employee's benefit deduction and
coverage.

Note: If you change the Primary Job or the Include Deductions check boxes and Retro Deductions is
activated, the system creates a retro/deduction trigger.

Job Data Page
Use the Job Data page (BN_ADDL_DATA_INQ) to view job details.

Navigation:

Click the Detail link on the Maintain Flags page.
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This example illustrates the fields and controls on the Job Data page. You can find definitions for the
fields and controls later on this page.

The system displays the job information that is in effect as of the effective date of the selected primary
jobs entry.

Automatically Building Primary Job Data for Multiple Employees

When you have established your employee population in the database (Personal Data, Employment, and
Job tables have been loaded), use the Primary Job Utility to automatically build primary job data for one
or more employees. Run the Primary Job Utility process whenever you add a new employee population to
the database through an external interface or database load (such as when implementing employee groups
in phases or acquiring another company).

Note: When you upgrade your PeopleSoft database from a previous release, the primary jobs information
is automatically built as part of the upgrade process. You do not need to run this utility after an upgrade
unless you have added more employees to the database through an external interface after performing the
upgrade.

Page Used to Automatically Build Primary Job Data for Multiple Employees

Page Name Definition Name Usage

Rebuild Primary Job Flags Page RUNCTL_BEN500 Automatically build primary job
information for multiple employees.
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Rebuild Primary Job Flags Page
Use the Rebuild Primary Job Flags page (RUNCTL_BEN500) to automatically build primary job
information for multiple employees.

Navigation:

Benefits > Maintain Primary Jobs > Rebuild Primary Job Flags > Rebuild Primary Job Flags

This example illustrates the fields and controls on the Rebuild Primary Job Flags page. You can find
definitions for the fields and controls later on this page.

When the utility runs, it deletes all existing data for the indicated employee population (if any) in the
Primary Jobs Table. For each employee, the utility makes a new effective-dated entry, assigning the
primary job designation to the lowest active employee record within a benefit record number. Primary
job information is created for a time span bounded by the earliest and latest job effective dates for all jobs
within a benefit record. If all jobs within a benefit record are terminated, the job with the lowest employee
record is designated as the primary job.

Warning! All manual changes made through the Maintain Flags page for the selected employee
population are lost, because the complete primary job history is rebuilt for each employee.

Field or Control Description

Run Option Specify which employees to process:

Employees Specified in List: Enter one or more employee IDs
in the Employee List group box.

All Employees in the Database: Select to specify that all
employees in the Personal Data Table be processed.

Employees in a PS Table: Enter the name of any PeopleSoft
table that is defined in the Application Designer and contains
an Employee ID field.

Employees in a non-PS Table: Enter the name of a non-
PeopleSoft table that contains an Employee ID field.
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Understanding Benefit Data Extraction

Just as you provide information to employees regarding provider benefit plans, you also provide
information to benefit providers about employee changes to plan elections.

Similarly, federal agencies send changes in health plan elections to the OPM.

To send benefits data to providers:

1. Specify the information to extract from your database.

2. Run the Enrollment Reporting Snapshot program to extract the data and write it to the snapshot tables:
BN_SNAP_PER, BN_SNAP_JOB, and BN_SNAP_PLAN.

Run this step only once per reporting period and generate all of your extracts from a single snapshot.

3. Create carrier extract files for your benefit providers.

4. Review the data in the snapshot tables or review a log that contains the date and time that the
Enrollment Reporting Snapshot, Carrier Extract, and Carrier Interface Supplier Integration processes
were run.

Specifying the Data to Extract

To define what data to extract, use the Enrollment Snapshot Options (BN_SNAP_CONFIG) component.

You can extract benefit plan types and other benefit-related information, such as deduction amounts, life
and disability coverages, implied terminations, and the original enrollment date.

Page Used to Specify Data to Extract

Page Name Definition Name Usage

Enrollment Snapshot Options Page BN_SNAP_CONFIG Define data to extract from the database.

Enrollment Snapshot Options Page
Use the Enrollment Snapshot Options page (BN_SNAP_CONFIG) to define data to extract from the
database.

Navigation:
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Set Up > Product Related > Base Benefits > Enrollment Snapshot Options > Enrollment
Snapshot Options

This example illustrates the fields and controls on the Enrollment Snapshot Options page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Plan Types to Include Select only the plan types for which you will create a carrier
interface extract or transmit data to the Carrier Interface
Supplier Integration process in eBenefits.

Note: If you are running the snapshot process only to create
a HIPAA EDI 834 file, check only the Health plan type to
reduce the time necessary to populate the Snapshot tables.

Include Payroll Deduction Info (include payroll deduction
information)

Select to include the last deduction taken and the pay end date
for each enrollment.

Calculate Life/Disability Covg  (calculate life/disability
coverage)

Select to have the Enrollment Reporting Snapshot process
calculate coverage for life and disability plans using the plan
definitions, calculation rules, and employee's compensation
rate or annual benefits base rate.

Include Implied Term (include implied terminations) Select to include enrollments that are no longer valid because
the participant has enrolled in another plan type, waived
coverage, or transitioned to COBRA coverage.

Note: You use this field whenever a carrier requires a positive
notification of a termination or plan change (some carriers can
detect these events simply by noticing a previous enrollment
record).
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Field or Control Description

Include Implied Dependent Terminations Select to create termination records for dependents in the
snapshot and report them in the HIPPA file when a termination
of an employee also terminated the dependent or when new
coverage has been added for an employee and a dependent
who was previously covered has been dropped from coverage.

Note: You must select Include Implied Employee
Terminations, for Include Implied Dependent Termination 
to be functional.

Include Original Enrollment Dt  (include original enrollment
date)

Select to include an employee's earliest continuous enrollment
date in the current, active plan. This applies only to employee-
level enrollments and allocations. Changes to coverage codes
in health plans, employee-specified coverage amounts in life
and disability plans, or employee contribution amounts do not
constitute a change in plan.

This field applies to employees and dependents.

Running the Enrollment Reporting Snapshot Process

The Enrollment Reporting Snapshot process extracts data that you specified on the Enrollment
Snapshot Options page from the database and writes it to the BN_SNAP_PER, BN_SNAP_JOB, and
BN_SNAP_PLAN tables. Each time that you run the Enrollment Reporting Snapshot process, the data in
the snapshot tables is cleared and new information is written.

Every time that the Enrollment Reporting Snapshot or Carrier Report processes are run, a record is written
to the BN_SNAP_HIST table. You can review this log using the Review Interface Run History page.

This section provides an overview of database record layout details and lists the pages used to run the
Enrollment Reporting Snapshot process.

Pages Used to Run the Enrollment Reporting Snapshot Process

Page Name Definition Name Usage

Refresh Benefits Snapshot RUN_BEN100A Extract information from the Manage
Base Benefits business process tables
into the BN_SNAP_PER, BN_SNAP_
JOB, and BN_SNAP_PLAN tables.

Review Snapshot Run History BN_SNAP_HIST Review a history of when the Enrollment
Reporting Snapshot, the Carrier Interface
Extract, and the Carrier Interface
Supplier Integration processes were run.
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Page Name Definition Name Usage

Snapshot History Detail BN_SNAP_HIST_DTL Review additional information about the
history record.

Review Snapshot Information BN_SNAP_PLAN Review the information extracted by the
Enrollment Reporting Snapshot process.

Enrollment Snapshot Detail BN_SNAP_PLAN_DTL View additional information regarding
the selected enrollment or allocation
record.

Understanding Database Record Layout Details
The following tables are populated by the Enrollment Reporting Snapshot process and used by the Carrier
Interface Extract and Carrier Interface Supplier Integration processes. You need this information when
creating a provider-specific SQR (Structured Query Report) extract.

BN_SNAP_PER

This table includes one row per participant (employee, dependent/beneficiary, and so on).

COLUMN KEY NOTES

EMPLID Yes

DEPENDENT_BENEF Yes Blank for employees. Populated for
dependents and beneficiaries.

EFFDT No The as of date specified by the user on
the run control page. The value is the
same for every row. Simplifies finding
related displays and descriptions.

NAME

LAST_NAME Alt

FIRST_NAME

NAME_PREFIX
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COLUMN KEY NOTES

NATIONAL_ID Primary national ID. If the employee,
 dependent, or beneficiary has not been
assigned a primary ID, the field is blank.

BIRTHDATE

SEX

RELATIONSHIP Blank for employees.

SMOKER Y/N

STUDENT Y/N; Applies only to dependents and
beneficiaries.

STUDENT_STATUS_DT Applies only to dependents and
beneficiaries.

DISABLED Applies only to dependents and
beneficiaries.

COUNTRY

ADDRESS1

ADDRESS2

ADDRESS3

ADDRESS4

CITY

NUM1

NUM2

HOUSE_TYPE
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COLUMN KEY NOTES

ADDR_FIELD1

ADDR_FIELD2

ADDR_FIELD3

COUNTY

STATE

POSTAL

GEO_CODE

IN_CITY_LIMIT

HOME_PHONE

BN_SNAP_JOB

One row exists per employee/benefit record/COBRA event; no rows exists for dependents and
beneficiaries. For an employee with multiple jobs, all job-related information is taken from the
employee's primary job for the indicated benefit record.

COLUMN KEY NOTES

EMPLID Yes

BENEFIT_RCD_NBR Yes

COBRA_EVENT_ID Yes Nonzero indicates a COBRA enrollment
event for this employee ID/benefit record
number.

EMPL_RCD Primary job as of the date entered on the
run control page.

JOB_EFFDT Effective date of the primary job on the
Job table.
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COLUMN KEY NOTES

JOB_EFFSEQ Effective sequence of the primary job on
the Job table.

EFFDT No The as of date entered on the run control
page. The value is the same for every
row. Simplifies finding related displays
and descriptions.

SERVICE_DT Primary job.

BENEFIT_PROGRAM

COMPANY Primary job.

PAYGROUP Primary job.

CURRENCY_CD Currency code for the benefit program.

PAY_SYSTEM_FLG Primary job.

BN_SNAP_PLAN

This table includes one row per employee-level enrollment and one row per dependent/beneficiary
attachment to an enrollment.

Column Key Notes

EMPLID Yes

DEPENDENT_BENEF Yes A blank entry indicates an employee-
level enrollment. A populated entry
indicates a dependent enrollment or
beneficiary allocation.

BENEFIT_RCD_NBR Yes This is the EMPL_RCD field from the
enrollment pages.

COBRA_EVENT_ID Yes A nonzero entry indicates a COBRA
event for this employee ID/benefit record
number.
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Column Key Notes

PLAN_TYPE Yes

COVERAGE_ELECT Yes Must be a key to allow for implied
terminations.

EFFDT No The as of date specified by the user on
the run control page. The value is the
same for every row. Simplifies finding
related displays and descriptions.

BENEFIT_PLAN Coverage_Elect = E indicates an
enrollment.

Coverage_Elect = T indicates that the
plan is being terminated.

If the field is blank and Coverage_Elect
= T or W, no prior enrollment was made.

SETID Comes from the benefit plan definition.
 It is blank for 7x plans.

VENDOR_ID Blank for 7x plans.

GROUP_NBR Blank for 7x plans.

COVRG_CD Applies only to 1x plan types.

LIFE_ADD_COVRG Applies only to 2x plan types. This is
the code from the plan definition, not an
employee enrollment.

COVERAGE_BEGIN_DT For enrollments, indicates the first day
of coverage. For terminations, indicates
the first day that coverage is no longer in
effect.

COVERAGE_ELECT_DT Indicates the date that this enrollment/
termination was entered into the system.
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Column Key Notes

DEDUCTION_BEGIN_DT For enrollments, indicates the first day
that deductions and credits are in effect.
For terminations, it indicates the first day
that deductions and credits should stop.

ENROLLMENT_DT Original enrollment date (coverage begin
date) for this plan. This is the earliest
continuous coverage begin date for
this same benefit plan, ignoring change
of coverage code (1x) and coverage
amount (2x). Populated only if the
INCLUDE_ORIG option is selected,
 and only for employee-level rows where
COVERAGE_ELECT = E.

ANNUAL_PLEDGE Applies only to 6x plan types.

FLAT_DED_AMT Applies only to 4x plan types. Zero if
employee is not contributing on a before-
tax basis or contributing a percent of
earnings.

PCT_GROSS Applies only to 4x plan types. Zero if
employee is not contributing on a before-
tax basis or contributing a flat amount.

FLAT_DED_AMT_ATAX Applies only to 4x plan types. Zero if
employee is not contributing on an after-
tax basis or contributing a percent of
earnings.

PCT_GROSS_ATAX Applies only to 4x plan types. Zero if
employee is not contributing on an after-
tax basis or contributing a flat amount.

VOLUNTARY_AMT Applies only to 8x plan types. Zero if
employee is not contributing a voluntary
flat amount or is contributing a voluntary
percentage of earnings.
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Column Key Notes

VOLUNTARY_PCT Applies only to 8x plan types. Zero if
employee is not contributing a voluntary
percentage of earnings or is contributing
a voluntary flat amount.

VACN_HOURS Applies only to 9x plan types.

VACN_BUY_FLAT_AMT Applies only to 9x plan types.

VACN_SELL_FLAT_AMT Applies only to 9x plan types.

BENEF_PCT Applies only to beneficiary records in
plan types 2x, 4x, or 8x. Zero if the
beneficiary allocation is a flat amount.

FLAT_AMOUNT See the Flat Amount Field section
following this table.

FACTOR_XSALARY Applies only to employee records for 2x
plan types. This field contains the salary
factor coverage defined at either the plan
level or employee level.

EXCESS Applies only to 2x, nondependent plans
and 8x dependent records. A Y in the
field indicates that this beneficiary is to
receive any excess benefit distribution.

CONTINGENT Applies only to 2x, nondependent plans
and 8x dependent records. A Y in the
field indicates that this beneficiary is a
contingent beneficiary.

DED_CUR The amount of the last payroll deduction
calculated for this enrollment. This field
is populated only if INCLUDE_DED is
selected.

PAY_END_DT The pay end date of the last payroll
deduction calculated for this enrollment.
This field is populated only if INCLUDE
_DED is selected.
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Column Key Notes

CALCULATED_BASE Applies only to 2x and 3x plans and
only if Calculate Life/Disability Covg
is selected on the Enrollment Snapshot
Options page. This field is zero for
dependents and beneficiaries and for
employees with Sum of Dependent
Coverage elections for Dependent Life/
AD&D plans. This field indicates the
calculated benefit amount with respect to
coverage minimum/maximum, multiple
jobs, and rounding rules for coverage
purposes.

PREMIUM_BASE Applies only to 2x and 3x plans and
only if Calculate Life/Disability Covg
is selected on the Enrollment Snapshot
Options page. This field is zero for
dependents and beneficiaries and for
employees with Sum of Dependent
Coverage elections for dependent life/
AD&D plans. This field indicates the
calculated benefit amount with respect to
coverage minimum/maximum, multiple
jobs, and rounding rules for premium
purposes.

HLTH_PROVIDER_ID Applies only to 1x plan types. This field
indicates the primary care physician.

PREVIOUSLY_SEEN Applies only to 1x plan types.

DEPBEN_RIDER_FLG Applies only to dependents and
beneficiaries. Y indicates that this
coverage or allocation is court-ordered.

CALC_RULES_ID Applies only to 2x and 3x plans and
only if Calculate Life/Disability/Covg
is selected on the Enrollment Snapshot
Options page. Identifies the calculation
rule the system uses when calculating
CALCULATED_BASE and PREMIUM
_BASE.

Copyright © 1988, 2022, Oracle and/or its affiliates. 477



Sending Benefit Information Chapter 20

Understanding the Flat Amount Field

This field has different meanings depending upon the plan type and the plan context. In general, this field
represents a flat amount of Life/AD&D coverage defined at either the plan level or the employee level;
the amount may be in addition to a factor of salary coverage. For dependent life and dependent AD&D
plans, it may represent the amount of coverage elected for a particular dependent. For nondependent Life/
AD&D plans and pension plans, it may represent a flat amount beneficiary allocation.

The following tables show how this field is used in each context.

Nondependent Life/AD&D Plan Types

This table shows how the Flat Amount field is used with nondependent Life and ADD plan types. Each
column represents the value of LIFE_ADD_COVRG, which defines how the coverage is calculated for a
plan.

Participant Flat Amount Flat + Factor EE-Specified Special Calc Sum of
Dependents

Employee Flat amount of
coverage

Flat amount portion
of total coverage

Flat amount, or flat
amount portion of
total coverage

Zero (not
applicable)

Zero (not
applicable)

Dependent/
Beneficiary

Beneficiary
allocation (if flat
amount)

Beneficiary
allocation (if flat
amount)

Beneficiary
allocation (if flat
amount)

Beneficiary
allocation (if flat
amount)

Zero (not
applicable)

Dependent Life and Dependent AD&D

This table shows how the Flat Amount field is used with dependent Life and ADD plan types:

Participant Flat Amount Flat + Factor EE-Specified Special Calc Sum of
Dependents

Employee Flat amount of
coverage for each
dependent

Flat amount portion
of total coverage
for each dependent

Flat amount, or flat
amount portion of
total coverage for
each dependent

Zero (not
applicable)

Zero

Dependent/
Beneficiary

Zero (not
applicable)

Zero (not
applicable)

Zero (not
applicable)

Zero (not
applicable)

This dependent's
coverage

Pension Plans

This table shows how the Flat Amount field is used with pension plan types:
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Participant Description

Employee Zero (not applicable)

Dependent/Beneficiary Beneficiary allocation (if flat amount allocation is elected)

Sending Data to Benefit Providers

After the Enrollment Reporting Snapshot process runs, you can send enrollment data to your plan
providers. Two ways are available to send this information:

• Run the appropriate SQR Provider Extract process to create a provider extract file.

• Use the PeopleSoft Carrier Reporting process in eBenefits.

This section discusses how to:

• Create SQR provider extracts.

• Run carrier extracts.

Related Links
"Integrating eBenefits with eBenX" (PeopleSoft eBenefits)

Creating SQR Provider Extracts
Provider requirements for enrollment data are seldom the same. The Manage Base Benefits business
process includes a set of sample extract SQR programs that you can modify for your providers. Each
sample SQR program:

• Includes a realistic set of data fields for the associated plan types.

• Records a history of each run.

• Sends an enrollment termination to a provider only once.

After determining file layout requirements for your providers, clone the appropriate sample SQR program
for each file layout that you need and make any necessary changes using the database record layout
information for BN_SNAP_PER, BN_SNAP_JOB, and BN_SNAP_PLAN.

Four sample SQRs and two library files are available:

• BEN102.SQR: sample file extract for health (1x) plans.

• BEN103.SQR: sample file extract for life/AD&D (2x) plans.

• BEN104.SQR: sample file extract for disability (3x) plans.

• BEN105.SQR: sample file extract for savings (4x) plans.
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• BENCRFNC.SQC: library of useful functions for developing provider extracts.

• BENCRTBL.SQC: library of internal cache tables.

Running Carrier Extracts
Create a flat file that can be sent to your plan providers. Use the Health, Life/ADD, Disability, and
Savings Extract pages, or your own provider-specific pages to do this.

If you rerun an extract because of a problem and have set up the extract to send terminations only once,
delete the run history record for this extract on the Review Interface Run History page before running the
extract again.

Sending HIPAA Data to Providers

Note: With the Affordable Care Act, HIPAA Certificates have become obsolete, and effective 1/1/2015,
they are no longer required.

The Health Insurance and Portability and Accountability Act of 1996 (HIPAA) requires a standard
electronic exchange of administrative and financial health care transactions between health care providers
and plans. The PeopleSoft HIPAA EDI File Create process enables you to send these HIPAA 834
transactions.

Note: Three types of data fields and segments exist for the HIPAA file output. They are: Required,
Situational, and Situational and under the insurance contract between the sponsor and the payer. The
PeopleSoft HIPAA EDI File Create process supports all Required data fields and segments. The process
might or might not support Situational fields and segments depending on whether information is available
for them in the system. Data fields and segment that are identified as Situational, and depends upon
contract are not supported. If your contract requires that you provide any except Required information,
you might need to customize the process to include it.

Before you can send HIPAA data to providers, you must:

1. Identify the providers on the Benefits EDI Trading Partners page who will be receiving the transaction
transmission.

2. Use the Benefits EDI 834 Transaction Map Table page to convert PeopleSoft code values to the
values required by the reporting standard.

3. Run the Refresh Benefit Snapshot process to populate the Benefit Snapshot extract tables with the
health plan data required to create the 834 transactions.

Note: Select the Use Runtime Date on the Refresh Benefit Snapshot (RUNCTL_ASODATE_BEN)
run control page for recurring processing when you schedule the Snapshot process to run at specified
intervals using automated Process Scheduler Recurrence definitions. With the check box selected, the
system automatically sets the As Of Date equal to the runtime date at each run without the need for
user intervention.

This section discusses how to create the HIPAA EDI 834 file.
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See Setting Up HIPAA Tables.

Page Used to Create the HIPAA EDI 834 File

Page Name Definition Name Usage

Create HIPAA 834 File Page RUNCTL_BEN834 Create the HIPAA EDI 834 file. Identify
the EDI trading partner, vendors, plan
types, and companies to include in the
transmission and run the process to
create the 834 transactions.

Create HIPAA 834 File Page
Use the Create HIPAA 834 File page (RUNCTL_BEN834) to create the HIPAA EDI 834 file.

Identify the EDI trading partner, vendors, plan types, and companies to include in the transmission and
run the process to create the 834 transactions.

Navigation:

Benefits > Interface with Providers > Create HIPAA EDI 834 File > Create HIPAA 834 File
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This example illustrates the fields and controls on the Create HIPAA 834 File page, 1 of 2. You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Create HIPAA 834 File page 2 of 2. You can find
definitions for the fields and controls later on this page.

To run the Create HIPAA EDI 834 File process, you must enter an EDI partner ID and at least one vendor,
company, and plan type.
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Field or Control Description

As Of Date Displays the last date that the Enrollment Reporting Snapshot
was run.

Note: You should not the snapshot using the current date as
the As of Date.

File Effective Date Enter a value that the system sends in a DTP segment (which
includes a date qualifier of 007).

File Enrollment Date Enter a value that the system sends in a DTP segment (which
includes the date qualifier of 382).

Acknowledgement Requested Select to request an acknowledgement from the EDI trading
partner.

EDI Partner ID Enter the trading partner for the transmission.

EDI partner IDs are defined on the EDI Transaction Partner
table.

File Type Select from one of the following values in this drop-down
menu:

• Full File Audit: Select this value to create a file
that contains records for all employees, including
terminations. This file type is the default.

• Full File Replacement: Select this value to create a file
that contains current records only as of the date of the file.
 The system drops all terminated employees from the file.
 This file is typically used in conjunction with Update
Only files and is sent to verify synchronization between
the two systems.

• Update Only File: Select this value to create a file that
contains only those records in which changes have
occurred to either the employee or any of his or her
dependents' records that are relevant to the vendor and
can be tracked in through the use of effective dates.

Note: When you select Update Only File, the following
fields appear and are required: From Date and To Date.

From Date and To Date This date range filters the change records to include only those
employee records that had changes within the date range.
 Benefit enrollment records use the Election Date as the date
that the change was made. This allows for backdated changes
in addition to future changes to be included in the file.

The system sets the to date automatically to the snapshot as of
date.
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Field or Control Description

Include All Vendors Select to include all vendors who are classified as providers
on the Provider/Vendor table and also appear on the Snapshot
Plan table.

Vendor ID Enter the vendor to be included in the transmission.

Valid values are only those vendors who are classified as
providers on the Provider/Vendor table and also appear on the
Snapshot Plan table.

Note: The providers selected for the 834 transaction must
have a valid Federal Employer Identification Number (FEIN)
entered on the Provider/Vendor table. The system generates a
warning if the FEIN is missing for one or more providers.

Include All Companies Select to include all companies that appear on both the
Company table and on the Snapshot Plan table.

Company Enter the company (employer) to be included in the
transmission.

Valid values are only those vendors who appear both on the
Company table and on the Snapshot Plan table.

Note: The companies selected for the 834 transaction must
have a valid FEIN entered on the Company table. The system
generates a warning message if the FEIN is missing for one or
more companies.

Include All Plan Types Select to include all plan types that appear on the Snapshot
Plan table.

Plan Type Enter the plan type to include in the transmission.

Valid values are only those plan types that appear on the
Snapshot Plan table.

Include All Benefit Plans Select to include in the 5010 version of the HIPAA file, all
benefit plans that appear on the Snapshot Plan table.

Note: To generate the 5010 version of the HIPAA file, select
the 5010 process on the Process Scheduler Request page.
 Oracle’s PeopleSoft does not support the 4010 version.

Benefit Plan Enter the benefit plan to include in the transmission of the
5010 version of the HIPAA file.

Valid values are only those benefit plans that appear on the
Snapshot Plan table.
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Field or Control Description

Include All Group Numbers Select to include in the 5010 version of the HIPAA file, all
group numbers that appear on the Snapshot Plan table.

Group Number Enter the group number to include in the transmission in the
5010 version of the HIPAA file.

Valid values are only those group numbers that appear on the
Snapshot Plan table.

Max Members in Transaction Set (maximum members in
transaction set)

Specify the maximum number of members to include in each
transaction set of the transmission.

The default value is 10,000, which is the maximum allowed by
the reporting standard, but you can set a lower number not less
than 100.

Related Links
Setting Up HIPAA Tables

(USF) Sending FEHB Data to the OPM

Federal agencies must send quarterly reports to major FEHB providers. These reports enable the provider
to compare their enrollment records with the agency's records.

To send FEHB data to the OPM:

1. Identify the employees and dependents who are enrolled in Medicare A, Medicare B, and Champus
plans using the Benefits Personal Data and the Federal Medicare Flags pages.

2. Run the FEHB Carrier Interface process to extract the data and write it to the extract file.

Note: The run control ID cannot be more than 8 characters.

Note: You must specify at least one plan or select the All Plans check box.

3. Send the data by running the Transmit Enrollments to eBenX.

4. Review the data using the Review FEHB Interface History page or the FEHB Reconciliation report.

Pages Used Send FEHB Data to the OPM

Page Name Definition Name Usage

FEHB Carrier Interface GVT_RUN_FGBN001 Extract data to send to the OPM.
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Page Name Definition Name Usage

Transmit Enrollments to eBenX (transmit
enrollments to electronic benefits
transmission)

BN_M_RUN_CNTL Sends data to the OPM.

Review FEHB Interface History GVT_INT_HIST Review data in the extract file.

Related Links
Benefits/FEHB Data Page
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Defining Benefit Rates for U.S. Same-Sex
Spouse

Understanding the U.S. Same-Sex Spouse Relationship

This topic describes the same-sex spouse relationship as assigned by the U.S. Federal Government.

You can define health care premium and life insurance benefit rates attributed to U.S. same-sex spouse for
taxation by state and local jurisdictions that do not recognize same-sex marriages.

On August 29, 2013 the IRS published IR-2013-72 stating that the U.S. Department of Treasury and the
IRS ruled that same-sex couples, legally married in a jurisdiction that recognizes same-sex marriage, will
be treated as married for federal purposes. The ruling applies regardless of whether the couple currently
resides in a jurisdiction that recognizes same-sex marriage or in a jurisdiction that does not recognize
same-sex marriage.

As per the IRS ruling, employees who purchase same-sex spouse health insurance coverage from their
employers may treat the amounts paid for that coverage as pre-tax and excludable from income. This
ruling affects taxation of spousal benefits including health and accident benefits (including employee
pre-tax contributions under IRC Section 125 plan), health savings accounts, health reimbursement
arrangements, and long-term care.

PeopleSoft HCM applications enable employers in states that do not recognize same-sex marriage to
process benefits and taxes for the new same-sex spouse dependent relationship. Specifically, PeopleSoft
HR Manage Base Benefits enables users to define the health care premium rates and life insurance rates
attributed to same-sex spouse for states and local jurisdictions that do not recognize same-sex marriages.

Understanding Benefit Rate Enhancements for U.S. Same-Sex
Spouse

This topic describes benefit rate enhancements for U.S. same-sex spouse.

The U.S. Federal Government recognizes same-sex marriage. Some states (and local jurisdictions within
those states) do not.

The same-sex spouse dependent relationship affects both the before-tax spouse portion and nontaxable
employer-contributed spouse portion of a benefit plan. In addition, for states that do not recognize same-
sex marriage, employers must process taxable benefits differently at the state and local level than at the
federal tax level.

For states that recognize same-sex marriage, the total (employee and beneficiaries) health and life
insurance benefit deduction amount reduces both federal and state taxable gross for dependent spouse
relationships.
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For states that do not recognize same-sex marriage, taxable benefits are processed differently at the state
and local level than at the federal tax level. For states that do not recognize same-sex marriage, the spouse
portion of benefits is taxable. In this situation, the state taxable same-sex spouse portion of the benefit
premium must be added to the federal taxable gross to determine the state taxable gross.

The employee contribution for the same-sex spouse and the employer contribution for the same-sex
spouse need to be separated, to be able to impute the appropriate portion of the deduction amount
according to each state and local jurisdiction. In addition, the ability to choose a deduction class to be
adjusted is also required.

This is to account for the following scenarios:

• In some states, the local tax jurisdictions do not recognize before-tax Sec 125 deductions and require
that such deduction amounts be added back in order to determine the employee’s local taxable wages.

• Some states do not exclude Sec 125 before-tax deductions from state unemployment taxable
wages. This does not impact employee paychecks, but impacts the employer’s correct reporting of
state unemployment taxable wages, and therefore state unemployment tax due.

The HR Manage Base Benefits product accounts for the above scenarios. For states/locals where tax
adjustment amounts need to be separated for the before-tax spouse portion and the employer contributed
spouse portion of a benefit plan, users can specify multiple tax adjustment amounts. These multiple tax
adjustment amounts are defined in a new Other Rates table found in the Benefit Rate definition identified
by Other Rate ID and Deduction Class.

To comply with different state tax processing requirements for states that do not recognize same-sex
marriage, the Taxable Gross Component ID ‘SSP’ is used on the Taxable Gross Definition Table for
each state, with the corresponding Tax Adjustment Other Rate ID and deduction class attached. For more
information about the use of the Taxable Gross Component ID, Other Rate ID, and deduction class in the
Taxable Gross Definition Table, see product documentation for Payroll for North America.

Reviewing U.S. Same-Sex Spouse Benefit Rates Setup

This topic describes the setup for U.S. same-sex spouse Benefit Rates.

• The Benefit Rates table enables additional tax adjustment rates to be defined for each row of rate data.

• The Other Rates table enables defining tax adjustment amounts that are different for the before-
tax spouse portion and the employer-contributed spouse portion of a benefit plan. Users can enter
different tax adjustment rates for the same-sex employee, spouse, and children.

Page Used to Set Up Same-Sex Spouse Benefit Rates

Page Name Definition Name Usage

Benefit Rates Page BN_RATE_TABLE Enter benefit rate information.
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Page Name Definition Name Usage

Other Rates Page BN_OTH_RATE_SEC Enter different tax adjustment rates for
the Other Rate IDs Employee – SS Rate,
Spouse – SS Rate and Children – SS
Rate.

Benefit Rates Page
You can enter more than one tax adjustment amount using the Benefit Rates Table. For each row of rate
data in the Benefit Rate Table, additional tax adjustment rates can be defined using the ‘Other Rates’ link.
This applies to all Benefit Rate Types. The ‘Other Rate’ will only apply to Detail Rates (by Deduction
Classes) and not to Composite Rates (by Employee and Employer Rate).

Navigation:

Set Up HCM > Product Related > Base Benefits > Rates and Rules > Benefit Rates>Tax Adjustment

This example illustrates the fields and controls on the Benefit Rates page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Tax Adjustment The rates on this page is used for existing tax adjustments that
do not require a different rate ID. If the TGCID entered on the
TGCID Definition Table does not have a corresponding Other
Rate ID, this amount will be used.

Other Rates This links to the ‘Other Rates’ table where other tax
adjustment rates are defined.
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Field or Control Description

Other Rates Exist This check box indicates whether other rates exist or not.

Other Rates Page
Use the Other Rates page to enter tax adjustment amounts that are different for the before-tax spouse
portion and the employer-contributed spouse portion of a benefit plan.

You can enter different tax adjustment rates for the Other Rate IDs Employee – SS Rate, Spouse – SS Rate
and Children – SS Rate.

Navigation:

Click the Other Rates link in the Benefit Rates page — Tax Adjustment tab.

This example illustrates the fields and controls on the Other Rates page. You can find definitions for the
fields and controls later on this page.
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Field or Control Description

Other Rate ID Select the Other Rate ID.

Other Rate IDs Employee – SS Rate, Spouse – SS Rate and
Children – SS Rate are delivered with the system. Other Rate
IDs per Deduction Class are linked to the TGCID entered on
the Deduction Table and Taxable Gross Definition.

Other Tax Rate Enter the tax rate for the Other Rate ID.

If the TGCID entered on the Taxable Gross Definition has
an Other Rate ID and Deduction Class that matches a row in
Other Rates, then this rate will be used to adjust the base gross.

Translate Values
Use the translate values Employee – SS Rate, Spouse – SS Rate and Children – SS Rate delivered with the
system, for the Other Rate ID.

This example illustrates the fields and controls on the Maintain Translate Values page for the Other Rate
ID.

Setting Up Health Insurance

For benefits rate IDs used for health benefit plans, do the following:

• Add coverage codes 22 and 24 to the benefit rates table.

• Specify Other Rates for these coverage codes. Use the Other Rates page to specify tax adjustment
amounts that are different for the before-tax spouse portion and the employer-contributed spouse
portion of a benefit plan. Enter different tax adjustment rates for Other Rate IDs.

Taxable Gross Component ID (TGCID) originates from Taxable Gross Definition and is a pointer to
where the Gross Adjustment is calculated from. TGCID is set at Deduction Table per Deduction Class. A
new TGCID ‘SSP’ is delivered to be associated with the Other Rates taxable gross adjustments for same-
sex spouse rate. The current TGCID ‘SSS’ set up in the Taxable Gross Definition table remains the same
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without Other Rate ID and Deduction Class associated with it; tax adjustment still originates from the
corresponding main Detail Rates per Deduction Class in the Benefits Rate table and not from the Other
Rates table. Thus for a State or Locality, it is possible to have both TGCIDs ‘SSS’ and ‘SSP’, but a user
would normally associate only one TGCID - either ‘SSS’ or ‘SSP’ per Deduction Class in the Deduction
Table, to get the corresponding tax adjustment rate from one source, i.e., either from the main Benefit
Rate table or Other Rates table, respectively.

Tax Adjustments defined in the Tax Adjustment tab of the Benefit Rate table is normally used as an extra
tax adjustment bucket that is different from the Detail Rate. If the Tax Adjustment currently contains
the same-sex tax adjustment, the user has to zero it out if new Other Rate will be used to define this
adjustment.

In summary, the keys Deduction Class, Other Rate ID and TGCID link Benefit Rates/Other Rates,
Deduction Table and Taxable Gross Definition to come up with Tax Gross Adjustment Rate. Consider
whether to define other taxable gross adjustment either using the main Tax Adjustment or Other Rates to
avoid duplicating rates defined in both.

For more information, refer to the document Taxation for U.S. Same-Sex Spouse Benefits in PeopleSoft
Payroll for North America in My Oracle Support.

Setting Up Spousal Life Insurance

This topic describes how to set up spousal life insurance for U.S. same-sex spouse.

Set up new dependent life plans and spousal life plans for U.S. same-sex spouse, to use benefit rates
different from the existing spouse relationship.

1. Set up a dependent life plan. The following screenshot shows a sample dependent life plan KUDLSS.
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This example illustrates the fields and controls on the Benefit Plan Table page.

This plan uses a new Benefit Rate ID KUSSS in the benefit program.

This example illustrates the fields and controls on the Option page.

2. Set up a spousal life plan. The following screenshot shows a sample spousal life plan KUSSL.
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This example illustrates the fields and controls on the Benefit Plan Table page.

This plan uses a new benefit rate ID KUSSS in the benefit program.

This example illustrates the fields and controls on the Benefit Program — Cost page.

3. This new Rate Table ID KUSSS is using detail rates. Specify the tax adjustment using the Other Rates
link on the Benefit Rates page.
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This example illustrates the fields and controls on the Benefit Rates page.

This example illustrates the fields and controls on the Other Rates page.
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Managing U.S. Health FSA Carryover

Understanding U.S. Health FSA Carryover

This topic provides an overview of US Health Flexible Spending Accounts (FSA) carryover.

Participants in health benefit plans (Plan Type 60) can carry over up to $500 from their FSA from year to
year.

A health FSA is treated as a qualified benefit, provided that the $125 cafeteria plan limits each
employee’s salary reduction contributions to the health FSA to not more than $2,500 per taxable year. A
participant can submit a claim for reimbursement of expenses for qualified benefits incurred during the
plan year, during the run out period immediately following the end of a plan year. Additionally, a grace
period rule allows an employee to use amounts remaining from the previous year (including amounts
remaining in a health FSA) to pay expenses incurred for certain qualified benefits during the period of up
to two months and 15 days immediately following the end of the plan year.

PeopleSoft HR Manage Base Benefits permits the use of up to $500 of unused amounts in a health FSA
in the immediately following plan year. The carryover of up to $500 may be used to pay or reimburse
medical expenses under the health FSA incurred during the entire plan year to which it is carried over,
and thus save the unused amount from being forfeited at the end of the plan year. The carryover of up
to $500 does not affect the $2,500 salary reduction limit applicable to each plan year. Although the
maximum unused amount that can be carried over in any plan year is $500, plan sponsors can specify a
lower amount as the permissible maximum, or not permit any carryover at all.

Plan sponsors have the option to allow employees a grace period after the end of the plan year. However,
a health FSA cannot have both a carryover and a grace period at the same time. It can have only one of
these options, or none.

Setting Up U.S. Health FSA Carryover

This topic describes how to set up U.S. Health FSA Carryover.

US Health FSA Carryover enables you to:

• Set up the FSA Benefits table to use either the grace period option, or the carryover option, or none.

• Set the maximum FSA carryover limit. The maximum carryover amount should not exceed $500.

• Adjust the carryover balance.

Additionally, you can:

• Review and override the FSA carryover amount during benefits enrollment.

• Review available claim amounts.
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• Review the carryover amount using the Year-to-Date Activity page.

Use the FSA Benefits Table > FSA Admin Config tab to define the maximum FSA carryover limit.

Navigation:

Set Up HCM > Product Related > Base Benefits > Plan Attributes > FSA Benefits Table > FSA
Admin Config

This example illustrates the fields and controls on the FSA Benefits Table page. You can find definitions
for the fields and controls later on this page.

The following table lists the carryover option used, based on the FSA Service From and Through dates:

Validation Carryover Option

If FSA Service Through Date – FSA Service From Date is <=
12 months and Carryover Limit is blank

No carryover option is used.

If FSA Service Through Date – FSA Service From Date is >
12 months and Carryover Limit is blank

Grace Period is allowed.

If FSA Service Through Date – FSA Service From Date is <=
12 months and Carryover Limit > 0

Carryover Amount is used.

If FSA Service Through Date – FSA Service From Date is >
12 months and Carryover Limit > 0

This is an invalid entry. An error message will be displayed.
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Note: As a Benefits Administrator, ensure the following when setting up the FSA Configuration for each
plan year:
A $125 cafeteria plan that allows FSA carryover cannot have an additional grace period in the plan year
to which unused amounts are carried over. Accordingly, if a plan permits amounts unused in a plan year
to be carried over to the following plan year, the plan cannot provide for a grace period in the plan year
to which the amount is carried over. For example, a calendar year plan permitting a carryover of unused
2014 health FSA amounts to 2015 cannot have a grace period in 2015, but might have had a grace period
during the first 2 ½ months of 2014.
If a plan has a grace period and is amended later to add a carryover provision, the grace period provision
must be eliminated by no later than the end of the plan year from which amounts may be carried over. The
ability to eliminate a grace period provision previously adopted for a plan year in which the amendment is
adopted may be subject to legal constraints.

Reviewing the Carryover Amount during Benefits Enrollment

This topic describes how to review the carryover amount during benefits enrollment.

Use the Spending Accounts page for Plan Type 60 to review the FSA carryover amount during benefits
enrollment. The Carryforward section displays the available carryover amount.

Navigation:

Benefits > Enroll In Benefits > Spending Accounts

This example illustrates the fields and controls on the Spending Accounts page. You can find definitions
for the fields and controls later on this page.

The Carryover Amount is generated as follows, depending on whether the FSA Admin installation table
is used:
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Installation Table Spending Accounts – Carryover fields

FSA Admin is selected The FSA Admin feature is in use. The carryover amount is
generated by the system.

The Carryover Amount field is display only.

FSA Admin is not selected Only Base Benefits is in use. The carryover amount is not
generated by the system.

• The Carryover Amount field is display only.

• The amount displayed is entered through carryover
adjustment.

Reviewing Available Claim Amounts

This topic describes how to review available claim amounts.

When creating or reviewing claim details using the Create/Modify FSA Claim pages, review the total
FSA claim amount on the Amount Available field. The field displays the total of the amount available
for the current claim year, and any amount that is in the carryover bucket during the run-out period. The
carryover amount is also displayed in the Carryover Amount field, after the previous plan year is closed
out.

Navigation:

Benefits > Admin Flex Spending Acct US > Submit Claims > Create FSA Claims

This example illustrates the fields and controls on the Create FSA Claims page.

Navigation:

Benefits > Admin Flex Spending Acct US > Review Claim/Payment Info > FSA Claim Details
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This example illustrates the fields and controls on the FSA Claim Details page.

Reviewing Year-to-Date Activity

This topic describes how to review year-to-date activity to review the amount that is carried over to the
next year during FSA closure.

Use the Year-to-Date Activity page to review the amount that is carried over to the next year during FSA
closure. The page displays the carryover amount from the prior year, and the carryover adjustment IT'D.
The carryover adjustment IT'D is the adjustment made to the carryover amount from the prior year, during
the current plan year.

Navigation:

Benefits > Admin Flex Spending Acct US > Review Claim/Payment Info > Year-to-Date Activity

This example illustrates the fields and controls on the Year-to-Date Activity page.
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Note: In order to allow the system to process the carryover amount correctly, ensure that you run FSA
Closure for the previous FSA Plan Year.

Adjusting the FSA Carryover Amount

This topic describes how to adjust the FSA carryover amount.

The FSA carryover amount will have to be adjusted in the following scenarios:

• For Base Benefits customers who do not use FSA Administration but want to keep a record of the
carryover amount.

• During the first year of an employee using FSA Administration and has a carryover amount being
brought in from a third party system.

• An employee needs to transfer a carryover amount from a different plan.

• For claim adjustment for history FSA Plan Years which affects the carryover amount.

Page Used to Adjust the FSA Carryover Amount

Page Name Definition Name Usage

Spending Account Adjustment Page Adjust the FSA carryover amount.

Spending Account Adjustment Page
Use the Spending Account Adjustment page to adjust FSA carryover amount.

Navigation:

Benefits > Enroll in Benefits > Spending Account Adjustment  > Spending Account Adjustment
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This example illustrates the fields and controls on the Spending Account Adjustment page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Adjustment to Carryover Amount Enter the FSA carryover adjustment amount.

Balance after Adjustment View the adjusted carryover balance.

Note: FSA carryover adjustment can be done only for the earliest open plan year. The adjusted current
carryover balance will be displayed on the Year-to-Date Activity page of the earliest open plan year in
the Carryover Balance field, and on the Year-to-Date Activity page of the following year under the
Carryover Amount from Prior Year field.
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Managing U.S. Affordable Care Act
Regulations

Understanding ACA Eligibility

This section provides an overview of U.S. ACA – Employer Shared Responsibility for Affordable Health
Coverage.

For general information about the ACA process as handled in PeopleSoft, see video:Affordable Care Act.

Based on the Affordable Care Act, employers employing at least 50 full-time employees (or a
combination of full-time and part-time employees that is equivalent to at least 50 full-time employees)
will be subject to the Employer Shared Responsibility provisions. Under these provisions, if these
employers do not offer affordable health coverage that provides a minimum level of coverage to their full-
time employees, they may be subject to an Employer Shared Responsibility payment if at least one of
their full-time employees receives a premium tax credit for purchasing individual coverage on one of the
new Affordable Insurance Exchanges.

Note: To be subject to these Employer Shared Responsibility provisions, an employer must be an
ALE (Applicable Large Employer), i.e., the employer must have at least 50 full-time employees or a
combination of full-time and part-time employees that is equivalent to at least 50 full-time employees (for
example, 100 half-time employees equals 50 full-time employees). A full-time employee is an individual
employed on average at least 30 hours per week; a half-time employee would be 15 hours per week.

The following terminology may be of use to understand ACA Eligibility:

• Employer Shared Responsibility: Employers with 50 or more employees will be required to provide
health benefits to full-time (30 or more hours per week) employees or pay a penalty per employee,
depending on the situation.

• ACA Full-time: An employee defined as working, or hired and expected to work at least 30 hours per
week or 130 hours per month: (52 weeks x 30 hours)/12 months = 130 hours per month.

• Standard Measurement Period: Determined by employer, and can be of duration from three to 12
consecutive months. The employer determines an employee’s average service hours based on the
standard measurement period.

• Stability Period: The stability period must be at least six months and not lesser than the standard
measurement period. If an employee is determined to be ACA full-time during the standard
measurement period, the employee is considered full-time during a subsequent stability period,
regardless of the employee’s number of hours of service during the stability period, as long as the
individual remains an employee. The stability period begins after the standard measurement period
and after any applicable administrative period.
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• Administrative Period: The time between the standard measurement period and the associated
stability period when employers determine ongoing employees’ eligibility for benefits coverage. The
administrative period may last up to 90 days after the standard measurement period.

• Limited Non-Assessment Period: A limited non-assessment period refers to a period during which
an ALE member is not subject to Employer Shared Responsibility payment under section 4980H(a) of
the Internal Revenue Code, and in certain cases section 4980H(b), for a full-time employee, regardless
of whether the employee is offered health coverage during that period.

• Ongoing Employee: An employee who has been employed by the employer for at least one complete
standard measurement period.

• New Employee: An employee who has been employed by the employer for less than one complete
standard measurement period.

• Variable Hour Employee: An employee for whom, based on facts and circumstances on his or her
start date, it cannot be determined whether the employee is expected to work on an average of at least
30 hours of service per week during the initial measurement period.

• Seasonal Employee: An employee who is hired into a position for which the customary annual
employment is 6 months or less. For example, retail workers or ski instructors.

Setting Up ACA Eligibility Tables

This section provides an overview of multiple companies and ACA Eligibility tables and describes how to
set up ACA Eligibility tables for HR Manage Base Benefits.

Note: ACA employer shared responsibility takes into account only the work performed in the United
States. Employees working abroad, whether or not U.S. citizens, will not be taken into account for
determining whether the employer owes an Employer Shared Responsibility payment. Therefore, include
only U.S. companies in this table.

Pages Used to Set Up ACA Eligibility Tables

Page Name Definition Name Usage

ACA Common ID Table Page ACA_TBL Define ACA Common IDs to group
together companies under the same
ownership.

ACA Company Table Page ACA_CMPY_TBL Assign a company to an ACA Common
ID.

Understanding Multiple Companies and ACA Eligibility Tables
Based on IRS rules, companies that have a common owner or that are otherwise generally related are
combined and treated as a single employer for determining whether or not they collectively employ a
minimum of 50 full-time employees (or full-time equivalents). If the combined employee total meets
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the minimum requirement, each separate company is subject to the Employer Shared Responsibility
provisions, including those companies that individually do not employ enough employees to meet the
minimum requirement.

Note: The rules for combining related employers do not apply for purposes of determining whether a
particular company owes an Employer Shared Responsibility payment. This will be determined separately
for each related company.

For example, if three companies have common ownership and each of the three companies has only 40
employees, since the combined employee count of the three companies is greater than 49, each of the
three individual companies is subject to the Employer Shared Responsibility provisions and requirements.
Each company is then evaluated individually to determine whether or not that company complies with the
Employer Shared Responsibility provisions and requirements. If two of the companies are found to be in
compliance (i.e., all eligible employees are offered health coverage) and one company is found not to be
in compliance (i.e., at least one of its employees purchased insurance on one of the state exchanges), only
the non-compliant company will be subject to any applicable penalties.

To account for this scenario, group companies under the same ownership using ACA Common ID table
and ACA Company table.

ACA Common ID Table Page
Use the ACA Common ID Table page (ACA_TBL) to define ACA Common IDs to group companies
under the same ownership.

Navigation:

Set Up HCM >Common Definitions >Affordable Care Act >ACA Common ID Table

This example illustrates the fields and controls on the ACA Common ID Table page.

ACA Company Table Page
Use the ACA Company Table page (ACA_CMPY_TBL) to associate a company to an ACA Common
ID. This is effective dated; i.e., a company can be associated to different ACA Common IDs at different
points in time.

Navigation:

Set Up HCM > Common Definitions > Affordable Care Act > ACA Company Table
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This example illustrates the fields and controls on the ACA Company Table page.

Recording ACA Data

This topic discusses how to record ACA data for an employee.

Page Used to Record ACA Data for an Employee

Page Name Definition Name Usage

ACA Employee Eligibility Page ACA_ELIGIBILITY Enter ACA eligibility details for an
employee.

ACA Employee Eligibility Page
Use the ACA Employee Eligibility page (ACA_ELIGIBILITY) to enter ACA eligibility information for
an employee.

Navigation:

• Click the ACA Eligibility Details link on the Job Data - Benefit Program Participation page.

• Benefits > Employee/Dependent Information >ACA Employee Eligibility >ACA Employee
Eligibility
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This example illustrates the fields and controls on the ACA Employee Eligibility page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Effective Date Enter the date on which the ACA eligibility status becomes
effective.

The effective date is usually the start of a stability period, but
can be different if required.

ACA Eligibility Status Choose the ACA eligibility status from the following values:

• Always Eligible: For example, a salaried full-time
employee who is always eligible for benefits.

• Eligible: An employee whose average hours is equal to
or above the minimum hours/week or hours/month so
that the employee is considered Benefits Full Time. The
employee is eligible for benefits.

• Excluded: For example, volunteer employees, student
employees, members of religious orders.

• Ineligible: An employee whose average hours is below
the minimum hours/week or hours/month so that the
employee is considered Benefits Part Time. The employee
is not eligible for benefits.

• To Be Determined: Unable to determine whether the
employee is Benefits Part-Time or Full-Time. Human
Resources needs to review and determine the employee’s
ACA Eligibility status.
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Field or Control Description

Non-Assessment Period Choose whether the employee is in a non-assessment period.

On selecting the Non-Assessment Period checkbox, the
Limited Non-Assessment Information section will be
displayed to enter further information about the employee’s
non-assessment period. The effective date represents the start
of the non-assessment period.

Average Hours of Service Enter the average hours based on all the jobs the employee has
under the same ACA Common ID.

Work Period Choose whether the work period for the average hours of
service is Weekly or Monthly.

Calculation Method Choose the calculation method used to determine ACA
eligibility. The values are:

• Monthly

• Look Back

Measurement Period The measurement period corresponds to the Look Back
calculation method. The measurement period should be
between 3 to 12 months if the work period is Monthly, and 12
to 52 weeks if the work period is Weekly.

Evaluation Period Begin Date Enter the start date of the Look Back period to be used to
determine the employee’s average service hours.

Evaluation Period End Date Enter the end date of the Look Back period to be used
to determine the employee’s average service hours. The
evaluation period cannot be less than three months or more
than 12 months.

Administration Period Begin Date Enter the next date after the evaluation period end date.

Administration Period End Date Enter a date within 90 days from the administration period
begin date.

ACA Stability Period Begin Date Enter the start date of the stability period in which the ACA
eligibility status or average hours of service is effective.

The ACA stability period begin date must be after the
evaluation period end date.
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Field or Control Description

ACA Stability Period End Date Enter the minimum end date that stability period has to
be provided to the employee if ACA eligibility is yes, and
the maximum end date that stability period provided to the
employee if ACA eligibility is no, according to the rules of the
Look Back method.

The date must be later than six months after the ACA stability
begin date.

Non-Assessment Reason Enter the reason of the non-assessment period:

• First Year as ALE Period: January through March of
the first calendar year in which an employer is an ALE,
 but only for an employee who was not offered health
coverage by the employer at any point during the prior
calendar year. For example, 2015 is not the first year that
an employer is an ALE, if that employer was an ALE in
2014.

• Initial Period - Hire: Variable hour employee,
 seasonal employee or part-time employee at the initial
measurement period due to hire.

• Initial Period - Rehire: Variable hour employee,
 seasonal employee or part-time employee at the initial
measurement period due to rehire.

• Initial Period - Status Change: The employee is
reasonably expected to be a full-time employee at waiting
period, and the employment status then changes to be a
variable hour employee, seasonal employee or part-time
employee.

• Wait Period - Hire: The employee is reasonably
expected to be a full-time employee at waiting period due
to hire.

• Wait Period - Rehire: The employee is reasonably
expected to be a full-time employee at waiting period due
to rehire.

• Wait Period - Status Change: A variable hour
employee, seasonal employee or part-time employee at
the initial measurement period, whose employment status
then changes to a position that is reasonably expected to
be a full-time employee.

Non-Assessment End Date Enter the end date of the non-assessment period. The date must
be after the effective date.

Last Updated User ID/Updated On Review the timestamp to keep track of when and by whom
the data was previously updated. This can be a system update,
 manual update by the HR Administrator, or data from
template-based hire.
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The ACA Calculation Hours grid lists the Total Hours for the measurement period for multiple jobs
handled by the employee (e.g. Employee Record) and companies that belong to the same parent ACA
Common ID.

Note: Currently, no automatic BAS Activity trigger is generated when ACA Employee Eligibility
Status is updated. Hence if an ACA Eligibility Status update needs to be accounted for in Benefits
Administration Event processing, as a Benefits Administrator, you need to manually enter a BAS Activity
trigger. It is recommended to set the Event Date to coincide with the Stability Begin Date or when the
new coverage should begin, based on ACA requirements. Here, it is assumed that the BAS Action for the
trigger is attached to the Event Rule where the Coverage Begin Date is set at ‘On the Event Date’.

Using the ACA Component Interface
This topic provides an overview of how to use the ACA component interface.

If you have third-party transaction data in a Microsoft Excel spreadsheet, you can use the
CI_ACA_ELIGIBILITY component interface to load the data into the ACA_PERSON,
ACA_PER_ELIG, and ACA_PER_DTL records. The component interface simplifies the process of
loading your data and performs the required validations during the process.

For more information, see PeopleTools documentation for PeopleSoft Component Interfaces.

Setting Up ACA Consent Processing

This section provides an overview of U.S. ACA – electronic format for Form 1095-C – employee consent
processing and discusses the setting up ACA Consent Processing in PeopleSoft HR Manage Base
Benefits.

Pages Used to Set Up ACA Consent Processing

Page Name Definition Name Usage

ACA Aggregated ALE Group Page ACA_ALE_GRP Create an Aggregated ALE Group if
ALE Member(s) need to be associated
with an Aggregated ALE Group.

ACA Applicable Large Employer Table
Page

ACA_ALE_TBL Ensure that there is a valid entry for the
employer. To set up the consent process,
 an employer must have a valid entry on
the ACA Applicable Large Employer
Table.

ACA Company Table Page ACA_CMPY_TBL Add an ALE Member to the ACA
Company Table where a Company is
associated to ALE Member. Multiple
Companies can be associated to same
ALE Member if they all share the same
Employee Identification Number (EIN).
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Page Name Definition Name Usage

ACA Form Options Page ACA_FORM_OPTS Enable the electronic option for Form
1095-C.

Maintain Text Catalog Page HR_SSTEXT_TEXT Select the type of consent form or email
text that you want to enter or update.

Understanding ACA Consent Processing
Under the Affordable Care Act, Applicable Large Employers (ALEs) use Forms 1094-C and 1095-C to
report information about offers of health coverage and enrollment in health coverage for their employees.
Form 1095-C is used to report information about an individual employee. Employers that offer employer-
sponsored self-insured coverage also use Form 1095-C to report information to the Internal Revenue
Service (IRS) and to employees about individuals who have minimum essential coverage under the
employer plan. Form 1094-C is used to report to the IRS summary information for each employer and to
transmit Forms 1095-C to the IRS.

PeopleSoft HR Manage Base Benefits enables employers to track employee health coverage and comply
with Form 1094-C and Form 1095-C reporting requirements on an annual basis.

Note: Employers are responsible for reviewing IRS instructions and reporting requirements to determine
their specific reporting obligations under the Affordable Care Act.

Employees must affirmatively consent to receive their Form 1095-C in an electronic format instead of
a paper copy. PeopleSoft HR Manage Base Benefits provides the set up to process employee consent to
receive the Form 1095-C electronically.

The following terminology may be of use to understand ACA Consent Processing:

• ACA full-time employee: An employee defined as working, or hired and reasonably expected to work
at least 30 hours per week or 130 hours per month: (52 weeks x 30 hours)/12 months = 130 hours per
month.

• Applicable Large Employer (ALE): An ALE is, for a particular calendar year, any single employer,
or group of employers treated as an Aggregated ALE Group, that employed an average of at least 50
full-time employees (including full-time equivalent employees) on business days during the preceding
calendar year.

• Aggregated ALE Group: An Aggregated ALE Group refers to a group of ALE Members treated as
a single employer under section 414(b), 414(c), 414(m), or 414(o) of the Internal Revenue Code.
An ALE Member is a member of an Aggregated ALE Group for a month if it is treated as a single
employer with the other members of the group on any day of the calendar month.

• Applicable Large Employer Member (ALE Member): An ALE Member is a single person or entity
that is an ALE, or if applicable, each person or entity that is a member of an Aggregated ALE Group.

• Designated Government Entity (DGE): A DGE is a person or persons that are part of or related to
the Government Unit that is the ALE Member and that is appropriately designated for purposes of
reporting requirements.
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ACA Aggregated ALE Group Page
Use the ACA Aggregated ALE Group page (ACA_ALE_GRP) to create an Aggregated ALE Group. To
identify which ALE Members belong to an Aggregated ALE Group, an ACA Aggregated ALE Group
Table is delivered.

Navigation:

Set Up HCM >Common Definitions > Affordable Care Act >ACA Aggregated ALE Group

This example illustrates the fields and controls on the ACA Aggregated ALE Group page.

ACA Applicable Large Employer Table Page
Use the ACA Applicable Large Employer Table page (ACA_ALE_TBL) to add a Company that is
identified as an ALE (Applicable Large Employer) Member. There must be a valid entry in the ACA
Applicable Large Employer Table for each employer that will use the employee consent process to
provide Form 1095-C electronically. An entry can be added to the ACA Applicable Large Employer Table
only for a Company that is identified as an ALE Member.

Navigation:

Set Up HCM >Common Definitions >Affordable Care Act >ACA ALE Member >ACA
Applicable Large Employer Table
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This example illustrates the fields and controls on the ACA Applicable Large Employer Table page. You
can find definitions for the fields and controls later on this page.

Field or Control Description

ALE Member Applicable Large Employer Member is a single person or
entity that is associated to Form 1094-C Reporting. Can be
associated with one Company or group of Companies that
share the same EIN.

Aggregated ALE Group If the ALE Member is a member of an Aggregated ALE
Group, the Aggregated ALE Group ID will be added here.
 Otherwise, blank.

Employee Contact Phone This phone number will appear on the contact phone of Form
1095-C.
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Field or Control Description

ACA Entity Type ‘ALE’ for ALE Member information.

‘DGE’ for Designated Governmental Entity information.

Each ALE Member must have a business name, Federal EIN,
 address and contact information under ACA Entity Type
‘ALE’.

If a Designated Governmental Entity is filing on behalf of
a Governmental Unit, the Governmental Unit is an ALE
Member and the Designated Governmental Entity information
is entered under ACA Entity Type ‘DGE’.

Same as Company/Agency Table If the Federal EIN and address of the ALE Member or
Designated Governmental Entity is the same as in the
Company Table, enter the Company here. The Company
information from the Company Table will be populated onto
the lines below and the fields will become display only.
 Otherwise, these fields can be entered manually.

Name Employer’s name.

Federal EIN 9-digits including dash.

Country Look up from Country Table.

Address Employer’s complete address including address, city, state, and
postal code.

Contact Information Contact First Name, Middle Name, Last Name, Suffix and
Phone are used on the Employer Form 1094-C transmittal file.

Certification of Eligibility Enter all the applicable Certifications that the ALE Member
applied for. This information will be included on the Employer
Form 1094-C transmittal file.

ACA Company Table Page
Use the ACA Company Table page (ACA_CMPY_TBL) to associate an ALE Member to a Company.
Multiple Companies can be associated to same ALE Member if they all share the same EIN.

Navigation:

Set Up HCM >Common Definitions >Affordable Care Act >ACA Company Table

516  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 23 Managing U.S. Affordable Care Act Regulations

This example illustrates the fields and controls on the ACA Company Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

ALE Member Enter Applicable Large Employer Member that is associated
with Company.

ACA Form Options Page
Use the ACA Form Options page (ACA_FORM_OPTS) to enable the electronic option for Form 1095-C.
This step is required to enable employees to grant consent to receive electronic forms.

Navigation:

Benefits >ACA Annual Processing >ACA Preparation >ACA Form Options

This example illustrates the fields and controls on the ACA Form Options page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Calendar Year Create a new row each tax year.
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Field or Control Description

Enable Electronic ACA Forms Select this check box to enable the ALE Member to provide
XMLP PDF forms in the eBenefits Self Service transaction.

If this check box is not selected, employees cannot request or
withdraw consent or view Form 1095-C.

After employees have granted/withdrawn consent, an
administrator can disable this option by deselecting this check
box and running the Reset 1095-C Consent Status process.

Maintain Text Catalog Page
Use the Maintain Text Catalog page (HR_SSTEXT_TEXT) to select the type of consent form or email
text that you want to enter or update.

Navigation:

Set Up HCM >Common Definitions >Text Catalog and Notepad >Maintain Text Catalog

This example illustrates the fields and controls on the Maintain Text Catalog page.

Text ID Usage Text Type Description

1095C Page Instructions Consent Agreement Instructional text displayed
on the Form 1095-C Consent
page to request consent.
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Text ID Usage Text Type Description

1095R Page Instructions Consent Agreement after
Reset

Instructional text displayed
on the Form 1095-C Consent
page to request consent after
the Consent has been reset by
employer.

1095W Page Instructions Withdrawal Agreement Instructional text displayed
on the Form 1095-C Consent
page to withdraw consent.

CC Consent Confirmation Confirmation text displayed
on the Form 1095-C Consent
page after Consent is
submitted.

CW Withdrawn Confirmation Confirmation text displayed
on the Form 1095-C
Consent page after Consent
Withdrawal is submitted.

EMCS E-Subject Consent Email Subject Notification Email Subject
to employee that Consent is
received.

EMC E-Body Consent Email Body Notification Email Body to
employee that Consent is
received.

EMWS E-Subject Withdraw Consent Email
Subject

Notification Email Subject
to employee that Consent is
withdrawn.

EMW E-Body Withdraw Consent Email
Body

Notification Email Body to
employee that Consent is
withdrawn.

EMRS E-Subject Reset Consent Email Subject Notification Email Subject to
employee that Consent is reset
by employer.

EMR E-Body Reset Consent Email Body Notification Email Body to
employee that Consent is reset
by employer.

Consent Instruction Requirements

The instructional page text that you create for granting and withdrawing consent should include these
details:
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• Notification that a paper copy will be provided if consent is not given.

• The scope and duration of the consent.

• Post-consent requests for paper statements.

• Option to withdraw consent.

• Conditions under which the employer will no longer furnish electronic statements.

• Procedures for updating information.

• Hardware and software requirements.

For example, inform employees that Adobe Reader is required to view the forms.

• Contact information.

Understanding ACA Safe Harbor Codes and Safe Harbor Relief
Groups

PeopleSoft HR Manage Base Benefits delivers ACA Safe Harbor Codes (from Code Series 2 — Section
4980H Safe Harbor Codes and Other Relief for Employers) which provide the IRS with information
used to administer the employer shared responsibility provisions of the Affordable Care Act. There are
nine Safe Harbor codes (2A – 2I); four of these codes (2E, 2F, 2G, and 2H) are classified as Safe Harbor
Relief Groups. The Safe Harbor Relief Groups component enables the employer to identify the employee
population that belongs to each of the code 2E, 2F, 2G, and 2H groups on a monthly basis.

The following terminology may be of use to understand ACA Safe Harbors and Safe Harbor Relief
Groups:

• Employer Shared Responsibility: Employers with 50 or more employees are required to provide
health benefits to full-time (30 or more hours per week) employees or pay a penalty per employee,
depending on the situation.

• ACA Full-time: An employee defined as working, or hired and expected to work at least 30 hours per
week or 130 hours per month. (52 weeks x 30 hours)/12 months = 130 hours per month.

• Minimum Essential Coverage (MEC): MEC refers to health coverage qualified as minimum essential
coverage under an eligible employer-sponsored plan.

• Minimum Value: A plan provides minimum value if the plan pays at least 60 percent of the cost of
benefits.

• Limited Non-Assessment Period: A limited non-assessment period refers to a period during which an
ALE member is not subject to an Employer Shared Responsibility payment under section 4980H(a)
of the Internal Revenue Code, and in certain cases under section 4980H(b), for a full-time employee,
regardless of whether the employee is offered health coverage during that period.
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Setting Up ACA Safe Harbors Codes and Safe Harbor Relief
Groups

This topic provides an overview of setting up the Safe Harbor Codes (Code Series 2) and Safe Harbor
Relief Groups.

Pages Used to Set Up ACA Safe Harbors Codes and Safe Harbor Relief
Groups

Page Name Definition Name Usage

ACA Safe Harbor Codes Page ACA_SFE_HB_CODE View the applicable codes from Code
Series 2 which provide the IRS with
information to administer the employer
shared responsibility provision of the
Affordable Care Act.

Safe Harbor Relief Groups Page ACA_SAFE_HARBOR_GP Group employees who qualify under
each of the four Safe Harbor Codes: 2E,
 2F, 2G, and 2H.

ACA Safe Harbor Codes Page
Use the ACA Safe Harbor Codes page (ACA_SFE_HB_CODE) to view the applicable Code Series 2 –
Section 4980H Safe Harbor Codes and other interim relief codes for employers.

Navigation:

Set Up HCM > Common Definitions > Affordable Care Act >ACA Safe Harbor Codes

This example illustrates the fields and controls on the ACA Safe Harbor Codes page.
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Field or Control Description

Safe Harbor Relief Groups Select this check box to indicate the Safe Harbor Code is used
for interim relief. For 2015, Safe Harbor Codes 2E, 2F, 2G and
2H are valid interim relief codes and can be used in the Safe
Harbor Relief Groups component.

Safe Harbor Code Description Short Description

2A Not employed SH Code 2A

2B Not full-time & not in MEC SH Code 2B

2C Enrolled in coverage offered SH Code 2C

2D Non-assessment period SH Code 2D

2E Multipl ER interim rule relief SH Code 2E

2F Affordability Form W-2 SH Code 2F

2G Affordability Fed Poverty Line SH Code 2G

2H Affordability Rate of Pay SH Code 2H

2I None-cal year trans relief SH Code 2I

Safe Harbor Relief Groups Page
Use the Safe Harbor Relief Groups page (ACA_SAFE_HARBOR_GP) to group employees who
qualify under each of the four Safe Harbor Codes: 2E, 2F, 2G, and 2H. The Safe Harbor Relief Groups
component enables the employer to identify the employee population that belongs to each of the codes
on a monthly basis. Some employees are qualified to be part of one or more of these Safe Harbor Relief
Groups.

Add a new entry for each month of a calendar year for which each of the Safe Harbor Codes is valid for
the ALE.

Navigation:

Benefits >ACA Annual Processing >ACA Preparation >Safe Harbor Relief Groups

522  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 23 Managing U.S. Affordable Care Act Regulations

This example illustrates the fields and controls on the Safe Harbor Relief Groups page.

Field or Control Description

As Of Date This will always be set to the last day of the specified month.

Query Name Select the user-defined query to list the employees in the
Safe Harbor Relief Group for the chosen time period. If the
Query Name is changed, one must click the Load/Re-Load
Employees button to refresh the grid below.

Load/Re-Load Employees Click this button to execute the query and load the selected
employees in the Safe Harbor Relief Group for the chosen
time period. Employees can also be inserted on the grid
manually. Each time this button is clicked, the employees
under the Qualified Employees grid will be deleted and
employees will be reloaded again based on the query result.
 Manually entered employees will also be deleted.

Understanding ACA Data Extraction, Transmittal, and Form 1095-
C Printing

The Affordable Care Act requires each ALE Member to file with the Internal Revenue Service Form
1094-C (Transmittal of Employer-Provided Health Insurance Offer and Coverage Information Returns),
and Form 1095-C (Employer-Provided Health Insurance Offer and Coverage) for each of its full-time
employees.

PeopleSoft HCM HR Manage Base Benefits product supports the filing of Forms 1094-C and 1095-C.
This process involves data tracking, annual data setup, data loading, reviews/updates, audit reporting,
electronic transmittal and form printing. These tasks can generally be grouped into three areas:

• Data extraction

• Form filing/transmittal
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• Printing Form 1095–C

Most of the data required by the Forms 1094-C and 1095-C is available in the PeopleSoft system. The
data extraction process loads each employee’s 1095-C data onto a page for administrator to review and
modify before the forms are finalized to be transmitted and printed. Some fields are extracted directly
from the PeopleSoft data source, while some fields are derived based on rules defined in the Data Extract
Definition. PeopleSoft also allows you to upload employee’s form data, if processed by a third party,
using the Excel-CI Load feature.

PeopleSoft Benefits supports the ISS-UI Channel to transmit ACA data to the IRS. In the ISS-UI
Channel, information returns are uploaded as XML files via the transmitter’s web browser. Two XML
files are transmitted: Request file and Manifest file. Once the extracted data are reviewed and finalized,
the Create XML Transmittal Process is run to generate the Request file, which contains the Form 1094-C
and Form 1095-C data. The Manifest File contains the ACA business header and request manifest details.
The employer must upload the Request file and the Manifest File at the same time.

PeopleSoft Benefits only supports printing of Form 1095-C. In addition to the printed paper copy, an
electronic version of the PDF form for employee Self Service is also provided.

Setting Up and Managing Data Extraction for Forms 1094-C and
1095-C

This section provides an overview of the set up tables for data extraction required by Forms 1094-C and
1095-C.

Pages Used to Set Up and Manage Data Extraction

Page Name Definition Name Usage

Health Plan Table Page HEALTH_PLAN_TABLE Define ACA health plan attributes
needed in forms, e.g. Self-Insured,
 Minimum Essential Coverage, and
Lowest Cost Monthly Premium.

ACA Employee Eligibility Group Page ACA_EMP_ELIG_GP Group different ACA eligibility statuses
into eligibility groupings for use in the
data extraction processes.

ACA Offer of Coverage Page ACA_CODE_SERIES1 Define eligible coverage codes for Code
Series 1 and indicate whether to Report
Employee Share of Lowest Cost for Self-
only.

ACA Data Extract Definition Page ACA_DATEXTR_DEF Define a set of data extraction rules.

ACA Data Source Page ACA_DATA_SOURCE Define other data sources to be used in
Excel-CI Load.
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Health Plan Table Page
Use the Health Plan Table page (HEALTH_PLAN_TABLE) to enter the ACA plan details.

Navigation:

Set Up HCM > Product Related > Base Benefits >Plan Attributes >Health Plan Table

This example illustrates the fields and controls on the Health Plan Table page.

Field or Control Description

Health Provider Required Select whether an employee must declare a health provider
when enrolling in this plan through self-service.

Wait Period Days Enter the number of days an employee must wait to be eligible
for the plan.

Self-Insured Plan Select this check box if the health plan is employer-sponsored
self-insured health coverage.

Benefit Plan Coverage Value Options include MEC and Minimum Value, MEC and Not
Minimum Value, and Not Minimum Essential Coverage.

Lowest-Cost Monthly premium This cost is the employee share of the lowest-cost monthly
premium for self-only minimum essential coverage providing
minimum value that is offered to the employee. (This field is
only used for employees using the Base Benefits product.)

ACA Employee Eligibility Group Page
Use the ACA Employee Eligibility Group page (ACA_EMP_ELIG_GP) to group different ACA
eligibility statuses into eligibility groupings for use in the data extraction process. This is a system-
delivered table and includes the FLTM (Full Time) and NFLT (Not Full Time) eligibility groups.
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Navigation:

Set Up HCM >Common Definitions >Affordable Care Act >ACA Employee Eligibility Group

This example illustrates the fields and controls on the ACA Employee Eligibility Group page.

Field or Control Description

Employee Eligibility Group Displays the name of the eligibility group. FLTM (Full Time)
and NFLT (Not Full Time) are eligibility groups delivered
with the system.

ACA Eligibility Status Status: Eligible and Always Eligible are assigned to FLTM.
 Ineligible, To be determined, and Excluded are assigned to
NFLT.

ACA Offer of Coverage Page
Use the ACA Offer of Coverage page (ACA_CODE_SERIES1) to define eligible coverage codes and
whether to Report Lowest Cost Self-only per Code Series 1 as defined in the IRS Instructions for Forms
1094-C and 1095-C. You do not need to define these rules as this is delivered as system data. However,
you can add other coverage codes as required.

Navigation:

Set Up HCM >Common Definitions >Affordable Care Act >ACA Offer of Coverage
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This example illustrates the fields and controls on the ACA Offer of Coverage page.

Field or Control Description

Code Series 1 Employee Offer of Coverage Codes (Code Series 1) published
in IRS Instructions for 1095-C. The valid codes are 1A – 1I for
tax year 2015.

Report Lowest-Cost Self-Only Select this check box to indicate that Employee Share of
Lowest Cost Monthly Premium is reported for the Code Series
1. For example, if code 1B, 1C, 1D, or 1E is reported on line
14 of Form 1095-C, the lowest self-only cost will be reported
on line 15 of Form 1095-C. For this reason, for codes 1B, 1C,
 1D, and 1E, the checkbox is selected.

Coverage Code List coverage codes that are associated with certain Code
Series 1 (e.g. 1B, 1C, 1D, or 1E).

ACA Data Extract Definition Page
Use the ACA Data Extract Definition page (ACA_DATEXTR_DEF) to define a set of data extraction
rules. Each set of data extraction rules has a corresponding ACA Data Extract ID.

ACA Data Extract ID 1094C1095C is delivered as system data and is defined to extract data required for
generating the Form 1094-C and Form 1095-C transmittal file and for issuing employee Form 1095-C.

Navigation:

Set Up HCM >Common Definitions >Affordable Care Act >ACA Data Extract Definition
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This example illustrates the fields and controls on the ACA Data Extract Definition 1 page.

Field or Control Description

Data Extract ID Assign a Data Extract ID for each set of data extract rules.

Data Extract ID 1094C1095C is system delivered for
extracting employer and employee data for Forms 1094-C and
1095-C.

Data Extract Options

Common As of Day in Month Select the common date to be used for effective date extract of
all monthly data.

The options available are First Day, Specified Day, or Last
Day.

Specified As of Day This edit box appears only when you select Specified Day
from the Common As of Day in Month drop-down menu.

Specify the day to use for each month.

Eligible Plan Types
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Field or Control Description

Plan Type Select the plan types that are eligible for this extract.

Part III ALE Member Monthly Flags & Codes

ALE Member Monthly Data Valid ALE Member Monthly Data options are:

• Aggregated Group Indicator

• Minimum Essential Coverage ID

• Sec 4980H Transition Relief ID

Sequence Specify the order of processing in the main extraction process.

Box Identifier Enter the box number or letter used in Form 1094-C and Form
1095-C.

Monthly Value Assignments

Priority Specify the order of processing within the monthly data type.

Assign Value Enter the value, count, or amount according to the
corresponding monthly data type.

Default Select this check box to use the Assign Value as default.

As of Day in Month If specified, this As of Day in Month overrides Common As
of Day in Month for effective date extract of this monthly
data value assignment.

The options available are First Day, Specified Day or Last
Day.

SQLID Object Enter the SQL that defines the data subject to data extraction.

Part III ALE Member Monthly Counts
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Field or Control Description

ALE Member Monthly Data Valid ALE Member Monthly Data options are:

• Full-Time Employee Count

• MEC Employee Offer Count

• Total Employee Count

Note: MEC Employee Offer Count is not reported on Form
1094-C but is needed in determining Column (a) Minimum
Essential Coverage Offer Indicator (e.g. the employer offered
MEC to at least 95% of full-time employees)

Monthly Count Assignments

Priority Specify the order of processing within the monthly data type.

Assign Value Enter the value, count, or amount according to the
corresponding monthly data type.

Default Select this check box to use the Assign Value as default.

As of Day in Month If specified, this As of Day in Month overrides Common As
of Day in Month for effective date extract of this monthly
data value assignment.

The options available are First Day, Specified Day or Last
Day.

As of Day This edit box appears only when you select Specified Day
from the As of Day in Month drop-down menu.

SQLID Criteria Enter the SQL that defines the data subject to data extraction.

SQLID Update Enter the SQL that will provide update to monthly data
extraction.

Note: User defined SQL objects can be created in PeopleSoft Application Designer to provide SQLID
Criteria and SQLID Update for data extraction and SQL name should start with ‘ACA’.
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This example illustrates the fields and controls on the ACA Data Extract Definition 2 page.

Field or Control Description

Part II Employee Monthly Codes

Employee Monthly Data Monthly codes to report for the employee. Valid options are:

• Offer of Coverage Code

• Safe Harbor & Other Relief Codes

Part II Employee Monthly Amounts

Employee Monthly Data Monthly amounts to report for the employee. Valid option is
Self-Only Lowest Premium Cost.

Covered Individual Monthly Flags

Monthly Dependent Data Valid option is Months of Coverage.
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ACA Data Source Page
Employee form data can be uploaded using Excel-CI Load. Use the ACA Data Source page
(ACA_DATA_SOURCE) to define other data sources to be used in Excel-CI Load.

This example illustrates the fields and controls on the ACA Data Source page.

Field or Control Description

ACA Data Source Assign a source ID to identify the source of data loaded using
Excel-CI Load.

Creating ACA Form Data for Forms 1094-C and 1095-C

This section provides an overview of ACA data extraction required to generate Forms 1094-C and 1095-
C.

Pages Used to Create Data Form Extraction

Page Name Definition Name Usage

ACA Data Extract Page ACA_DTEX_RUNCTL To extract, clean up, or finalize data
needed for forms transmittal.

ACA Employer Transmittal Data Pages ACA_ALE_XMIT_PART1 (ALE
Member tab)

ACA_ALE_XMIT_PART2 (ALE
Monthly Data tab)

To view the employer transmittal data
after the data extraction process.

ACA Employee Transmittal Data Page ACA_EMP_XMIT_PART1 (ALE
Member tab)

ACA_EMP_XMIT_PART2 (Monthly
Employee Data tab)

ACA_EMP_XMIT_PART3 (Covered
Dependent Data tab)

To view the employee transmittal data
after the data extraction process.
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Page Name Definition Name Usage

Review Employee Data Load Page ACA_EMP_DATA_LOAD To review/modify employee CI loaded
monthly codes.

Review Employee Amount Load Page ACA_EMPMDATA_LOAD To review/modify employee CI loaded
monthly amounts.

Review Covered Individual Load Page ACA_DEP_DATA_LOAD To review/modify employees or covered
individual CI loaded monthly flags.

ACA Data Extract Page
Use the ACA Data Extract page (ACA_DTEX_RUNCTL) to extract, clean up, or finalize data needed for
forms transmittal.

Navigation:

Benefits > ACA Annual Processing >Create ACA Form Data >ACA Data Extract

This example illustrates the fields and controls on the ACA Data Extract page.

Field or Control Description

Data Extract ID Enter the Data Extract ID that defines data to be extracted.

Applicable Large Employer Select the ALE Member for the data extract.

Calendar Year Enter the tax filing year.

Copyright © 1988, 2022, Oracle and/or its affiliates. 533



Managing U.S. Affordable Care Act Regulations Chapter 23

Field or Control Description

Extract Option The options available are:

• Extract ACA Employee Data – Extract data for selected
employees only. Specify the employees in the Participant
(s) grid below

• Extract ALE Employer Data – Extract data for Form
1094-C only. This is used after running the Merge
Process or after Employee Transmittal Data was modified
manually. This process will sync up the counts.

• Extract All Transmittal Data – Extract data for Forms
1094-C and 1095-C.

• Finalize for Transmittal – Flag as Final the highest
Sequence extracted data with Process Status of
PeopleSoft Extracted, User Modified, or Merged with
Data Load.

• Remove Extracted Data – Select this option to delete all
extracted data where Process Status is not Finalize for
Transmittal or Transmittal Created.

• Un Finalize Extracted Data – Reset the highest
sequence extracted data with Process Status of Finalize to
its previous status.

Note: If an extract has already been run for an ALE/Calendar Year, the same extract ID should be used for
that calendar year. Otherwise, an error message will be generated.

ACA Employer Transmittal Data Pages
Use the ACA Employer Transmittal Data page (ACA_ALE_XMIT_PART1 and
ACA_ALE_XMIT_PART2) to view or modify the employer transmittal data after the data extraction
process.

Navigation:

Benefits >ACA Annual Processing >Create ACA Form Data >ACA Employer Transmittal Data
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This example illustrates the fields and controls on the ACA Employer Transmittal Data page - ALE
Member tab.

Field or Control Description

Process Status Defines the status of Data Extract, such as, PeopleSoft
Extracted, User Modified, Merged with Data Load, VOID,
Finalized for Transmittal, and Transmittal Created. You
can add a ‘User Modified’ row to modify data before creating
the 1094-C transmittal file.

Note: Address is extracted based on the country format.
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This example illustrates the fields and controls on the ACA Employer Transmittal Data page - ALE
Monthly Data tab.

ACA Employee Transmittal Data Page
Use the ACA Employee Transmittal Data page (ACA_EMP_XMIT_PART1, ACA_EMP_XMIT_PART2
and ACA_EMP_XMIT_PART3) to view or modify the employee transmittal data after the extraction
process.

Navigation:

Benefits >ACA Annual Processing >Create ACA Form Data >ACA Employee Transmittal Data
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This example illustrates the fields and controls on the ACA Employee Transmittal Data page – ACA
Employee tab.

Note: Employee Address is extracted based on the address type table order (ADDR_TYPE_TBL
component) that you have set up.

Field or Control Description

Reissue Form 1095-C Between the time when Form 1095-Cs is furnished to
employees but the Transmittal File has not been submitted
to IRS, administrator can reissue Form 1095-C to their
employees. Add a user modified row with the changes
required and select the Reissue check box to indicate this data
row is for issuing a reissue form. Once changes are verified,
 set the Process Status to Finalized for Transmittal and run the
Create XML File (Reissue) process.
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This example illustrates the fields and controls on the ACA Employee Transmittal Data – Employee
Monthly Data tab.

Field or Control Description

Plan Start Month This is an optional field for 2015. The system defaults it to
‘00’.

Box ID 15: Employee Monthly Data The data from the first row Self Only Lowest Premium Cost
populates the corresponding box in the Form 1095-C. The Self
Low Cost Base Benefits, Self Low Cost BA No Credit and
Self Low Cost BA With Credit are three working rows used
to calculate cost and credits.

538  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 23 Managing U.S. Affordable Care Act Regulations

This example illustrates the fields and controls on the ACA Employee Transmittal Data page – Covered
Individual Data tab.

Using the ACA Component Interface
If you have third-party data in a Microsoft Excel spreadsheet, you can use the following component
interfaces to load employee Form 1095-C data:

• CI_ACA_EMPDATA_SRC loads line 14 and 16 of 1095-C

• CI_ACA_EMPMDATA_SRC loads line 15 of 1095-C

• CI_ACA_DEP_DATA_SRC loads Covered Individual Data, part III of 1095-C.

The component interface simplifies the process of loading your data and performs the required validations
during the process.

For more information, see PeopleTools documentation for PeopleSoft Component Interfaces.

The data thus loaded can be viewed and modified on the following pages:

• Review Employee Data Load

• Review Employee Amount Load

• Review Covered Individual Load
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Review Employee Data Load Page
Use the Review Employee Data Load page (ACA_EMP_DATA_LOAD) to review/modify employee CI
loaded monthly codes.

Navigation:

Benefits >ACA Annual Processing >Create ACA Form Data >Review Employee Data Load

This example illustrates the fields and controls on the Review Employee Data Load page.

Field or Control Description

Data Status Display/modify the status of the data reviewed. The options
available are Error, Initial Load, Merged, Updated, Void,
and Warning.

ACA Source Display/modify the source of data loaded using Excel-CI
Load.

Review Employee Amount Load Page
Use the Review Employee Amount Load page (ACA_EMPMDATA_LOAD) to review/modify employee
share of lowest cost monthly premium for self-only minimum value coverage.

Navigation:

Benefits >ACA Annual Processing >Create ACA Form Data >Review Employee Amount Load

This example illustrates the fields and controls on the Review Employee Amount Load page.
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Review Covered Individual Load Page
Use the Review Covered Individual Load page (ACA_DEP_DATA_LOAD) to review/modify data for
employee or covered dependent enrollment to employer-sponsored self-insured health coverage.

Navigation:

Benefits >ACA Annual Processing >Create ACA Form Data >Review Covered Individual Load

This example illustrates the fields and controls on the Review Covered Individual Load page.

Setting Up the Other Source Data Merge Process

There are cases where not all data required to complete Forms 1094-C and 1095-C exists in the
PeopleSoft system. Some customers may use third-party providers to process retirees, union employees,
or COBRA recipients. Form data from external systems can be uploaded using the Excel-CI Load. The
Data Merge Process merges data loaded from other sources with PeopleSoft extracted data in order to
complete the ACA-required employee forms and transmittal.

Pages Used for the Other Source Data Merge Process

Page Name Definition Name Usage

Merge Other Data Sources Page ACA_DTMRG_RUNCTL To merge other source data to the ACA
employee transmittal data.

Review ACA Merged Messages Page ACA_MESSAGES To view online the error messages
generated during the merge process.

Review Merged Transmittal Data Page ACA_EMP_MO_CH4_MRG To review the merged ACA employee
transmittal data and the original CI
loaded data for verification.

Merge Other Data Sources Page
Use the Merge Other ACA Data Sources page (ACA_DTMRG_RUNCTL) to merge other source data to
the ACA employee transmittal data.

Note: Data Extract Process must be first run to generate the base data for the merge, before running the
Merge Process.Only data that is not already transmitted can be merged.
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Navigation:

Benefits > ACA Annual Processing > Create ACA Form Data >Merge Other Data Sources

This example illustrates the fields and controls on the Merge Other Data Sources page.

Field or Control Description

Data Extract ID Enter the Data Extract ID that defines the data to be merged.

Applicable Large Employer Select the ALE Member for the data to be merged.

Calendar Year The calendar year for which data is being reported.

Processing Options The options available are:

• Merge Data – Merge the CI loaded data to the employee
extracted transmittal data for Forms 1095-C.

• Remove Merged Data – Select this option to delete
all merged data which has the process status “Data
Merged”.

Review ACA Merged Messages Page
Use the Review ACA Merged Messages page (ACA_MESSAGES) to view online the error messages
generated during the merge process. You can correct these errors and rerun the merge process.

Navigation:

Benefits >ACA Annual Processing >Create ACA Form Data >Review ACA Merged Messages
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This example illustrates the fields and controls on the Review ACA Merged Messages page.

Review Merged Transmittal Data Page
Use the Review Merged Transmittal Data page (ACA_EMP_MO_CH4_MRG) to review the merged
ACA employee transmittal data and the original CI loaded data for verification. The ACA Employee
Transmittal Data grid will show the merged data and the ACA Employee Other Source Data grid will
show the original loaded data.

If data is not merged as expected, run Merge Other Data Sources with Process Option ‘Remove Merged
Data’, correct the data from the CI load and then run again with process option ‘Merge Data’.

Navigation:

BenefitsACA Annual ProcessingCreate ACA Form DataReview Merged Transmittal Data

This example illustrates the fields and controls on the Review Merged Transmittal Data page.

Setting Up File Transmittal and Form 1095-C Printing

This section provides an overview of the set up tables for the file transmittal and Form 1095-C printing.

Pages Used for File Transmittal and Form 1095-C Printing

Page Name Definition Name Usage

ACA Transmittal Parameters Page ACA_XMIT_PARAMS To define parameters required for
generating the transmittal file
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Page Name Definition Name Usage

ACA Form Options Page ACA_FORM_OPTS To define the various Self Service
options for Form 1095-C.

ACA Form BI Publisher Options Page ACA_YE_XMLP_OPTION To define the annual parameters of the
Form 1095-C XML.

Create ACA XML Files Page ACA_RUN_BAC020 To generate the ACA transmittal files
and the PDF version of Form 1095-C.

View Form 1095-C Page ACA_SS_YE_FORM To view Form 1095-C as Administrator.

ACA Transmission History Page ACA_XMIT_HIST To review a history of when the Create
Transmittal File processes were run and
to enter the Receipt IDs received from
IRS after submission.

ACA Transmittal Parameters Page
Use the ACA Transmittal Parameters page (ACA_XMIT_PARAMS) to define parameters required to
generate the transmittal request file and manifest file.

Navigation:

Benefits > ACA Annual Processing > ACA Preparation >ACA Transmittal Parameters

This example illustrates the fields and controls on the ACA Transmittal Parameters page.

Field or Control Description

Calendar Year The calendar year for which data is being reported.

Form Type Code This is a protected field; it defaults to 1094/1095C.
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Field or Control Description

Number of Records Per File This field defaults to 10000. Due to an IRS transmittal file
size limitation, each file may not exceed 100 MB. The IRS
estimates that 100MB represents about 10,000 employee
records. You can adjust this default value based on your
specific business and environment.

Default File Type This field defaults to AATS. The valid values are AATS and
Production.

AATS stands for generating test-data submissions to the IRS.
 Production stands for generating real-data submissions to the
IRS.

ACA Form Options Page
Use the ACA Form Options page (ACA_YE_XMLP_OPTION) to define the various Self Service options
for ACA forms. An Administrator can use this page to enable the electronic option for Form 1095-C, and
to release the forms for viewing and printing.

Navigation:

Benefits >ACA Annual Processing >ACA Preparation >ACA Form Options

This example illustrates the fields and controls on the ACA Form Options page.
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Field or Control Description

Enable Electronic ACA Forms In Self Service Select this check box to release the ACA forms for viewing in
Self Service.

Availability Date Specify the date when the current ACA forms will be released
for viewing through Self Service.

Availability Notification Click the Availability Notification button to send notification
to employees that Form 1095-C is available in Self Service.
 Email notification will be sent only to employees who have
consented to receive Form 1095-C electronically.

Note: During the reissuing of forms, when you click the
Availability Notification button, email notifications are sent
only to those employees who receive a Reissue form.

ACA Form BI Publisher Options Page
Each filing year, Forms 1095-C and the Instructions for Form 1095-C may change. When these change,
the PeopleSoft delivered XML templates will also change correspondingly. An annual parameter setup
page is required to keep track of these templates and the location of where the form data items are stored.

Use the ACA Form BI Publisher Options page (ACA_YE_XMLP_OPTION) to define the annual
parameters of the Form 1095-C XML.

Navigation:

Benefits >ACA Annual Processing >ACA Preparation >ACA Form BI Publisher Options

This example illustrates the fields and controls on the ACA Form BI Publisher Options page.

546  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 23 Managing U.S. Affordable Care Act Regulations

Field or Control Description

Calendar Year The year for which data is to be reported.

Form ID The valid Form ID is 1095-C.

XML Data Files: URL Identifier Define a URL address to store the filing data.

Filing Instructions:URL Identifier Define a URL address to store the filing instructions that
correspond to the forms for the year for which data is to be
reported.

Filing Instructions:Attached File Displays the filename of the filing instructions for the filing
year for which data is to be reported.

SSN Masking Select the SSN Masking checkbox to turn on the masking
option.

On Form 1095-C statements furnished to employees, the
Social Security Number can be truncated to show only the
last four digits of the SSN and replace the first five digits with
Xs. By default the masking option is turned on (i.e. checkbox
selected).

Report Name The Report Name identifies each form option for Form 1095-
C. Three form options are supported for 2015 reporting:

• ACA95C15_EE – 2015 Form 1095-C cut form print copy.

• ACA95C15_ES – 2015 Form 1095-C electronic copy.

• ACA95C15_SM – 2015 Form 1095-C pressure-seal print
copy.

Note: Replace ACA95C15_EE with ACA95C15_SM if you
choose to use pressure-seal form instead of cut-sheet.

Template ID The Template ID is used in conjunction with Report Name;
each Report Name has a corresponding Template ID:

• ACA95C15_EE_1

• ACA95C15_ES_1

• ACA95C15_SM_1

Copy Type There is only one copy type: Employee Copy.
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Field or Control Description

Burst? Select this checkbox to indicate that the report is using the
bursting feature.

Bursting key is defined in BI publisher Report Definition
setup.

Batch Size Batch Size is used for printing hardcopy forms. The user can
control how many employees are to be printed in each PDF
file. The default is blank, meaning that forms for all employees
will be generated in one PDF file.

Note: There is a file size limitation on BI Publisher. If the PDF
file is too big, it cannot be opened up for printing. A batch size
field is included on the options pages to define the size of each
print file in order to group the forms into smaller batches for
printing.

Create ACA XML Files Page
Use the Create ACA XML Files page (ACA_RUN_BAC020) to generate the ACA transmittal file(s) and
the PDF version of Form 1095-C.

Navigation:

Benefits >ACA Annual Processing >Transmittal and Forms >Create ACA Transmittal Files
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This example illustrates the fields and controls on the Create ACA XML Files page.

Field or Control Description

Data Extract ID Enter the Data Extract ID that was used to run the data extract.
 Data extracted using this rule will be used to generate the
transmittal file(s) and the PDF forms.

Applicable Large Employer The Applicable Large Employer for which data is being
reported.

Calendar Year The calendar year for which data is being reported.

Sort By First sort option of the employees being reported.

Within Sort, Order By Second sort option within the Sort By option, of the
employees being processed.
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Field or Control Description

Process Type The options available are:

• Original – This is the default value.

• Re-Issue – Select this option to correct a Form 1095-C
that was previously furnished to an employee, but not
filed with the IRS. When this option is selected, the word
“CORRECTED” will be printed on the new Form 1095-C
to be furnished to the employee.

Final Run Select this check box to process the final run.

For a preliminary run (when the Final Run checkbox is not
selected), the Request file will be generated with a temporary
file name. No Manifest file will be generated. Only the
Benefits Administrator can view Form 1095-C records which
are created in a preliminary run.

For the final run, the Request file will be generated with the
file name specified by the IRS. The Manifest file will be
generated. Form 1095-C records which are created in the final
run will be available for viewing in Self Service.

Note: Perform Final Run only when the preliminary runs
have been satisfactory and results have been verified. Once
Final Run is processed for selected ALE employer and ACA
employee data, the same data cannot be reprocessed in a
subsequent Final Run. An exception to this is before the
transmittal files from the Final Run have been transmitted to
IRS and the reissue of Form 1095-C is required. In which case,
new sequenced data can be added to prepare the employee data
for reissue.

File Type Displays the File Type selection on the ACA Transmittal
Parameters page.

Number of Records Per File Each file transmitted to the IRS must not exceed the 100MB
file size limit imposed by the IRS. If the submission is larger
than 100MB, it must be split into two or more separate file
transmissions. The default Number of Records Per File is set
at the ACA Transmittal Parameters page.

Note: If the generated file exceeds 100MB during preliminary
runs, reduce the number of records and re-generate the files.

Blank Plan Start Month Select to print blank Plan Start Month on Form 1095-C and
to omit the data element equivalent in the transmittal file.
 This option is only visible when Calendar Year is 2015, when
reporting of Plan Start Month is optional.

Test Scenario ID Enter the number of a test scenario as prescribed by IRS.
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Field or Control Description

Total Form Filed for ALE Enter Total Form Filed for ALE that corresponds to the Test
Scenario ID selected.

Note: Test Scenario Parameters group box is only visible when the File Type is “AATS”.

The following files are created when the Create ACA XML Files process (Job ACA1095C) is run with
the Final Run checkbox deselected:

1. PREXMIT<TCC><Date>T<TimeStamp>Z.xml,

where <TCC> is the TCC code of the ALE Member, <Date> and <TimeStamp> are the date/time of
when the file was created. This is a preliminary transmittal file that should not be submitted to IRS.
The date in the file name is in the YYYYMMDD format.

2. ACA95C15_EE.pdf. The print file of 1095C PDF forms to be sent to employees.

3. ACA95C15_ES.pdf. The Self-Service 1095C PDF form for an employee that can be viewed by an
employee via Self-Service who has given his/her consent on or before the Self Service Availability
date of the ACA form.

The following files are created when the Create ACA XML Files process (Job ACA1095C) is run with
the Final Run check box selected:

1. 1094C_Manifest_<Submission>__<TCC>_<Date>T<TimeStamp>Z.xml, where <Submission> is
the Submission ID of the transmittal file, <TCC> is the TCC code of the ALE Member, <Date> and
<TimeStamp> are the date/time of when the file was created.

2. 1094C_Request_<TCC>_<Date>T<TimeStamp>Z.xml, and
PREXMIT<TCC><YYYYMMDD>T<TimeStamp>Z.xml,

where <TCC> is the TCC code of the ALE Member, <Date> and <TimeStamp> are the date/time of
when the file was created. The Manifest and Request files, as a set of files, can be transmitted to the
IRS using the AIR UI Channel.

3. ACA95C15_EE.pdf. The print file of 1095C PDF forms to be sent to employees.

4. ACA95C15_ES.pdf. The Self-Service 1095C PDF form for an employee that can be viewed by an
employee via Self-Service who has given his/her consent on or before the Self Service Availability
date of the ACA form.

View Form 1095-C Page
Use the View Form 1095-C page (ACA_SS_YE_FORM) to view Form 1095-C. A Benefits Administrator
can view all employees’ Form 1095-Cs, irrespective of whether or not they are finalized.

Navigation:

Benefits >ACA Annual Processing >Transmittal and Forms >View Form 1095-C
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This example illustrates the fields and controls on the View Form 1095-C page.

Field or Control Description

Tax Form Click the Tax Form link to open a PDF version of Form 1095-
C.

Filing Instructions Click the Filing Instructions link to open a PDF document
containing filing instructions.

Final Print A selected check box is displayed to identify forms which are
final and which are preliminary only.

ACA Transmission History Page
Use the ACA Transmission History page (ACA_XMIT_HIST) to review a history of when the Create
Transmittal File processes were run. This page is also used for entering the Receipt IDs and the
transmittal status of the files as received in the acknowledgement file from the IRS.

Navigation:

Benefits >ACA Annual Processing >Transmittal and Forms >ACA Transmission History

This example illustrates the fields and controls on the ACA Transmission History page.

Field or Control Description

Process Type The Process Type field indicates whether the transmittal file is
an original file, reissue file, replacement file, or correction file.

Receipt ID Enter the Receipt ID received from the IRS on submission of
the files.
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Field or Control Description

Transmittal Status Enter the Transmittal Status of the files as mentioned in the
Acknowledgement file from the IRS.

The options available are: Accepted, Accepted with Error,
Created in Error, Not Transmitted, Rejected. By default the
Transmittal Status is displayed as Not Transmitted.

Tips for Printing PDF Files
If you encounter alignment problems printing a PDF file, investigate the following possible sources of the
problem:

• Page Scaling: You may need to change this setting to “Shrink oversized pages” or “Actual size”.

• Page Size: Verify that the page size is correct (letter or legal) for the form you are printing.

• Print on Both Sides: Verify that this feature is not selected.

The following settings are suggested based on test-printing PDF files (where “xx” represents the last two
digits of the tax year for which data is to be reported):

• XMLP – ACA95Cxx_EE

Page Scaling = Shrink oversized pages

Page Size = Letter

• XMLP – ACA95Cxx_SM

Page Scaling = Actual size

Page Size = Legal

Setting Up and Managing Correction/Replacement of Forms 1094-
C and 1095-C

PeopleSoft Benefits generates transmission ACA data to the IRS as two XML transmittal files: Request
file and Manifest file. If these files are rejected by the IRS, then the Manifest file and a Correction
Request file has to be re-generated as replacement files for re-submission. If the file is accepted by the
IRS but there is error to a form, then a Correction Form 1095-C will be issued to the employee, and the
Correction Request file along with a Manifest file will be submitted to the IRS.
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Pages Used to Set Up and Manage Correction/Replacement of Forms 1094-
C and 1095-C

Page Name Definition Name Usage

Import ACA Transmission
Acknowledgement Page

ACA_IMPORT_ACK To upload the IRS Transmission
Acknowledgement file.

ACA Transmission Errors Page ACA_XMIT_ACK To view the ACA transmittal errors.

ACA Transmission History Page ACA_XMIT_HIST To review a history of when the Create
Transmittal File processes were run.

ACA Employer Transmittal Data Pages ACA_ALE_XMIT_PART1

ACA_ALE_XMIT_PART2

To view or modify the employer
transmittal data after the data extraction
process.

ACA Employee Transmittal Data Pages ACA_EMP_XMIT_PART1

ACA_EMP_XMIT_PART2

ACA_EMP_XMIT_PART3

To view or modify the employee
transmittal data after the extraction
process.

Create ACA XML Files Page ACA_RUN_BAC020 To generate the ACA transmittal files
and the PDF version of Form 1095-C.

View Form 1095-C Page ACA_SS_YE_FORM To view Form 1095-C as Administrator.

Import ACA Transmission Acknowledgement Page
Use the Import ACA Transmission Acknowledgement page (ACA_IMPORT_ACK) to upload the IRS
Transmission Acknowledgement file.

Navigation:

Benefits >ACA Annual Processing > Transmittal and Forms >Import ACA Transmission
Acknowledgement

This example illustrates the fields and controls on the Import ACA Transmission Acknowledgement page.
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ACA Transmission Errors Page
Use the ACA Transmission Errors Page (ACA_XMIT_ACK) to view the ACA transmittal errors.

Navigation:

Benefits >ACA Annual Processing >Transmittal and Forms >ACA Transmission Errors

This example illustrates the fields and controls on the ACA Transmission Errors page.

ACA Transmission History Page
Use the ACA Transmission History page (ACA_XMIT_HIST) to review a history of when the Create
Transmittal File processes were run. This page is also used for entering the Receipt IDs received from IRS
after submission.

Navigation:

Benefits >ACA Annual Processing >Transmittal and Forms >ACA Transmission History

This example illustrates the fields and controls on the ACA Transmission History page.

Field or Control Description

Process Type The Process Type field indicates whether the transmittal file is
an original file, reissue file, replacement file, or correction file.

Receipt ID Enter the Receipt ID received from the IRS on submission of
the files
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Field or Control Description

Transmittal Status Enter the Transmittal Status of the files as mentioned in the
Acknowledgement file from the IRS.

The options available are: Accepted, Accepted with Error,
Created in Error, Not Transmitted, Rejected. By default the
Transmittal Status is displayed as Not Transmitted.

ACA Employer Transmittal Data Pages
Use the ACA Employer Transmittal Data pages (ACA_ALE_XMIT_PART1 and
ACA_ALE_XMIT_PART2) to view or modify the employer transmittal data after the data extraction
process.

Navigation:

Benefits > ACA Annual Processing > Create ACA Form Data >ACA Employer Transmittal Data

This example illustrates the fields and controls on the ACA Employer Transmittal Data page.
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Field or Control Description

Process Status Defines the status of Data Extract, such as, PeopleSoft
Extracted, User Modified, Merged with Data Load,
Created In Error, Merge Error, Finalized for Transmittal,
and Transmittal Created. You can add a ‘User Modified’ row
to modify data before creating the 1094-C transmittal file.

Correct Form 1094-C Select this checkbox to make a correction to the Form 1094-C.

Note: Address is extracted based on the country format.

This example illustrates the fields and controls on the ACA Employer Transmittal Data page - ALE
Monthly Data tab.

ACA Employee Transmittal Data Pages
Use the ACA Employee Transmittal Data pages (ACA_EMP_XMIT_PART1, ACA_EMP_XMIT_PART2
and ACA_EMP_XMIT_PART3) to view or modify the employee transmittal data after the extraction
process.

Navigation:

Benefits > ACA Annual Processing > Create ACA Form Data > ACA Employee Transmittal Data
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This example illustrates the fields and controls on the ACA Employee Transmittal Data page - ACA
Employee tab.

Field or Control Description

Process Status Defines the process status of data transmittal, such as, Created
in Error, Finalized for Transmittal, Merge Error, Merged
with Data Load, PeopleSoft Extracted, Transmittal
Created, and User Modified.

Note: The Created in Error option is used to remove data
that were entered in error, before the form is transmitted.

Submission ID Represents the system assigned Submission ID in an IRS
transmission file. It is generated by the Create XML File
Process during the Final run.

Record ID Represents the system assigned Record ID within the above
Submission ID, as referenced in an IRS transmission file. An
IRS transmission file may contain one or more records in one
submission. This is generated by the Create XML File Process
during Final run.
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Field or Control Description

Form Type The options available are:

• Original

• Reissue – Between the time when Form 1095-C are
furnished to employees but the Transmittal file has not
been submitted to IRS, administrator can reissue Form
1095-C to their employees. Add a user modified row
with the changes required and select the Reissue radio
button to indicate that this data row is for issuing a reissue
form. Once changes are verified, set the Process Status to
‘Finalized for Transmittal’ and run the Create XML File 
(Reissue) process.

• Correction– After the Transmittal file is submitted
to the IRS, if any correction needs to be made to the
Form 1095-C, the administrator can choose to run the
Correction process. Add a user modified row with the
corrections and select the Correction radio button to
indicate that this data row is for correcting a form. Once
changes are verified, set the Process Status to ‘Finalized
for Transmittal’ and run the Create XML File (Correction)
process.

VOID To void a Form 1095-C, select the Reissue or Correction
radio button and select the Void checkbox.

This example illustrates the fields and controls on the ACA Employee Transmittal Data page - Employee
Monthly Data tab.

Field or Control Description

Plan Start Month This is an optional field for 2015. The system defaults it to
‘00’.
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Field or Control Description

Box ID 15: Employee Monthly Data The data from the first row Self Only Lowest Premium Cost
populates the corresponding box in the Form 1095-C.

The Self Low Cost Base Benefits, Self Low Cost BA No
Credit andSelf Low Cost BA With Credit are three working
rows used to calculate cost and credits.

This example illustrates the fields and controls on the ACA Employee Transmittal Data page - Covered
Individual Data tab.

Create ACA XML Files Page
Use the Create ACA XML Files page (ACA_RUN_BAC020) to generate the ACA transmittal file(s) and
the PDF version of Form 1095-C.

Navigation:

Benefits ACA Annual Processing Transmittal and Forms Create ACA Transmittal Files
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This example illustrates the fields and controls on the Create ACA XML Files page.

Field or Control Description

Data Extract ID Enter the Data Extract ID that was used to run the data extract.
 Data extracted using this rule will be used to generate the
transmittal file(s) and the PDF forms.

Applicable Large Employer The Applicable Large Employer for which data is being
reported.

Calendar Year The calendar year for which data is being reported.

Sort By First sort option of the employees being reported.

Within Sort, Order By Second sort option within the Sort By option, of the
employees being processed.
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Field or Control Description

Process Type The options available are:

• Original – This is the default value.

• Reissue – Select this option to correct a Form 1095-
C that was previously furnished to an employee, but
not filed with the IRS. Also use this option to correct
Form 1094-C information. When this option is selected,
 the word “CORRECTED” will be printed on the new
Form 1095-C to be furnished to the employee. The
Manifest and Request files will be re-generated for all the
employees from the original file and replaced with the
latest information.

• Correction – Select this option to correct an information
return that was previously filed and Accepted (with or
without errors) by the IRS, but contained erroneous or
incorrect information.

• Replace Submission - Select this option to replace a
rejected submission by the IRS.

• Replace Transmission - Select this option to replace a
rejected transmission by the IRS.

Receipt ID If Replace Submission or Replace Transmission is selected,
 select the Receipt ID of the file to be replaced.

Final Run Select this check box to process the final run.

For a preliminary run (when the Final Run checkbox is not
selected), the Request file will be generated with a temporary
file name. No Manifest file will be generated. Only the
Benefits Administrator can view Form 1095-C records which
are created in a preliminary run.

For the final run, the Request file will be generated with the
file name specified by the IRS. The Manifest file will be
generated. Form 1095-C records which are created in the final
run will be available for viewing in Self Service.

Note: Perform Final Run only when the preliminary runs
have been satisfactory and results have been verified. Once
Final Run is processed for selected ALE employer and ACA
employee data, the same data cannot be reprocessed in a
subsequent Final Run. An exception to this is before the
transmittal files from the Final Run have been transmitted to
IRS and the reissue of Form 1095-C is required. In which case,
new sequenced data can be added to prepare the employee data
for reissue.

Rerun Select this check box to rerun an Original, Reissue, or
Correction process in Final Run. The Manifest and Request
files will be re-generated with identical information.
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Field or Control Description

ACA ALE Sequence For Rerun and Original or Correction process, select the ACA
ALE Sequence to which the rerun is to be processed. The
ACA ALE Sequence is located on the ACA Transmission
History.

File Type Displays the File Type selection on the ACA Transmittal
Parameters page. Once communication test is passed and IRS
moved the ALE to production, file type should be changed
from AATS to Production.

Number of Records Per File Each file transmitted to the IRS must not exceed the 100MB
file size limit imposed by the IRS. If the submission is larger
than 100MB, it must be split into two or more separate file
transmissions. The default Number of Records Per File is set
at the ACA Transmittal Parameters page.

Note: If the generated file exceeds 100MB during preliminary
runs, reduce the number of records and re-generate the files.

Blank Plan Start Month Select this check box to print blank Plan Start Month on
Form 1095-C and to omit the data element equivalent in the
transmittal file. This option is only visible when Calendar Year
is 2015, when reporting of Plan Start Month is optional.

Test Scenario ID Enter the number of a test scenario as prescribed by IRS. (This
is only used with File Type AATS.)

Total Form Filed for ALE Enter Total Form Filed for ALE that corresponds to the Test
Scenario ID selected. (This is only used with File Type AATS.
)

View Form 1095-C Page
Use the View Form 1095-C page (ACA_SS_YE_FORM) to view Form 1095-C. A Benefits Administrator
can view all employees’ Form 1095-Cs, irrespective of whether or not they are finalized.

Navigation:

Benefits ACA Annual Processing Transmittal and Forms View Form 1095-C
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This example illustrates the fields and controls on the View Form 1095-C page.

Field or Control Description

Form Status Form Status is either Original, Reissue, or Correction.

Tax Form Click the Tax Form link to open a PDF version of Form 1095-
C.

Filing Instructions Click the Filing Instructions link to open a PDF document
containing filing instructions.

Final Print This check box identifies forms which are final and which are
preliminary only.
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Benefits Assistant

Understanding Benefits Assistant

A chatbot is a computer program that maintains a conversation with a user in natural language,
understands the intent of the user, and sends a response based on business rules and data of the
organization. The Benefits Assistant is a PeopleSoft chatbot created for the Benefits users. This chatbot
is designed to assist employees in looking up basic information about their current enrolled benefits,
dependents and beneficiaries, vendor/provider information and administrator contacts. Apart from what
PeopleSoft delivers, you can configure additional utterances for the chatbot based on your company’s
requirements.

The Benefits Assistant is available for all Benefits users as a tile and/or as a widget at the lower right-
hand corner of fluid Benefits pages. Click the tile or widget to open a chat window. The employee
may begin interacting with the chatbot via a simple greeting, or start directly with a question in a
conversational way. This feature is available for both desktop and mobile users.

Working with Benefits Assistant using ODA
With the Benefits Assistant tile, Benefits users can access the Benefits Assistant for quick answers to
queries related to benefits using Oracle Digital Assistant (ODA), the Oracle chatbot technology platform.
ODA allows enterprises to create and deploy digital assistants for their users. With ODA, you create:

• Digital Assistants, which are artificial intelligence (AI)-driven interfaces that help users accomplish
a variety of tasks in natural language conversations. For each digital assistant, you assemble one or
more skills.

• Skills, which are individual bots that are focused on specific types of tasks, such as changing your
dependants/beneficiaries, tracking inventory, submitting time cards, and creating expense reports.

You can add skills to digital assistants or deploy them to a channel on their own. Intents allow your
skill to understand what the user wants it to do. An intent categorizes typical user requests by the tasks
and actions that your skill performs.

For details, refer to Oracle Digital Assistants and Skills.

For Benefits Assistant, the Benefits Assistant skill consists of the following intents:

• EntryGreeting

• GetAdminContactInfo

• GetDependentBeneficiary

• GetLifeEventInfo

• GetMainMenu
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• GetOpenEnrollmentInfo

• GetPlanCost

• GetPlanDetail

• GetPlanProvider

• UpdateBenefitSummary

• ExitAssistant

• unresolvedIntent

The entities associated with each intent are defined within the skill.

Entities Associated Intents

LIFEEVENT_TYPE GetLifeEventInfo

GetDependentBeneficiary

GetPlanCost

GetPlanProvider

PLAN_CATEGORY

GetPlanDetail

GetDependentBeneficiary

GetPlanCost

GetPlanProvider

GetPlanDetail

PLANTYPE

UpdateBenefitSummary

SUMM_UPD_FLAG

SUMM_UPD_ACTION

UpdateBenefitSummary

These services can be used to call relevant application functionality as part of a query. The Chatbot
Integration Framework delivers some services that can be used to help the chatbot carry out various tasks
that these services allow to perform. To integrate the chatbot with the application services, you need to
create a proxy user. This proxy user is used for the chatbot to communicate with the application services.

The dialog flow definition is the model for the conversation itself, one that lets you choreograph the
interaction between a skill and its users.
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The Services used in Benefits Assistant are:

• HCM.benefit.Services

• HCM.benefit.GetChildNode

If users need to create new service, then they can use the Application Service Framework to create custom
services.

For more information please refer the documentation on Application Service Framework https://
support.oracle.com/epmos/faces/DocumentDisplay?id=2557046.1

For details, refer Configure a Component Service

"Understanding Application Service for Chatbot Integration Framework" (Enterprise Components)

PeopleSoft Employee Digital Assistant

PeopleSoft Intelligent Chatbot ASsistant from Oracle (PeopleSoft PICASO) is a consolidated, single-
point access chatbot where your employees can ask questions spanning multiple PeopleSoft applications
like Absence, Benefits, Employee Directory, Expenses, North American Payroll, and more. For
information on PeopleSoft PICASO, see "Understanding PeopleSoft PICASO" (Enterprise Components).

Benefits Assistant Interface
The Benefits Assistant helps employees with their queries on benefits-related information such as their
plan details, plan costs, administrator contacts, provider/vendor contacts, life events and open enrollment
dates.

Note: The Benefits Assistant provides answers for queries related to Open Enrollment only for
organizations with the PeopleSoft Benefits Administration.

The Benefit Details Navigation Collection users can access the Benefits Assistant as a widget. The
Benefit Details Tile dashboard users get the tile system delivered on the Benefit Details Tile dashboard
and as a widget on all the fluid Benefits pages.

Note: The roles and permission lists are part of the standard PeopleTools security administration, used
to grant access to components and pages. The roles and permission lists are discussed in detail in the
PeopleTools: Security Administration documentation.

Examples of Use Cases Benefits component from which the chatbot
retrieves information

• Tell me about my life insurance.

• I want to know about my short term disability plan.

• I want to know the plan detail for savings plan/ 401(K)
plan/profit sharing/retirement/pension plans/vacation
benefits/legal services?

Benefit Plan Detail
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Examples of Use Cases Benefits component from which the chatbot
retrieves information

• What is my insurance?

• What is my health plan?

• Tell me about my benefits.

• I want to know the benefit plans I am enrolled in.

• Show me my benefits summary.

Benefit Plan Category

Benefit Plan Type

• List my Dependents

• Who all have I enrolled as beneficiaries?

Dependents/Beneficiaries

• I want to know the provider for my medical plan.

• Tell me my provider details.

Benefit Vendor Information

• I need an Admin contact

• Health admin contact details

• Ben admin

• Contact details

Administrator Contacts

Setting Up Benefits Assistant

This topic discusses how to configure the Benefits Assistant for the Benefits users.

Pages Used to Configure Benefits Assistant as an Administrator Using the
PeopleSoft Fluid User Interface

Page Name Definition Name Usage

Content Ref Administration Page

For details, refer topic in Enterprise
Components: "Adding the Chatbot for
a New Skill to a PeopleSoft Page as a
Tile" (Enterprise Components)

PORTAL_CREF_ADM Add the Benefits Assistant tile to the
Benefit Details Tile dashboard.

Bot Definitions Page

For details, refer topic in Enterprise
Components: "Bot Definition
Page" (Enterprise Components)

EOCB_BOTSRCH_FL View, edit or add a new bot definition.
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Page Name Definition Name Usage

"Add Bot Definition Page" (Enterprise
Components)

EOCB_ADDBOTDEFN_FL Add a new Bot Definition.

Maintain Bot Definition page

For details, refer topic in Enterprise
Components: "Maintain Bot Definition
Page" (Enterprise Components)

EOCB_BOTDEFN_FL View the existing definitions for a
chatbot.

"Maintain Branding Template
Page" (Enterprise Components)

EOCB_BRNDTMPL_FL Control the branding aspects of the bot
definition.

Component Mapping Page

For details, refer topic in Enterprise
Components: "Adding the Chatbot to a
PeopleSoft Page as a Widget" (Enterprise
Components)

EOCB_COMPSRCH_FL Choose the component (that is, the
Benefits fluid page) on which the
Benefits Assistant widget should be
made available.

Configuring the Benefits Assistant Tile

The Benefit Details Navigation Collection users with the appropriate roles can access the Benefits
Assistant as a widget.

Note: Roles and permission lists are part of standard PeopleTools security administration, used to grant
access to components and pages. For details, refer PeopleTools: Security Administration documentation.

The Benefit Details Tile dashboard users get the tile system delivered on the Benefit Details Tile
dashboard and as a widget on all the fluid Benefits pages. The Administrator has to follow the steps below
to set the tile up on the dashboard for their organization:

1. Using the BEN_CHAT_ASST that is delivered with the system, edit and add the bot app ID from the
ODA channel.

a. Navigate to Enterprise Components >Chatbot Configurations > Bot Definitions.

b. Click the Edit button for BEN_CHAT_ASST (Benefits Assistant) and enter the Bot App ID value
from the ODA channel.

Oracle delivers a default branding template for the Benefits Assistant:
PS_ORWEBSDK_DEFAULT_V1. You can choose to use this template without making any changes.

2. Your employees need access to the Benefits fluid pages and the Benefit Details Tile dashboard, along
with the Benefit Chatbot role to access the Benefits Assistant. For this, ensure all employees have the
appropriate roles.

Note: For details on roles and permission lists, refer PeopleTools: Security Administration
documentation.
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Related Links
"Creating Bot Definitions" (Enterprise Components)
"Understanding the Chatbot Architecture" (Enterprise Components)

Content Ref Administration Page
Use the Content Ref Administration (PORTAL_CREF_ADM) page — Fluid Attributes tab
(PORTAL_GROUPLET), to add the Benefits Assistant tile to the Benefit Details dashboard.

Navigation:

PeopleTools > Portal > Structure and Content.

Then select Self Service > HR Fluid Components.

Under Content References, select Edit for the label Benefits Assistant and select Fluid Attributes tab.

For details, refer the topic: "Adding Chatbot to Application pages" (Enterprise Components).

This example illustrates the fields and controls on the Content Ref Administration page (1 of 2).
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This example illustrates the fields and controls on the Content Ref Administration page (2 of 2).

Select the Fluid Attributes tab to open the Tile Repository section.

This example illustrates the fields and controls on the Fluid Attributes tab.

Select the Dashboard checkbox under Include In Repository to enable the Benefits Assistant  tile to the
Benefit Details Tile dashboard.
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Bot Definitions Page
Use the Bot Definitions (EOCB_BOTSRCH_FL) page to view the existing chatbot identifiers and newly
define a chatbot.

Navigation:

Enterprise Components > Chatbot Configurations > Bot Definition

This example illustrates the fields and controls on the Bot Definition Page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Select Add to open the Add Bot Definition page to create a
new bot definition.

Maintain Bot Definition page
Use the Maintain Bot Definition page (EOCB_BOTDEFN_FL) to view the existing definitions for a
chatbot.

Navigation:

Enterprise Components > Chatbot Configurations > Bot Definitions
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This example illustrates the fields and controls on the Maintain Bot Definition page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Bot Identifier Displays the root package ID defined in the application server.

Bot Name Enter the name of the chatbot.

Bot Channel ID Specify the channel ID generated by the ODA Skill created
for this chatbot. This ID links the chatbot with the skills in the
ODA.

Bot Type Choose whether to deploy the chatbot client as a tile or as
a widget in a page or both. Bot types are embedded (for
components) and widget (lower right-hand corner button).

Branding Template Choose the Branding template for the bot.

Business Name Name of the chatbot as it will appear to the users.

Business Icon Choose the bot icon according to your business need.
 Refer, PeopleTools: Creating Image Definitions, for more
information.

Role Name Choose the roles that should be given access to this chatbot.

For details, refer Enterprise Components Documentation "Understanding the Chatbot
Architecture" (Enterprise Components).
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Component Mapping Page
Use the Component Mapping page (EOCB_COMPSRCH_FL) to choose the component (that is, the
Benefits fluid page) on which the Benefits Assistant widget should be made available.

Navigation:

Enterprise Components >Chatbot Configurations >Component Mapping

This example illustrates the fields and controls on the Component Mapping Page.

Field or Control Description

Component Displays the fluid components or fluid Benefits pages on
which the Benefits Assistant widget can be enabled.

Edit Click the Edit button to access the Maintain Component
Mapping page and enable the Benefits Assistant on the
component pages.

This example illustrates the fields and controls on the Maintain Component Mapping Page.
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Communicating with Benefits Assistant

This topic provides an overview of how employees can interact with the Benefits Assistant chatbot.

Pages Used to Communicate with the Benefits Assistant Chatbot

Page Name Definition Name Usage

Benefits Assistant Tile HC_HGA_CHAT_ASST_FLU (cref for
the tile)

Launch the Benefits Assistant chatbot
from the Benefit Details Tile dashboard.

Benefits Assistant Page EOCB_CLIENT_FL Begin the interaction with the Benefits
Assistant chatbot for quick answers to
queries on benefits-related information
such as plan details, plan costs,
 administrator contacts, provider/vendor
contacts, life events and open enrollment
dates.

Benefits Assistant Tile
Use the Benefits Assistant tile (HC_HGA_CHAT_ASST_FLU - cref for the tile) to launch the Benefits
Assistant chatbot from the Benefit Details Tile dashboard.

Navigation:

Employee Self Service >Benefit Details Tile >Benefits Assistant Tile

This example illustrates the Benefits Assistant tile.

Benefits Assistant Page
Use the Benefits Assistant page (EOCB_CLIENT_FL) to ask queries on benefits-related information
such as plan details, plan costs, administrator contacts, provider/vendor contacts, life events and open
enrollment dates.

Note: The Benefits Assistant provides answers for queries related to Open Enrollment only for
organizations with the PeopleSoft Benefits Administration.

Navigation:
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• Benefit Details Tile dashboard users can select the Benefits Assistant tile from the tile dashboard to
access the Benefits Assistant chatbot window.

• Benefit Details Tile dashboard users can also click the Benefits Assistant widget at the lower right-
hand corner of a fluid Benefits page to open the Benefits Assistant chatbot window.

Note: The Benefits Assistant widget is not available on the Open Enrollment page.

• Benefit Details Navigation Collection users can click the Benefits Assistant widget at the lower right-
hand corner of the page to open the Benefits Assistant chatbot window.

This example illustrates the Benefits Assistant page accessed from the Benefits Details Tile dashboard.

This example illustrates the Benefits Assistant widget as seen in a fluid Benefits Summary page on a
laptop device.
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This example illustrates the Benefits Assistant widget as seen on a smartphone.

This example illustrates the Benefits Assistant widget for the Navigation Collection users.
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Queries on Current Enrollments

When employees ask general benefit questions, the chatbot offers guidance by displaying a list of choices
which the employee can select to view additional details.

This example illustrates a general query on benefit plans.
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This example illustrates a general query on benefit plans — Options list 1.
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This example illustrates a general query on benefit plans — Options list 2.

Note: The options to view the latest deductions are available only for organizations with the PeopleSoft
Payroll for North America.
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This example illustrates a general query on benefit plans — latest deductions.

Note: Once the employee has chosen an option from the list, the entire list gets grayed out. The employee
cannot go back and select a different option, instead he/she can repeat the question or even ask another
one.
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This example illustrates a query on a plan not enrolled in.

Queries on Dependents and Beneficiaries

For queries on dependents and beneficiaries the chatbot returns the details as listed in the employee’s
profile as well as options to view enrolled dependents and beneficiary designations. For queries
on changing or updating beneficiary designation, the chatbot directs the employees to the Benefits
Summary page from where they can complete the task.

Note: Your organization must have the PeopleSoft Benefits Administration product for access to the
enrollment features.
Employees are able to change and update beneficiary designations based on the setup on the Benefits
Program Table.
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This example illustrates a query for Dependents/Beneficiaries.
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This example illustrates a query for Dependents/Beneficiaries.
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This example illustrates a query for Dependents/Beneficiaries.
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This example illustrates the query to the chatbot updating beneficiary designation.

Queries on Life Event

Employees can ask the chatbot how to start life events or how to update their dependents/beneficiaries
based on recent life event changes like marriage, childbirth, adoption, divorce etc.
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This example illustrates the query to the Benefits Assistant on starting a life event as seen on a
smartphone.

For queries related to life event transactions, the chatbot offers two options: Take me there and Maybe
later. The Take me there button directs the employee to the relevant page from where he/she can
complete the task. The Maybe later button, does not direct the employee elsewhere but remains in focus
for additional questions.
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This example illustrates the Maybe later button.

Queries on Open Enrollment Periods

Employees can ask the chatbot for the Open Enrollment start or end dates and the chatbot returns the
requested information. In case open enrollment is not available at the time, the chatbot offers the Benefit
Administrator Contact for more information.
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This example illustrates an answer to a query on Open Enrollment.

Note: For organizations with only the PeopleSoft Base Benefits product, the Open Enrollment
information is not available in the PeopleSoft system.
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This example illustrates an answer to a query on Open Enrollment in organizations with only the
PeopleSoft Base Benefits product.

A chevron appears at the right side of the contact information box when there are multiple administrator
contacts available. Click the chevron to view details of the next administrator contact.

Queries on Benefit Plan Costs

Employees can ask the chatbot about the costs of their benefit plans. The chatbot offers different lists with
options from which the employees can choose to view the desired information.

Note: The plan cost information is available only for organizations with the PeopleSoft Payroll for North
America.
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This example illustrates a query on benefit plan cost.
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This example illustrates a query on benefit plan cost — Options list 1.
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This example illustrates a query on benefit plan cost — details

Note: The options to view the latest deductions are available only for organizations with the PeopleSoft
Payroll for North America.

Queries on Updating Savings Contributions

When an employee asks the chatbot how to update the savings contribution, the chatbot directs him/her to
the Benefits Summary page from where he/she can make the updates.

Note: Employees are able to change and update their savings contributions based on the setup on the
Benefits Program Table.
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This example illustrates a query to the chatbot updating savings contribution.

Note: When the employee is already on the Benefits Summary page and asks the chatbot a query on
updating a benefits-related information, the chatbot simply states that the task can be completed from the
Benefits Summary page instead of providing a link to the page.
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This example illustrates a query on updating a savings contribution on a smartphone, when the employee
is already on the Benefits Summary page.

Queries on Benefit Vendor Information

For general provider/vendor information queries, the chatbot determines the specific benefit plan the
employee is seeking and lists the details as available in the Provider/Vendor Table.
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This example illustrates a query for the medical plan provider info.

In this example, the Kaiser Permanente button takes the employee to a third-party website as configured
in the Provider/Vendor Table ("Policy Information Page" (Application Fundamentals)).

Queries for Administrator Contacts

When employees request administrator contacts, the chatbot lists the contact name, email, and phone
number as available in the Administrative Contacts page. When there are multiple contacts available, a
chevron appears at the right side of the contact information box. Employees can click the chevron to view
details of the next contact.
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This example illustrates the Administrator Contacts.

Main Menu

When an employee types an ambiguous query, an informal abbreviation or an incorrect spelling (for
example Dnt pln or Benfit pln instead of dental plan or benefit plan), the chatbot returns the main menu
with options for current enrollments, dependents/beneficiaries and Benefit Administrator contact.
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This example illustrates the Main Menu on the Benefits Assistant chatbot.
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This example illustrates an example for a query with incorrect spelling.

Copyright © 1988, 2022, Oracle and/or its affiliates. 599



Benefits Assistant Chapter 24

600  Copyright © 1988, 2022, Oracle and/or its affiliates.


	Legal Notices
	Contents
	Preface
	Understanding the PeopleSoft Online Help and PeopleBooks
	Hosted PeopleSoft Online Help
	Locally Installed Help
	Downloadable PeopleBook PDF Files
	Common Help Documentation
	Field and Control Definitions
	Typographical Conventions
	ISO Country and Currency Codes
	Region and Industry Identifiers
	Translations and Embedded Help

	Using and Managing the PeopleSoft Online Help
	Related Links for PeopleSoft HCM
	Contact Us
	Follow Us

	Getting Started with PeopleSoft Manage Base Benefits
	PeopleSoft Manage Base Benefits Overview
	PeopleSoft Manage Base Benefits Business Process
	PeopleSoft Manage Base Benefits Integrations
	PeopleSoft Manage Base Benefits Implementation

	Setting Up the Installation Table for Base Benefits
	Defining the Installation Settings for Base Benefits
	Pages Used to Define Benefits Installation Settings
	Benefits Installation Page


	Setting Up Base Benefits Core Tables
	Understanding the Core Tables for PeopleSoft Manage Base Benefits
	Setting Up Benefit Providers
	Setting Up Dependent Relationships
	Page Used to Set Up Dependent Relationships
	Understanding Dependent Relationships
	Dependent Relationships Table Page

	Setting Up Coverage Codes
	Page Used to Set Up Coverage Codes
	Understanding Coverage Codes
	Health Coverage Codes Page

	Setting Up Coverage Group Codes
	Page Used to Set Up Coverage Group Codes
	Understanding Coverage Group Codes
	Life and AD/D Coverage Groups Page

	Setting Up FEGLI Codes
	Page Used to Set Up FEGLI Codes
	FEGLI Code Table Page

	Setting Up the Service Step Table
	Page Used to Set Up the Service Step Table
	Understanding the Service Step Table
	Service Step Table Page

	Setting Up Benefit Rates
	Pages Used to Define Benefit Rates
	Understanding Benefit Rates
	Understanding Percent of Gross Limits
	Benefit Rate Types Page
	Benefit Rates Page
	Amount Subject to Limit Page

	Setting Up Annual Benefits Base Rates
	Page Used to Set Up ABBR Types
	Annl Benef Base Rt Type Tbl Page

	Setting Up Calculation Rules
	Page Used to Set Up Calculation Rules
	Understanding Calculation Rules
	Calculation Rules Table Page

	Setting Up Deduction Codes
	Page Used to Set Up Deduction Codes
	Understanding Deduction Codes
	Deduction Table - Setup Page

	Setting Up Special Accumulators
	Page Used to Set Up Special Accumulators
	Understanding Special Accumulators
	Special Accumulator Table Page

	Setting Up Limits for Qualified Savings Plans
	Page Used to Set Up Limits for Qualified Savings Plans
	Understanding Limits
	Understanding 401 Limit
	Understanding 402 Limit
	Understanding 403 Limit
	Understanding 415 Limit
	Understanding 415Z Limit
	Understanding 457 Limit
	Understanding Limit Extensions
	Common Elements Used to Define Limits
	Limit Table Page for 401(a) Limits
	Limit Table Page for 402(g) Limits
	Limit Table Page for 403(b) Limits
	Limit Table Page for 415 Limits
	Limit Table Page to Set Up 415(c) Limits for 403(b) Plans
	Setting Up Deduction Class Order for 415 Limit Tables
	Limit Table Page for 457 Limits
	Limit Table Page for User Defined Limits

	Setting Up Dependent Rules for Health Plans
	Understanding Dependent Rules
	Dependent Rules Table Page

	Setting Up Earnings for Leave and Vacation Buy/Sell Plans
	Setting Up Payroll Information for Leave Accruals
	Setting Up Vacation Buy and Sell Earnings

	Setting Up Benefits Certifications
	Page Used to Create Benefit Certification Forms
	Understanding Benefits Certification
	Certification Definition Page


	Setting Up Benefit Plans
	Defining Benefit Plans
	Page Used to Define Benefit Plans
	Understanding Benefit Plans
	Benefit Plan Table Page

	Setting Up Health Plans
	Page Used to Set Up Health Plans
	Health Plan Table Page

	Setting Up Simple Rate Plans
	Page Used to Set Up Simple Rate Plans
	Understanding Simple Rate Plans
	Simple Plan Table Page

	Setting Up Life Insurance and Accidental Death Plans
	Understanding Coverage Calculation Formulas
	Coverage Formula Table Page
	Life and AD/D Plan Table Page
	(USF) Understanding Option A - Standard FEGLI Plan Calculations

	Setting Up Disability Plans
	Page Used to Set Up Disability Plans
	Prerequisites
	Disability Plan Table Page

	Setting Up Savings Plans
	Pages Used to Set Up Savings Plans
	Employee Limit on Investments Page
	Employer Contribution/Match Page
	Calculating Thrift Savings Plan (TSP) Employer Match for Federal Benefits
	Rollover of Funds Page
	Setting Up Thrift Savings Plans (TSP)

	Setting Up Leave Plans
	Page Used to Set Up Leave Plans
	Leave Plan Table Page

	Setting Up FMLA Plans
	Page Used to Set Up FMLA Plans
	Prerequisites
	FMLA Plan Table Page

	Setting Up FSA Plans
	Pages Used to Set Up FSA Plans and HSA Excluded Coverages
	Understanding FSA Plans
	Spending Accounts Page
	HSA Contribution Limits Page
	FSA Admin Config Page
	HSA Excluded Coverages Page

	Setting Up Retirement Plans
	Page Used to Set Up Retirement Plans
	Retirement Plan Page

	Setting Up Pension Plans
	Pages Used to Set Up Pension Plans
	Pension Plan Table Page (USA)
	Pension Plan Table CAN Page

	Setting Up Vacation Buy/Sell Plans
	Page Used to Set Up Vacation Buy/Sell Plans
	Vacation Buy/Sell Table Page


	Building Base Benefit Programs
	Understanding Benefit Programs
	Understanding Benefit Programs
	Understanding Plan Types
	Understanding Plans
	Understanding Effective Dates

	Building Benefit Programs
	Pages Used to Build Benefit Programs
	Benefit Program Table - Benefit Program Page
	Benefit Program Table - Plan Type and Option Page
	Benefit Program Table - Cost Page

	Cloning Benefit Programs, Coverage Formulas, Eligibility Rules, Event Rules, or Life Event Templates
	Page Used to Clone Benefit Programs, Coverage Formulas, Eligibility Rules, Event Rules, or Life Event Templates
	Benefit Clone Utility Page


	Setting Up Additional Manage Base Benefits Features
	Setting Up Benefits Billing
	Pages Used to Set Up Benefits Billing
	Understanding Benefits Billing Set Up
	Billing Parameters Page
	Define Calendar Page

	Setting Up Internal Administrative Contact Information
	Page Used to Set Up Internal Administrative Contact Information
	Understanding Internal Administrative Contact Information
	Administrative Contacts Page

	Setting Up COBRA Administration
	Pages Used to Set Up COBRA Administration
	Prerequisites
	Linking COBRA to Benefit Packages
	Identifying COBRA-Eligible Benefit Plans
	Establishing Coverage Codes for COBRA
	Defining COBRA-Qualifying Events
	Event Rules Page

	Setting Up HIPAA Tables
	Pages Used to Set Up HIPAA Tables
	EDI Trading Partners Page
	EDI 834 Transaction Map Table Page

	Setting Up Multiple Jobs
	Page Used to Set Up Multiple Jobs
	Understanding Multiple Jobs
	Multiple Jobs Options Page

	Setting Up Retroactive Benefits and Deductions
	Pages Used to Set Up Retroactive Benefit and Deduction Programs and Mass Requests
	Prerequisites
	Retro Ben/Ded Program Page
	Retro Ben/Ded Mass Request Page


	Entering Dependent and Beneficiary Information
	Understanding Dependent and Beneficiary Information
	Entering Dependent and Beneficiary Information
	Entering Dependent and Beneficiary Comments
	Page Used to Enter Dependent and Beneficiary Comments
	Dependent/Beneficiary Comments Page

	Updating Benefits Certifications
	Page Used to Edit Benefits Certifications
	Maintain Benefit Certification Page

	(USF) Designating Beneficiaries for a Final Check
	Page Used to Designate Beneficiaries for a Final Check
	Assign Final Check Beneficiary Page

	Terminating Dependent Enrollments or Beneficiary Status
	Entering Court Orders and Spousal Waivers
	Approving Dependent Documents using Fluid Approval
	Understanding Dependent Document Approval
	Page Used to Approve Dependent Documents
	Pending Approvals - Dependent Updates Page


	Enrolling Participants
	Reviewing Employee Eligibility
	Page Used to Review Employee Eligibility
	Employee HR and Payroll Data Page

	Enrolling Participants in Benefit Programs and Plans
	Pages Used to Enroll Participants in Benefit Programs and Plans
	Understanding Enrolling Participants in Base Benefits
	Assign to Benefit Program Page
	Health Benefits Page
	Life and AD/D Plan Enrollment Page
	Benefits Personal Data page
	Update ABBRs Page
	Disability Plan Enrollment Page
	Savings Plans Page
	Benefits Leave Plans Page
	Spending Accounts Page
	Retirement Plans Page
	Pension Plans USA Page
	Vacation Benefits Page
	Simple Benefits Page

	(USF) Enrolling Employees in Benefit Programs and Plans
	Pages Used to Enroll Employees in Benefit Programs and Plans Through the PAR
	Benefits/FEHB Data Page
	FEGLI/Retirement Data/FICA Page
	FEGLI Assignments - Assignee Page
	FEGLI Assignments - Assignee Benef Page
	TSP Agency Basic Page
	TSP Investment Allocations Page

	Terminating Dependent Enrollments or Beneficiary Status
	Generating HIPAA Certificates
	Pages Used to Generate HIPAA Certificates
	HIPAA Compliance Report Page
	Notification Letters Page


	Reviewing Enrollments and Benefit Calculations
	Auditing Your Benefit Information
	Viewing Current Benefits Summary Data
	Pages Used to View Benefits Summary Data
	Benefits Deduction Calculations
	Benefit Enrollment Summary Page
	Benefit Deduction Summary Page

	Viewing Enrollment Statistics Using the Health Benefits Pagelet
	Pages Used to View Enrollment Statistics Using the Health Benefits Pagelet
	Making the Health Benefits Pagelet Available to Users
	Health Benefits Pagelet
	HEALTH_BENEFITS- Health Benefits Page

	Overriding the Frequency of Benefit Deductions
	Page Used to Override the Frequency of Benefit Deductions
	Arrears/Frequency Override Page


	Performing Nondiscrimination Testing
	Understanding Section 401 Nondiscrimination Tests
	Basic and Alternate Section 401(k) Tests
	Basic and Alternate Section 401(m) Tests
	The Aggregate Limit Test

	Defining Highly Compensated Earnings
	Identifying Highly Compensated Employees
	Setting Up Test Criteria and Plans
	Page Used to Set Up Test Criteria and Plans
	Nondiscrimination Rules Page
	Identifying Benefit Plans to Include in a Test

	Defining the Nondiscrimination Test Run Control
	Pages Used to Define the Nondiscrimination Test Run Control
	Section 401 Define Test Page
	Section 129 Define Test Page

	Running Nondiscrimination Tests
	Pages Used to Run Nondiscrimination Tests
	Section 129 Highly Compensated Page
	401(k) Nondiscrimination Test - Run Control Page and NDT Section 401(m) Testing Page
	Running Section 129 Nondiscrimination Testing

	Understanding Nondiscrimination Test Results
	Viewing Nondiscrimination Test Results
	Pages Used to View Nondiscrimination Test Results
	Savings Plan Page
	Review Section 401 Test Result Page
	Review Section 129 Test Result Page
	Running Nondiscrimination Test Reports

	Setting Limits to Comply with Test Results

	Managing Life Events
	Understanding Life Events
	Defining Life Event Rules
	Page Used to Define Life Event Rules
	Understanding Life Event Rules
	Life Event Rules Page

	Configuring A Life Event
	Pages Used to Configure Life Event Templates and Action Items in Benefits
	Understanding Life Event Templates (Including Action Items / Steps)
	Classic Templates Page
	Fluid Templates Page
	Action Item Page
	Child Action Item Page
	Dependent Action Item Page

	Configuring Fluid Life Event Document Upload
	Pages Used to Configure Fluid Life Event Documents Upload
	Understanding Fluid Life Event Document Upload
	Maintain Definitions Page
	Review Benefits Attachment Page

	Setting Up the Life Event Selection Menu
	Page Used to Define the Life Event Selection Menu
	Classic Category Page
	Fluid Category Page

	Creating Life Event Descriptive Pages
	Understanding Life Event Descriptive Pages
	Page Used to Create Life Event Descriptive Pages
	Maintain Text Catalog Page
	Field and Control Definitions

	Configuring the Employee Enrollment Summary Statement
	Understanding the Enrollment Summary Statement
	Page Used to Configure the Employee Enrollment Summary Statement
	Enrollment Statement Controls Page

	Understanding Life Event Processing
	Processing the Marriage Event
	Pages Used to Process the Marriage Event

	Processing the Child Birth Event
	Pages Used to Process the Child Birth Event

	Processing the Adoption Event
	Pages Used to Process the Adoption Event

	Processing the Divorce Event
	Pages Used to Process the Divorce Event

	Using the PeopleSoft Fluid User Interface to Enter Life Events
	Pages Used to Enter Life Events Using the PeopleSoft Fluid User Interface
	The Activity Guide Composer Framework for Life Events
	Welcome to <Transaction Name> Event Page
	Marital Status or Divorce Status Page
	Birth Date or Adoption Date Page
	Dependent and Beneficiary Coverage Summary Page
	Add Individual Dependent/Beneficiary Information Page
	Pay and Compensation - Direct Deposit Page
	Summary Page

	Uploading Fluid Life Event Documents
	Page Used to Upload Fluid Life Event Documents
	Life Event Document Upload Page
	Benefits Attachment Page

	Approving Life Event Documents
	Understanding Document Approval
	Page Used to Approve Life Event Documents
	Approve Life Event Document Page
	Field and Control Definitions

	Approving Life Event Documents Using Fluid Approvals
	Pages Used to Approve Life Event Documents Using Fluid Approvals
	Pending Approvals — Benefits Document Filing Page

	Delegating Life Events Document Approval
	Understanding Document Approval Delegation
	Reviewing Delivered Document Approval Delegation Setup
	Steps to Set Up a Delegation Request
	Delegating Document Approval Requests
	Managing Delegation Authorities

	Managing Benefits Instances
	Understanding Benefits Instances Maintenance
	Page Used to Manage Benefits Instances
	Manage Benefits Instances Page

	Delegating Life Events Document Approval Using Fluid Delegations
	Pages Used to Delegate Life Events Document Approval Using Fluid Delegations
	Understanding Document Approval Delegation
	Reviewing Delivered Document Approval Delegation Setup
	Steps to Set Up a Delegation Request
	Delegating Document Approval Requests
	Managing Delegation Authorities


	Managing Savings Plans
	Understanding Savings Plan Management
	Calculating 403(b) and 457 Extensions
	Pages Used to Calculate 403(b) and 457 Extensions
	Understanding the 403(b) and 457 Extensions
	Calculate 403(b) Extensions Page

	Identifying Age-50 Extensions
	Page Used to Identify Age-50 Extensions
	Understanding Age-50 Extension
	Savings Plan Age-50 Extensions page

	Managing Savings Plan Limits
	Pages Used to Manage Savings Plan Limits
	Understanding Managing Savings Plan Limits
	Benefits Savings Management Page
	403(b) Adjustments Page
	457 Adjustments Page


	Managing FMLA Plans
	Understanding FMLA Plan Administration
	Entering FMLA Leave Requests
	Page Used to Enter FMLA Leave Requests
	Request/Authorize/Track Leave - Request Page
	Monitoring Leave Requests

	Determining FMLA Eligibility
	Page Used to Determine FMLA Eligibility
	Request/Authorize/Track Leave - Eligibility Page

	Scheduling FMLA Leave
	Pages Used to Schedule FMLA Leave
	Request/Authorize/Track Leave - History Page
	Schedule Leave Days Page
	Mark Paid Leave Page

	Tracking FMLA Activity
	Page Used to Track FMLA Activity
	Request/Authorize/Track Leave - Activity Page


	Managing Leave Plans
	Understanding the Leave Process
	Processing Leave Accruals
	Page Used to Process Leave Accruals
	Leave Accrual Process Page

	Viewing Employee Balances
	Page Used to View Employee Balances
	Review Leave Accrual Balances Page


	Managing Vacation Buy/Sell Plans
	Understanding the Vacation Buy/Sell Process
	Reviewing Vacation Buy/Sell Calculation Results
	Page Used to Review Vacation Buy/Sell Calculation Results
	Vacation Benefits Page
	Viewing the Number of Vacation Hours Bought or Sold


	Managing Benefits Billing
	Understanding Benefits Billing
	Prerequisite

	Understanding the Billing Calculation Process
	Enrolling Participants
	Pages Used to Enroll Participants
	Locating Eligible Participants
	Enrolling Participants Automatically
	Enroll in Benefits Billing Page
	Billing Hold/Alternate Address Page

	Calculating Charges
	Pages Used to Calculate Charges
	Calculate Billing Charges Page
	Enter Billing Manual Charges Page

	Reviewing Charges
	Pages Used to Review Charges
	Charge Page
	Charge Detail Page
	Charge Summary by Bill Period Page
	Charge Summary by Plan Type Page

	Generating Benefits Billing Statements
	Pages Used to Generate Benefits Billing Statements
	Print Billing Statement Page
	Reprint Billing Statements Page

	Processing Payments
	Pages Used to Process Payments
	Allocate Billing Payments Page
	Review Billing Payment Details Page

	Adjusting Charges and Payments
	Pages Used to Adjust Charges and Payments
	Billing Charges Adjustment Page
	Billing Payment Adjustment Page

	Reviewing Charge and Payment History
	Page Used to Review Charge and Payment History
	Employee Billing Balances Page


	Managing COBRA
	Understanding COBRA Management
	Determining Qualified COBRA Events
	Page Used to Determine Qualified COBRA Events
	Understanding COBRA Events
	Review COBRA Triggers Page
	Overriding Initial and Secondary COBRA Events

	Running the COBRA Process
	Pages Used to Run the COBRA Process
	Understanding the COBRA Process
	COBRA Qualifying Process Page
	Understanding COBRA Event Status
	Assigning Qualified COBRA Beneficiaries to Benefit Programs
	Determining Eligible Plan Types
	Determining Eligible Options
	Calculating COBRA Costs for Eligible Options
	Processing Secondary COBRA Qualifying Events
	COBRA Processing Messages Page

	Creating Notification Letters
	Pages Used to Create Notification Letters
	Determining Notification Recipients
	COBRA Notification Letter Page
	COBRA Secondary Letter Page
	Reprint COBRA Letter Page

	Entering COBRA Elections and Waivers
	Page Used to Enter COBRA Elections and Waivers
	Understanding COBRA Elections
	COBRA Participant Elections Page
	Validating and Enrolling Elections

	Processing Enrollments for Secondary Events
	Understanding Initial Event Status and Secondary Events
	Identifying Differences in Individual and Dependent Coverage Processing
	Understanding Combination Events

	Managing COBRA Events
	Pages Used to Manage COBRA Events
	Review COBRA Event Summary Page
	Update COBRA Event Status Page

	Managing COBRA Benefit Plan and Dependent Information
	Pages Used to Manage COBRA Benefit Plan and Dependent Information
	Assign COBRA Benefit Program Page
	Health Plan Enrollment Page
	COBRA FSA Plan Enrollment Page
	Name Page

	Managing Nonemployee COBRA Participants
	Pages Used to Manage Non-Employee COBRA Participants
	Medicare and Job Page
	Converting Nonemployee Individual Coverage to Dependent Coverage

	Terminating COBRA Coverage
	Pages Used to Terminate COBRA Coverage
	Terminate COBRA Participants Page
	COBRA Termination Letter Page

	Enrolling Participants in COBRA Coverage Manually
	Pages Used to Enroll Participants in COBRA Coverage Manually
	Create COBRA Non-Employee Page
	Manual COBRA Benefit Program Page
	Select Health Benefits Page


	Processing Retroactive Benefits and Deductions
	Understanding Retroactive Benefits and Deductions
	Triggering Individual Retroactive Benefit/Deduction Requests
	Triggering Mass Retroactive Benefit/Deduction Requests
	Page Used to Trigger Mass Retroactive Benefit/Deduction Requests
	Setting Up Mass Retroactive Benefit/Deduction Programs and Requests
	Process Mass Retro Deductions Page

	Handling Duplicate Requests
	Viewing Retroactive Benefit/Deduction Requests
	Page Used to View Retroactive Benefit/Deduction Requests
	Retro Ben/Ded Request Summary Page

	Calculating Retroactive Benefits and Deductions
	Pages Used to Calculate Retroactive Benefits and Deductions
	Calculate Retroactive Ben/Deds Page
	Viewing Error Messages

	Reviewing and Updating Calculated Retroactive Benefits and Deductions
	Pages Used to Review and Update Calculated Retroactive Benefits and Deductions
	Update Retro Ded Calc Results Page

	Loading Calculations into PeopleSoft Payroll for North America
	Page Used to Load Calculations into Payroll for North America
	Load Retro Deductions Page
	Processing Payroll for Retroactive Benefits and Deductions


	Managing Multiple Jobs
	Understanding Multiple Jobs
	Changing Benefit Record Numbers
	Understanding Multiple Jobs Data and Calculating Deductions
	Understanding Calculation Rules

	Changing Primary Job Data
	Pages Used to Change Primary Job Data
	Maintain Primary Job Flags Page
	Job Data Page

	Automatically Building Primary Job Data for Multiple Employees
	Page Used to Automatically Build Primary Job Data for Multiple Employees
	Rebuild Primary Job Flags Page


	Sending Benefit Information
	Understanding Benefit Data Extraction
	Specifying the Data to Extract
	Page Used to Specify Data to Extract
	Enrollment Snapshot Options Page

	Running the Enrollment Reporting Snapshot Process
	Pages Used to Run the Enrollment Reporting Snapshot Process
	Understanding Database Record Layout Details

	Sending Data to Benefit Providers
	Creating SQR Provider Extracts
	Running Carrier Extracts

	Sending HIPAA Data to Providers
	Page Used to Create the HIPAA EDI 834 File
	Create HIPAA 834 File Page

	(USF) Sending FEHB Data to the OPM
	Pages Used Send FEHB Data to the OPM


	Defining Benefit Rates for U.S. Same-Sex Spouse
	Understanding the U.S. Same-Sex Spouse Relationship
	Understanding Benefit Rate Enhancements for U.S. Same-Sex Spouse
	Reviewing U.S. Same-Sex Spouse Benefit Rates Setup
	Page Used to Set Up Same-Sex Spouse Benefit Rates
	Benefit Rates Page
	Other Rates Page
	Translate Values

	Setting Up Health Insurance
	Setting Up Spousal Life Insurance

	Managing U.S. Health FSA Carryover
	Understanding U.S. Health FSA Carryover
	Setting Up U.S. Health FSA Carryover
	Reviewing the Carryover Amount during Benefits Enrollment
	Reviewing Available Claim Amounts
	Reviewing Year-to-Date Activity
	Adjusting the FSA Carryover Amount
	Page Used to Adjust the FSA Carryover Amount
	Spending Account Adjustment Page


	Managing U.S. Affordable Care Act Regulations
	Understanding ACA Eligibility
	Setting Up ACA Eligibility Tables
	Pages Used to Set Up ACA Eligibility Tables
	Understanding Multiple Companies and ACA Eligibility Tables
	ACA Common ID Table Page
	ACA Company Table Page

	Recording ACA Data
	Page Used to Record ACA Data for an Employee
	ACA Employee Eligibility Page
	Using the ACA Component Interface

	Setting Up ACA Consent Processing
	Pages Used to Set Up ACA Consent Processing
	Understanding ACA Consent Processing
	ACA Aggregated ALE Group Page
	ACA Applicable Large Employer Table Page
	ACA Company Table Page
	ACA Form Options Page
	Maintain Text Catalog Page

	Understanding ACA Safe Harbor Codes and Safe Harbor Relief Groups
	Setting Up ACA Safe Harbors Codes and Safe Harbor Relief Groups
	Pages Used to Set Up ACA Safe Harbors Codes and Safe Harbor Relief Groups
	ACA Safe Harbor Codes Page
	Safe Harbor Relief Groups Page

	Understanding ACA Data Extraction, Transmittal, and Form 1095-C Printing
	Setting Up and Managing Data Extraction for Forms 1094-C and 1095-C
	Pages Used to Set Up and Manage Data Extraction
	Health Plan Table Page
	ACA Employee Eligibility Group Page
	ACA Offer of Coverage Page
	ACA Data Extract Definition Page
	ACA Data Source Page

	Creating ACA Form Data for Forms 1094-C and 1095-C
	Pages Used to Create Data Form Extraction
	ACA Data Extract Page
	ACA Employer Transmittal Data Pages
	ACA Employee Transmittal Data Page
	Using the ACA Component Interface
	Review Employee Data Load Page
	Review Employee Amount Load Page
	Review Covered Individual Load Page

	Setting Up the Other Source Data Merge Process
	Pages Used for the Other Source Data Merge Process
	Merge Other Data Sources Page
	Review ACA Merged Messages Page
	Review Merged Transmittal Data Page

	Setting Up File Transmittal and Form 1095-C Printing
	Pages Used for File Transmittal and Form 1095-C Printing
	ACA Transmittal Parameters Page
	ACA Form Options Page
	ACA Form BI Publisher Options Page
	Create ACA XML Files Page
	View Form 1095-C Page
	ACA Transmission History Page
	Tips for Printing PDF Files

	Setting Up and Managing Correction/Replacement of Forms 1094-C and 1095-C
	Pages Used to Set Up and Manage Correction/Replacement of Forms 1094-C and 1095-C
	Import ACA Transmission Acknowledgement Page
	ACA Transmission Errors Page
	ACA Transmission History Page
	ACA Employer Transmittal Data Pages
	ACA Employee Transmittal Data Pages
	Create ACA XML Files Page
	View Form 1095-C Page


	Benefits Assistant
	Understanding Benefits Assistant
	Working with Benefits Assistant using ODA
	Benefits Assistant Interface

	Setting Up Benefits Assistant
	Pages Used to Configure Benefits Assistant as an Administrator Using the PeopleSoft Fluid User Interface
	Content Ref Administration Page
	Bot Definitions Page
	Maintain Bot Definition page
	Component Mapping Page

	Communicating with Benefits Assistant
	Pages Used to Communicate with the Benefits Assistant Chatbot
	Benefits Assistant Tile
	Benefits Assistant Page



